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1.  What's new?

1.1.  New in Switch 2020 Spring
This release includes the following features:

The Switch Web Portal

• Now it's possible to bookmark your favorite Portal page as your homepage, so it's shown by
default when you log in. Refer to Setting a homepage on page 317.

• Administrators can now also view flows remotely, from within the Portal. They can even add
annotations to the flows and print the flow documentation. Note that for the moment, it's
only a viewer: it's not possible (yet) to edit flows remotely. Refer to Admin view: Flow viewer on
page 372.

Other changes and improvements

• There is a new Switch component, Switch Processor, that enables Switch users to run
Node.js scripts (via the script element). This new Switch component is installed as part of the
Switch Service. More information about the support for Node.js can be found in the Switch
scripting guide (available on our website).

• The Messages overview opened in Designer (instead of a browser window), has got the same
look and feel as the browser version. Remember that you can choose where to open the
Messages overview via the User interface category of the Switch preferences (last setting).
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2.  Understanding Switch

2.1.  About Enfocus Switch
Enfocus Switch is a modular software solution that allows you to automate tasks, such as
receiving files or folders, sorting them and routing them to a particular process or folder.

Modules

Switch consists of different modules:

• A core engine module, which offers the basic functionalities, and
• A number of additional modules that you can purchase if you need more advanced

functionality.

The table below gives an overview of the different modules.

Module Description

Switch Core
Engine

• Provides the basic functionality for receiving, sorting, routing and
tracking of files.

• Enables PDF-specific handling like splitting and merging of PDF
files.

Configurator
Module

• Allows you to use a number of third-party applications in a Switch
flow, such as the Adobe Creative Suite and other applications that
are often used in the graphical industry. For a list of all supported
applications, refer to the Configurator Module documentation.

• For each of the supported applications, Switch offers a configurator
which streamlines the connection between Switch and the
application concerned, and controls the output destination of the
processed files.

Note:  All supported configurators are available by default,
but you must have an active license for the third-party
application to be able to use the configurator. For example,
you can only use Adobe InDesign in a Switch flow if you
have an active license for Adobe InDesign.

Database Module • Automates the communication between databases and Switch,
without the need for additional scripting.

• If you have purchased the Database Module, the Database connect
flow element becomes available and allows you to integrate a
database into your Switch flow, i.e.:

• Use values from a database.
• Read, write, update and delete information in a database.
• View database values through the Switch Web Portal.
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Module Description

Metadata Module • Allows you to use metadata information stored in XML or JDF
tickets, stored as XMP data, or stored as a dataset in some custom
file format (opaque dataset).

• If you have purchased the Metadata Module, the Metadata flow
elements become available, allowing you to:

• Use metadata wherever Switch uses variables, for example to
route files or process jobs dynamically.

• Update or add information in XMP packages.

Scripting Module • Allows you to use scripts and script expressions in Switch.
• Scripts can be developed with SwitchScripter, a Switch application

component that comes with the Switch core engine. You don't
need an active license for the Scripting Module to develop scripts;
however, to use them in Switch (using the Script element), you do
need such a license.

• If you want to write scripts for the integration of third-party
applications in Switch, you also need to buy the Configurator SDK.
Contact Enfocus for more information.

SwitchClient
Module

• Allows you to access the Switch Server remotely. You can:

• Submit jobs to Switch flows (via Submit points)
• Review and route jobs (via Checkpoints)

• You can either use this functionality through the Switch Web Portal,
or through your own custom job client.

• The SwitchClient Module comes with 5 concurrent user licenses,
meaning that 5 users can access Switch through a web interface
at the same time. Additional client licenses can be purchased if
necessary.

Switch Web
Services Module

• Allows you to design custom Switch client interfaces with existing
applications or web-based interfaces. For example, you could build
an interface to allow your customers to submit files straight from
your company website.

• Allows you to submit and check jobs through the Switch Web
Portal.

• The API is well-documented and can be found on the Enfocus
website.

Performance
Module

• The Performance Module offers additional processing capabilities,
i.e. an unlimited number of concurrent processes as well as
advanced performance tuning.

Note:  The Switch Core Engine allows up to 4 concurrent
processes; you can also buy a specific license key
for additional concurrent processes. For more
information, please contact your local Enfocus reseller or
sales@enfocus.com.
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Module Description

Reporting Module • The Reporting Module allows you to create and display dashboards
on the Switch Web Portal. You can configure the data you want to
use (by defining job boards) and choose from different widgets to
display live data or historical data (to get statistics).

Note:  When you install Switch, all modules are installed by default, but you have only
access to those for which you have entered a license key.

2.2.  Switch application components
Switch consists of 5 applications components that are all installed at once when running the
Switch installer.

Switch Server

The Switch Server is the core engine of Switch. It runs in the background to execute all
processes and does not have its own interface.

Switch Server is started and terminated by the Switch Watchdog, an application designed to
monitor Switch Server. The Switch Watchdog doesn't have an interface either and is started and
terminated by the Designer, unless the Switch Watchdog is set up as a Windows service. In that
case, the Switch Server is started automatically when a user logs in, and Switch can continue
processing even if the Switch Designer is closed.

Switch Designer

The Switch Designer is the Switch user interface. It allows you to design, activate, and monitor
Switch workflows. The Designer communicates with and manages the Switch Server.

The Designer and the Server can run on the same computer to establish a one-on-one
communication, but this is not mandatory.

If you install Switch on multiple computers, you can launch the Designer from another computer
and manage the flows remotely. In that case, do not forget to define which users have the right
to connect to a given Switch Server by means of the Remote Designer (See Setting up Switch
users on page 57).

For a detailed overview, refer to the chapter about the Switch graphical user interface.

Switch Web Portal

The Switch Web Portal allows you to connect to the Switch Server through a web browser
interface, for example to view log messages and active jobs or to submit and check jobs
without having to use a Switch Designer. You can also create job boards to keep an eye on your
production and dashboards with counters and different kinds of graphs.

Note that submitting and checking jobs through the Web Portal requires a SwitchClient or a Web
Services license; creating dashboards requires a license for the Reporting Module.

Access rights for individual users or user groups can be set through the Users pane.

For more information, refer to Using the Switch Web Portal on page 312.
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Switch Web Services

The Switch Web Services take care of all data communication between Switch and its client
applications such as the Switch Web Portal, our customers' own clients etc. It's part of the
default Switch installation.

SwitchScripter
 

 

SwitchScripter offers a scripting development environment, that is, it allows creating and
testing script packages for use with Switch.

The Switch installer automatically installs SwitchScripter. Although there is no technical
requirement, SwitchScripter usually runs on the same computer as the Designer.

For more information, see Scripting Module on page 472.

2.3.  Getting started

Switch Quick Start Guide

If you are new to Switch, we recommend reading the Switch Quick Start Guide.

This Guide explains the basic concepts of Switch and helps you to create and design your first
flows. It also contains a number of exercises: you can try to make them yourself, and afterwards
check the sample solution or watch a video about the topic concerned.

The Switch Quick Start Guide is available on the Manuals section of the Enfocus website.

Training

You can also take an eLearning course (with interactive exercises), or watch a product movie or
a recorded webinar.

All training material can be found on the Learn section of the Enfocus website. Make sure to
select "Switch" and "Beginner".

A good start are the "Getting Started with Switch" eLearning modules:

• Module 1: Installation, activation and configuration

• Module 2: Creating your first flow

• Module 3: Exercise

• Module 4: Metadata

• Module 5: Working with folders and subfolders

• Module 6: Tips and tricks

9

http://www.enfocus.com/en/products/switch/manuals
http://www.enfocus.com/en/learn


Switch

3.  Installing, activating and starting Switch
This section contains all you need to know about installing, activating and starting Switch.

3.1.  Before you start the installation

General setup

Before you can use Switch, you must:

1. Install the application, by running the Switch Installer. The Switch Installer installs Switch
Designer and the other Switch components (Switch Server) with all the different Switch
modules (Core Engine, Configurator Module, Database Module ...).

2. Install the components that should run on a different system (optional). All components can
perfectly run on one system. However, for performance reasons, you may want to run the
Dashboard Service (needed to create job boards and dashboards on the Switch Portal) on a
different server. Or you may want to use Remote Designer (to be able to access the Switch
Server remotely). In that case, some extra steps are required.

3. Activate the modules on the server that is running Switch Server, by entering a valid license
key.

Note:  Afterwards, you can still activate additional Switch modules.

System requirements

Before installing Switch, make sure to check the system requirements on the Enfocus website.

Installation order for Switch and third-party applications/PitStop Server

If you are going to use Switch with a third-party application or PitStop Server (using a
configurator), we recommend installing this application first, before installing Switch. That way,
Switch can automatically find the third-party application. This is necessary for the configurator
to run.

If the third-party application/PitStop Server is installed afterwards while Switch is running,
make sure to restart Switch.

For more information, refer to About the Configurator Module on page 379 and About the
configurators on page 381.

Some tips to optimize the performance of Switch
Use multiple processors
As Switch is a multi-threaded application, it takes full advantage of multiple processor systems.
Also, if you're working with third-party applications, they too will require processing time
(cycles). More processors can help improve the overall performance.
The number of concurrent processing tasks is however limited by default in Switch Core Engine
(see the preference 'Concurrent processing tasks'). If you have a multi-core powerful system,
you may want to buy additional concurrent processes licenses or even the Performance module
to have an unlimited number of concurrent tasks.
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Ensure sufficient disk space and speed
Switch will be managing many files in and out of the Switch workflow. As well, 3rd-party
applications will need to open and work with files on the local Switch Server. To increase
performance of the system, selecting faster access (read/write) disk drives will help speed
up the performance of each application. Also ensure to allow for enough disk space to
accommodate your highest possible workload.

Provide sufficent system memory (RAM)
Although Switch is not RAM intensive, be sure to take into account third-party application
requirements as well. In general, the more RAM available, the better and it will help improve
the overall system performance.

Make sure to meet all network requirements
Given Switch will work with files from all over your network as well may be receiving or sending
information or jobs to other systems within your workflow, be sure the Switch Server can easily
access to all your shared systems.

3.2.  Installing Switch
Prerequisites: You must have administrator rights on your local computer to install and run
Switch.

Note:

• If you have already installed an older version of Switch, refer to Upgrading to a new
version of Switch on page 26.

To install Switch

1. Download Switch using the link you received from your local reseller.

Switch is only sold via local resellers. Different from other Enfocus products, you cannot
download it directly from the Enfocus website.

2. If necessary, double-click the Switch installer.

3. Follow the onscreen installation instructions.

Important:  It's important to pay attention to all messages shown during the
installation.

At some point Windows users will be asked to disable UAC. For more information, refer to
Disabling UAC (Windows only) on page 12.

4. During the 'Installation Type' step, select Switch Service.

This component installs the Switch Server, the Designer, the Dashboard Service and the
Switch Processor. This is the default setup, required for the system that will run the main
Switch processes. Do not clear this checkbox, unless you're installing a Remote Designer or
a Dashboard Service on a different system (see further).

If relevant, now install the components that should run on a different system.
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Once you have finished the installation, Switch is started automatically (unless you have turned
off the Start Switch Server automatically at login preference). Remember that you still have to
activate your Switch license(s) before you can start using Switch.

3.2.1.  Disabling UAC (Windows only)
User Account Control (UAC) is a security feature in Windows. It allows you to determine whether
or not you want to be notified if changes that require administrator permission are made to your
system.

During the installation of Switch, you are asked to disable UAC. If you don't, you will not be able
to install Switch, nor will you be able to work with it. You must leave UAC disabled, also after you
have finished the installation.

Note:  This warning may pop up even if you have already disabled UAC. In that case, just
ignore the warning and click Next to proceed.

To disable UAC

1. Open the User Account Control Settings panel.

If you don't know where to find it, open the Windows start screen and search for 'User
Account Control'.

2. Drag the slider to the bottom, to the option Never notify.

3. Click OK.

4. Restart the computer.

3.3.  Installing Switch components on a different
server

3.3.1.  Remote installation of the Dashboard Service
The Dashboard Service is the Switch service that is needed to create job boards and dashboards
on the Switch Portal. It is possible to install this service on a different system than Switch
Server. For more info concerning the dashboard functionality, refer to Finding Switch jobs
through the Switch Web Portal on page 324.

Installation

1. Start the Switch installer on the system where you want to install the Dashboard Service.
2. During the 'Installation Type' step, clear the Switch Service checkbox and select the

Dashboard Service checkbox.

After installation, the Dashboard Service is started automatically.
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Configuration

1. On the system where you installed the Dashboard Service, the PortsSettings.prefs file
contains the port for communication between Switch Server and the Dashboard Service. If
necessary, you can change the default port (55092).

Location of PortsSettings.prefs:

• Windows: C:\Users\<Username>\AppData\Roaming\Enfocus\Switch\

• Mac: /Users/<Username>/Library/Application Support/Enfocus/Switch/).
2. On the system where Switch Server is installed, configure the Dashboard Service Location in

the Switch User preferences (Reporting preference).

3.3.2.  Remote installation of Switch Designer

Local Designer versus Remote Designer

By default, Switch is installed and activated on one system, and this one system will be used to
configure Switch flows (with Switch Designer) and to run processes (with Switch Server).

However, it's also possible to access Switch Server remotely, so you can configure flows and
administer Switch on another computer than the one that is running the processes. This is
called a Remote Designer.

You can have several Remote Designers managing one particular Switch Server; just make sure
that you're using the same version of Switch on all systems.

Installation

1. Start the Switch installer on the system on which you want to install a Remote Designer.
2. Follow the installation instructions; during the 'Installation Type' step, clear the Switch

Service checkbox and select the Designer checkbox.

When starting Switch, you will be asked if you want to connect to a local or a remote Switch
Server.

See also Starting Switch on page 27.

Configuration

Do not forget to configure the users and/or users groups that will have the right to use Remote
Designer. This must be done on the system that runs Switch Server.

3.4.  Activating Switch
Once you have installed Switch, you must activate the application on the system that runs Switch
Server.

Trial version

If you want to try the application before you buy it, you can activate a trial version. A trial version
remains active for 30 days.
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The Switch Core Engine doesn't have a built-in trial version; contact your local Enfocus reseller
and request a trial version. You will receive a license key which can be activated in the same way
as a purchased license (see further).

The Switch additional modules do have a built-in trial version. Once you have activated the
Switch Core Engine, you can activate trial versions of the other modules, without having to
contact a reseller. Refer to Activating a Switch trial for additional modules (online method) on page
19 or Activating a Switch trial for additional modules (offline method) on page 20.

Licensed version

If you have bought the application, you can activate the modules for which you have a license:

• If you installed Switch on a computer with internet access, refer to Activating Switch (online
method) on page 14.

• If you installed Switch on a computer without internet access, refer to Activating Switch (offline
method) on page 15.

Note:  In this case, you need another computer with internet access to communicate
with the Enfocus web server.

Remember that you can only activate licenses with a local Designer. When using Remote
Designer, you can view the license information, but you cannot change it.

3.4.1.  Activating Switch (online method)

Once you have installed Switch, you must activate the modules for which you have a license.

Note:

• You need at least a license for the Switch Core Engine. Other modules are optional.
• If you’re using a firewall, make sure to allow Switch to communicate with https://

licensingservices.esko.com using ports 80 and 443.

This procedure describes how to activate Switch on a computer with internet access.

To activate Switch

1. Start Switch and connect to the local Switch Server.

Activation is only possible on a local Switch Server.

The About Enfocus Switch dialog appears.

2. Enter your Enfocus ID and password.

If you don't have an Enfocus ID yet, click the Create Enfocus ID link and enter the required
information. Your account is created immediately, so you can proceed with the activation
procedure.

Note:  If your system environment requires HTTP connections to pass through a
proxy server, Switch will ask you to enter the details of your proxy server. Note that,
to be able to use external services with Switch, you will also have to turn on the HTTP
proxy user preferences.

3. Click Sign In.
A dialog pops up. Here you should enter your product key(s) or your product key license file.
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4. To supply your product key(s), do one of the following:

• Enter the product keys in the text area.
• Drop the product key file into the text area.
• Click Browse to select the product key license file from a location on your local system.

A green check mark next to the product key indicates that the key is valid.

5. Click Activate.
The Manage licenses dialog appears, providing you with an overview of the Switch modules
and their current activation status. If you have activated a time-limited license, you'll see

a yellow icon ; a permanent license results in a green icon  next to the module
concerned.

6. Click Close.

3.4.2.  Activating Switch (offline method)
This procedure describes how to activate Switch on a computer without internet access.

Prerequisites:

• You must have an additional computer with internet access to communicate with the Enfocus
web server.

• You need an Enfocus ID.

To create an Enfocus ID (on a computer with internet access), go to https://my.enfocus.com/
en/user/register and follow the on-screen instructions. Your account is created immediately,
so you can proceed with the activation procedure.

How it works:

Activating Switch offline consists of three steps:

1. Create an activation request on the computer on which you installed Switch.
2. Save this file on another computer with internet access and upload it to the Enfocus

activation website. Enfocus will check your licenses and, if the license is valid, provide you
with a response file.

3. Upload the response file to the computer on which you installed Switch and activate it.

Each of these steps is explained below.

To activate Switch

1. On the computer on which you installed Switch:

a. Start Switch and connect to the local Switch Server.

Activation is only possible on a local Switch Server.

The Enfocus Software Activation dialog appears.
b. Enter your Enfocus ID and password.
c. Enter your product key by doing one of the following:

• Type or copy-paste your product key in the Product key field.
• Browse to your product key license file or drag and drop it into the Product key field.

d. Select the Off-Line Mode checkbox.
e. Click Activate.

15

https://my.enfocus.com/en/user/register
https://my.enfocus.com/en/user/register


Switch

f. In the Off-Line Activation dialog, click Save and save the activation request file
requestactivate.xml on your local computer.

2. On a computer with internet access:

a. Make requestactivate.xml available.

Tip:  You can copy requestactivate.xml to a USB stick, and connect the USB stick
to your online system.

b. Go to http://www.enfocus.com/products/activation?lang=en
c. Select Offline Product Activation, and click Continue.
d. Upload requestactivate.xml, and click Continue.
e. Fill in your Enfocus ID password, and click Continue.
f. Click Continue to confirm.

The Enfocus web server creates a file: response.xml.
g. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.
b. In the Off-Line Activation dialog (see step 1f), in the right part, click Load and upload

response.xml.
c. Click Activate.

You have activated Switch.
d. Click Close.

3.5.  Managing your Switch licenses
Once you have installed Switch, you can manage your licenses from within the application.
You can for example check the status of your licenses, activate additional modules, deactivate
modules, export license information, and so on.

3.5.1.  About the Switch licenses
Switch modules are activated via licenses or product keys. For each module you want to use, you
need a separate license.

Note:  An overview of your licenses can be found in the Manage licenses pane (Help >
Manage Licenses).
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Trial licenses

If you are new to Switch, you can try the software for a period of 30 days. Request a trial key via
the form on the Enfocus website.

You will receive a key for the Switch Core Engine. The other modules can be activated separately
via the Trial button in the Manage Licenses panel (see Activating a Switch trial for additional
modules (online method) on page 19).

Module licenses

At the time of the purchase, you receive an HTML file with a key for each module you have
bought.

The Switch Core Engine license is mandatory. The other modules are optional and can be
activated afterwards when you need them. If the Switch Core Engine license expires before a
module's trial period or time limit, then the modules will stop working too.

License Status versus Maintenance Status

The License Status indicates the validity of the license; if the license status is active, you have
the right to use the Switch module.

The Maintenance Status (only shown in the details of the Core Engine) indicates if your
maintenance contract for Switch is expired or about to expire. Maintenance is mandatory during
the first year and includes free updates of the software and priority tech support.

The Maintenance End Date indicates the end of the maintenance period (not of the license!):
after that date, the software will continue to work, but you will no longer be entitled to free
updates and support. The Maintenance End Status will be "Expired" and the Maintenance End
Date will be a date in the past.

If you renew your maintenance contract, you will receive a Switch Maintenance key. This key will
have a new Maintenance End Date that will be taken into account to determine whether or not
you have the right to upgrade. Do not forget to activate this new maintenance key, so the details
and the new Maintenance End Date become visible in the Manage Licenses panel.
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Upgrading to a new Switch version

To determine whether or not you are entitled to a new Switch version, the Application Creation
Date is used.

The Application Creation Date is the release date of the Switch version installed on your
computer. This date is compared to the Maintenance End Date: if that version of Switch was
released before the Maintenance End Date, you're entitled to use it.

For example, if your maintenance expired on 28/03/2018, you have the right to upgrade to Switch
2018 (released on 22/03/2018), no matter what the current date is and although the Maintenance
Status is "Expired".

However, if your maintenance expired on 28/02/2018, you do not have the right to upgrade to
Switch 2018 (released on 22/03/2018); if you'd like to upgrade (from Switch 13 or 2017), you must
renew your maintenance contract.

For more information, refer to Upgrading to a new version of Switch on page 26.

Note:  The Switch 2019 license is backward compatible to Switch 2017.x, meaning that
you can use the Switch 2019 key to run previous versions of Switch if required.

Additional concurrent processes
The Switch Core Engine allows for up to 4 concurrent processes. If that's not sufficient, you can
buy a number of additional concurrent processes through a license of the Performance Module.

To know how many concurrent processes have been licensed, check the value of the "Allowed
Concurrent Processes" field in the details of the Core Engine or the Performance Module
license.

The first number represents the number of allowed concurrent processes based on the selected
module, the second number represents the total number of concurrent processes for the whole
Switch installation. In the below example, 1 additional license for the Performance Module has
been purchased (in addition to the 4 included in the Core Engine).

3.5.2.  Checking the status of your Switch licenses
Check the status of your licenses, if you want to know which Switch modules are activated, when
your licenses expire or when your maintenance contract ends. The end of your maintenance
contract is important, because it determines whether or not you can upgrade to a new version of
Switch.

To check the status of your Switch licenses

1. Open Switch.

2. On the Help menu, click Manage licenses.

3. In the left part of the Manage licenses dialog, select the module of which you want to see the
status.
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The details of the selected module are shown in the Details pane on the right. For more
information, refer to About the Switch licenses on page 16.

The table below explains the icons that represent the License Status.

Icon Meaning

 

 

The license is time-limited. You can use the module concerned during a certain
period of time. Check the License Period in the right part of the dialog.

 

 

The license is permanent.

 

 

The license has expired. You will not be able to use the module concerned.

3.5.3.  Activating a Switch trial for additional modules (online
method)

You can activate a 30-day trial for one or more additional modules.

Note:  Contact your local reseller if you want to try the Switch Core Engine.

Trial versions cannot be deactivated; they become inactive once the trial period has expired.

This procedure describes how to activate Switch on a computer with internet access.

To activate a Switch trial for additional Switch modules

1. Start Switch and connect to the local Switch Server.

Activation is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.
The Manage licenses dialog appears.

3. Select the module(s) you want to activate.

4. Click Trial.

5. If you're not signed in in Switch yet, a dialog will pop-up. Enter your Enfocus ID and
password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you don't
remember your password, click the Forgot Password? link.

6. In the dialog that appears, click Activate.
You have activated a Switch trial version. All information about the activated version (for
example the validity period) is displayed in the right part of the Manage licenses dialog.
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7. Click Close.

3.5.4.  Activating a Switch trial for additional modules (offline
method)

You can activate a 30-day trial for one or more additional modules.

Note:  Contact your local reseller if you want to try the Switch Core Engine.

Trial versions cannot be deactivated; they become inactive once the trial period has been
expired.

This procedure describes how to activate Switch on a computer without internet access.

Prerequisites:

• You must have an additional computer with internet access to communicate with the Enfocus
web server.

How it works:

Activating Switch modules offline consists of three steps:

1. Create an activation request on the computer on which you installed Switch.
2. Save this file on another computer with internet access and upload it to the Enfocus

activation website. Enfocus will provide you with a response file.
3. Upload the response file to the computer on which you installed Switch and activate it.

Each of these steps is explained in detail below.

To activate a Switch trial for additional Switch modules

1. On the computer on which you installed Switch:

a. Start Switch and connect to the local Switch Server.

Activation is only possible on a local Switch Server.
b. On the Help menu, click Manage licenses.

The Manage licenses dialog appears.
c. Select the module(s) for which you want to activate a trial.
d. Click Trial.
e. In the Enfocus Software Activation dialog, select the Off-Line Mode checkbox.
f. Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you
don't remember your password, on your computer with internet access, go to https://
my.enfocus.com/en/user/password.

g. Click Activate.
h. In the Off-Line Activation dialog, click Save and save the activation request file

requestactivate.xml on your local computer.

2. On a computer with internet access:

a. Make requestactivate.xml available.

Tip:  You can copy requestactivate.xml to a USB stick, and connect the USB stick
to your online system.
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b. Go to http://www.enfocus.com/products/activation?lang=en
c. Upload requestactivate.xml, and click Continue.
d. Fill in your Enfocus ID password, and click Continue.
e. Click Continue to confirm.

The Enfocus web server creates a file: response.xml.
f. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.
b. In the Off-Line Activation dialog (see step 1h), in the right part, click Load and upload

response.xml.
c. Click Activate.

You have activated a Switch trial version. All information about the activated version (for
example the validity period) is displayed in the right part of the Manage licenses dialog.

d. Click Close.

After updating the license keys, you must restart the application.

3.5.5.  Activating additional Switch modules (online method)
If you have purchased one or more additional modules, you have to activate them by entering the
product keys you received from your local reseller.

This procedure describes how to activate additional modules on a computer with internet access.

To activate additional modules

1. Start Switch and connect to a local Switch Server.

Activation is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.
The Manage licenses dialog appears.

3. Click Activate New.

4. If you're not signed in in Switch yet, a dialog appears. Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you don't
remember your password, click the Forgot Password? link.

5. To supply your product key(s), do one of the following:

• Enter the product keys in the text area.
• Drag and drop the product key license file into the text area.
• Click Browse to select the product file from a location on your local system.

A green check mark next to the product key indicates that the key is valid.

6. Click Activate.

In the right part of the dialog, a green icon  (in case of a permanent license) or a yellow

icon (in case of a time-limited license) appears next to the activated module(s).

7. Click Close.
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After updating the license keys, you must restart the application.

3.5.6.  Activating additional Switch modules (offline method)
This procedure describes how to activate additional modules on a computer without internet
access.

Prerequisites: You must have an additional computer with internet access to communicate with
the Enfocus web server.

If you have purchased one or more additional modules, you have to activate them by entering the
product keys you received from your local reseller.

Activating Switch modules offline consists of three steps:

1. Create an activation request on the computer on which you installed Switch.
2. Save this file on another computer with internet access and upload it to the Enfocus

activation website. Enfocus will check your licenses and, if the license is valid, provide you
with a response file.

3. Upload the response file to the computer on which you installed Switch and activate it.

Each of these steps is explained in detail below.

To activate additional modules

1. On the computer on which you installed Switch:

a. Start Switch and connect to a local Switch Server.

Activation is only possible on a local Switch Server.
b. On the Help menu, click Manage licenses.

The Manage licenses dialog appears.
c. Click Activate New.
d. Enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you
don't remember your password, on your computer with internet access, go to https://
my.enfocus.com/en/user/password.

e. Enter your product key(s) by doing one of the following:

• Type or copy-paste your product key in the Product key field.
• Browse to your product key license file or drag and drop it to the Product key field.

f. Select the Off-Line Mode checkbox.
g. Click Activate.
h. In the Off-Line Activation dialog, click Save and save the activation request file

requestactivate.xml on your local computer.

2. On a computer with internet access:

a. Make requestactivate.xml available.

Tip:  You can copy requestactivate.xml to a USB stick, and connect the USB stick
to your online system.

b. Go to http://www.enfocus.com/products/activation?lang=en
c. Upload requestactivate.xml, and click Continue.
d. Fill in your Enfocus ID password, and click Continue.
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e. Click Continue to confirm.
The Enfocus web server creates a file: response.xml.

f. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.
b. In the Off-Line Activation dialog (see step 1h), in the right part, click Load and upload

response.xml.
c. Click Activate.

You have activated the requested Switch modules.
d. Click Close.

After updating the license keys, you must restart the application.

3.5.7.  Deactivating Switch modules (online method)
Deactivate a Switch module if you want to move the license for this module to another computer,
or if for any reason you don't need it anymore.

This procedure describes how to deactivate additional modules on a computer with internet
access.

To deactivate Switch modules

1. Start Switch and connect to the local Switch Server.

Deactivation is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.

3. In the left part of the Manage licenses dialog, select the module(s) you want to deactivate.

To select multiple modules, hold down the Ctrl key while clicking the modules concerned.

The details of the selected module are shown in the Details pane on the right. For more
information, refer to About the Switch licenses on page 16.

4. Click Deactivate.

5. Make sure the Off-Line Mode checkbox is cleared.

6. If you want to export the license file (with the key being deactivated), so that you can
reactivate it on another system, proceed as follows:

a. Select the Export license information during deactivation checkbox.
b. Save the product key license file on your computer.

7. Click Deactivate.
The selected license is deactivated.

8. Click Close.

3.5.8.  Deactivating Switch modules (offline method)
This procedure describes how to deactivate additional modules on a computer without internet
access.
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You must have an additional computer with internet access to communicate with the Enfocus
web server.

Deactivate a Switch module if you want to move the license for this module to another computer,
or if for any reason you don't need it anymore.

Deactivating Switch offline consists of three steps:

1. Create a deactivation request on the computer on which you installed Switch.
2. Save this file on another computer with internet access and upload it to the Enfocus

activation website. Enfocus will provide you with a deactivation response file.
3. Upload the response file to the computer on which you installed Switch and deactivate it.

These steps are explained in detail below.

To deactivate Switch modules

1. On the computer on which you installed Switch:

a. Open Switch
b. On the Help menu, click Manage licenses.
c. In the left part of the Manage licenses dialog, select the module(s) you want to

deactivate.

To select multiple modules, hold down the Ctrl key while clicking the modules
concerned.

d. Click Deactivate.
e. In the Enfocus Software Activation dialog, select the Off-Line Mode checkbox.
f. Select the Export license information during deactivation checkbox.

This enables you to export the license file (with the key being deactivated), so that you
can reactivate it on another system.

g. Click Deactivate.
A dialog pops up, allowing you to select a download location and a name for the license
backup file (LicensesBackup.html).

h. Browse to a download location, and click Save.
The Off-Line Deactivation dialog appears. It allows you to download a deactivation
request file.

i. In the left part of the dialog, click Save and save the deactivation request file
requestdeactivate.xml on your computer.

2. On a computer with internet access:

a. Make requestdeactivate.xml available.

Tip:  You can copy derequestactivate.xml to a USB stick, and connect the USB
stick to your online system.

b. Go to http://www.enfocus.com/products/activation?lang=en
c. Upload requestdeactivate.xml, and click Continue.
d. Fill in your Enfocus ID password, and click Continue.
e. Click Continue to confirm.

The Enfocus web server creates a file: response.xml.
f. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.
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b. In the Off-Line Deactivation dialog (see step 1i), in the right part, click Load and upload
response.xml.

c. Click Deactivate.
You have deactivated the selected Switch module(s).

d. Click Close.

3.5.9.  Repairing Switch (online method)
Licenses are linked to the hardware characteristics of your computer. If the hardware
characteristics change (for example: you added memory or a new network card), the license is
not valid anymore and you must repair it.

This procedure describes how to repair Switch on a computer with internet access.

To repair Switch

1. Start Switch and connect to a local Switch Server.

Repairing licenses is only possible on a local Switch Server.

2. On the Help menu, click Manage licenses.
The Manage licenses dialog appears.

3. Select the module(s) that need to be repaired.

If a module needs to be repaired, the Repair button is activated.

4. Click Repair.
The Enfocus Software Repair dialog is opened.

5. Make sure that the Off-Line Mode checkbox is cleared.

6. Click Repair.
Your system communicates with the Enfocus web server and repairs your license. In case of
problems, please contact Enfocus:

• activation@enfocus.com
• http://www.enfocus.com/en/support/request-feature-report-problem

7. Click Close.

3.5.10.  Repairing Switch (offline method)
This procedure describes how to repair Switch on a computer without internet access.

Prerequisite: You must have an additional computer with internet access to communicate with
the Enfocus web server.

Licenses are linked to the hardware characteristics of your computer. If the hardware
characteristics change (for example: you added memory or a new network card), the license is
not valid anymore and you must repair it.

Repairing Switch offline consists of three steps:

1. Create a repair request on the computer on which you installed Switch.
2. Save this file on another computer with internet access and upload it to the Enfocus

activation website. Enfocus will provide you with a deactivation response file.
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3. Upload the response file to the computer on which you installed Switch and repair it.

These steps are explained in detail below.

To repair Switch

1. On the computer on which you installed Switch:

a. Start Switch and connect to a local Switch Server.

Repairing licenses is only possible on a local Switch Server.
b. On the Help menu, click Manage licenses.

The Manage licenses dialog appears.
c. Select the module(s) that need to be repaired.

If a module needs to be repaired, the Repair button is activated.
d. Click Repair.

The Enfocus Software Repair dialog is opened.
e. Select the Off-Line Mode checkbox.
f. Click Repair.
g. In the Off-Line Repair dialog, click Save and save the repair request file

requestrepair.xml on your local computer.

2. On a computer with internet access:

a. Make requestrepair.xml available.

Tip:  You can copy requestrepair.xml to a USB stick, and connect the USB stick to
your online system.

b. Go to http://www.enfocus.com/products/activation?lang=en
c. Upload requestrepair.xml, and click Continue.
d. Fill in your Enfocus ID password, and click Continue.
e. Click Continue to confirm.

The Enfocus web server creates a file: response.xml.
f. Download the file.

3. On the computer on which you installed Switch:

a. Make response.xml available on this computer.
b. In the Off-Line Repair dialog (see step 1f), in the right part, click Load and upload

response.xml.
c. Click Repair.

You have repaired Switch. In case of problems, please contact Enfocus:

• activation@enfocus.com
• http://www.enfocus.com/en/support/request-feature-report-problem

d. Click Close.

3.5.11.  Upgrading to a new version of Switch
Upgrading to a new Switch version will replace your current version. As soon as you launch
Switch, all your flows will be upgraded as well.

Important:  Before you start, check your maintenance status (by selecting Help >
Manage licenses). You can only upgrade if the Switch Maintenance End Date is more
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recent than the Application Creation date (i.e. the creation date of the new Switch
version). If this is not the case, please contact your local reseller and request a
maintenance key.

To upgrade your current version to a new version of Switch

1. Quit all Switch processes (Designer, Server, Watchdog, Scripter) (using File > Stop Switch
Server).

If the preference Start Server automatically at login is set to No and if there are no active
flows, quitting the Designer will stop the Switch Server and the Watchdog automatically.

If the preference Start Server automatically at login is set to Yes, you can stop the server
manually. Refer to Stopping the Switch Server on page 485.

Tip:  To ensure that there are no Switch processes running, you can use the Activity
Monitor on Mac or the Task Manager on Windows.

2. Install the new version of Switch.

We strongly recommend making a backup of the Switch data root (after installing) but
before starting Switch Designer. On Windows, you can immediately start making a backup by
clicking the Yes button in the dialog that appears at the end of the installation process. On
Mac, you should locate and start the backup tool yourself. Refer to Making a backup of your
Switch installation on page 489.

3. Launch Switch.
After installing a new version of Switch, when it is launched for the first time, Switch detects
the version change and presents a warning dialog.

4. Click the Proceed button.

If you click the Cancel button, Switch quits without making any changes to the flows. In that
case, you will not be able to work with these flows in the new version.

Switch makes a backup of existing flows and then re-imports them. While re-importing the
flows, Switch adjusts all flow elements and properties so that they comply with the current
version of Switch. If there are any problems, a warning appears. For more information, refer
to Importing and exporting flows on page 276.

3.6.  Starting Switch
Prerequisites: You must have administrator rights on your computer to run Switch.

When starting Switch, you are actually starting the Switch Designer. With Switch Designer you
can then connect to a local Switch Server, or to a Switch Server installed (and already running)
on another computer.

Note:  Switch Server allows only one connection at a time, from either a local or a
remote Designer. The same holds for Switch Designer: Switch Designer can only be
connected to one single (local or remote) Switch Server at a time.

To start Switch

1. Do one of the following:
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• Select Switch in the Start menu (Windows)
• Locate the application (Switch.exe or Switch.app) and double-click to start Switch.

Switch is installed by default in the following directory:

• Windows: C:\Program Files\Enfocus\Enfocus Switch

• Mac OS: /Applications/Enfocus/Enfocus Switch

2. In the Connect to Switch Server dialog, do one of the following:

• To connect to the Switch Server installed on your local computer, select the Connect to
local Switch Server checkbox.

• To connect remotely, i.e. to connect to a Switch Server installed on another computer,
enter the required details:

• IP address or host name of the computer on which you have installed Switch Server.

Note:  The previously used IP address (if any) is stored.

• Port number

Note:  You can set a default value for the port number. See Switch preferences:
Internal communication on page 47.

• User name and password as required.

Note:  This depends on the setup in the Users pane.

Note:  To be able to connect remotely, the Switch Server must be running on the
remote computer. For more information, refer to Starting/restarting Switch Server on
page 29.

Tip:  You can automatically start the Switch Server every time you log in to
the operating system, by enabling the corresponding user preference (Start
Switch Server automatically at login). See Switch preferences: User interface
on page 32. Note that when this preference is enabled, Switch Server will
remain running even if you exit Switch Designer.

If you connect to a local Switch Server, the Switch Server is started automatically
when starting Switch.

3. To hide this dialog next time when you start Switch, clear the Show dialog at startup
checkbox.

Note:  If you hide this dialog, the selected connection (local or remote connection
to a particular computer) is considered the default connection. You can afterwards
still change the connection from within Switch, by selecting File > Connect to Switch
Server.

4. Click OK.
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If you're signed in with your Enfocus ID already, Switch Designer is opened. You can ignore
the remaining steps of this procedure. If you're not signed in yet, the About Switch dialog
appears and you should continue with the next step of this procedure.

5. On the Sign In tab, enter your Enfocus ID and password.

You should have created an Enfocus ID when activating the Switch Core Engine. If you don't
remember your password, click the Forgot Password? link.

Note:

• This step is not obligatory (but highly recommended), unless you want to activate
licenses or buy apps in the Enfocus Appstore. See Working with apps in Switch on
page 304.

• You remain signed in (until you sign out explicitly), so next time you start Switch,
you won't see this dialog anymore.

6. Click Close.
Switch Designer is opened. In the title bar of the Switch Designer, you can see:

• If you're connected with Remote Designer: Your user name followed by "@" and the IP
address or host name (as entered in step 2) of the computer you are connected to, for
example: "user@Switch Server MAC (10.33.133.213)"

• If you're connected with a local Designer: The name of the Switch Server followed by
"(localhost)".

Note:  Remember that your access rights depend on the settings in the Users pane.
Users having read-only access (this is indicated in the title bar), will not be able to
edit flows or to change settings.

7. If you're launching Switch for the first time, the Switch Insight Dashboard dialog pops
up. Read the text carefully and click Yes, I'd like my Dashboard to get your own personal
dashboard.

You can change your mind any time. For more info, refer to The Switch Insight Dashboard on
page 486.

3.7.  Starting/restarting Switch Server
Starting Switch Server

The Switch Server must be running in order to process tasks.

However, you do not have to start the Switch Server manually:

• If the Switch Server is configured to start automatically at login (see Switch preferences: User
interface on page 32), it starts when you log in to your operating system.

• On Windows, if the Switch Watchdog is configured as a Windows service, Switch Server starts
when you log in to your operating system.

• If Switch Server is not running when logging in to your operating system, the Switch Server is
started when you open Switch and connect to the local Designer.
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Note:  If the Switch Server is not yet running, connecting to the Switch Server with
Remote Designer is not possible! You must first connect to a local Designer (which
starts the Switch Server), before you can use the local Designer.

Restarting Switch Server

Restarting the Switch Server is only necessary if there are changes in the preferences or
licenses which require a Server restart.

To restart Switch Server

In Switch local Designer, select File > Restart Switch Server.

3.8.  Troubleshooting
When installing or activating Switch, you may encounter one of the following problems.

Activation license failed

If activating the license failed, check the following:

• If you copy-pasted the product key, double-check the license key pasted in the text field. You
may have forgotten part of the key, or you may have added redundant spaces by accident.

• If you uploaded a file, try with a new copy of the file. It may have been corrupted.
• If this doesn't solve the problem, contact your local reseller and ask for a new activation file.

Activation license expired

If your license has expired, contact your dealer to resolve this issue.

Not all modules are activated

If one of the modules you purchased for Switch is not activated, double-check whether you
received multiple activation files, and whether you have uploaded all of them.

If that does not resolve your problem, contact your local reseller and ask for the missing
licenses.

Need more help?

Contact the Enfocus support team using our Support Portal: http://www.enfocus.com/
supportportal.
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4.  Configuring Switch
Once you have installed and activated Switch, we recommend setting up:

• User preferences

Provide Switch with the required data to send e-mails and notifications, to use Active
Directory settings etc. Furthermore, you may want to change the language of the interface, to
set the preferences for error messages etc.

• Users

If you have licensed the SwitchClient Module, you should define which users are allowed
to access Switch through Submit points and/or Checkpoints, and assign these users the
appropriate access rights.

If you want to allow certain users to view messages and/or jobs via the Switch Web Portal,
you should explicitly do so via the Users pane.

If you want to allow certain users to view or create job boards and/or dashboards on the
Switch Web Portal, you should also do so via the Users pane.

If you are using Remote Designer, you should define who has the right to access the Switch
Server remotely.

• Switch Watchdog (Windows only) as a Windows Service

Set up Switch Watchdog as a Windows Service, to allow Switch to continue processing after
you have logged off from the computer.

• Setting up custom icons for job boards on page 68

If you're using job boards on the Switch Portal, you may consider replacing the standard
icons for file types with your own images.

4.1.  Configuring Switch user preferences
Switch user preferences allow you to:

• Customize Switch to your needs.

You can for example choose the language of the interface, indicate whether or not
unavailable configurators must be hidden, determine how many processes are allowed to
run in parallel etc.

• Provide Switch with data it needs for sending e-mail notifications, setting up FTP
connections, connecting to databases etc.

Note:  Note that, when launching Switch using Remote Designer, a number of user
preferences are hidden. Furthermore, if you have limited access (read-only access), you
will only be able to view the preferences; you will not be able to change them. For more
information, refer to Configuring Switch users on page 57.
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4.1.1.  Setting your Switch preferences
After you have installed and activated Switch, we recommend going over the user preferences
and setting them as required. Note that a number of settings are required, in order to run
Switch, for example the name of the Switch Server and, if you want to use Active Directory in
Switch, the Active Directory settings.

To set your Switch user preferences

1. Navigate to:

• On Windows OS : Edit > Preferences.
• On Mac OS: Enfocus Switch > Preferences.

The User preferences dialog appears.

2. In the left part of the dialog, click a category, for example User interface.
The corresponding properties are shown in the right part of the dialog. The meaning of the
different options is explained further in this manual.

3. Enter the required values.

4.1.2.  Switch preferences: User interface
These preferences allow you to configure some aspects of the Switch user interface.

Property Description

Designer
Language

The language of the user interface of the Switch Designer. You can select
one of the following languages:

• English
• German
• French
• Chinese
• Japanese

Note:

• Restart the Switch Designer to apply your changes.
• You can also configure the language of the Switch Server. For

more information, refer to Switch preferences: Processing on
page 39.

Large icons in
elements pane

If set to Yes, the Flow elements pane displays large icons; otherwise it
displays small icons.

Save flows
automatically

• If set to Yes, flows are saved automatically before they are processed
(activated, imported, exported).

• If set to No, you're explicitly asked if you want to save the changes
before activating, importing or exporting the flow
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Property Description

Note:  This preference can also be set to Yes by selecting the
Save flows automatically checkbox in the Modified flows dialog.
That is the dialog that pops up when you want to activate, import
or export a modified flow.

Start Switch
Server
automatically
at login

• If set to Yes, (default) the Switch Server is started automatically when
the user logs in, and it remains running, even if the user exits Switch
Designer.

• If set to No, the Switch Server will be started automatically when the
local Designer is started. If the local Designer exits, the behavior
depends on the currently active flows:

• If no flows are active, Switch Server is stopped automatically.
• If at least one flow is active, the preference below (When exiting

the flow designer) will determine what happens.

When exiting
the flow
designer

This option is only available if Start Switch Server automatically at login
is set to No. It determines what happens to the Switch Server when the
user quits Switch Designer:

Note:  This preference is taken into account only in case there
are currently active flows; otherwise Switch Server always exits
disregarding the preference value.

Options:

• Ensure processing is started: When quitting Switch Designer, Switch
Server remains running in the background and continues processing
the flows that are currently active.

• Ensure processing is stopped: When quitting Switch Designer, all
active flows are stopped and Switch Server exits.

• Ask the user (default option): When quitting Switch Designer,
Switch displays a dialog so the user can decide what to do. The user
can choose either to continue processing the active flows in the
background or stop all active flows and exit.

Show
messages in
Designer (beta
feature)

This option determines how the Log Messages overview is shown when
clicking the Messages button or View > Messages option or when
pressing F6 in the Switch Designer:

• If set to Yes, the Messages overview is opened inside Switch Designer,
in the Messages view (not in a separate window).

• If set to No, the Messages overview is opened in a separate browser
window, outside the Switch Designer user interface.

In both cases, the message overview contains the same information (so
the same messages). Refer to Viewing log messages  on page 285.

33



Switch

Property Description

Note:  This feature is not yet supported on all systems. If it
doesn't work on a your system, you'll get an empty window
instead of the Messages view.

4.1.3.  Switch preferences: Mail send
These preferences allow you to configure the settings for the Mail send and the Checkpoint via
mail tool. If you do not configure them, you will not be able to send e-mail notifications. You
can check if the settings are configured correctly by clicking the Test connection button at the
bottom of the dialog.

Property Description

SMTP server
address

The URL or IP address of the SMTP email relay server.

Example: smtp.gmail.com

SMTP port The port used by the SMTP server.

SMTP server
requires
authentication

Defines whether the SMTP server requires authentication.

If set to Yes, following additional fields appear:

• User name: The login name for the SMTP server, for example:
user@gmail.com. Leave empty if none is required.

• Password: The password for the SMTP server. Leave empty if none
is required.

• Use secure password verification: Defines whether or not to use
secure password verification.

If set to Yes, the Authentication method property appears.

• Authentication method:  The authentication method used to
establish the connection to the mail server. The following
secure authentication schemes are supported:

• Automatic (The element will try the different methods one
by one until the connection can be established)

• Password
• NTLM
• CRAM-MD5
• KERBEROS

Encrypt connection Defines whether or not the mail server requires an encrypted
connection (TLS1, 1.1, 1.2).

Options: Yes/No.

Sender name The sender's name for outgoing email messages.
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Property Description

Sender address The sender's address for outgoing email messages.

Note:

• The sender name and email address are used in the _From _SMTP header that is
normally shown by email client applications as 'From' field of an email. If the 'Reply
to' field of an email is not defined, the content of the 'From' field is used to send a
reply.

• It is also possible to use a different sender name and address for a particular flow. To
do so, you can specify the new name, email address and authentication parameters
(i.e. the user name and password linked to this email address) in the flow element
concerned. Refer to Mail send on page 178 and Checkpoint via mail on page 187.

Example: The screenshot below is an example of the Mail send preferences required for sending
e-mails using Gmail.

 

 

4.1.4.  Switch preferences: FTP proxy
If your system environment requires FTP connections to pass through a proxy server, you must
fill in the configuration details for the proxy server. Otherwise, you will not be able to use the
FTP receive and FTP send tools.

Property Description

Type of proxy The type of proxy:

• No proxy: no proxy is required for FTP connections

• Tunneling proxy: uses the HTTP protocol

• SOCKS4 proxy: uses the SOCKS4 protocol

• SOCKS5 proxy: uses the SOCKS5 protocol
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Property Description

Name or IP address
of host

Name or IP address of the proxy server on your local network.

Proxy user name The user name for logging in to the proxy server.

Proxy password The password for logging in to the proxy server.

Proxy port The port number for communicating with the proxy server.

Note:  If you are using the FTP proxy protocol (type of proxy = No proxy), do not forget to
enter the appropriate proxy information in the FTP receive and FTP send properties:

• In the FTP server address property, enter the name or IP address of the proxy server
(instead of the FTP site being targeted).

• In the user name property, append an @ sign and the target FTP
site address (domain or IP address) to the regular user name
( "<ftpserverusername>@<ftpserveraddress>").

• The other properties, including the password, remain unchanged.

See also: FTP receive on page 163 and FTP send on page 169.

4.1.5.  Switch preferences: HTTP proxy
If your system environment requires HTTP connections to pass through a proxy server, you must
fill in the configuration details for the proxy server. Otherwise, you will not be able to access the
internet or external services (e.g. upload files to DropBox using the HTTP request flow element
or download apps from the Enfocus Appstore).

Property Description

Use HTTP proxy Turn on or off HTTP proxy support.

If set to Yes, an HTTP proxy connection will be estabilished for all
HTTP(S) operations in Switch.

The depending properties are shown and filled in automatically if
they are present in the system settings.

Proxy server Name or IP address of the proxy server on your local network.

Proxy port Port number for communication with the proxy server.

Authenticate If set to Yes, credentials are required for logging on to the proxy
server. The following dependent properties pop up:

• Proxy user name
• Proxy password

The type of authentication is always Basic Authentication.
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Property Description

Bypass proxy for
these servers

Define the servers for which the proxy settings should NOT be
used, for example for local communication between different
internal servers or between the Switch Server and the Dashboard
Service. You can enter the IP addresses (one per line) or the host
name. Note that you can use the wildcards "*" and "?" to denote a
range of servers.

Example: 192.166.4.14?

4.1.6.  Switch preferences: Mac file types
Mac files not always have a filename extension. Still, filename extensions are useful, to avoid
confusion and to make it possible to exchange files with other operating systems (Windows,
Unix). That's why Switch offers the possibility to automatically add filename extensions to all
files (without filename extension) arriving in Switch. This filename extension is based on Mac file
type information associated with the file (i.e. the file type and file creator codes).

For more information, refer to to About Mac file types on page 37.

Property Description

Add filename
extension

If set to Yes, Switch automatically adds a filename extension to arriving
Mac files; if set to No (default value), the filename is left unchanged.

4.1.6.1.  About Mac file types

Background information

Microsoft Windows uses the filename extension (which is required) to determine a file's type.

Apple's Mac OS X uses the filename extension (if present) and in addition uses the file type and
creator codes (if present) stored in the catalog entry for the file. This allows Mac OS X to be
compatible with the external world (i.e. Windows and Unix, which use filename extensions) and
with Mac Classic (which exclusively used Mac file types).

Successfully exchanging files in a mixed platform environment requires performing a mapping
between Mac file types and filename extensions, and since the catalog entries for file type and
creator codes are supported only by Mac-specific file systems (such as HFS), they must be
emulated on foreign file systems (such as FAT).

Mac OS X (and Mac Classic) also allows files to have a resource fork (a second stream of
information in addition to the main data). In its most extreme form, a file may store all of its
information in the resource fork and have zero data bytes (as is the case for certain types of
Classic font files). Modern applications tend to rely less on the contents of the resource fork
than Classic applications, but in general the resource fork cannot be ignored.

Again resource forks are directly supported only by Mac-specific file systems, and thus must be
emulated on foreign file systems.
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Emulation with dot-underscore file (AppleDouble)

When a Mac OS X user copies a file from a Mac-specific volume to a foreign volume, the system
splits out any information that is not located in the data fork of the file and writes it to a hidden
file on the destination volume. The name of this file is the same as the original file except that it
has a dot-underscore prefix. For example, if the user copies a file named MyMug.jpg to a foreign
volume, there will be a file named ._MyMug.jpg in addition to the MyMug.jpg file in the same
location.

When a Mac OS X user copies a file from a foreign volume to a Mac-specific volume, the system
looks for a matching "dot-underscore" file. If one exists, the system uses the information in the
dot-underscore file to recreate the resource fork and file type attributes. If the hidden file does
not exist, these attributes are not recreated.

Emulation using NTFS alternate data streams

Although this feature is not widely known, the NTFS file system (used by most modern
Microsoft Windows systems) supports alternate data streams in a file. In a way this feature is
a generalization of the Mac resource fork concept. Each individual stream can be opened for
input or output, but otherwise the file (with all its associated streams) is managed as a single
unit. The Windows user interface provides no interface to alternate data streams, and regular
Windows applications never use alternate data streams.

Several AppleTalk file sharing protocol (AFP) implementations for Windows servers, including
Microsoft's own implementation, emulate Mac file types and resource forks on the Windows
NTFS file system using alternate data streams. Note that these AFP implementations do not
support the FAT file system since it doesn't offer alternate data streams.

This mechanism has the benefit of storing the emulated information in one single file with the
regular data. However the presence of this extra data is extremely hard to detect for a Windows
user (i.e. only through specialized shareware utilities).

Furthermore, while the Windows file system correctly copies any alternate data streams with
a file, the extra information is lost when the file is attached to an e-mail message or when it is
stored in an archive such as a ZIP.

Automatically adding filename extensions

On Windows a file must have a filename extension to be correctly recognized by the applications
operating on it; so there is almost never a reason for not including the extension that is
appropriate for the file's type.

Even on Mac OS X, while it is not a requirement, there seem to be several factors in favor of
including filename extensions when working with automated processes:

• It makes an implicit attribute explicit for the human operator, avoiding confusion (i.e. the
operator and the system might interpret the file type differently if it was not made explicit).

• It allows files to be more easily interchanged with foreign systems (which may happen even if
it is not currently planned).

Therefore Switch offers a function to automatically add an appropriate filename extension to
arriving files, based on Mac file type information associated with the file. This feature is turned
on by default (recommended), and it can be turned off in the Preferences dialog.

Specifically, when Switch detects that a new file has arrived (and the "Add filename extension"
feature is enabled), Switch looks for Mac file type information in the following way:

• On Mac OS X, it looks in the file system catalog.
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• On Windows, it looks for an appropriate alternate data stream attached to the file, and
it looks for a dot-underscore file with the same name as the file (in other words, Switch
supports both emulations discussed above).

If Switch finds meaningful Mac file type information, and if it can locate the corresponding
filename extension in its built-in table, and if the file doesn't already have the appropriate
filename extension, Switch will add the filename extension to the file's name. Otherwise the
filename is left unchanged.

Copying files

When Switch copies or moves a file under its own control (for example, between two folders),
it ensures that all available Mac file type information and resource fork data is copied along
with the file. (On Mac OS X this means using the native file operations; on Windows this involves
supporting the emulations discussed above).

This preserves Mac file type information (which may be superfluous if a filename extension is
also present), but more importantly it also preserves any resource fork data - which allows, for
example, to process Classic Mac fonts through Switch on a Windows system.

Note however that other processes and third-party applications may not carry along Mac file
types and resource forks. On Windows this is almost never the case, and even on Mac some
modern applications no longer support these Classic features.

Changing the file type

The file type tool allows setting a file's filename extension and/or Mac file and creator types
to a specified value. This is handy if you know the correct type of a file (for example, because
it was created by an application under your control) but you suspect that it may not have the
appropriate filename extension or Mac file type information.

Filtering on file type

Several Switch tools offer the possibility to sort files based on file type; see Specifying file filters
on page 246.

4.1.7.  Switch preferences: Processing
These preferences allow you to configure the way jobs are processed in Switch.

A number of these preferences affect the performance of Switch. For more information, refer to
Switch performance tuning on page 495.

Property Description

Server language Language used by the Switch Server for alert e-mails.You can select
one of the following languages:

• English
• German
• French
• Chinese
• Japanese

Note:
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Property Description

• Restart the Switch Server to apply your changes.

• You can also configure the language of the Switch Designer.
For more information, refer to Switch preferences: User
interface on page 32.

Language
environment

Indicates the overall language environment in which Switch is
installed: Western or Japanese.

This setting affects the text encoding defaults for email and ZIP
compression to match the legacy standards used in the selected
language environment (that is, for interacting with software that does
not use Unicode).

Concurrent
network transfer
tasks

The number of FTP and e-mail file transfers (counting both send and
receive) allowed to occur in parallel.

Concurrent
transfers to the
same site

The number of file transfers to the same FTP site allowed to occur in
parallel (counting both send and receive).

If there is no limit other than the overall maximum number of
concurrent file transfers (as determined by the previous preference),
select Automatic ; otherwise select Inline value and enter a value
between 1 and 100.

Concurrent
processing tasks

The number of job processing tasks allowed to run in parallel.

Note:  Recommended value = the number of CPUs of the
server + 1.

"Processing tasks" are tasks performed by the following flow
elements:

• All flow elements in the Configurators section
• The following elements in the Basics section:

• Set hierarchy path
• Ungroup job
• Split multi-job
• Assemble job
• Execute command

• The following elements in the Tools section:

• Sort by preflight state
• Compress
• Uncompress
• Split PDF
• Merge PDF
• Hold job
• Inject job
• Rename job
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Property Description

• Sort job
• Log job info
• Sort files in job

• The Script element in the Scripting section:

Heavy scripts affect the number of concurrent processing tasks. For
more details about light and heavy scripts, see Execution slots on
page 301.

• The following elements in the Communication section:

• Pack job
• Unpack job
• Monitor confirmation
• Remote process

• The Database connect element in the Database section.

Default number
of slots for
concurrent
elements

The number of slots available for scripts and tools working in
concurrent mode:

• 0 = Tasks will be executed in concurrent mode and all available
slots will be used.

• 1 (default) = Tasks will be executed one after the other (serialized
execution mode).

• 2 or more = Tasks will be performed in concurrent mode.

In Switch, the default value set in the Preferences can be overruled for
a particular flow. Proceed as follows:

1. Set the the flow property Allow advanced performance tuning to
Yes.

2. For all flow elements (in that particular flow) that support
concurrent processing, change the element property Number of
slots from Default to any other value.

Note:  Be cautious when tuning performance properties;
unwary use may slow down performance!

Scan user-
managed folders
every (seconds)

The frequency with which the user-managed folders (i.e. the folders
with a path defined by the user) and Submit hierarchies (i.e. by default
user-managed) are scanned for newly arrived jobs.

Process file only
after (seconds)

The time for which newly arrived jobs must be stable before they
are processed; to avoid picking up an input job before it has been
completely written to disk, Switch ensures that the size of the file (or
the total size of a job folder) has not changed for at least this amount of
time before processing the job.

Reactivate flows
upon startup

When starting up, if this property is set to Yes, Switch automatically
reactivates flows that were active when Switch was closed; otherwise
all flows are inactive after startup.
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Property Description

Stop processing
if free disk space
is less than (MB)

If the amount of free disk space for application data is lower than the
entered amount, processing will stop, avoiding "Disk Full" processing
errors.

Release acquired
slots after
(minutes)

When a flow is stopped, this option will determine when the acquired
slots are released. The default value is 20 minutes.

Note:  In Switch 2019 Spring, so before this preference was
added, acquired slots were released immediately. If you want
this, set this preference to 0.

This preference is relevant for flows with remote processing (that is,
flows that contain the Remote process flow element or scripts that
directly acquire and release slots). In the time period between the flow
stop and the release of the acquired slots, processing continues, so
that jobs that are being processed can be finished. After that time, all
jobs that are still in the flow are aborted.

4.1.8.  Switch preferences: Error handling
These preferences allow you to configure the way problems are handled in Switch.

Property Description

Abort file transfers
after (minutes)

Time in minutes. If an FTP or e-mail file transfer takes longer
than this, it is considered crashed or locked up and it is aborted.

If the value is set to 0, the transfer will never be aborted.

Abort FTP scanning
after (minutes)

If an FTP directory scanning takes longer than this time, it is
considered crashed or locked-up and it is aborted. The default
value is 30 minutes.

If the value is set to 0, the scanning operation will never be
aborted.

Abort processes after
(minutes)

Time in minutes. If a process other than a file transfer takes
longer than this, it is considered crashed or locked-up and it is
aborted.

If the value is set to 0, the transfer will never be aborted.

Abort FTP transfers on
stopping flow

Determines whether or not ongoing FTP transfers are aborted
immediately when a flow is stopped:

• Yes: The flow is stopped immediately. FTP transfers in
progress are aborted. This may result in partially uploaded
and corrupt files.

• No (default setting): The flow is stopped after the FTP
transfer has been finished.
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Property Description

Retry mail transfers
after (minutes)

Time interval in minutes. If a mail transfer fails, Switch tries
again after the specified number of minutes.

If the value is set to 0, Switch stops trying. (not recommended)

Retry FTP transfers
after (minutes)

Time interval in minutes. If an FTP transfer fails, Switch tries
again after the specified number of minutes.

If the value is set to 0, Switch stops trying. (not recommended)

Retry unreachable
folder after (minutes)

Time interval in minutes. If a folder cannot be reached, Switch
tries again after the specified number of minutes.

If the value is set to 0, Switch stops trying. (not recommended)

Retry failed external
processes after
(minutes)

Time interval in minutes. If an external process fails, Switch tries
again after the specified number of minutes.

If the value is set to 0, Switch stops trying. (in this case: the
recommended value!)

Send crash reports If Switch crashes, a detailed crash report is generated
automatically. This information is useful for Enfocus to improve
its software. You can choose to:

• Not send this information to Enfocus (Never).

• Automatically send the crash reports to Enfocus (Always).

• Have the user decide whether or not to send a crash report
(Ask user).

4.1.9.  Switch preferences: Problem alerts
These preferences allow you to configure the way system administrators are notified of
problems.

Property Description

Send problem alerts
to

Enter the destination e-mail addresses (one per line) and the body
text for your alert message; information about the error will be
appended to the body text.

Problem job arrives If set to Yes, an alert is sent whenever Switch moves a job to the
Problem jobs folder.

Processing takes
more than (minutes)

Send an alert if a process, other than the file transfer process,
takes longer than the time set (in minutes) here.

If set to 0, no alert will be sent.

Mail server is down
for more than
(minutes)

Send an alert when an email server cannot be accessed for the
time (in minutes) indicated here.
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Property Description

If set to 0, no alert will be sent.

FTP site is down for
more than (minutes)

Send an alert when an FTP site cannot be accessed for the time (in
minutes) indicated here.

If set to 0, no alert will be sent.

Folder is
unreachable for
more than (minutes)

Send an alert when a backing folder is unreachable for more than x
minutes.

External process
fails

If set to Yes, an alert is sent when a process other than folder, fails
(that is, its process is put in the "problem process" state).

Switch Server quit
unexpectedly

If set to Yes an alert is sent when upon startup, Switch detects that
the Switch Server quit unexpectedly (due to a hardware or software
failure).

Alert if free disk
space for application
data is less than, MB

Send an alert when the amount of free disk space for application
data is less than the defined amount.

4.1.10.  Switch preferences: Application data
These preferences configure the cleanup mechanism for Switch's application data, which is
stored in a nested folder hierarchy under a single root folder, which is called the Application
data root.

Some temporary application data cannot be removed automatically. To ensure that the amount
of data does not grow indefinitely, Switch performs a cleanup process at regular intervals.

Property Description

Application data root The location of the application data, i.e. the root folder for the
hierarchy in which the Switch application data is stored.

Default location:

• Windows: C:\Users\<user>\AppData\Roaming\Enfocus\Switch
Server

• Mac OS: /Users/<user>/Library/Application Support/Enfocus/
Switch Server/

Note:  For testing purposes, you can change the location
of the application data root tool using the Application Data
Root Tool. Note that changing data in the application data
folder is NOT allowed, unless explicitly requested by the
Enfocus Support team!

Keep internal job
tickets for (hours)

The time period (in hours) after which internal job tickets may be
deleted for jobs that left the flow; Switch will not delete internal
job tickets for jobs that are still active.
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Property Description

Note:  A job is considered inactive, if it is located in a flow
output folder (i.e. a folder without outgoing connections)
disregarding if the job's unique prefix has been stripped
or not. This means its job ticket will be cleaned up after
some time. If your workflow configuration assumes
handing over jobs between flows (like described in the
section on unique name prefixes), please, make sure
the time difference between the moment a job reaches
the end of the previous flow and the moment the job is
picked up by the next flow is less than the value of this
preference.

Keep log messages
for (hours)

The time period (in hours) after which log messages will be
deleted.

Run cleanup starting
at (hh:mm)

The time offset from midnight at which to run the cleanup process
for application data.

Run cleanup every
(hours)

The period or frequency with which to run the cleanup process for
application data.

4.1.11.  Switch preferences: Logging
These preferences allow you to configure the way (log) messages are handled in Switch.

For more information about the log messages, refer to The Messages overview on page 286.

Property Description

Log to CSV file If set to Yes, all execution log messages are written to a CSV
file in addition to the regular log database.

A new log file is created when the size of the log file has
reached 2.5 MB. The name of the log file includes the date
and the time (YYYYMM-DDHHmmss).

Note:  Enable this option only on request of
the Enfocus technical support team or if you're
debugging a script that issues debug messages.

The following options are only available if Log to CSV file is set to
Yes.

CSV file delimiter

The delimiter separating the records in the generated CSV log
file, for example a comma or a semicolon.

Log files folder

Folder where the CSV log files will be stored.
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Property Description

If set to Default, the log files are stored in the "Logs" folder of
the Application data root (see Switch preferences: Application
data on page 44).

Log debug messages If set to Yes, assert and debug messages are logged. They are
shown in the Messages overview and written to a CSV file.

If set to No, the assert and debug messages are discarded.

Note:  Enable this option only on request of
the Enfocus technical support team or if you're
debugging a script that issues debug messages.

Refer to The Messages overview on page 286.

Log FTP interaction If set to Yes, problems with failed FTP transfers are logged
and saved in:

• FtpSendTrace.log for FTP send
• FtpWatchFolderTrace.log and FtpReceiveTrace.log for FTP

receive

These files can be found in the logs folder of the Switch
Application Data Root (as set in the  Application data
preferences).

The following option is only available if Log FTP interaction is set
to Yes.

Clean the log when flow is activated

If set to Yes, the FTP interaction logs will be deleted when the
flow is activated.

Note:  When logs are stored for a long time, Switch
may become slow and sometimes non-responsive.
Therefore, we recommend clearing logs regularly.

4.1.12.  Switch preferences: Flows backup
When upgrading to a new version of Switch, the existing flows are updated automatically to that
version. That's also the case, when you're installing a new version of an app or a configurator: in
that case, the flows in which the updated app or configurator are used, are updated as well.

The preferences in this category allow you to make an automatic safety backup (at a location of
your choice) before updating the flows.

Property Description

Flows backup folder By default, this is a subfolder ('Backup ') of the application
data root, but you can choose a different location as required.
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Property Description

The flows are placed in a subfolder that refers to the date and
time of the export.

Backup flows before
updating

When set to Yes, a backup is made whenever an upgrade
takes place.

Note:  Group information is not preserved. The flows
are saved as separate flow files (*.sflow).

4.1.13.  Switch preferences: Internal communication
These preferences configure advanced settings related to the communication between Switch
application components. Do not change these settings unless you understand why you need to
change them.

Note:  The ports in the range 0 to 1023 are often managed by the IANA and should only
be used by privileged users.

Property Description

Switch Server name The name of the instance of the Switch Server as it is displayed
to users of the client application.

Note:  Changing the server name requires a restart of
Switch.

Port for Switch
Designer

The port used for communication between Switch Server and
Switch Designer, in the range of 1 to 65535.

Port for Watchdog -
Switch Server

The port used for communication between Switch Server and
Switch Watchdog, in the range of 1 to 65535.

Port for Watchdog The port used for communication between Switch Designer and
Switch Watchdog, in the range of 1 to 65535.

Note:  If you want to set a firewall rule to allow all network communication (like the
Switch Web Portal, FTP ...), you need to set an exception for the Switch Service process
instead of the Switch Designer process, because network communication for Switch
happens through this process. For more information on which ports should be used,
check the above table.

4.1.14.  Switch preferences: ODBC data sources
This section of the Preferences dialog is only relevant if you have an active license for the
Databases module.

It allows you to configure the ODBC database connection you want to use with Switch.
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Property Description

ODBC data
source
information

Click  to set up the database connections. See Setting up an ODBC
database connection on page 49.

4.1.14.1.  About ODBC data sources in Switch

Guidelines

Please take into account the following guidelines when accessing ODBC data sources in Switch:

Before you set up the connection to the data source, you should have defined your database
(i.e. the Database Source Name (DSN)) in the DSN settings of your operating system. Read the
documentation of your database to learn how to set up the DSN.

Windows users can find more information on the Microsoft website: http://msdn.microsoft.com/
en-us/library/ms710252%28v=VS.85%29.aspx

Mac users should install an ODBC Administrator, for example http://www.odbcmanager.net/, to
be able to set up ODBC connections on Mac.

Note:  Switch allows you to use both User and System DSN on Windows and Mac
platforms.

Make sure to install a 64-bit ODBC driver.

• Example Windows OS: In case of MySQL database, the ODBC driver installer mysql-
connector-odbc-5.1.8-winx64.msi is used. When you launch this installer and choose the
Custom installation, you will see that two drivers are available: 32-bit and 64-bit. Install the
64-bit driver and preferably disable the 32-bit driver, to avoid mix-up of driver versions in the
future. This will guarantee that Switch uses the correct driver.

For more information on ODBC drivers and data sources, refer to http://msdn.microsoft.com/en-
us/library/ms710285%28v=VS.85%29.aspx .

• Example Mac OS X: In the MySQL database, two versions of Mac OS X ODBC drivers are
available: 32-bit and 64-bit. You must use the 64-bit version (mysql-connector-odbc-5.2.7-
osx10.7-x86-64bit.dmg).

Make sure to use the 64-bit version of the ODBC Administrator tool to configure your data
sources (DSNs).

On 64-bit Windows computers, two ODBC Administrator tools are available:

• 32-bit version: ..\windows\sysWOW64\odbcad32.exe

• 64-bit version: ..\windows\system32\odbcad32.exe

Use the 64-bit version from \windows\system32\odbcad32.exe to configure your DSNs for
Switch.

• If you install only the 64-bit ODBC driver and then launch the 32-bit version of the tool, you
will not be able to configure any DSNs, because the 32-bit version of the tool does not show
the 64-bit ODBC drivers.

• If you have installed the 32-bit ODBC drivers, then in the 32-bit version of the tool you will see
the 32-bit driver and you will be able to configure DSNs for that driver. However, Switch will
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not work with these DSNs and you will get the error message The specified DSN contains an
architecture mismatch between the Driver and Application".

For more information on managing data sources, refer to http://msdn.microsoft.com/en-us/
library/ms712362%28v=VS.85%29.aspx .

Using the INGRES database in combination with Switch?

You should set the following flag (in the INGRES database):

return NULL for SCHEMA columns in ODBC catalog function result sets 

Otherwise, you will get an error ("invalid table") when setting up SQL statements.

4.1.14.2.  Setting up an ODBC database connection
If you want to use Switch with an ODBC data source (and you have licensed the Database
module), you must set up a connection to the preferred database.

Note:  If you have more than one database, you can configure different database
connections as required.

To configure an ODBC database connection

1. In Switch, navigate to Edit > User Preferences > ODBC data sources.

2. Do one of the following:

•
Select the ODBC data source information field and click .

• Double-click the ODBC data source information field.

The ODBC data sources dialog appears.

3.
To add and configure an ODBC data source, click .
The ODBC sources field now contains one data source, temporarily called Data Source. You
can rename it in the next step of this procedure.
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4. In the Properties pane, in the Data Source text field, provide a name for the data source.

5. In the Description text field, provide a small definition for the data source.

6.
To select the DSN (Database Source Name) from the library, click .

The DSN must be defined in the DSN settings of your operating system. For more
information, refer to About ODBC data sources in Switch on page 48.

7. Provide a Username and Password.

These two fields can also be left blank if username and password are not required, or if they
have already been defined for the DSN.

8. From the drop-down menus, select the appropriate Query codec and Data codec, if required.

9. To test the database connection, click Check connection.
If the connection succeeded, a message box appears displaying the message Connection
successful.

Note:  In case of problems, you will see an error message generated by the ODBC
tool of your operating system.

10. To close the message, click OK.

If you have more than one database, repeat step 3 to 10 and add as many data sources as
you have databases.
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11. To close the ODBC data sources dialog, click OK once more.

4.1.15.  Switch preferences: Remount volumes
Note:  Remount volumes is available only when Switch Server is running on Mac OS X.

The backing folders used by flow elements may be located on mounted volumes. On Mac OSX,
if the network connection is interrupted, Switch automatically remounts the volumes that are
used by the elements in active flows. By default, when remounting, Switch uses the volume
information from the backing folder path. However it is also possible to define the additional
remount information in the Switch preferences.

Property Description

Volume
remount
information

List of volume paths with corresponding user name and password.

The specified user name and password is used to mount these volumes.

To edit the volume remount information, double-click the property. See
Setting up remount volume information on page 52.

Property editor

This preference uses a new property editor which offers the following three columns:

Column header Description

Volume path The complete network path identifying a volume that may
have to be remounted by Switch.

User name The user name to be used for remounting the volume
(required field).

Password The password to be used for remounting the volume.

Leaving the user name empty is equivalent to not listing the volume at all. When user closes the
property editor all items with empty user names are automatically removed. This is relevant to
the suggestion feature described in the next section.

Show volume paths used by active flows

When editing the Volume list, the Show volume paths used by active flows can be used to list
all volume paths currently in use by active flows at the end of the list. By default this checkbox
is turned on. Its state is remembered between uses of the property editor and across Switch
sessions. If the volume path contains a user name, this will be entered in the User name field.
The password is NOT added automatically.
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When turning the option off, all volume paths with an empty user name will be removed from
the list.

4.1.15.1.  Setting up remount volume information
If your Switch is running on Mac OS X, you can make sure that volumes will be remounted if the
network connection is interrupted.

To configure remount volume information

1. In Switch, navigate to Edit > User Preferences > Remount volumes.

2. Do one of the following:

•
Select the Volume remount information field and click .

• Double-click the Volume remount information field.

The property editor appears.

3. Enter the following details:

• Volume path: The complete network path identifying a volume that may have to be
remounted by Switch.

• User name: The user name to be used for remounting the volume (required field).

Note:  Do not leave the user name empty! When closing the dialog, volumes
without a user name are automatically removed if Show volume paths used by
active flows is disabled (see step 4 of this procedure).

• Password: The password to be used for remounting the volume.

4. Select or clear the Show volume paths used by active flows checkbox as required:

• If selected (default value), all volume paths currently in used by active flows will be added
to the list of volumes to be remounted. If the volume path contains a user name, it is
added automatically as well, but this is NOT the case for the password. You must add the
password manually.

• If cleared, all volume paths with an empty user name will be removed from the list.

Note that the state of this checkbox (enabled/disabled) is remembered between uses of
the property editor and across Switch sessions.

5. Click OK.

4.1.16.  Switch preferences: Active Directory settings
Active Directory Settings are only relevant if you want to use your existing Active Directory user
accounts to define access rights for the Switch Web Portal and/or Remote Designer. For more
information, refer to Setting up Switch users on page 57.

Double-clicking Active Directory information, displays a dialog with the following fields:
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Property Description

Server
address

Address of the Active Directory server.

Example: SERVER001.enfocus.com

Server port Port number of the Active Directory server.

Example: 389

Secure
connection

If selected, Switch will set up a secure TLS/SSL connection to the Active
Directory server.

Remark:

• If server port 636 is used, the SSL negotiation will start immediately
after the connection has been established.

• If a different port is used, Switch connects in plain text to the AD
server, then explicitly starts the SSL negotiation through the StartLS
command.

LDAP version The version of the LDAP protocol used on your Active Directory server.

Example: 2 or 3 (default)

Base DN Distinguished name to be used as the search base.

Example:

Usually, users and user groups are located under the domain
name. If users are stored in the folder enfocus.com, the base DN is:
DC=enfocus;DC=com.

Note:  If you don't know the base DN, you can leave it empty.
Once you have executed an AD directory query, it will be filled in
automatically.

Use pre-
Windows 2000
logins

This option defines how user names are generated when Active Directory
users are added in the Users pane:

• When selected, the name of an Active Directory user added in the
Users pane will have the format "domain\user" (also known as pre-
Windows 2000 domain name), e.g. Netbios\sAMAccountName. Make
sure to also use this format for the user to be used to log on to the
Active Directory server (next field).

• When cleared, the name of an Active Directory user added in the Users
pane will have the format "user@domain" (also known as the User
Principal Name), e.g. user@example.com. Make sure to also use this
format for the user to be used to log on to the Active Directory server
(next field).

Note:  Changing this option has no impact on the users already
present in the Users pane. However, if needed, you can manually
adjust the User names in the Users pane.

User User name to log on to the Active Directory server.

If Use pre-Windows 2000 logins is selected, the required format is
"domain\user", for example: enfocus\user1
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Property Description

If Use pre-Windows 2000 logins is cleared, the required format is
"user@domain", for example: user1@enfocus.com

Password Password to log on to the Active Directory server.

Note:  To verify the connection to the Active Directory server, click the Test connection
button.

4.1.17.  Switch preferences: Web services
These preferences configure the settings related to the communication between Switch and its
client applications.

Property Description

Port for the
Switch Web
Service

The port used for communication between the Switch Web Service and a
client application, in the range of 1 to 65535.

Default value: 51088

Port for the
Switch Web
Portal

The port used for communication between the SwitchClient WebServer
and a client application, in the range of 1 to 65535.

Default value: 51089

Protocol The protocol used for the communication between the Switch WebServer
and the browser. Choices:

• HTTP (default value)
• HTTPS (secured, encrypted communication for which you need a

certificate) You must set the HTTPS settings in the corresponding
Switch preferences category: Switch preferences: HTTPS settings on
page 56.

Note:  If your browser does not recognize the used certificate,
it may block the Log messages overview. In that case, you
must add it as an exception in your browser settings.

Privacy policy
page

URL (starting with "http" or "https") of the privacy policy of your company.
This URL is used to make the privacy policy of your company available to
users of the Switch Web Portal.

Example URL: http://www.enfocus.com/en/privacy-policy/

If this property is empty, no privacy policy is displayed.

Note:  Changing this property requires a restart of Switch.

A privacy policy contains the guidelines a company uses to protect the
information provided by its customers. It's a legal requirement to have
such a privacy policy if you're collecting data from your customers. As
in Switch the language preference of the users is stored (using cookies)
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Property Description

when they launch messages in a web browser, we recommend entering
the link to your privacy policy.

The privacy policy is made available as follows:

• On the login page of the Switch Web Portal, there's a 'Privacy policy'
button; when a user clicks this button, the web page concerned is
displayed.

• Once signed in to the Switch Web Portal, the Info menu in the bottom
left corner gives access to the Privacy policy.

4.1.18.  Switch preferences: Reporting
These preferences relate to the Dashboard Service that enables the creation of dashboards and
job boards on the Switch Web Portal.

Property Description

Dashboard
Service
location

Indicates where the Dashboard Service was installed.

• Local (default): The Dashboard Service was installed on the same
system as the Switch Server.

• Remote: The Dashboard Service was installed on a different system
(for example to avoid overload of the server), so the connection
between Switch and the Dashboard Service is remote. If this option is
chosen, the following additional properties appear:

• Address: IP address of the system on which the Dashboard Service
was installed.

• Port: Port used for the communication between the Switch Server
and the Dashboard Service.

Default value: 55092

Keep
historical data
for (days)

Indicates how long historical data (= data about jobs that left a flow) should
be kept. During this period of time, the historical data can be used in
history graphs in dashboards on the Switch Web Portal.

The default value is 120 days.

This preference is only available if the Reporting Module is licensed.

Note:  To verify the connection to the Dashboard Service, click the Test connection
button.

4.1.19.  Switch preferences: Webhooks
These preferences relate to the webhooks, a mechanism that allows external applications to
request information from Switch.
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Property Description

Enable HTTP
listener

If set to Yes, Switch accepts requests from external applications/third-
party services via HTTP. This triggers a new property:

• Port for HTTP listener: Port used for the communication between the
Switch HTTP listener and the third-party service. The default value is
51080.

Enable HTTPS
listener

If set to Yes, Switch accepts requests from external applications/third-
party services via HTTPS (secured, encrypted communication for which
you need a certificate).

You must set the HTTPS settings in the corresponding Switch preferences
category: Switch preferences: HTTPS settings on page 56.

Requests
delivery
timeout (in
minutes)

Indicates how long (in minutes) a request that is not received remains
valid. After this period of time, the request is removed.

4.1.20.  Switch preferences: Remote processing
These preferences relate to the tools for remote processing.

Property Description

Enable HTTP If set to Yes, Switch accepts requests from external applications/third-
party services via HTTP. This triggers a new property:

• Port: Port used for the communication.The default value is 51120.

Enable HTTPS If set to Yes, Switch accepts requests from external applications/third-
party services via HTTPS (secured, encrypted communication for which
you need a certificate).

You must set the HTTPS settings in the corresponding Switch preferences
category: Switch preferences: HTTPS settings on page 56.

4.1.21.  Switch preferences: HTTPS settings
These preferences hold the settings for external communication via HTTPS (secured, encrypted
communication). These settings are used whenever HTTPS is enabled, for example for remote
processing (see Switch preferences: Remote processing on page 56) or for webhooks Switch
preferences: Webhooks on page 55.

Property Description

Certificate Path to the certificate file.

Private key Path to the private key file.
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Property Description

Password for
private key

Corresponding password.

4.2.  Configuring Switch users

When do you need to set up users?

Switch user configuration is only relevant if you want to allow users to:

• Submit or check jobs using Submit points and Checkpoints (which requires a SwitchClient
license).

• View log messages through the Switch Web Portal.

• View and/or create job boards and dashboards on the Switch Web Portal.

• Launch Switch Server using Remote Designer.

Procedure

1. Set up the users and/or groups that should get access.
2. Assign access to particular Submit and Checkpoints (as required).

4.2.1.  Setting up Switch users

How does it work?

If a user connects to the Switch Server through the Switch Web Portal or through Remote
Designer, he must enter a user name and a password. The user name identifies the user to the
server and grants him access based on his permissions. For example, if a Remote Designer
user has read-only access, he will be able to view all flows and settings, but he will not be able
to change anything.

Users or groups?

If several users should have the same permissions (for example because they have the same
role), you may consider to group them and define their (access) rights at group (or "role") level.
This will save you time if something changes. For example, if a new employee with a particular
role enters the company, you can simply add the new user to the appropriate group.

Example:

• Group 1: Administrators having access to all Submit points and Checkpoints. Only this group
has full access to Remote Designer.

• Group 2: Operators having access to all Submit points and Checkpoints, but with limited
access to Remote Designer.

• Group 3: Customers having access to particular Submit points and Checkpoints (so they can
only see their own jobs), but with no access to Remote Designer.

With this setup, you have to configure the permissions and access rights only three times,
instead of e.g. x times (with x being the number of users).
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Groups are also required if you want to allow users to share their job boards and dashboards on
the Switch Web Portal. Sharing of boards is only possible among group members.

Note:  In case of conflicting permissions, the highest permission level is taken into
account. For example, if a user has no access to Remote Designer, but the group(s) he
belongs to does have access, he will have access as well.

If you have configured a group, you can define a group manager for that group. Group managers
can view jobs of their group members, whereas regular group members can only see their own
jobs (unless otherwise configured).

How to configure users?

There are different ways to set up users:

• You can create new users and groups in Switch.

• You can import users and groups that you exported from a previous Switch version or from a
Switch copy installed on another computer.

• You can import existing Active Directory users and user groups from your Active Directory
domain.

4.2.1.1.  Configuring a user

Note:  You can set up new users and groups for use in Switch only, or you can re-use
your Active Directory users and user groups. This topic explains how to set up users for
use in Switch only.

To configure a user

1.

In the toolbar at the top of the application, click the Users button .

2. Under Users & Groups, select the Users category .

3.
Click the Add user button  at the bottom of the pane.
A new user (New User <number>) is added to the Users category.

4. Enter the required details:

• User name
• Full name
• Password
• Email address. The email address is used to send messages to users (if configured as

such in a flow).

5. If the user belongs to a group, proceed as follows:

a. Click the plus icon  at the bottom of the Member of field.
b. Select the group(s) the user belongs to.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

58



Switch

To remove groups from the list as required (for example if you made a mistake, or if the
user does no longer belong to the group), select the group(s) concerned and click the minus

icon .

6. Assign the appropriate permissions for the Switch Web Portal:

• In case of an active SwitchClient license, to allow the user to submit and check jobs
through the Switch Web Portal, select the Submit and check jobs checkbox and
determine which jobs the user is allowed to handle:

• All jobs (also the ones submitted by other users)

• Own jobs (only the ones submitted by the user) or Own jobs and group members' jobs
(this option is only available for group managers)

Note that this only applies to jobs in Checkpoints the user has access to.
• To allow the user to view error messages through the Web Portal, select the View

messages checkbox.
• To configure the permissions for boards on the Web Portal, select the appropriate

option:

• To allow the user to view and create dashboards, select Full access.

• To allow the user to only view shared boards, but not create them themselves, select
Read-only.

• To hide all boards from the user, select No access.

7. Configure the appropriate permissions for Remote Designer (as required):

• To grant the user the same permissions as if he were working locally, select Full access.
• To allow the user to only view data, but not change them, select Read-only.
• To not allow the user to launch Switch using Remote Designer, select No access.

If the user has the right to submit and check jobs (step 6), next thing to do is: assign access to
particular Submit and Checkpoints.

4.2.1.2.  Configuring a user group

Note:

• You can set up new users and groups for use in Switch only, or you can re-use your
Active Directory users and user groups. This topic explains how to set up groups for
use in Switch only.

• The Administrators group is available by default and cannot be removed. Members
of this group have full access to the Switch Web Portal (including the Admin view)
and to Remote Designer. Do not forget to add users to this group (see step 6 of this
procedure). Note that administrators can unlock jobs of all users on the Switch
Server.

To configure Switch user groups
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1.

In the toolbar at the top of the application, click the Users button. 

2. Under Users & Groups, select the Groups category. 

3.
Click the Add user group button  at the bottom of the pane.
A new user group (New Group <number>) is added to the Groups category.

4. Enter the group name.

5. Select the group manager(s) (as required):

a. Click  at the bottom of the Group manager field.
b. Select the user(s) that need(s) group manager rights.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

Tip:  Alternatively, you can select a member in the Group members field and drag it
to the Group manager field.

• Group managers have more rights than the other group members. They can for example
unlock the jobs of their group members (in addition to their own jobs) on the Web Portal.

• To remove users from the Group manager list as required, select the user(s) concerned

and click .

6. To select the group members that belong to the group

a. Click  at the bottom of the Group members field.
b. Select the user(s) belonging to the group.

To select several users in one go, hold down the Ctrl key while selecting them.
c. Click OK.

To remove users from the list (for example, if you made a mistake), select the user(s)

concerned and click .

7. Assign the appropriate permissions for the Switch Web Portal:

• In case of an active SwitchClient license, to allow the users of the group to submit and
check jobs through the Switch Web Portal, select the Submit and check jobs checkbox
and determine which jobs the group members are allowed to handle:

• All jobs (the user's jobs and the jobs of other users, not limited to the other group
members' jobs)

• Own jobs (the users of this group can only see their own jobs, the group manager can
see all the jobs of the group he belongs to)

Note that this only applies to jobs in Checkpoints the user has access to.
• To allow the members of this group to view error messages through the Web Portal,

select the View messages checkbox.
• To configure the group permissions with regard to boards on the Web Portal, select the

appropriate option:
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• To allow the users of the group to view and create dashboards, select Full access.

• To allow the users of the group to only view shared boards, but not create them
themselves, select Read-only.

• To hide all boards from the user of the group, select No access.

8. Determine whether or not the members of this user group are allowed to launch Switch
using Remote Designer:

• To grant the users the same permissions as if they were working locally, select Full
access.

• To allow the users to only view data, but not to change them, select Read only.
• To not allow the user to launch Switch remotely, select No access.

If the group members have the right to submit and check jobs (step 7), next thing to do is: assign
access to particular Submit and Checkpoints.

4.2.1.3.  Importing users and user groups from Active Directory
An Active Directory domain controller manages and authenticates all users in a company
network. If you import Active Directory users and user groups in Switch, the user names and
passwords used in Switch will be checked against your Active Directory server and not against
the local Switch user database. As a consequence, users can use the name and password they
use to log in on their work computers.

Note:  You must have configured your Active Directory settings (such as server address,
user name and password) in the User Preferences pane. For more information, refer to
Switch preferences: Active Directory settings on page 52.

To import users and user groups from LDAP directory

1.

In the toolbar at the top of the application, click the Users button. .

2.
In the Users pane, click the Select AD user or group button  at the bottom of
the pane.

3. In the dialog that pops up, enter (part of) the AD (user) name or email address.

Note:  The search function is case-insensitive.

4. Click Search.

5. Select the user or user group you want to use in Switch.

Tip:  You can sort the search results alphabetically, by clicking the column headers.

6. Click OK.
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• If you selected an Active Directory group, the group name and the group members are
displayed in the Groups category in the Switch Users pane. Subgroups (if any) are not
preserved; all users are presented in one flat list.

• If you selected an Active Directory user, the user name, full name and email address are
displayed in the Users category in the Switch Users pane. Note that these details are
read-only.

7. If you selected an Active Directory user, you can optionally add the user to an existing group:

a. Click  at the bottom of the Member of field.
b. Select the group(s) the user belongs to.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

To remove user groups from the list as required, select the group(s) concerned and click .

8. If you selected an Active Directory user group, you can select a group manager (as required):

a. Click  at the bottom of the Group manager field.
b. Select the user(s) that need(s) group manager rights.

To select several user groups in one go, hold down the Ctrl key while selecting them.
c. Click OK.

Tip:  Alternatively, you can select a member in the Group members field and drag it
to the Group manager field.

• Group managers have more permissions than the regular group members. Refer to step
9 of this procedure.

• To remove users from the Group manager list as required, select the user(s) concerned

and click .

9. Assign the appropriate permissions for the Switch Web Portal:

• In case of an active SwitchClient license, to allow the users (or the members of the user
group) to submit and check jobs through the Switch Web Portal, select the Submit and
check jobs checkbox and determine which jobs the users are allowed to handle:

• All jobs

• Own jobs (users can see their own jobs; if they are a group manager, they can also
see the jobs of the other group members)

Note that this only applies to jobs in Checkpoints the group or the user has access to.
• To allow the users (or members of this user group) to view error messages through the

Web Portal, select the View messages checkbox.
• To configure the permissions for boards on the Web Portal, select the appropriate

option:

• To allow the users (or members of this group) to view and create dashboards, select
Full access.

• To allow the user (or members of this group) to only view shared boards, but not
create them themselves, select Read-only.
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• To hide all boards from the users (or members of this group), select No access.

10. Determine whether or not the users (or members of a user group) are allowed to launch
Switch using Remote Designer:

• To grant the user the same permissions as if he were working locally, select Full access.
• To allow the user to only view data, but not to change them, select Read only.
• To not allow the user to launch Switch using Remote Designer, select No access.

4.2.1.4.  Importing users and user groups
If you have installed different copies of Switch, it can be useful to export the user information
from one copy and import it into the other. This topic describes how to import user information.

To import users and user groups

1.

In the toolbar at the top of the application, click the Import button. 

2. In the Import users and groups dialog, select the user information file exported from
Switch.

This can be a text file or an XML file.

3. Click Open.

In case of conflicts (for example if a user already exists in Switch), a warning is displayed.
You are asked which user (or user group) you want to keep (i.e. the imported user or the one
that already exists in Switch).

The imported users and user groups are displayed in the Users and Groups panel in Switch.

Note:  When you're importing Switch 18 /18 update 1 users or user groups, all users
that had the right to create boards will have full access to boards in later Switch
versions. Users that did not have the right to create boards, will have no access. You can
change this setting manually if required.

4.2.1.5.  Exporting users and user groups
If you have installed different copies of Switch, it can be useful to export the user information
from one copy and import it into the other. This topic describes how to export user information.

To export users and user groups

1.

In the toolbar at the top of the application, click the Export button. 

2. In the Export users and groups dialog, type a name for the exported file.

3. Select the preferred file type:
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• To save the exported file as an XML file, select: Switch users and groups (*.xml).
• To save the exported file as a text file, select Switch users and groups (*.txt).

4. Click Save.

4.2.2.  Assigning access rights
If you have designed flows with Submit points and Checkpoints, you can indicate who has the
right to use them. This is done in the right part of the Users pane.

What users can do in Submit and Checkpoints depends on:

• The permissions assigned to the group they belong to (if applicable)
• Their permissions on user level (View messages/Submit and check jobs).
• Their role in the group (group manager or regular group member). For example, group

members can see, edit, route and unlock other group members' jobs, whereas regular group
members can only do this for their own jobs (unless otherwise configured).

4.2.2.1.  Assigning access to Submit points and Checkpoints
For each Submit point and Checkpoint used in your Switch flows, you can define which users or
user groups have the right to access it.

To assign access to Submit points and Checkpoints

1.

In the toolbar at the top of the application, click the Users button. 
In the right part of the Users pane, under Submit points, all flow groups and flows with a
Submit point configured in Switch are shown. Under Checkpoints, flow groups and flows
with a Checkpoint are shown.

2. To assign access to one or more Submit points, under Submit points, select:

•  All, to give access to all Submit points in all flows on the Server.

• A flow group ( ), to give access to all underlying Submit points (i.e. all Submit points
configured for all flows in the selected group).

•
A flow ( ), to give access to all Submit points configured for that flow.

• A Submit point ( ), to give access to this particular Submit point.

Note:  The users or groups that have access to the selected level are listed on the
right; users for whom the access has been set on a higher level (e.g. on group level
iso flow level) are also shown but grayed out. Note that you must select the correct
level to remove a user or user group.

3. Click .
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Note:  Alternatively, if (earlier selected) users or groups are listed in the right part
of the panel, you can simply select them and drag and drop them (one by one) to the
appropriate Submit point.

4. Select the appropriate user or group.

5. Click OK.
The name of the selected user or group is shown.

6. Proceed in the same to way to give access to Checkpoints .

4.3.  Running Switch Watchdog as a service
Note:  This section is only relevant if your operating system is Microsoft Windows.

4.3.1.  Switch Server and Switch Watchdog
Switch offers its functionality through a number of separate applications. See Switch application
components on page 8.

The Switch Server runs in the background (without user interface) to execute flows, monitored
and managed by the Switch Watchdog. In normal circumstances it is automatically started and
terminated as needed by the Switch Designer.

4.3.2.  Setting up Switch Watchdog as a Windows service
On Microsoft Windows, the Switch Watchdog can be operated as a Windows service. This allows
Switch to continue processing after you have logged off from the computer. In addition, you can
specify that Switch should be restarted automatically after a system failure. Running the Switch
Watchdog as a Windows Service will also restart Switch when it quit unexpectedly.

Note:  Are you using third-party configurators in Switch? In that case it is not
recommended to set up Switch Watchdog as a Windows service. Most third-party and
desktop applications do not support this. Refer to Switch Service not compatible with
(configurators for) desktop applications on page 67.

To set up Switch Watchdog as a Windows service, proceed as follows:

1. In Switch, navigate to Edit >  Preferences > User Interface and configure the following
preferences:

• Start Switch Server automatically at login = No

• When exiting the flow designer = Ensure processing is started.

This avoids that Switch is started when a user logs in to Windows. For more information,
refer to Switch preferences: User interface on page 32.

65



Switch

2. In the Windows operating system, navigate to Start  > Control Panel > Administrative Tools
> Services.

If necessary, switch to "Classic View".

3. In the list of services, locate Enfocus Switch Watchdog.

4. Right-click this service and choose Properties.

5. On the General tab, choose the startup type you prefer:

• Automatic will make sure the service is started when booting your computer.

(Note that configuring this setting does not start the service; Switch Watchdog will start
as soon as you reboot your computer.)

• Manual means you will have to start the service explicitly from this dialog box.

6. On the Log On tab, enter the information for the user account that should be used to run the
service.

This allows Switch to get access to information saved in a specific user's preferences (such
as Photoshop actions) and to use Switch data stored in the application data root (which is
linked to a specific user and looks like this: C:\Users\<user>\AppData\Roaming\Enfocus
\Switch Server). If you want to keep using the same application data, after switching to
Windows service mode, make sure to use the same user.

Also, if Switch should get access to the network (e.g. to save files), make sure the chosen
user has the appropriate access rights.

7. Back on the General tab, click the Start button to launch the Switch Watchdog as a service.

Note:  When shutting down or rebooting the operating system, the operating system will
wait for maximum 30 minutes before terminating the Switch Watchdog service and all
its child processes. Therefore, to make sure that the Switch Watchdog service is able to
shut down gracefully, we advise stopping all flows before shutting down or rebooting the
operating system.

4.3.3.  Operating Switch as a Windows service
After you install the Switch Watchdog as a service in the installer, the Server need not to be
installed as a service anymore.

At startup, the Designer checks if the watchdog is running. If the Watchdog is not running, the
Designer starts the Watchdog as a background application. The Watchdog starts the Server
almost immediately and the Designer connects to the Server.

Be careful though:

• When you quit the Switch Designer, you will be asked whether you want the server to keep
running. If you choose No, the server will terminate.
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• The Switch Designer next sends a message to the Switch Watchdog to quit.

4.3.4.  Switch service and mapped drives
Microsoft Windows allows assigning a drive letter to a network computer or folder, creating a
mapped drive. A mapped drive letter (such as Z) can be used in a file or folder path just like a
local drive letter (such as C). But there is a catch: the drive mappings are established when a
user logs in to the system - and a service is not logged in (even if it is associated with a user
account).

Thus while Switch Server is running without any user logged in, it cannot access mapped drives.
You must ensure that all folders and file paths in the flow definitions are local drive paths or
UNC paths (of the form \\server\volume\directory\file) rather than mapped drive paths. This holds
for all paths including user-managed folders and references to files in configurator properties.

4.3.5.  Switch Service not compatible with (configurators for)
desktop applications

Configurators that communicate with a desktop application won't work when running Switch as
Windows service. This is due to a Windows limitation. Desktop applications cannot be started by
a Windows Service, hence their configurators cannot be used either.

Configurators concerned

• Adobe Photoshop
• Adobe Illustrator
• Adobe InDesign
• Adobe Acrobat Professional/Distiller
• Microsoft Office configurators (Microsoft Word, Microsoft Excel, Microsoft Powerpoint)

Some background information

Since the introduction of Windows Vista, Microsoft no longer allows applications that run as
a Service to interact with the desktop. This means for example that these applications cannot
show any UI to the user. As desktop applications cannot function with this limitation, their
configurators do not work either.

Note:  This problem does not affect Switch itself, because the Switch Watchdog (which
has no UI) - and not the Switch Designer - is set up as a Windows Service.

Remark

If you want to use the configurators for desktop applications, you must run Switch as a regular
process and not as a Windows service. However, in that case, you may want Switch to start
processing automatically when a user logs in. To do so, ensure that the preference Start Switch
Server automatically at login is set to Yes (See Switch preferences: User interface on page
32). Remember that a user has to log in in order to start Switch, which is not necessary when
running Switch as a Windows service.
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4.4.  Setting up custom icons for job boards
Job boards can be created on the Switch Portal; these virtual boards enable users to view
Switch jobs remotely. The jobs can be filtered by flow and/or job stage.

The jobs on the job boards are represented by an icon that refers to the file type of the job. For
the most common file types Enfocus provides the standard icon. However, if you're working
with different file types for which there is no icon yet, or if you prefer other icons, you can easily
replace (some of) the standard icons with your own images.

The icons must be supplied as PNG files. The file name must refer to the file extension, for
example psd.png ( icon for Photoshop files), txt.png (icon to be used for text files), … Best size is
128x128 (but the icons are scaled automatically).

To set up custom file type icons

1. On the system that runs the Switch Server, go to:

• On Windows: AppData\Roaming\Enfocus\SwitchSite

• On Mac: \Users\<user>\library\Application Support\Enfocus\SwitchSite\

2. Create a subfolder named 'icons'.

3. Copy the images to this folder.

4. Restart the Switch Server.
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5.  Working with Switch
This section gives a detailed overview of the graphical interface of the application and explains
how to use the different Switch modules.

5.1.  Switch Graphical User Interface
This section gives a detailed overview of all elements of the Graphical User Interface.

5.1.1.  Workspace overview
When the Switch Designer is launched, it displays the main window called the workspace, shown
here in its default configuration (design view):

 

 

Toolbar

The toolbar is the strip at the top of the workspace offering a number of tool buttons.

See Toolbar on page 72 for more details.
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Panes and views

The workspace contains a number of panes which can be manipulated as distinct entities (show,
hide, resize, move, ...). Examples include the Flows pane, the Flow elements pane, and the
Properties pane.

The central area that displays a flow design is called the canvas; it is a special pane because it
has no title bar and it can't be moved from its central position.

One or more panes (optionally including the canvas) combine to make up a workspace
configuration called a view. The currently displayed view is selected by pressing one of the
buttons in the leftmost section of the toolbar.

Configuring the workspace

The workspace offers a number of panes that are displayed in a number of pre-configured
views. Each of the views can be configured at will to display an arbitrary combination of panes.
The contents of a pane persists across views (i.e. the different views display the same instance
of the pane rather than different copies).

Panes can be shown or hidden by choosing the corresponding item in the View > Show panes
menu. Panes can be resized by dragging the separators between them, they can be rearranged
next to one another or overlaid as tabs by dragging their title bar, and they can be undocked as a
floating pane. All configuration settings are persistent across sessions.

The currently displayed view can be returned to its pre-configured settings by selecting View >
Show panes > Reset view.

Views

The Workspace offers the following views. The intended function is only a recommendation,
since the user can re-configure the views at will.

Tool button View name Intended function

 

 

Design Design a flow

 

 

Test Test-run a flow

 

 

Run Run a flow in production

 

 

Messages View and export log
messages
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Tool button View name Intended function

 

 

Statistics View statistics

 

 

Users Manage users/groups
and their access rights

Panes

The workspace offers the following panes, which can be combined at will in the different views.

Pane Description

Dashboard Displays status information on problem jobs
or processes, as reported by the Switch
Server

Flow elements Lists the icons representing flow elements
that can be dragged onto the canvas

Jobs Serves to view and explore the contents of
flow element backing folders (i.e. mostly
jobs)

Can also be used to view the contents of an
arbitrary folder in the file system, but this is
not a primary function

Flows Lists all flows

Progress Displays progress information for tasks
currently being executed by the Switch
Server

Properties Displays the properties of the currently
selected flow or flow element

Statistics Displays statistics about job execution by
the Switch Server

Statistics 2, 3 Extra statistics panes that may be
configured to display a different set of
statistics.

Job Information Displays the number of jobs waiting to be
processed by each flow element.
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Pane Description

Health Indicator Monitors the internal communication
processes within Switch.

Users pane Allows managing user names, passwords
and access rights

5.1.1.1.  Toolbar
The toolbar is the strip located at the top of the workspace window; it contains a number of tool
buttons to accomplish common tasks.

Tool sets

The tool buttons are grouped in tool sets, which are shown or hidden depending on which panes
are currently shown or hidden. The following table provides an overview of the tool sets and
their function.

Tool set Function

 

 

• Always shown
• Select a view

(Workspace, Messages,
Statistics, Users).
See Configuring the
workspace in Workspace
overview on page 69

 

 

• Shown with the Flows
pane

• New Flow, Import Flow,
Delete Flow

See Importing and
exporting flows on page
276

 

 

• New as of Switch 12
update 2

• Shown with the Canvas
and Flows pane

• Save Flow, Revert Flow

See Saving and reverting
flows on page 272

 

 

• Shown with the Canvas
and Flows pane

• Activate Flow, Stop Flow
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Tool set Function

See Activating and
deactivating flows on
page 274

 

 

• New as of Switch 12
update 3

• Shown with the Canvas
and Flows pane

• Generate HTML
documentation

See Generating flow
documentation on page
279.

 

 

• Shown with the Canvas
and Dashboard pane

• Retry Flow, e.g. in case
of a problem job or
problem process.

See Viewing flow
problems in the
Dashboard pane on page
293 and Manual retry
on page 300

 

 

• Shown with the Users
pane on page 85

• Allows export and import
of user information.

See also Setting up
Switch users on page 57,
Importing users and user
groups on page 63 and
Exporting users and user
groups on page 63.

 

 

• Allows to inspect
metadata.

See Working with sample
jobs on page 414

5.1.1.2.  Canvas
The canvas is the central workspace area that allows viewing and editing flows. Here's an
example of a simple flow displayed in the canvas:
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To display a flow in the canvas, select it in the Flows pane.

To make changes to a flow, ensure that it is inactive and unlocked.

You can also:

• drag new flow elements from the elements pane onto the canvas,
• create connections between flow elements,
• configure flow elements using the properties pane, and
• drag flow elements around to adjust the layout of the design.

5.1.1.3.  Dashboard pane
The Dashboard pane gives an overview of problems found during flow execution. The
information is updated dynamically: a problem item appears as soon as it is detected and
disappears as soon as the problem is solved or handled.
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For more information, refer to Viewing flow problems in the Dashboard pane on page 293.

5.1.1.4.  Flow elements pane
The Flow elements pane lists the icons representing flow elements (such as folders,
connections, tools, apps and configurators) that can be dragged onto the canvas and become
part of a flow design.

Filtering

You can use the Search field on top to filter the flow elements. See Filtering lists on page 87

Favorites

The Favorites section can contain shortcuts to elements in other sections. It looks and functions
like other section headers, but its content is managed by the user.

You can

• Select Add to Favorites from the context menu of a flow element to add a shortcut to the
Favorites section.

Note:  Add to Favorites menu is disabled for flow elements, which have already been
added to the Favorites section.

• Drag a flow element into the Favorites section to add a shortcut to the Favorites section.

• Select Move up or Move down from the context menu of a shortcut in the Favorites section,
to change the order.

• Drag and drop shortcuts in the favorites section to change the order.

• Select Remove from Favorites from the context menu of a shortcut in the Favorites section,
to remove it from the Favorites section.

Note:  You can use keyboard shortcuts to add your favorite flow elements to the canvas.
Just click ctrl+<number 1-9> (Windows) or cmd+<number 1-9> (Mac). The <number>
refers to the position of the flow element in the Favorites category (first element = 1,
second = 2, etc.).

Sections

The Flow elements pane groups the flow elements in sections. Click on a section header to open
or close the sections, showing or hiding the flow elements in the section.

Section Description

Basics Basic flow elements that form the fabric of a flow design,
including folder and connection

Tools Built-in tools such as compress and rename, mostly for file
handling

Scripting Built-in tool for using script packages

Communication Built-in tools for communication including email and FTP
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Section Description

Configurators Configurators for third-party applications for processing jobs

Metadata Built-in tools for working with metadata, including XML

Database Built-in tools for using ODBC data sources

Apps Small applications that can be used without a license for the
Configurator module and made avavailable through the Enfocus
Appstore. This category becomes available as soon as you have
installed at least one app. See also Working with apps in Switch on
page 304.

Flow elements

The list of flow elements displayed in the Flow elements pane depends on the Switch modules
you have licensed. See the Flow elements matrix on page 213 for an overview.

Detailed information

Refer to: Flow elements: overview on page 90.

5.1.1.5.  Jobs pane
The Jobs pane serves to view and explore the contents of flow element backing folders (that is,
mostly jobs).

 

 

Use the Jobs pane to:

• View the contents of the backing folder for one of more flow elements by selecting the flow
elements in the canvas.

• Drop files and folders in a flow using copy and paste or drag and drop.

• Delete files and folders by pressing the delete key or by choosing the Delete context menu
item; deleted items are moved to the system's recycle bin.
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Row types

Each row in the Jobs pane represents a file or folder as described in the following table. Folder
rows offer a triangle button to show/hide the rows representing the contents of the folder.

Icon Row represents Information displayed

 

 

The backing folder of a flow
element

Flow element name and backing
folder path

 

 

A job folder Folder info; Job info

 

 

A job file File info; Job info

 

 

A regular folder Folder info

 

 

A regular file File info

Jobs pane columns

The rows in the Jobs pane have multiple columns as listed in the following table. Individual
columns can be shown or hidden through the "Show columns" context menu item. By default,
only a subset of the columns is shown.

The visible columns can be resized and reordered by dragging. Clicking on a column header
selects that column as the key for sorting the rows in the Jobs pane, and toggles between
ascending and descending order. Rows that have the same parent (and thus are on the same
hierarchical level in the tree) are sorted according to this specification. Root rows are always
sorted on the name column (ascending or descending depending on the last setting).

Column Description

Name Name of the file or folder represented by the row

For a job file or folder the unique name prefix is removed

Size The file size in bytes for job files and regular files; blank for folders

Type The file type as retrieved from the operating system

Modified The date/time the folder or file was last modified

Job Prefix The unique name prefix for job files and job folders; blank otherwise
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Column Description

This field is shown in red color if there is no corresponding valid internal job
ticket (i.e. the job ticket doesn't exist or its file path doesn't point to this job)

The following columns are not shown by default

Waiting
since

The date/time the job arrived in this backing folder (more precisely, when it
was detected by the server)

State The name of the state currently attached to the job, or blank if there is none.
A state can be attached to a job through the "Attach job state" property of
the folder flow element; for more information, see the Folder element and
Viewing statistics on page 296.

Entered
state

The date/time the job entered the state currently attached to it, or blank if
there is none. A state can be attached to a job through the "Attach job state"
property of the folder flow element; for more information, see the Folder
element and Viewing statistics on page 296.

Submit point The name of the Submit point through which the job was submitted, or blank
if it wasn't submitted through a Submit point

Submitted The date/time the job was submitted through a Submit point, or blank if it
wasn't submitted through a Submit point

User name The name of the user associated with the job, or blank if there is none (a
user is automatically associated with the job when it is submitted through a
Submit point)

Custom 1

...

Custom 5

A user-configurable value calculated through variables or a script
expression

Both the column header and the column value can be configured through
the context menu items "Set column header" and "Set column value (first
make the column visible with the "Show columns" context menu item)

Initially the values for these columns are blank

Example of custom columns

In the following example, two custom columns were configured to display the date when the
picture was taken and the camera model (see defining text with variables).

A third custom column was configured to display whether the flash fired when taking the picture
(see defining a condition with variables).
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5.1.1.6.  Flows pane
The Flows pane lists all flows known to Switch at the present time. It allows you to organize
these flows in a hierarchy of groups and subgroups, and provides a context menu for managing
flows in various ways.

Note:  If a flow is not saved yet, it is displayed in italics, followed by an asterisk.

 

 

Filtering

You can use the search field on top to filter the flows. See Filtering lists on page 87.
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Actions

If you click the Actions icon (  ), a list appears with all the items that are available in the
Flow menu on the menu bar.

Flows and groups

Each row in the flows pane represents a flow or a group. A group can contain flows and other
groups, up to any nesting level. When you select a group, all the flows in the group (and in any
subgroups) are automatically selected as well. You can open/close a group by clicking the arrow
at the left. You can reorganize the order and nesting structure in the flows pane by dragging the
rows.

When you select a flow in the flows pane, it is displayed in the canvas and you can see its
properties in the properties pane.

When you select two or more flows in the flows pane, a scaled-down representation of all the
selected flows is shown in the canvas. You can perform many operations (such as activate/
deactive) on multiple flows at the same time; however you can't make changes to the flow
design while two or more flows are selected.

For more information, refer to the chapter Organizing flows on page 263.

State

An icon is displayed at the left of each row to indicate its flow state, as described in the following
table. The flow state for a group row is equal to the "highest" flow state for any of the flows in
the group (the table lists the flow states from high to low). For more information, refer to the
chapter Activating and deactivating flows on page 274.

Icon Description

The flow can't be activated because it contains a design error.

The flow is being activated.

The flow is active, that is, it is being executed by Switch.

The flow is active, that is, it is being executed by Switch, but one or more of the
connections are put on hold.

The flow is being deactivated.

The flow is inactive and it is locked for editing.

The flow is scheduled and will become active during the time specified in the Flow
properties (See Flow properties on page 269).

The flow is scheduled, but one or more of the connections are put on hold.

Name and description

You can rename a row by clicking on the name field and entering the new name. You can also
change the value of the "Name" property in the properties pane. You can add a longer (possibly
multi-line) description of the flow or group in the "Description" property.
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Marker

The rightmost column in the flows pane can display a marker icon selected from a predefined
list of icons (including colored flags, priorities, and level of completeness indicators). You can
set these markers at your discretion to help organize your flows (for example, indicate work in
progress). The markers have no meaning to Switch.

If you do not want to use markers, you can hide the marker column with the "Marker column"
context menu item.

For more information, refer to the chapter Setting flow markers on page 266.

5.1.1.7.  Progress pane
The Progress pane displays a list of currently executing processes (for all active flows) with
their progress information.

Examples of processes include internal processes (such as downloading a file from an FTP
site), external processes controlled by Switch (such as distilling a PostScript file) and remote
processes (triggered by the Remote process element). Processes are dynamically added to and
removed from the list as they occur.

The columns can be reordered as usual in Switch. Following columns are displayed:

• Flow: flow concerned
• Element: name of the flow element in the flow
• Task type and task category:

• Task types include file handling tasks (such as copying and moving jobs), file processing
tasks executed by configurators and apps, network transfer tasks, ...

• Task categories include "disk" (disk operations, mainly related to copying and moving
jobs), "light" (quick tasks executed by scripts used in the Script element), "processor", ...

Note:  Task type and task category are taken into account to calculate the
maximum number of concurrent slots. Refer to Execution slots on page 301.

• Job prefix and job: unique prefix and name of the job
• Status: current status
• Progress: current progress
• Process ID: process ID, may be useful for troubleshooting.

For more information, see Viewing processes in the Progress pane on page 292.

5.1.1.8.  Properties pane
The Properties pane shows the properties of a flow or a flow element, depending on what's
selected on the canvas:
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• If a single flow element is selected on the canvas, the Properties pane shows the properties of
that flow element.

To learn how you can edit the values in the Properties pane, refer to Changing flow element
properties on page 226.

• If multiple flow elements are selected, the Properties pane shows all mutual properties, i.e.
the properties that can be set for every selected flow element. This allows you to change the
(same) property for multiple flow elements at once.

Note:  The Name and Description of a flow element must be changed one by one.

• If no flow elements are selected, the Properties pane shows the flow properties.

For more information, refer to Changing flow properties on page 268.
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5.1.1.9.  Statistics pane
The Statistics pane allows you to display the average time jobs reside in a particular folder or
state while being moved along a flow.

You can open this pane, by clicking  in the Switch toolbar, or by selecting View > Statistics
from the menu at the top of the application.

Important:  Do not forget to refresh the statistics ( by selecting View > Refresh Statistics
), to make sure the most recent information is displayed.

The chart gives an overview of the folders or states (on the y-axis) and the average time in
seconds (on the x-axis) jobs spent in each of them.

You can determine what is shown by changing the options in the Show time spent per and Sort
results on sections:

• Show time spent per Folder/State determines what's shown in the chart below; either
the average time spent in a particular (statistics-enabled) Folder or the time spent in a
particular State.

• Sort results on determines how the information in the chart is sorted: based on the Name of
the folder/state (alphabetically), or the Time (decreasing).

In the top right corner of the pane, you can see the number of files that have been processed,
and the date and time the first and last file were processed.
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For more information, see Viewing statistics on page 296.

5.1.1.10.  Job Information pane

The Job Information pane displays current job distribution in the flows, that is, the number of
jobs waiting to be processed by each flow element. Here elements are grouped by flows.
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This pane requires presence of responsive Server process as it is updated constantly when
visible.

5.1.1.11.  Health indicator pane
The Health indicator monitors the internal communication processes within Switch. Under
normal operation, the Health Indicator will show a green status bar.
 

 

If Switch begins to experience problems communicating with internal processes due to delayed
or excessive internal communication requests, the indicator bar will change to orange or red
in extreme cases. However, the Health Indicator does not change due to number of jobs or the
heavy processing as this does not typically threaten the stability of Switch.

In most cases when an internal process becomes unavailable or communication is lost, the
Switch Watchdog will automatically restart the failed service. If the Health Indicator frequently
shows orange or red, it is recommended that you review the Statistics pane for details on which
Switch services are experiencing problems and may require corrective action. See Statistics
pane on page 83.

5.1.1.12.  Users pane
The Users pane allows you to manage the access rights of users accessing the Switch Server
from another computer, i.e.:

• Through the Switch Web Portal via Submit points and Checkpoints (requires a SwitchClient
license) or to view log messages.

• From another computer than the one on which the Switch Server is installed, via Remote
Designer.

You can open this pane, by clicking the Users button in the toolbar, or by selecting View > Users
from the menu at the top of the application.

The Users pane consists of two parts:

• In the left part of the pane, you can configure users and user groups, and assign them
permissions for the Switch Web Portal and/or for Remote Designer.
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• In the right part of the pane, you can grant users and user groups access to particular
Submit points and Checkpoints. This part is only visible, if you have activated the
SwitchClient and/or the Web Services module.
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The buttons in the toolbar allow you to import and export user information.
 

 

For more information, see Configuring Switch users on page 57 and Assigning access to Submit
points and Checkpoints on page 64.

5.1.1.13.  Filtering lists
Filtering restricts the set of items shown in the list by comparing search terms (entered in the
search field) with one or more search targets associated with the items.

Filtering is available for Flow elements and Flows.

In the Flow elements pane, items are not only filtered, but also searched for in the Enfocus
Appstore. If the search term matches an app, you will see the app appear in the bottom part of
the Flow elements pane, under "Enfocus Appstore results" and, if it is installed already on your
system, you will also see it in the Apps category. See also Working with apps in Switch on page
304.
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Using the search field
The search field is located above the list of items being managed.
 

 

• If the search field is empty, all items are shown in the list.
• If the search field is not empty, a clear button  appears at the right side of the field, to

clear the search field and show all elements.

Refresh button (Flow elements pane only)

If an app you recently purchased is not in the list, you may have to click the Refresh button

. This will install the app concerned on your local computer.

Using the search menu

You can open the search menu by clicking the Search button  on the left side of the search
field.
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The search menu contains:

• The last 7 strings entered in the field. Selecting one will reapply this filter.

• A number of search options.

This controls the search targets included in the search. Each menu item has a checkbox
which can be turned on or off by choosing the menu item.

For Elements, the name of the elements is always included in the search. You can also search
for keywords, which are associated with the elements. For example searching for "PDF" will
include Adobe Acrobat Distiller, although "PDF" is not a part of the Element name. For an
overview of all elements and their keywords, see the Flow elements: overview on page 90.

For Flows, you can search in the flow names, the flow descriptions, the elements used in the
flows, or even the properties or values in the flow's elements. This allows for example to
search for Flows containing the "Adobe Acrobat Distiller" element. If found, the flow element
or connection is highlighted in green (see example below).

• Sort options, allowing to sort the search result alphabetically, or in the order they were
found.

Example of a search result found in the name of a flow element
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5.1.2.  Flow elements: overview
This section gives a detailed overview of all flow elements available in the Flow elements pane.
They are sorted by category (Basics, Tools, Scripting...) just like in the application.

Note that you can change the way the flow elements are displayed (show/hide unavailable
configurators, open or collapse categories etc.), by clicking the button next to the search field.
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5.1.2.1.  Basics

Connection

Connection is a special flow element that serves to interconnect other flow elements. The
network of connections in a flow determines how jobs can travel between the flow elements.

To connect two flow elements that are already present on the canvas, do one of the following:

• Drag the connection icon from the Elements pane and drop it onto the first flow element;
then click on the second flow element.

• Double-click the first flow element to start a connection and drop it on the second flow
element to connect it with the first flow element.

• Select "Start connection" in the context menu of the first flow element and drop the
extension on the second flow element.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Connection element will be shown in the list:
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• move
• filter
• traffic light

Flow element types

In terms of connectivity, there are four types of flow elements (other than connection itself):

Flow element type Description

Folder Represents a folder on disk that can hold jobs before, after or
in between processing steps; folder has a central role in Switch
(see below).

Processor Processes jobs and thus accepts incoming and outgoing
connections.

Producer Injects jobs into a flow from an outside source (such as an
email inbox); a producer does not accept incoming connections.

Consumer Consumes jobs from a flow and possibly transports them to an
outside target (such as an FTP site); a consumer does not allow
outgoing connections.

The central role of the Folder element

At least one of the two flow elements being connected must be a folder. In other words, a flow
element other than a folder can be connected only to a folder.

A simple rule of thumb is "there must always be a folder in between".

Connection types

There are several types of connections, each with a slightly different set of properties. The type
of a connection is determined by the flow element from which the connection originates. All
connections originating at a particular flow element have the same type. Some flow elements
also restrict the number of outgoing connections.

Connection
type

Description

Move Simply moves jobs along (under the control of Switch); a flow element with
outgoing move connections often produces only a single output along one
of the outgoing connections (for example, file balancer), or it may allow just
one outgoing connection

Filter Offers properties for file filtering in addition to the move properties; a
flow element with multiple outgoing filter connections (for example,
folder) usually sends identical copies of its output along these connections
(assuming a connection's filter allow the output to pass)

Traffic light Offers data and log subtypes and allows to set success-, warning- and
error- filters; this connection type is used by flow elements that produce a
report for human consumption and/or validate jobs against some specified
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Connection
type

Description

rules (for example, preflight); multiple connections of the same subtype
carry identical copies of the output

No-options Jobs are moved under the control of a third-party application; this
connection type is used only in conjunction with generic application; it
offers only the most basic set of properties

Properties

The following table lists the properties for all connection types (i.e. no single connection
offers all of these properties). Some flow elements "inject" extra properties in their outgoing
connections. These properties are described with the flow element that injects them.

Property Description

Name The name of the connection displayed in the canvas; most connections
have a blank name (the default) but the user can add a name if so desired;
some flow elements use the name of their connections for special
purposes (these rare cases are described for each flow element where
applicable)

Description A description of the connection displayed in the canvas. This description is
also shown in the tooltip that appears when moving your cursor over the
connection.

Corner angle Determines the layout of a connection as it is drawn on the canvas

Consider the rectangle formed by drawing horizontal and vertical line
segments through the center of the two flow elements being connected;
the breakpoint in the connection line can be positioned anywhere on the
diagonal of this rectangle

The corner angle is an integer number in the range [-90, 90] inclusive;
the value is a measure for how much the corner formed at the breakpoint
differs from a straight line; thus a zero value means a straight line (the
default) and a value of ±90 means a rectangular corner (the breakpoint is
positioned at one of its extremes).

Color The color of the connection displayed in the canvas. The default is Gray,
but you can select another color from the list (Yellow, Green, Cyan, Blue,
or Magenta). Alternatively, you can change the color via the context menu,
by selecting the Choose color option.

Note that connections can also have "conditional" colors:

• If a value is wrong in the properties, the connection can be displayed in
red.

• If the connection is put on hold, it's displayed as an orange dashed
line. See Putting a connection on hold on page 281.

• If a property of the connection matches a keyword entered in the
search field of the Flows pane, it's displayed in green. See Using the
search menu on page 88.
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Property Description

Note:  The "conditional" colors take priority over the "custom"
colors set in this property. For example, even if you have chosen
Green for your connection, its color will change to orange when
the connection is set on hold. When the connection is released,
the chosen color (green) will be restored.

Hold jobs While set to yes, jobs are not allowed to move through the connection;
this is mostly used to temporarily hold jobs (perhaps because there is a
problem with a process downstream)

The value of this property can be modified while the flow is active (through
a canvas context menu item); see putting connections on hold.

Include these
jobs

Jobs that match the specified filter are moved through this connection,
unless they are explicitly excluded (see next property); refer to Specifying
file filters on page 246 for more details.

Note:  If you're using a script expression, remember that the
script expression should return a boolean value (true or false),
instead of a string. For example, you could create a script
expression to include jobs smaller than 1 MB. If the checked job
< 1 MB (= matches), the result of the script is "true" and the job is
included.

Exclude these
jobs

Jobs that match the specified filter are never moved through this
connection; refer to Specifying file filters on page 246 for more details.

Note:  If you're using a script expression, remember that the
script expression should return a boolean value (true or false),
instead of a string. For example, you could create a script
expression to exclude jobs smaller than 1 MB. If the checked job
< 1 MB (= matches), the result of the script is "true" and the job is
excluded.

Include these
folders

Subfolders that match the specified filter are included for this connection;
injected by producers that retrieve jobs from an outside folder hierarchy,
such as FTP receive; refer to Specifying file filters on page 246 for more
details.

Note:  If you're using a script expression, remember that the
script expression should return a boolean value (true or false),
instead of a string. For example, you could create a script
expression to include folders smaller than 1 MB. If the checked
folder < 1 MB (= matches), the result of the script is "true" and
the folder is included.

Exclude these
folders

Subfolders that match the specified filter are ignored for this connection;
injected by producers that retrieve jobs from an outside folder hierarchy,
such as FTP receive; refer to Specifying file filters on page 246 for more
details.
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Property Description

Note:  If you're using a script expression, remember that the
script expression should return a boolean value (true or false),
instead of a string. For example, you could create a script
expression to exclude folders smaller than 1 MB. If the checked
job < 1 MB (= matches), the result of the script is "true" and the
folder is excluded.

Carry this type
of jobs

Determines the type of files carried by this connection:

• Data: data file (regular output)

• Log: log file (reports)

• Data with log: data file with the corresponding log file associated to
it as a metadata dataset; this is equivalent to picking up the log file
with one of the existing pickup tools; see Picking up metadata on page
453. The data model that is used is determined by the element of the
outgoing traffic light connection.

Dataset name If the previous property is set to "Data with log", this property defines the
name of the metadata dataset containing the log file attached to the data
file; see Picking up metadata on page 453

Success out If set to yes, a file will move along the connection if the originating
process did not log any warnings or errors

Warning out If set to yes, a file will move along the connection if the originating
process logged at least one warning and no errors

Error out If set to yes, a file will move along the connection if the originating
process logged at least one error

Folder

Folder is a central flow element that serves as an intermediary for moving jobs between other
flow elements. Each folder flow element instance represents a backing folder on disk that
can hold jobs before, after or in between processing steps. The contents of the backing folder
can also be accessed by external processes or by users. For example, a folder may be used to
submit jobs into a flow or to retrieve the results of a flow.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Folder element will be shown in the list:

• backing
• input
• output
• hot
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• watched

Processing jobs

Any subfolders placed into a folder are treated as a job folder; that is, the subfolder and its
contents are moved along as a single entity.

If a folder has no outgoing connections (that is, it is a "dead-end" folder), a job placed in the
folder will stay there until it is removed by some external process that is not under the control of
Switch.

If a folder has at least one outgoing connection, a job placed in the folder is removed after it
was processed by all outgoing connections. If none of the filters on the outgoing connection(s)
match, the job is moved to the problem jobs folder. Refer to Handling problem jobs on page 297
and error handling preferences for more details.

User-managed versus auto-managed folders

The backing folder (on disk) for a folder on the canvas can be auto-managed (default) or user-
managed. The difference is explained in the following table:

Auto-managed User-managed

Location on
disk

Special area managed by Switch, i.e.
"the application data root" (see Switch
preferences: Application data on page 44)

Location selected by the
user (through the Path
property)

Editable by
the user?

No, users should not manipulate auto-
managed folders!

Note:  The Open in Explorer/
Finder option in the context menu
is only available if you hold down
Shift while right-clicking the
folder on the canvas. This is an
advanced preference that only
should be used for debugging
purposes!

Yes, through the Open in
Explorer/Finder option in
the context menu.

Scanned? No need to scan, as the contents is known
and managed by Switch.

Yes, at regular intervals as
defined in the Preferences
(See Switch preferences:
Processing on page 39)

Lock icon? Yes
 

 

No
 

 

Remarks External processes (not under control
of Switch) and users should not refer to
auto-managed folders since they can
change the name and/or location under
the control of Switch!

It is not allowed to point
user folders to auto-
managed folders (e.g.
containing the result of
another flow). As auto-
managed folders are not
scanned, this will not work.
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For more information on how to create an auto-managed or user-managed folder (or to switch
from one type to the other), refer to Using Folder elements in Switch on page 100.

Properties

Note that certain properties are present only for folders that have at least one outgoing
connection, and certain other properties are present only for folders that have no outgoing
connections ("dead-end" folders)

Property Description

Name The name of the folder displayed in the canvas. A newly created folder
receives a default name ("Folder 1", "Folder 2", ...), which you should
replace with a meaningful name.

Note:  If you set up a user-managed backing folder while a
"Folder <number>" name is still in place, the flow element
automatically adopts the name of the backing folder. For
example, if you drag "D:\data\input" onto the canvas, the folder
will be named "input".

Description A description of the folder displayed in the canvas. This description is
also shown in the tooltip that appears when moving your cursor over the
folder.

Path The path of the folder's backing folder on disk, or auto-managed.

The following options in italics relate to the frequency of which the folders
are scanned for new files. As auto-managed folders are not scanned, these
options are only available for user-managed folders.

Leave originals
in place

If set to Yes, incoming jobs are left untouched in the folder. Switch never
writes to the folder, so read-only access rights suffice. For more details,
refer to Leaving originals in place on page 234.

If set to No (default), incoming jobs are moved out of the folder; Switch
needs full access rights to rename, create and remove files and folders.

Ignore updates (only available if if Leave originals in place is set to Yes)

If set to Yes, a job will only be processed once, regardless of any
changes to the file size or modification date. This can be used for
workflows where the input job is replaced by the processing result, to
avoid triggering endless loops.

If set to No, the job will be reprocessed when its file size or modification
date is different. This allows processing jobs which have the same file
name as previously submitted jobs.

Minimum file
size (KB)

Used to set the minimum file size limit (in KB) before Switch picks up
the files or folders. To set no limits, leave it empty.

Scan every
(seconds)

The frequency with which this folder is scanned for newly arrived jobs.

If set to Default or zero, the global user preference is used instead; see
Switch preferences: Processing on page 39.
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Property Description

Time-of-day
window

If set to Yes, the folder detects (and moves) newly arrived jobs only
during a certain time of the day (specified in the subordinate properties).

Allow from (hh:mm) and Allow to (hh:mm)

The time-of-day window during which to detect jobs. The values are
structured as "hh:mm" (hours, minutes) indicating a time of day on a 24
hour clock; an empty value means midnight; two identical values mean
the folder always detects jobs.

Day-of-week
window

If set to Yes, the folder detects (and moves) newly arrived jobs only
during certain days of the week (specified in the subordinate properties).

Allow from and Allow to

The days of the week (Monday, Tuesday, Wednesday, Thursday, Friday,
Saturday, Sunday) during which to detect jobs. Two identical values
mean the folder only detects jobs on that specific day.

Day-of-month
window

If set to Yes, the folder detects (and moves) newly arrived jobs only
during a certain day of the month (specified in the subordinate
properties).

Day

The day in the month during which to detect jobs, as a number in the
range [1 . .31]; the default value of one means the first or the last day of
the month (depending on the following property).

Relative to

Determines whether the day of the month is relative to "Start of the
month" or "End of the month".

Color The color of the folder displayed in the canvas. The default is Yellow, but
you can select another color from the list (Orange, Green, Cyan, Blue,
Magenta). Alternatively, you can change the color via the context menu,
by selecting the Choose color option. Refer to Adjusting the colors of
folders and connections on page 230.

Attach hierarchy
info

If set to Yes, the folder's name is added to each job's hierarchy location
path as the job passes through the folder; see Using hierarchy info on
page 237.

Add name at the top

If set to Yes, the folder name is added at the top of the hierarchy
location path; otherwise it is added at the bottom.

Attach email
addresses

The specified email addresses are added to each job's email info as the
job passes through the folder; see Using email info in Switch on page
238.

Attach email
body text

The specified email body text is added to each job's email info as the job
passes through the folder; see Using email info in Switch on page 238.
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Property Description

Attach job state If the specified string is non-empty, the job state of each job is set to
the string as soon as the job arrives in the folder; the statistics view can
display the average time spent for each job state. For more information,
see Viewing statistics on page 296.

Flow stage The stage assigned to the job folder. This allows you to check where jobs
are in a flow. The flow stage of a job can be viewed on the job boards on
the Switch Portal. Refer to Working with flow stages on page 101.

Set job priority • If set to None (default), nothing happens.

• If set to any other value (including zero), the job priority of each job is
set to this new value as soon as the job arrives in the folder.

Note:  The specified value is converted to a number and
rounded to the nearest integer; text strings that do not
represent a number are converted to zero.

To specify a negative value, use the Single-line text with variables
property editor or provide a script expression.

Safe move This option is only available for output folders and relevant for
transferring job files between folders on different volumes (drives/
partitions).

If set to Yes (default value), Switch will first copy the job to a temporary
file before deleting the job from the original location. This is useful to
avoid that files get lost in case of network problems.

If set to No, Switch immediately moves the job files to the output folder.
This may be necessary in case of network permission issues.

Strip unique
name

If set to Yes, the unique name prefix added to the filename by Switch is
removed before placing the job in the folder. the default is to strip the
prefixes from jobs deposited in a dead-end folder - leaving the prefixes
in place avoids overwriting a previously deposited job with the same
name.

Duplicates

Determines what happens when Strip unique name is set to Yes and a job
arrives with the same name as a job already residing in the folder:

• Overwrite: replace the existing job with the new one – this is the default
behavior.

• Keep unique name: preserve the new job's unique name prefix, leaving
the existing job untouched (without unique name prefix).

• Add version number: add an incrementing version number at the end of
the filename body for the new job ("2", "3", … "9", "10", "11"), leaving the
existing job untouched. For example, "job.pdf" will become "job1.pdf","
job2.pdf", ...
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Property Description

Optionally, you can add a separator between the filename body and the
version number, for example an underscore. In that case, e.g. "job.pdf"
will become "job_1.pdf"," job_2.pdf", ... By default, the Separator
property is empty.

You can also determine the width of the version number, i.e. the number
of digits used for the version number. For example, if Width is set to
"5", the version number will consist out of 5 digits (e.g. job_00001.pdf),
meaning that leading zeros will be added as required.

• Fail: move the new job to the problem jobs folder, leaving the
existing job untouched.

Ignore these
subfolders

All subfolders that match the specified folder filter are ignored for the
purpose of counting the number of jobs residing in this folder.

This property appears only when the folder's outgoing connection
leads to a generic application; if that application stores information in
subfolders inside its input folder, this property allows Switch to ignore
these folders and their contents.

Set job private
data (property
not present
in dead end
folders)

Allows you to attach private data to the jobs arriving in the folder.

Format: key=value (one key per line)

Example:

Reference=[Job.NameProper]
Customer=[Email.From]

Note:  The first instance of the equals sign ('=') separates the
key from its value. As a consequence,'=' is not allowed in the
key, but it can be used in the value of the key if required.

Show in
statistics

Set to Yes, if the average time that jobs reside in this folder should be
calculated and displayed in the Statistics pane. For more information,
see Viewing statistics on page 296.

Using Folder elements in Switch
To create a Folder element in Switch

1. Do one of the following:

• To create an auto-managed folder, drag the Folder icon from the Elements pane onto the
canvas.

If you check the Path in the Folder properties, you will see that the value "auto-managed"
is filled in automatically.

• To create a user-managed folder, drag a folder from your system onto the canvas.

If you check the Path in the Folder properties, you will see that the path to the folder is
filled in automatically.
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Note:  Submit hierarchy folders are always user-managed, as the hierarchy of the
folders must be determined by the user.

2. To convert a folder from auto-managed to user-managed as required, do one of the
following:

1. Choose a folder path for the Folder's Path property
2. Drag a folder from the Folders pane onto the folder in the canvas.
3. Drag a folder from any location onto the Folder element on the canvas.

3. To convert a folder from user-managed to auto-managed, choose auto-managed for the
Folder's Path property.

Working with flow stages

What are flow stages?

"Flow stage" is an optional property of certain flow elements* that indicates a logical stage in a
flow.

For example, if in the first part of the flow files are preflighted, in the second part they are
prepared for large format print and in the last part they are moved to the appropriate folder on
the server, you may split up your flow in three stages: Preflight, Prepare for print, and Distribute
(regardless of the number of folders in your flow).

* Currently only Folders, Submit points, Checkpoints and Submit hierarchies have this property.

For which flow elements a flow stage should or can be defined?

A job gets associated with a flow stage as soon as it arrives in the flow element. This means that
flow elements that mark the beginning of a stage should have a flow stage defined.

If a job arrives in a flow element that does not have a flow stage, the flow stage linked to the job
simply does not change.

If a job is moved to the Problem jobs folder, it gets the default "Problem jobs" stage assigned.
This stage is kept until the job is retried and is injected in the flow again; from that moment
onwards the job gets the previous job stage assigned (= the stage it should have if not moved to
the Problem jobs folder).

Note that it is not possible to define a flow stage for a folder at the end of a flow (so a folder
without outgoing connection).

Note:  Stages do not have to be unique, not on flow-level, not on Switch-level.

Where can you see the flow stage of a job?

The flow stage associated with a job is shown on the Switch Web Portal, on the job boards (in the
properties of the job).

What are flow stages typically used for ?

The flow stage of a job provides information about the status of the job; it indicates in what
logical stage of the flow a job currently is. It can be interesting for an operator to know which
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jobs are in a particular stage, for example which jobs are problem jobs (= have the 'problem
jobs' status), which jobs are finished, etc.

For a quick overview of the jobs and the flow stage they are in, you can create virtual job boards
on the Switch Web Portal. Such a job board could for example only display jobs with a particular
flow stage.

For more information, refer to Finding Switch jobs through the Switch Web Portal on page 324

Problem jobs

Problem jobs is a special flow element that represents the Switch problem jobs folder. When a
Switch process fails to handle a particular job, the "problem job" is moved to the problem jobs
folder.

Refer to Handling problem jobs on page 297 for more information.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Problem jobs element are:

• error
• failure

Connection

The problem jobs tool can be placed in a flow on its own, without any connections. In that case
it serves simply as an easy way to access the problem jobs from the designer user interface
(for example, when you select the problem jobs tool, the Files pane shows its contents). See
Handling problem jobs on page 297 for more information.

If the problem jobs tool has an outgoing connection, it acts as a producer picking up any
problem jobs that arrive and injecting them into the flow (again). This allows providing
automated error handling. You can add a filter to the outgoing connection to select the jobs you
want to handle, leaving the others in the problem jobs folder. In any case be careful to avoid
endless loops of jobs that fail over and over again.

The problem jobs tool supports only one outgoing connection. To overcome this limitation,
connect it to a regular folder from which you can originate as many connections as you like.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the problem jobs folder displayed in the canvas,
for example indicating if the flow contains all problem jobs of all
flows or only the current flow's problem jobs (see next property). The
description is also shown in the tooltip that appears when moving your
cursor over the connection.
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Property Description

Handle problem
jobs for

Determines the "scope" of this problem jobs tool:

• This flow only: acts on problem jobs generated just by the flow
containing this flow element

• All flows: acts on all problem jobs generated in this copy of Switch

Send alerts to This property is only available if Handle problem jobs for is set to This
flow only.

Determines who will receive alert messages if a job arrives in a
Problem jobs folder.

Note:  Alerts are only sent if enabled in the Problem alerts
preference, i.e. if the Problem job arrives preference is set to
Yes! Otherwise, no alerts are sent!

Options are:

• Default: In this case, alerts are sent to the email addresses entered
in the Send problem alerts to preference.

• One or more email addresses, separated by a colon (if entered via
Inline Value) or a newline (if entered via the multi-line text editor):
alerts will be sent to all entered email addresses.

Multiple problem jobs tools

A flow can have at most one problem jobs element; including more than one will keep the flow
from activating.

In addition, at any one time, the active flows in Switch can have at most one problem jobs
element with a scope set to "All flows".

Submit hierarchy

Submit hierarchy is a producer that supports one or more levels of subfolders. Since it is a
producer, a Submit hierarchy can be used only to submit jobs into a flow. The backing folder (on
disk) for a Submit hierarchy should typically be user-managed.

Each subfolder up to the nesting level specified by the "Subfolder levels" property is treated as if
it were an individual hot folder.

A file placed inside a subfolder at the specified nesting level, or at any level closer to the main
folder, moves along the flow as a file.

A job folder placed inside a subfolder at the specified nesting level moves along the flow with its
contents as a single entity (that is, as a job folder).
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A job folder placed on the same level as the allowed subfolders is treated as a subfolder by
mistake, and its contents are moved along as separate files.

Keywords

Keywords can be used with the search function available in the Flow elements pane.

The keywords for the Submit hierarchy element are:

• backing
• folder
• subfolder
• structure
• input
• hot
• watched

Connections

Submit hierarchy does not allow incoming connections.

Submit hierarchy injects folder filter properties into its outgoing connections so that it is
possible to include/exclude certain subfolders in the hierarchy for particular connections.

Note:  The number of eligible jobs for processing is shown in a small rectangle beside
the Submit hierarchy element.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

Path The path of the Submit hierarchy's backing folder on disk.
This is the highest level where Switch must start searching
for files or folders to be processed.

Note:

• From Switch 13 onwards, it is no longer
possible to define "auto-managed" Submit
hierarchy elements.

• If you have different Submit Hierarchy flow
elements in one flow, they are allowed to point
to (partly) the same paths as required. As this
is special behavior (not allowed for other flow
elements!):

• You will get a warning in the error log, but it
won't stop the flows from being activated.

• In the Jobs pane, the content of all Submit
hierarchies using the same path will be
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Property Description

shown when clicking on each individual
element. The same goes for the counters on
the canvas.

Leave originals in place If set to Yes, incoming jobs are left untouched in the folder
hierarchy; read-only access rights suffice. For more
information, refer to Leaving originals in place on page
234.

If set to No (default value), incoming jobs are moved out
of the folder hierarchy; Switch needs full access rights
to rename, create and remove files and folders in the
hierarchy.

Ignore updates This option is only available if Leave Originals in place is set to
Yes.

If set to Yes, a job will only be processed once, regardless
of any changes to the file size or modification date. This
can be used for workflows where the input job is replaced
by the processing result, to avoid triggering endless loops.

If set to No, the job will be reprocessed when its file size or
modification date is different. This allows processing jobs
which have the same file name as previously submitted
jobs.

Minimum file size (KB) Used to set the minimum file size (in KB) limit before
Switch picks up the files or folders. To set no limits, leave
it empty (value None).

Scan every (seconds) The frequency with which this submit hierarchy is scanned
for newly arrived jobs; if set to Default or zero, the global
user preference is used instead; see Switch preferences:
Processing on page 39.

Time-of-day window If set to Yes, Submit hierarchy detects (and moves) newly
arrived jobs only during a certain time of the day (specified
in the subordinate properties).

Allow from (hh:mm)

Allow to (hh:mm)

Only available if Time-of-day window is set to Yes.

The time-of-day window during which to detect jobs;
the values are structured as "hh:mm" (hours, minutes)
indicating a time of day on a 24 hour clock; an empty
value means midnight; two identical values mean Submit
hierarchy always detects jobs.

Day-of-week window If set to Yes, Submit hierarchy detects (and moves) newly
arrived jobs only during certain days of the week (specified
in the subordinate properties).

Allow from Only available if Day-of-week window is set to Yes.
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Property Description

Allow to The days of the week (Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday, Sunday) during which to detect
jobs; two identical values mean Submit hierarchy only
detects jobs on that specific day.

Day-of-month window If set to Yes, Submit hierarchy detects (and moves)
newly arrived jobs only during a certain day of the month
(specified in the subordinate properties).

Day Only available if Day-of-month window is set to Yes.

The day in the month during which to detect jobs, as a
number in the range [1 . .31]; the default value (1) means
the first or the last day of the month (depending on the
following property).

Relative to Determines whether the day of the month is relative to
"Start of the month" or "End of the month".

Subfolder levels The number of nested subfolder levels considered to be
hot folders (as opposed to job folders); indicates how many
levels deep Switch must search for new files or jobs. Note
that, if the specified level contains another subfolder,
this subfolder will be considered as one job, i.e. it will be
processed as one entity, and not as a separate job.

Tip:  If you are not sure about the number of
levels, or if you want all files to be processed
separately (regardless of their nesting level in the
hierarchy), set the Subfolder levels property to a
very high value (for example: 999).

Process these folders Defines the initial set of folders that should be processed
by the Submit hierarchy tool. This set can be adjusted by
defining one or more rules in the subsequent properties.
Options available in this menu are:

• All Folders (default)

• No Folders

Adjusted by (rule 1) This property defines a rule for adjusting the set of
folders to be processed, by including or excluding folders
matching or not matching a folder name. Different rules
can be applied, and will be processed in the order as they
are specified.

Options available in this menu are:

• None (default)

• Including folders named

• Including folders not named
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Property Description

• Excluding folders named

• Excluding folders not named

Folder name The following properties are only available if Adjusted by
(rule1) is enabled.

A pattern for the folder name to be included or excluded.

For example: all folders containing a particular prefix (e.g.
"input_") or a particular value (e.g. the current date).

Note:  If you're using a script expression,
remember that the script expression should
return a boolean value (true or false), instead of a
string matching the folder name. For example, you
could create a script expression to filter out all
folders smaller than 1 MB. If the checked folder <
1 MB (= matches), the result of the script is "true"
and the folder is filtered out.

On levels The level or range of levels to which this rule applies.

Restriction Defines an optional restriction on the parent or ancestors
for the folder in this rule. Options available are:

• None (default)

• With immediate parent named

• With no immediate parent named

• With any ancestor named

• With no ancestor named

Parent name or Ancestor name Only available if a restriction is set on a parent or ancestor for
the folder.

A pattern for the folder name of the parent or ancestor.

Nesting Defines whether this rule operates on subfolders of the
target folder, which are deeper in the hierarchy than the
defined level range. The matching rule is also applied on
these subfolders.

• Exclude/Include nested subfolders as well

• Don't exclude/include nested subfolders

Adjusted by (rule 2)

. . .

Adjusted by (rule 5)

You can configure up to 5 rules for adjusting the set of
folders to be processed. The properties are identical to
Adjusted by (rule 1).

107



Switch

Property Description

Flow stage The stage assigned to the Submit hierarchy. This allows
you to check where jobs are in a flow. The flow stage of a
job can be viewed on the job boards on the Switch Portal.
Refer to Working with flow stages on page 101.

Attach hierarchy info If set to Yes, (part of) a job's submit location, depending on
the hierarchy info configuration, is added to its hierarchy
location path as it is submitted in the flow.

By default, once the files have been processed, they
are all placed in the same output folder, at the highest
level. However, if you set Attach hierarchy info to Yes, the
original location of the job in the hierarchy is stored with
the file (in a so called “internal job ticket”), so that it can be
used to recreate the hierarchy.

Thanks to this mechanism, you can "on the fly" (so while
the job is passing different flow elements) construct the
path in which the processed job will be placed.

For more details, refer to Using hierarchy info on page
237.

Include hierarchy name Only available if Attach hierarchy info is enabled.

If set to Yes, the name of the flow element is included at
the top of the remembered location path.

Include subfolder levels Identifies the number of hierarchy segments in the
hierarchy information.

Save top subfolders If set to Yes, the top-most subfolders are remembered in
the location path.

If set to No, the bottom-most subfolders are remembered.

Attach email info Email addresses and body text specified with the editor
for this property are added to each job's email info as
the job is submitted in the flow; the information added
can vary depending on the subfolder in which the job was
submitted. See Using email info in Switch on page 238.

Allow subfolder cleanup If set to Yes, subfolders created in the Submit hierarchy
(by an external process or a user) are automatically
removed when they become empty.

Starting from this level Only available if Allow subfolder cleanup is set to Yes.

The number of upper levels for which not to clean up
subfolders
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Archive hierarchy

Archive hierarchy is a consumer that creates a nested hierarchy with one or more levels
of subfolders. It is used to archive jobs into a structured hierarchy at the end of a flow. The
resulting jobs are to be consumed (and removed) by an external process. The backing folder (on
disk) for an archive hierarchy should typically be user-managed.

It is not allowed for an external process or a user to place files into an archive hierarchy.

An archive hierarchy uses the hierarchy location path stored in a job's internal job ticket to
determine where the job should be stored, up to the nesting level specified for the archive
hierarchy. Any superfluous segments in a location path are ignored. Subfolders are created
automatically.

See Using hierarchy info on page 237 for more details.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Archive hierarchy element will be shown in the list:

• backing
• folder
• subfolder
• structure
• output

Connections

The Archive hierarchy allows outgoing traffic light connections. With the help of these traffic
light connections, you can fail files that were not archived properly and you can also send a
notification to the administrator or IT department about this problem.

With the Archive hierarchy tool, you can first archive your files and later send email notification
to internal operators, CRMs, etc. You can also store your files in the internal Archive before
uploading them to an FTP Server to make them accessible to external users.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Path The path of the archive hierarchy's backing folder on disk, or
"auto-managed".
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Property Description

Subfolder levels The number of nested subfolder levels in the archived structure;
see also the description on subfolders earlier.

Safe move This option is only relevant for transferring job files between
folders on different volumes (drives/partitions).

If set to Yes (default value), Switch will first copy the job to a
temporary file before deleting the job from the original location.
This is useful to avoid that files get lost in case of network
problems.

If set to No, Switch immediately moves the job files to the Archive
hierarchy. This may be necessary in case of network permission
issues.

Strip unique name If set to Yes, the unique name prefix added to the filename by
Switch is removed before placing the job in the archive hierarchy;
the default is to strip the prefixes from jobs deposited in an
archive hierarchy - leaving the prefixes in place avoids overwriting
a previously deposited job with the same name

Duplicates Determines what happens when Strip unique name is set to Yes
and a job arrives with the same name and location as a job already
residing in the hierarchy:

• Overwrite: replace the existing job with the new one – this is the
default behavior.

• Keep unique name: preserve the new job's unique name prefix,
leaving the existing job untouched (without unique name prefix).

• Add version number: add an incrementing version number at
the end of the filename body for the new job ("2", "3", … "9", "10",
"11"), leaving the existing job untouched. For example, "job.pdf"
will become "job1.pdf"," job2.pdf", ...

Optionally, you can add a separator between the filename body
and the version number, for example an underscore. In that case,
e.g. "job.pdf" will become "job_1.pdf"," job_2.pdf", ... By default,
the Separator property is empty.

You can also determine the width of the version number, i.e. the
number of digits used for the version number. For example, if
Width is set to "5", the version number will consist out of 5 digits
(e.g. job_00001.pdf), meaning that leading zeros will be added as
required.

• Fail: move the new job to the problem jobs folder, leaving the
existing job untouched.

• Discard: remove the new job, leaving the existing job
untouched
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Set hierarchy path

Set hierarchy path is a processor that replaces or augments the hierarchy path in the internal
job ticket by constructing a fresh path from the segments specified as its properties. There are
five segment properties and thus a maximum of five path segments can be specified (an empty
value means "unused").

Since the segment properties support variables ( and script expressions), this tool is a great
help when building custom archive hierarchies, for example organizing jobs in a folder hierarchy
based on today's year, month, and day.

Keywords

Keywords can be used with the search function above the elements pane.

The keywords for the Set hierarchy path element are:

• folder
• subfolder
• structure

Connections

Set hierarchy path allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving your
mouse over the flow element

Action Determines how to combine the new segments with the existing
hierarchy location path:

• Replace: replace any existing hierarchy location path by the path
formed by the new segments

• Add at the top: add the new segments at the top of the existing
hierarchy location path

• Add at the bottom: add the new segments at the bottom of the
existing hierarchy location path

• Remove: remove one or more segments from the existing
hierarchy location path
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Property Description

• Reverse: put the top segments at the bottom and vice-versa

Path segment 1 …

Path segment 5

The new path segments; an empty value means "unused"; a maximum
of five path segments can be specified

Start index The one-based index of the first segment to remove (topmost segment
is index 1)

End index The one-based end index of the last segment to remove; zero means
until the end of the path

Job dismantler

Job dismantler is a processor that disassembles a job folder (which may have one or more
levels of subfolders) into separate files.

This tool is often used to dismantle job folders that really do not represent a single job. This
happens for example when a user submits a folder into the flow that contains a set of otherwise
unrelated files that need to be processed individually rather than as a single entity.

Each incoming file or job folder is treated with the semantics of a submit hierarchy with regards
nested subfolders and job folders.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Job dismantler element are:

• hierarchy
• folder
• subfolder
• ungroup
• group
• assemble
• disassemble

Connections

Job dismantler injects folder filter properties into its outgoing connections so that it is possible
to include/exclude certain subfolders in the incoming job folders for particular connections. Also
see the "skip folders" property described below.

Properties

Property Description

Name The name of the flow element displayed in the canvas
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Property Description

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

Subfolder levels The number of nested subfolder levels considered to be hot folders
(as opposed to job folders); see also the description in Submit
hierarchy on page 103

Attach hierarchy
info

If set to yes, (part of) a job's location in the job folder is added to
its hierarchy location path as it is injected in the flow; see Using
hierarchy info on page 237

Add dismantler name If set to yes, the name of this flow element is included in the
remembered location path

Add job folder name If set to yes, the name of the incoming job folder is included in the
remembered location path

Include subfolder
levels

Identifies the number of hierarchy segments in the hierarchy
information.

Save top subfolders If set to yes, the top-most subfolders are remembered in
the location path, otherwise the bottom-most subfolders are
remembered

Keep existing info If set to yes, the new information is added at the bottom of the
existing location path; otherwise the existing location path is
replaced

Attach email info Email addresses and body text specified with the editor for this
property are added to each job's email info as the job is injected in
the flow; the information added can vary depending on the subfolder
in which the job was located; see Using email info in Switch on page
238 for more details

Ungroup job

Ungroup job is a processor that, in combination with assemble job, provides a way to keep track
of files that belong together while they are being processed separately.

Ungroup job injects all files from a job folder into the flow as separate jobs. After these
files have been processed through the flow (and possibly were renamed), assemble job
can reassemble them into a new job folder with a structure similar to the original one, with
provisions for injecting additional files and for dealing with incomplete jobs or orphaned files.
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Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Ungroup job element are:

• hierarchy
• folder
• subfolder
• ungroup
• group
• assemble
• disassemble

Usage examples

• Split a multi-page PDF file in separate pages; process each page separately through one or
more applications that can deal only with a single page at a time; recombine the pages in a
job folder; merge the pages into a single PDF file.

• Receive a job folder that contains a nested structure of related files; disassemble the folder
into separate files; sort the files on file type and put them through some different process
depending on the file type; re-assemble the files into a job folder with a structure that is
identical to the incoming job folder.

Connections

Ungroup job allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Private data key The first portion of the private data key used to store the information
for reassembling the job later on

Varying this value here and in assemble job allows:

• Ensuring that a job is reassembled by the intended assembler

• Nesting ungroup/reassemble operations

Private data

Ungroup job stores the following information in the internal job ticket for each injected job file,
for use by assemble job:

Private data key Stored value

<key>.JobID The unique name prefix of the incoming parent job
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Private data key Stored value

<key>.JobName The name of the incoming parent job (without prefix)

<key>.NumFiles The total number of files injected in the flow for this parent job

<key>.FileName The name of this file as injected in the flow

<key>.FilePath The relative path of this file within the parent job folder

Split multi-job

Related Adobe InDesign or QuarkXPress jobs are often stored in a single job folder with multiple
"main" files at the top level and shared resources (such as images and fonts) in subfolders. The
Switch configurators for these applications however expect a single main file in each job folder,
so these "multi-job folders" cannot be processed without change.

The Split multi-job tool splits a multi-job folder in separate job folders, one for each main file.
Each resulting job folder contains a single main file, and a full copy of all resources (in fact,
everything from the original job folder except for the other main files).

Keywords

Keywords can be used with the search function above the Flow elements pane.

The keywords for the Split multi-job element are:

• Adobe InDesign
• QuarkXPress
• multiple
• job
• package
• folder
• assemble
• disassemble

Connections

Split multi-job allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This description is
also shown in the tooltip that appears when moving your cursor over the flow
element
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Property Description

Main file
type

The file type or file name extension of the main files. The tool will output a
separate job folder for each main file in the incoming job folder. Main files
are recognized only if they are located immediately inside the job folder, not
in a subfolder

Assemble job

Assemble job is a processor that offers various schemes for assembling a job folder from
individual job files.

Note:  When designing a flow, do NOT use folders with network paths prior to the
Assemble job element.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Assemble job element are:

• hierarchy
• folder
• subfolder
• ungroup
• group
• assemble
• disassemble
• build

Connections

Assemble job supports outgoing traffic light connections of the following types:

• Success out: carries successfully assembled jobs.

• Error out(optional): carries incoming jobs that cannot be assembled into a job after a certain
timeout period.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Scheme Determines the scheme used to assemble jobs:
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Property Description

• Arbitrary files: combines arbitrary files based on number
and/or time

• Numbers in filename: uses digit groups in the incoming
filenames to combine files

• Filename patterns: uses filename patterns to combine up to
5 related files in a job

• Ungrouped job: uses the information stored by an instance
of ungroup job to reassemble a job

• Custom: allows specifying a custom formula for
determining matching files

Every N jobs Displayed when Scheme is Arbitrary files. A job is completed
whenever it contains at least the indicated number of files; a
value of 0 means this option is disabled

Every N minutes Displayed when Scheme is Arbitrary files. A job is completed
whenever more than the indicated time has expired since the
previous assembly was completed; a value of 0 means this
option is disabled

After N minutes Displayed when Scheme is Arbitrary files or Custom. A job is
completed whenever more than the indicated time has expired
since the first job in this assembly arrived; a value of 0 means
this option is disabled

Number index for total Displayed when Scheme is Numbers in filename. The one-
based index of the digit group determining the total number
of files; automatic means the digit group that represents the
largest number

Number index for serial Displayed when Scheme is Numbers in filename. The one-
based index of the digit group determining the serial number
for each file; automatic means the digit group that represents
the smallest number

Match filename Displayed when Scheme is Numbers in filename. The filename
without the indexed numbers of the files to asemble in job
must be the same.

Filename pattern 1

…

Filename pattern 5

Displayed when Scheme is Filename patterns. Up to five
filename patterns (using the regular wildcards ? and *) that
serve to detect matching files; empty patterns are ignored

For filenames to match, they must conform to the specified
patterns and the text portions matched by the wildcards must
be identical

When the Assemble job tool takes an incoming job, it matches
the job file name with the file patterns. When the job file name
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Property Description

matches with a filename pattern, the matched pattern is
no longer used. Therefore, the order in which you enter the
filename patterns is important.

For example: You have two filename patterns and one is
an extension of the other, viz., *.png and *_test.png. It is
recommended to enter *_test.png in the Filename pattern 1
field and enter *.png in Filename pattern 2 field.

Private data key Displayed when Scheme is Ungrouped job. The first portion
of the private data key used to store the ungroup information;
specify the same value as in ungroup job

Number of files Displayed when Scheme is Ungrouped job or Custom. The total
number of files expected to complete the output job:

• Automatic: the same number of files as was present in the
original folder before it was ungrouped

• Inline value: enter an explicit value in the field

• Define single-line text with variables: a constant integer
or a short JavaScript expression in function of the variable
"N" (example: "N+2" or "2*N"); this function has NO access
to the scripting API

• Define script expression: a script expression (with full
access to the scripting API) that has an integer result; the
expression is re-evaluated for each newly arrived job in the
context of that job

Job identifier A string value using variables ( or a script expression),
evaluated in the context of each arriving job, that identifies the
output job in which the arriving job belongs

The string is used only for the purpose of determining which
jobs belong together; it has no other meaning

Complete condition A job (using Custom scheme) is completed if this condition
is true, even if the required number of jobs hasn't arrived.
The condition is re-evaluated for each newly arrived job in
the context of that job. A value of None means this option is
disabled.

Merge metadata If set to no, the metadata for the assembled job is copied from
a single (arbitrary) incoming job, and metadata from all other
jobs is lost. If set to yes, the metadata for the assembled job is
derived from all incoming jobs:

• All email addresses are used, and email bodies are
merged.

• User name and Job state will be arbitrarily selected from
all jobs, or will be empty if this is empty for all jobs
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Property Description

• The highest priority among all incoming jobs will be used.

• Private data and External datasets will all be retained. If
multiple jobs have private data or external datasets with the
same tag, a dataset or value will be arbitrarily chosen.

All other metadata will be arbitrarily selected from one of
the incoming jobs

Job folder name The filename of the created job folder, or Automatic to
construct a default name depending on the scheme (e.g. the
reassemble scheme uses the job name stored by the ungroup
tool)

Question marks in the filename pattern are replaced by a
running count; e.g. Job??? will produce Job001, Job002, ...

Variables ( and script expressions) are executed in the context
of one of the incoming jobs, chosen arbitrarily

Subfolder levels The number of nested subfolder levels in the job folder being
assembled

The tool uses the hierarchy location path or the ungrouped job
private data to determine where the job should be stored, up to
the specified nesting level (similar to archive hierarchy)

Strip unique name If set to yes, the unique name prefix is removed before placing
the job in the job folder being assembled

Duplicates Determines what happens when "strip unique name" is set to
yes and a job arrives with the same name and location as a job
already residing in the job folder being assembled:

• Overwrite: replace the existing job with the new one – this is
the default behavior

• Keep unique name: preserve the new job's unique name
prefix, leaving the existing job untouched (without unique
name prefix)

• Add version number: add an incrementing version number
at the end of the filename body for the new job ( "2", "3", …
"9", "10", "11"), leaving the existing job untouched

• Discard: remove the new job, leaving the existing job
untouched

• Fail: move the new job to the problem jobs folder, leaving
the existing job untouched

Orphan timeout (minutes) The time delay after which incoming jobs are considered
orphaned because they are not part of a completed job.
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Property Description

Incoming jobs remain in their respective input folder until the
last job arrives that completes an output job folder; whenever
a new job arrives, the timeout counter is reset for already
arrived jobs that are part of the same output job folder.

Orphaned jobs are moved along the outgoing data error
connection, or if there is no such connection, they are moved to
the problem jobs folder.

If this property is set to 0, incoming jobs that are not part of a
completed job remain in the input folder. Switch does not treat
them as orphaned jobs; they are not moved along the outgoing
data error connection (if there is one) and they are not moved
to the problem jobs folder.

Generic application

Generic application is a processor that functions as a stand-in for a third-party hot-folder
application.

Note:  The Generic Application element is only available if you have an active license for
the Configurator Module.

The third-party application must be configured independently, and its input and output folders
must refer to the backing folders of the corresponding flow elements preceding and following
the generic application in the flow design.

Files are moved along the incoming and outgoing connections of a generic application under
the control of the third-party application (not under the control of Switch). Still, designing the
generic application flow element and its connections into the flow at the appropriate place has
several key advantages:

• Switch ensures that the third-party application's output files receive the appropriate unique
name prefix so that internal job ticket information (such as hierarchy info and email info) is
preserved.

• Switch automatically cleans up files left in the input folder by the third-party application.

• If the third-party application runs on the same computer, Switch can launch the application
when needed.

• Switch is able to gather its regular processing statistics for the third-party application.

• The third-party application's function is documented in context of the complete flow.

Because the incoming connection is under the control of the third-party tool, the incoming
folder, the connection and the generic application tool itself behave different than regular
Switch flow elements:

• the input folder has no properties to attach hierarchy info, e-mail addresses, e-mail body text
or job state, set job priority or show in statistics.

• the input folder does have a special property to ignore sub folders.
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• the input folder can only have one outgoing connection
• the connection cannot be set on hold.
• the generic application tool can only have one incoming connection.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Generic application element are:

• hot
• watched
• folder
• third-party

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

Known application Set to yes if you can browse to the third-party application's
executable on the same computer system; this allows Switch to
launch and monitor the application

Path The absolute file path of the third-party application's executable

Launch application If set to yes, Switch launches the third-party application when it is
needed and if it is not already running

Abort application If set to yes, Switch aborts the third-party application if it exceeds
the time limit specified by the user preference "Abort processes
after" (see error-handling preferences)

Perform cleanup If set to yes, Switch removes files left in the input folder left by
the third-party application; it is strongly recommended to leave
this option turned on unless you are sure that the third-party
application removes its input files in all circumstances, including
error conditions

When detecting
output files (N)

Remove a file from the input folder after at least the specified
number of output files have been detected for the file; a value of
zero means this option is disabled; Switch uses the unique name
prefix to match output files with input files, so if the third-party
application's output files are not named similar to its input files,
this option will not work

After (min) Remove a file from the input folder if more than the specified
time has passed; provide sufficient extra time for unforeseen
circumstances; a value of zero means this option is disabled
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Execute command

Execute command is a tool that executes a system command or a console application with the
specified command-line arguments and output mechanisms.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Execute command element are:

• command
• console
• third-party
• CLI

Connections

Execute command allows only a single outgoing connection

Properties

Properties Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

Execution Mode This property helps you to configure the tool to handle jobs in
parallel (concurrent) or serial mode:

• Concurrent: Choose this option to enable the tool to process
jobs simultaneously through multiple instances of the Execute
Command tool while using the same application.

Note:

• The application you choose should support
concurrent processing.

• Use the Concurrent processing tasks property in
the User Preferences > Processing tab to set the
number of concurrent processes.

• Serialized: Choose this option to enable the tool to process jobs
using only a single instance of the Execute Command tool.

Command or path The system command to be executed (only allowed for commands
from the operating system!), or the absolute path to the console
application to be invoked.
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Properties Description

Note:  If you don't know the location of the application,
search for it in the documentation of the application or
search for the application on your disk. On Windows,
applications are usually installed under C:\Program Files
\ or C:\Program Files (x86)\. On Mac, you can use Spotlight
to search in the system files (see http://support.apple.com/
kb/HT4355) .

Arguments The remainder of the command line; the following substitutions are
made in the specified text:

• %1: the absolute path of the input file/job folder

• %2: the absolute path of the output file/job folder (which does
not yet exist) including filename and extension

• %3: the absolute path of a folder (which does exist) in which
output or temp files may be placed

All of these substitutions work even if "Output" is set to None or
Original (in which case any generated output is discarded)

Placeholders (%1, %2, %3) and argument values that may contain
spaces (such as file paths) must be enclosed in quotes!

Output Determines how the command generates its output (the tool
automatically moves the output to the outgoing connection):

• None: the command generates no output (or any generated
output is discarded) and nothing is moved to the outgoing
connection

• Original: the command generates no output (or any generated
output is discarded) and the incoming job is moved to the
outgoing connection

• Updated input job: the command updates or overwrites the
incoming job in place

• Result next to input job: the command places the output next to
the input job (i.e. in the same folder)

• File at path: the command places a single output file at the
absolute path specified by %2

• Folder at path: the command places a single output job folder at
the absolute path specified by %2

• Result in folder: the command places the output inside the
existing folder at absolute path %3

Note:  When you enter %3 in the Arguments
property, the tool creates a temporary folder named
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Properties Description

ExecuteCommandTemp. Switch sends the entire
ExecuteCommandTemp folder (and not just the
contents of the folder) as job folder to the outgoing
connection.

Copy input job If set to yes, the incoming job is copied to a temporary location
before the command is triggered; this must be turned on in cases
where the command modifies the input job or places files in the
folder where the input job resides

This property is not present for some choices of output because in
those cases the incoming job must always be copied

Output job filter Determines which of the generated files or folders is the output
file; Automatic works unambiguously if a single file is generated;
otherwise a simple heuristic is used to make an "educated guess"

Output extension The filename extension of the output job to be provided to the
command line (i.e. the substitution of %2); Automatic means use
the same extension as the input job

Fail if exit code is Fails the job (that is, moves it to the problem jobs folder) if the
command's exit code is:

• Nonzero

• Negative

• In range

• Outside range

• Disregard exit code

Range A range specified as "n1..n2;n3..n4" where the n's represent a
positive or negative integer or are missing to indicate an open end;
for example: "-7..-4; 0.."

Fail if stdout
contains

Fails the job (that is, moves it to the problem jobs folder) if the
regular console output contains the search string or pattern; empty
means disregard the regular console output

Fail if stderr contains Fails the job (that is, moves it to the problem jobs folder) if the
console error output contains the search string or pattern; empty
means disregard the console error output

Best practice

We recommend creating a working command in Command Prompt on Windows or Terminal on
Mac first, before actually configuring the Execute command flow element.

Keep in mind that Switch will execute the command directly in the operating system while
Command Prompt and Terminal use a shell. This results in some differences in behavior, the
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most important one being that you always have to provide the full path to the command line
application in Switch, even when this is not necessary in Command Prompt or Terminal!

For complex issues, it may be handy to enable the logging of debug messages (see Switch
preferences: Logging on page 45). The table below gives an overview of the debug messages that
will be logged when running the Execute Command Tool:

Debug message Meaning

Executing Complete command which Switch will execute after it replaced the
placeholders with the actual paths.

Outcode The outcode/exitcode of the command. Switch decides whether or
not the command was successful.

Stdout Output of the command in case executing the command went
well. This is the same output as you would see when executing the
command in Command Prompt or Terminal.

Stderr Output of the command in case of problems. This is the same
output as you would see when executing the command in Command
Prompt or Terminal.

If none of the above debug messages are generated, the operating system failed to execute the
command itself. Check if the path to the application is correct and check if you have the right
permissions.

Redirecting

Redirecting output from a command to a text file is a feature of the shells used in Terminal and
Command Prompt and is therefore not possible using the Execute command tool in Switch.

As a workaround, you can create a batch file that uses a shell that supports redirecting. Use this
batch file as a command and send input and output paths as arguments to this batch file.

Example:

Setup of the Execute Command Element:

• Command or path: /path/to/bash/script.sh
• Arguments: "%1" "%2"
• Output: File at path

Contents of the script.sh batch file:

#!/bin/bash
sed "s/\&/\&amp;/g" "${1}" >> "${2}" (This example will replace “&” with “&amp;” in
 text files)

Best practices

• Sometimes it is useful and easier to write arguments in the Script Expression dialog. Below
is an example:

Command or path: cp
Arguments: Script expression defined:        
      "var destPath = "/Users/user/Desktop/dest";         
      var path = job.getPath();         
      var command = "\"" + path + "\" \"" + destPath + "\"";         
      command;"
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• Make sure that all the passed arguments are the real arguments of the specified process. In
the example below, the TASKKILL command is not the command of Application.

Command or path: C:/Program Files/Application /Application 1.0/Application/
Application.exe     
Arguments:     /t "%1" "option with space" "option with space"  TASKKILL /IM
 "Application.exe" <-- WRONG -->

A similar mistake would be to write the following in cmd:

C:\Users\user>dir "c:\folder1\folder2" taskkill /im Application.exe <-- WRONG -->

On the contrary, this is the right way to write it:

C:\Users\user>dir "c:\folder1\folder2"        <-- CORRECT -->   
C:\Users\user>taskkill /im Application.exe    <-- CORRECT -->

• Make sure to use variables (%1, %2, %3) correctly. Below is an example:

Command or path: tar     
Arguments: -zxvf "%1" -C "%3"

• Remember to use quotes when referring to paths.

dir c:/folder/inner folder  <-- WRONG -->
dir "c:/folder/inner folder" <-- CORRECT -->

• Preferably, use a bat file/shell script instead of an executable or an app.

This means that the "Command or path" property is used to select the bat file or shell script
and the variable parameters. All other arguments are put in the bat file or shell script. This
approach has two advantages:

• It keeps the Arguments property cleaner and easier to read.
• The executable or app in the Execute command is running in a different environment than

when used in a command prompt/terminal window. This may be necessary to be able to
work with certain environment variables.

Example:

Content of the shell script:
#!/bin/bash
export PATH="$PATH:/cygdrive/c/Program Files/MySQL/MySQSL Server 5.7/bin"
echo $PATH
#do everything that you want
#start your application for example
mysql $1

Command or path: <path to bash>
Arguments: <path to sh> <mysql arguments>

• You can use Switch variables in the 'Arguments' property, because all the variables are
evaluated and actual values are passed inside the script; actually, the arguments from the
'Arguments' property become script arguments, accessible inside the script via $1, $2 etc.
or %1, %2 etc. However, keep in mind that it is useless to write Switch variables inside .sh
or .bat scripts, as Switch doesn't work with the script content.

• Use the Run tool to recheck the command and arguments on Windows. For example,
proceed as follows:

1. Find Run on your system.
2. Put "cmd /K dir <path to the directory>" ( without quotes ) in Run.
3. Press Enter.
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4. Recheck that the output is correct.

5.1.2.2.  Tools

Sort by preflight state

Sort by preflight state is a processor that sorts incoming Enfocus Certified PDF files across its
outgoing connections depending on their preflight state: Error, Success, Warning or Sign-off.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Sort by preflight state element are:

• Enfocus
• Status check
• PDF
• preflight
• error
• success
• warning
• sign-off

Properties

Property Description

Name The name of the configurator. Default is "Sort by preflight
state".

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element.

Rejecting jobs

This tool rejects the following incoming jobs (that is, these jobs are moved to the Problem jobs
folder):

• Jobs other than a single PDF file
• PDF files that are not Certified PDF

Archive
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Archive is a processor that places the incoming file or a job folder into a compressed ZIP archive
(ZIP64-compliant). All files in a job folder are placed in a single archive. The archive is named as
the incoming file or job folder with a ".zip" extension.

Note:

• The Archive tool replaces the (now outdated) Compress tool, which did not provide
Unicode support. Only use Compress (now available in the Legacy category) for
maintenance reasons.

• Very large files (+4 GB) can be archived as well.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Archive element are:

• ZIP
• archive

Connections

Archive allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Compress If set to Yes, the files in the ZIP archive are compressed (default
behavior).

If set to No, the files are stored in the ZIP archive without
compression, dramatically reducing the processing time; this can
be meaningful when speed is more important than size, or when
the files will not compress well anyway (for example, in case of
JPEG images) – but you still want a single archive containing all
files.

Password The password used for protecting archives, or None (if not
password-protected).

Note:  Switch uses zlib which does not support the AES encryption, therefore Switch
cannot read passwords which use the AES encryption. Hence, the Unarchive tool cannot
read passwords which have been encrypted using the AES encryption. As a workaround,
users can try using a third-party archiver as a command line application from Switch.
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Unarchive

Unarchive is a processor that extracts files from an archive in ZIP or RAR format (ZIP64-
compliant).

Any files that are not recognized as an archive are passed through the Problem jobs folder.

Note:

• The Unarchive tool replaces the (now outdated) Uncompress tool, which did not
provide Unicode support. Only use the old Uncompress (now available in the Legacy
category) if you need support for MIME.

• Very large archives (+4 GB) can be unarchived as well.

Keywords

Keywords can be used with the search function above the Flow elements pane.

The keywords for the Unarchive are:

• ZIP
• RAR
• archive
• compress
• decompress
• unzip
• unrar

Filenames and folder structure

The following table describes the resulting file or folder structure and the corresponding
naming conventions.

Multiple files from the same archive are always placed in a job folder. If the intention is to inject
these files into the flow as separate jobs, a job dismantler should be placed directly after the
Unarchive flow element.

Archive contents Unarchive result

Single file The file (named as specified in the archive).

Multiple files or folders with a
common root folder

A job folder (named as the nearest common root folder)
containing all files and folders (named as specified in the
archive).

Multiple files or folders
without a common root folder

A job folder (named as the archive after stripping the
extension) containing all files and folders (named as
specified in the archive).
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Connections

Unarchive allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Passwords A list of passwords for opening password-protected archives; each
of the passwords in the list will be tried in turn.

The script expression can be used to determine a password
dynamically, for example based on the sender of the packed data.

Note:  The result of the script expression evaluation must
be a string containing one password or a list of passwords
separated by a newline character ('\n').

Example:

var thePasswords = new Array();
thePasswords.push( "password" );
thePasswords.push( "password2" );
thePasswords.join( '\n' );

Remove redundant
folders

If set to Yes, for archives where the files or job folders are
contained in deeply nested subfolder structures, removes all but
the deepest subfolder level while uncompressing.

Example: A PDF file that is archived as "Folder 1\Folder 2\Folder
3\Test.pdf" is uncompressed as "\Folder3\Test.pdf", if this option
is enabled.

Note:  The Unarchive tool cannot read passwords which have been encrypted using
the AES encryption. Switch uses zlib which does not support the AES encryption. As a
workaround, users can try using a third-party archiver as a command line application
from Switch.

Split PDF

Split PDF is a processor that produces a job folder containing a separate PDF file for each page
or range of pages in the incoming PDF file. The tool does not require Adobe Acrobat or any other
external application to be installed.
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Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Split PDF element are:

• PDF
• split
• merge
• pages

Connections

Split PDF allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Pages per file The number of pages in each output file. You can enter a number,
or use variables and script expressions.

Examples:

• To create output files of 20 pages each, select Inline value and
type "20".

• To create 5 output files, each of the same number
of pages (depending on the total number of pages
of the input file), select Define single-line text
with variables and compose the following variable:
[Switch.Calculation:Expression="[Stats.NumberOfPages]/5"].

Filename prefix The string pattern to be inserted before the filename.

Filename suffix The string pattern to be inserted after the filename (but before the
file name extension.

Keep page labels Select Yes to retain the page labels from the original file; select
No if the resulting files should not contain any page labels.

File naming

For each incoming PDF file, the tool creates a job folder that contains the PDF files resulting
from splitting the incoming PDF file into sections of one or more pages. The files are named by
adding a prefix and/or suffix to the incoming file's name.

In the values of the filename prefix and suffix properties described above, the following
character sequences (regardless of case) are replaced by the appropriate number for the file as
follows:
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sequence Replaced by

[Index] The one-based index (in the original file) of the first page stored in this
result file.

[LastIndex] The one-based index (in the original file) of the last page stored in this
result file.

[Label] The PDF page label of the first page stored in this result file. If the page
does not have a label, its one-based index is used.

[LastLabel] The PDF page label of the last page stored in this result file. If the page
does not have a label, its one-based index is used.

[LastSourceLabel] The PDF page label of the last page in the original file. If the page does
not have a label, its one-based index is used.

[Total] The total number of pages in the original file.

Note:

• For [Index] and [LastIndex], leading zeros are added so that the index has the same
number of digits as the total number of pages in the original file.

• If the constructed filename contains characters that are not allowed in filenames on
Windows (control characters, \, /, :, *, ?, <, > and |), these characters are replaced by
a #, even if Enfocus Switch is running on Mac.

Example

This example is based on a PDF file named "Booklet.pdf". It contains 15 pages. The first 4 pages
are labled in roman numbers, followed by 2 chapters with respectively 6 and 5 pages, labeled
"1-2", "1-3", etc.

Property settings Resulting files

Default settings:

• Pages per file = 1

• Prefix = ""

• Suffix = "_[Index]"

• Booklet_01.pdf

• Booklet_02.pdf

• ...

• Booklet_15.pdf

• Pages per file = 2

• Prefix = ""

• Suffix = " pages [index]-
[LastIndex] of [Total]"

• Booklet pages 01-02 of 15.pdf

• Booklet pages 03-04 of 15.pdf

• ...

• Booklet pages 15-15 of 15.pdf

• Pages per file = 1 • 01 Booklet i.pdf
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Property settings Resulting files

• Prefix = "[Index]"

• Suffix = "[Label]

• 02 Booklet ii.pdf

• 03 Booklet iii.pdf

• 04 Booklet iv.pdf

• 05 Booklet 1-1.pdf

• ...

• 10 Booklet 1-6.pdf

• 11 Booklet 2.1.pdf

• ...

• 15 Booklet 2-5.pdf

Merge PDF

Merge PDF is a processor that produces a single PDF file containing all of the pages provided by
the PDF files in the incoming job folder. The tool does not require Adobe Acrobat or any other
external application to be installed.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Merge PDF element are:

• PDF
• split
• merge
• pages

Connections

Merge PDF Pages allows only a single outgoing connection

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.
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Property Description

Keep page labels Select the "Yes" option in the drop-down menu to retain the page
labels from the original file. If you select the "No" option, the
resulting files will not contain any page labels

PDF metadata

File, Title, Author, Subject and Keywords will be merged if all input PDF files have the same
value. So in case a flow uses a Split PDF and Merge PDF tool, this metadata can be restored. If
the metadata has different values, the merged PDF will have empty metadata fields.

Switch metadata

The Merge PDF tool processes a job folder, so Switch metadata is derived from that folder and
not from the individual PDF files.

PDF version

The merged PDF will have the highest PDF version number. Example: Merge two files, one PDF
version 1.4 and the other PDF version 1.6, the result will be PDF version 1.6.

Merge order

The tool will merge the files in increasing alphabetical order of file name.

However, if

• every file name contains at least one number and

• every file has the same amount of numbers (consecutive digit groups) in their file name,

the Merge order processor will take the lowest number represented by any of the digit groups in
the file name as "Rank". If no two files have the same rank, the processor will merge the files in
order of increasing rank.

Note:

More advanced merge ordering can be achieved by using the Sort files in job tool in front
of the Merge PDF pages tool. See Sort files in job on page 150.

Examples

The Merge PDF will correctly collate all of the examples provided for the Split PDF in Pages tool
(see Split PDF on page 130)

Incoming files Ordering

• Booklet_01.pdf

• Booklet_02.pdf

• ...

• Booklet_15.pdf

All file names have a single digit group representing a
ranking number that is unique among the complete set of
files: this ranking is used to order the files
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Incoming files Ordering

• Booklet pages 01-02 of
15.pdf

• Booklet pages 03-04 of
15.pdf

• ...

• Booklet pages 15-15 of
15.pdf

All file names have the same number of digit groups (3). The
lowest number offers a correct ranking that is unique among
the complete set of files: this ranking is used to order the
files

• 01 Booklet i.pdf

• 02 Booklet ii.pdf

• 03 Booklet iii.pdf

• 04 Booklet iv.pdf

• 05 Booklet 1-1.pdf

• ...

• 10 Booklet 1-6.pdf

• 11 Booklet 2-1.pdf

• ...

• 15 Booklet 2-5.pdf

The file names have different amounts of digit groups (1 vs
3), so the files will be ordered alphabetically. Even if the file
names would have the same number of digit groups, the
ranking would be alphabetically, as their would be doubles in
ranking (each chapter number occurs more than once.

However, because the page index (including the leading
zeroes) appears early in the file name, the alphabetical order
will put the pages in the same order as before splitting

Hold job

Hold job is a processor that offers various time-based schemes for holding and releasing jobs
and for distributing jobs across multiple outgoing connections.

Note:  When designing a flow, do NOT use folders with network paths prior to the Hold
job element.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Hold job element are:

• delay
• file
• balancer
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• priority
• queue
• distribute

Connections

Hold job allows any number of outgoing move connections and offers additional properties on
each of those connections.

Properties

Properties Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element

Job priority The priority assigned to each incoming job; jobs with
higher priority are released first; a greater number
indicates a higher priority

Default means: use the job priority defined in the job ticket

The value of this property is converted to a floating point
number; the Boolean value True and string values that
commonly represent True convert to 1, the Boolean value
False and any string values that don't represent a number
or True convert to 0

Delay scheme Select "Delay", "Release condition" or "None" in this drop-
down menu to define the type of delay scheme you want to
define.

Delay: When you select "Delay", jobs are delayed for
a certain period of time (specified in the subordinate
properties), and a job becomes eligible for release
only after it has resided in the input folder for at least
the specified period of time (as set in the subordinate
properties).

Release condition: When you select "Release condition",
jobs become eligible for release only after the release
condition has been evaluated to true (that is, it has
satisfied the conditions which have been set in the
subordinate properties).

The following subordinate properties are present if Delay
scheme is set to Delay.

Unit Select the unit for the time delay: Seconds, Minutes,
Hours, Days

Delay Provide the job delay in the units indicated by the previous
property.
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Properties Description

You can enter an explicit value in the field or specify using
the Define single-line text with variables or Define script
expression dialogs available from the pop-up menu.

The following subordinate properties are present if Delay
scheme is set to Release condition.

Release condition Specify the condition which should be evaluated to true
before the job is released.

You can specify the value using the "Define condition with
variables" or "Define script expression" dialogs available
from the pop-up menu (making it possible for you to use
values from Switch variables, metadata, a database or
script expressions).

The release condition is executed repeatedly using N
units. For example: if we set the delay as 5 minutes, the
release condition will be checked every 5 minutes

Retry unit Select the unit for the time delay: Seconds, Minutes,
Hours, Days

Retry after Provide the job delay in the units indicated by the previous
property.

You can enter an explicit value in the field or specify using
the Define single-line text with variables or Define script
expression dialogs available from the pop-up menu

Release attempts threshold Determines when the job will fail (hence will be sent to the
Problem jobs folder):

• 0 (default): The job will never fail due to unsuccessful
release attempts.

• Number > 0: The job will fail after the given number of
unsuccessful release attempts.

Output order Determines the order in which outgoing connections
receive jobs (relevant only if there is more than one):

• Cyclic: always in the same cyclic order

• Random: in pseudo-random order

Outgoing connection properties

The following properties are provided for each of the outgoing connections in addition to the
basic connection properties.
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Property Description

Connection priority The priority of this connection; a greater number indicates a
higher priority; at any given time only the eligible connections
with the highest priority will receive jobs

Folder constraint If set to yes, this connection is eligible to receive jobs only
when certain constraints on the target folder (specified in the
subordinate properties) are met

Maximum job count This connection receives a job as long as its target folder contains
no more than this number of jobs after adding the job; a zero
value means this constraint is disabled

Maximum file count This connection receives a job as long as its target folder contains
no more than this number of files after adding the job; a zero
value means this constraint is disabled

Maximum folder size
(MB)

This connection receives a job as long as its target folder's size
does not exceedthis limit after adding the job; a zero value means
this constraint is disabled

Target folder The absolute path of the folder that should be checked for job
count and/or size; Default means the connection's target folder

Note:  Whenever a job arrives in the Hold job tool, Switch
checks the Target folder. Jobs that are in between the
Hold job tool and the Target folder are not taken into
account for the constraint. To make sure that there
are no jobs in between the Hold job tool and the Target
folder, space the jobs apart for a certain period of time.

Time-of-day window If set to yes, this connection is eligible to receive jobs only
during a certain time of the day (specified in the corresponding
properties)

Allow from (hh:mm)

Allow to (hh:mm)

The time-of-day window during which to receive jobs; the values
are structured as "hh:mm" (hours, minutes) indicating a time
of day on a 24 hour clock; an empty value means midnight; two
identical values mean the connection is always eligible

Day-of-week window If set to yes, this connection is eligible to receive jobs only during
certain days of the week (specified in the subordinate properties)

Allow from

Allow to

The days of the week (Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday, Sunday) during which to receive jobs; two
identical values mean the connection is eligible for that 1 single
day

Day-of-month window If set to yes, this connection is eligible to receive jobs only
during a certain day of the month (specified in the subordinate
properties)
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Property Description

Day The day in the month during which to receive jobs, as a number in
the range [1 .. 31]; the default value of one means the first or the
last day of the month (depending on the following property)

Relative to Determines whether the day of the month is relative to "Start of
month'" or "End of the month"

Space jobs apart If set to yes, jobs moving over this connection are spaced apart
by a minimum period of time (specified in the subordinate
properties); example: after the connection receives a job it
becomes eligible to receive another job only after the specified
period of time has passed

Unit Select the unit for the subsequent property: Seconds, Minutes,
Hours, Days

Delay The spacing delay in the units indicated by the previous property

Scheduling algorithm

The scheduling algorithm is executed whenever a new job arrives, at regular intervals:

1. Determine J, the set of eligible jobs, to include all incoming jobs that have fully arrived and
that have waited for at least the delay specified for the job (if any).

2. If J is empty, there are no jobs to be moved – terminate.
3. Sort the jobs in J on priority (higher priority first) and within the same priority on arrival

stamp (earliest arrival first).
4. For each job in J, in the sorted order, perform these steps:

a. Consider A to be the set of outgoing connections.
b. Determine B as the subset of A containing connections that can accept the job at this

time (that is, the connection is not on hold and none of its constraints are violated).
c. If B is empty, the job can not be moved at this time – skip to next job.
d. Determine C as the subset of B containing all connections with the highest priority that

occurs within B. By definition all connections in C have the same priority and C is non-
empty.

e. Select one of the connections in C according to the selected algorithm (cyclic or
random).

f. Move the job along this connection.

Inject job

Inject job is a a processor (acting as a producer) that injects a job into the flow when triggered by
an incoming job or by various time-based events. The injected job can be selected dynamically
from a repository of jobs, it can be a fixed job, or it can be the incoming job itself.

The properties for each outgoing connection specify what needs to happen for that connection
(independently of other connections). For example, to inject a job from a repository based on the
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metadata of some incoming job while keeping the original job around, setup one connection to
receive the incoming job, and a second connection to receive the job from the repository.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Inject job element are:

• trigger
• timer

Connections

Inject job supports an optional incoming connection and allows any number of outgoing
connections. It offers additional properties on each of its outgoing connections.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Outgoing connection properties

The following properties are provided for each of the outgoing connections in addition to the
basic connection properties

Property Description

Action Specifies the action for the connection:

• Fail: the connection will only be used to move failed jobs

• Inject: the connection will inject jobs

The following subordinate properties are present if Action is set to
Inject.

Trigger Specifies the type of event that triggers injection for this
connection:

• Incoming job: an injection is triggered for each incoming job.

• Time since previous job: an injection is triggered when the
specified period of time passed since the last job arrived.

• Time of day: an injection is triggered at the specified time(s)
during the day.
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Property Description

The following subordinate properties are present if Trigger is set to
Time since previous job.

Unit Selects the unit for the subsequent property: Minutes, Hours,
Days.

Delay The trigger delay in the units indicated by the previous property.

Repeat If set to Yes, a new injection is triggered repeatedly at the
specified interval as long as no jobs arrive; if set to no, an
injection is triggered only once (until a new arrival resets the
timer).

The following subordinate properties are present if Trigger is set to
Time of day.

Time (hh:mm) The time of day when the first injection is triggered. The
specified time value is used only for the first injection after a
flow was activated. The subsequent injections are controlled by
the Repeat unit and Repeat delay properties.

Repeat unit Selects the unit for the subsequent property: Minutes, Hours.

Repeat delay The repeat delay in the units indicated by the previous property;
a value of zero means "do not repeat".

Inject Specifies the scheme for determining the injected job for this
connection:

• Incoming job: inject the incoming job (or a copy, if more than
one connection specify this scheme); if the injection is not
triggered by an incoming job this behaves as if Dummy job
was selected.

• Dummy job: inject an empty file called dummy.txt (generated
by the tool).

• Specific job: inject the job specified in a subordinate property
through its absolute file or folder path.

• Job repository: inject the job specified in a subordinate
property through an absolute folder path (the repository
containing the jobs) and a job name (the name of the job
residing in the repository).

The following subordinate properties are present if Inject is set to
Specific job.

Job path The absolute file or folder path of the job to be injected (if a fixed
file path is selected, the selected file is included in the exported
flow).
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Property Description

Delete after injection If set to Yes or if the condition is true, the original injection
job is deleted after being injected in the outgoing connection.
Otherwise, the original job is unaffected.

The following subordinate properties are present if Inject is set to
Job repository.

Job repository The absolute folder path of the repository containing the jobs.

Job name The file or folder name of the job residing in the repository
(possibly including the filename extension, depending on the
value of the subsequent property).

Extension The filename extension for the job residing in the repository
(without the period); an empty value means that the filename
extension is included in the Job name property (or that there is
no filename extension).

Delete after injection If set to Yes or if the condition is true, the original injection
job is deleted after being injected in the outgoing connection.
Otherwise, the original job is unaffected.

The following subordinate property is present if Inject is set to
anything but NOT Incoming job.

Name job after Specifies how to determine the name of the jobs injected into
this connection:

• Incoming job: use the name of the incoming job; if the
injection is not triggered by an incoming job this behaves as if
"Injection job" was selected.

• Injection job: use the name of the job selected for injection.

• Custom: use a custom job name (optionally specified using
variables and script expressions).

The following subordinate property is present if Name job after is
set to Custom.

Name Specifies a custom name for the job injected into this connection

Note:  Job variables (in text with variables) and objects
(in script expressions) can only be used if the injection
was triggered by an incoming job!

Rename job
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Rename job is a processor that provides various mechanisms for renaming the incoming job
and/or the files inside a job folder.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Rename job element are:

• remove
• add
• replace
• filename
• name
• extension
• prefix
• suffix
• regular expression
• regexp

Connections

Rename job allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

Affect job name for Determines for which jobs the rename actions are applied to the
name of the job (individual file or job folder):

• All jobs

• Individual files only (= files not being part of a job folder!)

• Job folders only

• No jobs

Remember original
name

If set to yes, the original filename of the incoming job is stored in
private data in the internal job ticket for the job so that it can be
restored with a subsequent rename flow element; see Restoring
the original filename on page 146

Only the name of the job is remembered; not the name of any files
inside a job folder

Private data key The first portion of the private data key used to store the original
filename; see Restoring the original filename on page 146
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Property Description

Files inside job folder Determines what to do with files inside a job folder:

• Leave alone

• Rename files

• Rename files and folders

• Flatten hierarchy (discarding folders)

• Flatten hierarchy and rename files

Nested folder levels Specifies the number of nested subfolder levels to act on (zero
means "leave alone"; use a large number to act on all levels)

Resolve collisions Determines how to resolve situations where two files on the same
level end up with the same name (after all other actions specified
in this tool have been performed):

• Add suffix after filename proper (= filename without extension)

• Add suffix after complete filename

• Modify name without changing length

Pattern A pattern for the suffix or replacement string used to resolve
collisions; "count" is replaced by a number with an appropriate
number of digits (that is, a single digit unless there are many files
colliding to the same name)

Action 1 Determines the first rename action taken:

• None

• Add prefix

• Add suffix

• Remove segment

• Keep segment

• Replace

• Search and replace

• Reduce character set

• Remove extension

• Add extension

• Replace extension
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Property Description

Act on Determines which portion of the filename is affected:

• Filename proper (= filename without extension)

• Complete filename (select this if the file has no extension)

Prefix The prefix to add at the start of the filename

Suffix The suffix to add at the end of the filename

Start index The one-based start index of the filename segment to remove/
keep

End index The one-based end index of the filename segment to remove/
keep; zero means until the end of the filename

Search for The search string to be replaced, or a regular expression that
matches the string to be replaced.

Note:  The values specified using the 'Single-line text
with variables' and 'Script expression' editors are
considered regular expressions. As a consequence,
special characters like () [] {}) are considered part of
the regular expression. If you want to search for strings
that contain those brackets, we recommend using the
"Inline value" or "Define a regular expression" editor. For
example, to replace (1) you could enter the inline value
(1) as search string, or define a regular expression: \(1\).
Single-line text with variables and script expression will
find 1 instead of (1) (unless you're using a workaround that
escapes the special characters in variables e.g. through a
script element).

Replace by The replacement string, or a regular expression that can use the
groups captured by the search regexp

Repeat Determines the repeat behavior of the search/replace:

• Once: only the first match is replaced

• Consecutive: repeated as many times as needed to reach the
end of the filename (however the replaced portion is NOT
searched again)

• Recursive: consecutive is repeated until the filename no longer
changes (with a max. of 99 iterations)

Allowed character set Determines the allowed character set:

• Local8bit: the current ANSI code page on Windows (Latin1 on
Western systems); UTF-8 (i.e. anything) on Mac OS X
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Property Description

• Portable ASCII: printable 7-bit ASCII less those characters that
aren't allowed in filenames on some systems

Replacement
character

Determines the replacement for disallowed characters:

• Underscore

• Space

• Remove

New extension The new filename extension

Action 2 … Action 5 The subsequent rename actions taken; these properties have the
same subordinate properties as the first action property

Restoring the original filename

If the "Remember original name" property is set to yes, the tool stores the original name of the
incoming job in the internal job ticket for the job using private data keys as follows:

Private data key Stored value

<key>

<key>.Name

The original filename including extension

<key>.NameProper The original filename without extension

<key>.Extension The original filename extension

For example, if the private data key property is left to its default value, the original filename
without extension can be retrieved later on with the following variable:

[Job.PrivateData:Key="Original.NameProper"]

The "Remember original name" option works even if all rename actions are set to "none"; this
can be useful to capture the job name before it gets changed by some other tool or application.

File type

File type is a processor that sets a filename extension for a file and if applicable its Mac file type
and creator type to a specified type.

Job folders are moved along without change.

See also About Mac file types on page 37 and Switch preferences: Mac file types on page 37.
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Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the File type element are:

• replace
• filename
• name
• extension

Connections

File type allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

File type One of the file types presented by the file type property editor,
except for Folder; see also Specifying file filters on page 246

Sort job

Sort job is a processor that offers various schemes for sorting incoming jobs across its outgoing
connections depending on metadata associated with the jobs.

For each job the tool determines the value of the specified metadata field and compares this
value with the names of the outgoing connections. If a match is found, the job is moved along
that connection. Otherwise the job is moved along the outgoing data error connection, or if there
is no such connection, it is moved to the problem jobs folder.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Sort job element are:

• metadata
• switch
• route

Connections

Sort job supports outgoing traffic light connections of the following types:
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• Success out: the name of each connection is matched with the value of the job's metadata
field; if a match is found, the job is moved along that connection.

• Error out(optional): if no match is found the job is moved along this connection; if there is no
such connection, the job is moved to the problem jobs folder.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Scheme Determines the scheme used to specify a metadata value:

• Direct: use variables or a script expression to calculate a
value

• Location path

• Key/value pair

Value The value to be used for sorting the job

Dataset The name of the metadata dataset to query; Default means the
embedded dataset

Data model The data model used for querying the dataset (one of XMP, JDF,
XML); this must match the data model of the dataset except
that XML can be specified to query JDF

Location path The location path pointing at the value to be used for sorting the
job (for XML this can be an arbitrary XPath expression)

Array location path The location path pointing at the array containing the key/value
pairs

Key name The name of the key field

Key contents The value of the key

Value name The name of the value field

Log job info

Log job info is a processor that issues a message to the Switch execution log containing the
value of the specified metadata field. It is intended mainly for use while testing a flow.
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Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Log job info element are:

• metadata
• debug

Connections

Log job info allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Message text The message to be logged; %1 will be replaced by the
argument value; if %1 is not present it is added at the end of
the string

Message level Determines the message level: Info, Warning or Debug

Scheme Determines the scheme used to specify a metadata value:

• Direct: use variables or a script expression to calculate a
value

• Location path

• Key/value pair

Value The value to be logged

Dataset The name of the metadata dataset to query; Default means the
embedded dataset

Data model The data model used for querying the dataset (one of XMP,
JDF, XML); this must match the data model of the dataset
except that XML can be specified to query JDF

Location path The location path pointing at the value to be logged (for XML
this can be an arbitrary XPath expression)

Array location path The location path pointing at the array containing the key/value
pairs

Key name The name of the key field
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Property Description

Key contents The value of the key

Value name The name of the value field

Sort files in job

Sort files in job is a processor that provides a mechanism for "sorting" the files inside a job
folder, in other words to perform the following two steps:

1. Determine the desired sorting order of the files based on their current filename.
2. Rename the files so that they alphabetically collate in the desired sorting order.

This is useful to prepare the job for tools that process files in alphabetical order, for example
merging pages into a single document.

Sort files in job ignores any nested subfolders and their contents (that is, it works only on the
files immediately inside the job folder). Individual job files are passed along unchanged.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Sort files in job element are:

• remove
• add
• replace
• order
• filename
• name
• extension

Connections

Sort files in job allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element

Sort key 1 Determines the first sort key:

• None
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Property Description

• Number: the Nth distinct group of consecutive digits

• Segment: the segment specified by start index and length

• Search: the segment matching a regular expression

• Extension: the filename extension

Number index The one-based index of the intended digit group; automatic
means "use the smallest number" of all digit groups

Start index The one-based start index of the intended filename segment

Length The length of the intended filename segment; zero means
until the end of the filename, excluding extension

Search pattern A regular expression that matches the intended segment; if
there is no match the sort key is empty

Sort as numbers If set to no, the filename segments specified in the previous
properties are sorted as regular text strings

If set to yes, the segments are first padded with leading
zeroes (to the maximum length in the set) so that they collate
as one would expect for numbers (note that this procedure
works for hexadecimal numbers in addition to regular
decimal numbers)

This property setting is irrelevant in case the filename
segments all have the same length

Sort key 2

Sort key 3

The second and third sort keys; these have the same
subordinate properties as the first sort key

If two or more filenames have identical sort key values, they
are sorted alphabetically

Rename scheme Determines the rename action taken to make files collate:

• Add prefix

• Add prefix and suppress digits: each digit group in the
original filename is replaced by an underscore

• Replace filename (leave extension)

• Replace filename and extension

Prefix pattern A pattern for the prefix; "count" is replaced by a number with
an appropriate number of digits (depending on the number
files)
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XSLT transform

XSLT transform is a processor that performs an XSLT 1.0 transformation on the incoming XML
file and produces the resulting XML, HTML or text file.

Refer to the XSLT 1.0 specification and to widely available literature about XSLT for more
information.

See also External metadata on page 453.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the XSLT transform element are:

• XML
• JDF
• XMP
• HTML
• CSV
• metadata

Connections

XSLT transform allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

XSLT stylesheet The XSLT transform to be applied to the incoming XML file;
this must be a valid XML document representing an XSLT 1.0
style sheet

Output file type The type of the transformed output file: XML, JDF, XMP, HTML,
Text, Log, or CSV

Recycle bin
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Recycle bin is a consumer that deletes incoming jobs either immediately or depending on the
jobs size, age etc...

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Recycle bin element are:

• trash can
• remove
• delete

Connections

Recycle bin does not allow outgoing connections.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Path The path of the Recycle bin's backing folder on disk, or "auto-
managed". For more information on "user-managed" versus
"auto-managed" folders, refer to Folder on page 95.

Keep N jobs If set to zero, jobs are deleted immediately when they arrive in the
Recycle bin (unless another Keep ... jobs property applies).

If non-zero, the Recycle bin only deletes the jobs when the total
number of jobs in the Recycle bin exceeds the given limit (N);
the oldest jobs are then deleted until the number of jobs in the
Recycle bin is once again under the limit.

Note:  The different "Keep...jobs" properties of the
Recycle bin tool are independent; jobs are deleted as
soon as they exceed the limit of any of the "Keep ... jobs"
properties.

Keep N MB jobs If set to zero, jobs are deleted immediately when they arrive in the
Recycle bin (unless another Keep ... jobs property applies).

If non-zero, the Recycle bin only deletes the jobs when the total
size of all jobs in the Recycle bin exceeds the given limit (N); the
oldest jobs are then deleted until the total size of the jobs in the
Recycle bin is once again under the limit.

Note:  The different "Keep...jobs" properties of the
Recycle bin tool are independent; jobs are deleted as
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Property Description

soon as they exceed the limit of any of the "Keep ... jobs"
properties.

Keep jobs for N
(hours)

If set to zero, jobs are deleted immediately when they arrive in the
Recycle bin (unless another Keep ... jobs property applies).

If non-zero, the Recycle bin only deletes the job after a specific
number (N) of hours; any job that is older than the limit is
permanently removed from the Recycle bin.

Note:  The different "Keep...jobs" properties of the
Recycle bin tool are independent; jobs are deleted as
soon as they exceed the limit of any of the "Keep ... jobs"
properties.

Move to system
recycle bin

If set to No (default), jobs moved to the Recycle bin are deleted
permanently.

If set to Yes, jobs deleted by the Recycle bin tool are not
permanently deleted but instead moved to the system Recycle bin,
so they can be recovered if they were deleted by accident. Note
that you need to empty the bin regularly, otherwise you'll run out
of disk space.

Strip unique name Only available if Move to system recycle bin is set to Yes.

If set to Yes, the unique name prefix added to the filename by
Switch is removed before moving the job to the system Recycle
bin.

5.1.2.3.  Scripting

Script element

Script is a flow element that executes a script program specified by the user to process, produce
or consume jobs.

A script flow element can be a processor, producer or consumer depending on the
specifications in the attached script declaration. In addition, the script declaration may
inject extra properties into the script element and into its outgoing connections. These extra
properties serve as arguments to the script program.

For more information on scripting in Switch, refer to the Scripting documentation on the Enfocus
website.
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Keywords

Keywords can be used with the search function above the Flow elements pane.

The keywords for the Script element are:

• package
• program
• custom
• plug-in
• plugin
• visual basic
• javascript

Script package

A script package is an archive file (with filename extension "sscript") that contains all
information about a script. It includes a script declaration, a script program, and possibly an
icon to be displayed in the Switch flow designer instead of the standard script element icon. A
script package can be exchanged between users as a single entity.

To assign a new script package (created with SwitchScripter or received from a third-party) to
a script element, right-click on the script element in the canvas and select the "Choose script
package" menu item, or edit the "Script package" property in the properties editor.

To edit the script package selected in a script element, right-click on the script element in the
canvas and select the "Edit script package" menu item. The script package will be opened in
SwitchScripter for viewing or editing.

Connections

The type and maximum number of outgoing connections for a script element are determined by
the script declaration attached to the script element. Furthermore, the script declaration may
cause the script element to inject extra properties into its outgoing connections.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Enable debug mode This property is only available if the script package includes a
Node.js.script. For more information, refer to the Scripting Guide
available on our website.

If set to Yes, it is possible to debug the included Node.js script
using Chrome or Visual Studio Code editor.

Note:  The script execution mode is set to ‘Serialized’
automatically, once the debug mode is enabled.
This prevents the flow element instance that uses
the script from executing entry points concurrently.
The debugging can be enabled for only one Node.js
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Property Description

script at a time. The flow designer must ensure that
different Script elements do not execute the entry
points concurrently.

Port This property is only available if Enable debug mode is set to Yes.

Defines the port number a debugger can use to connect to a
Node.js process. The default port is 9229.

Debug entry points This property is only available if Enable debug mode is set to Yes.

Defines the list of script entry points to debug. The default value
is jobArrived.

Script package The Switch script package to be attached to this script element

<Injected> The script declaration may define extra properties to be
injected into the script element as arguments for the script
program

5.1.2.4.  Communication

HTTP request

HTTP request is a processor that for each incoming job executes an HTTP or HTTPS request.
Thus the incoming job is a request trigger and it can be used to define the request specification:
URL, authentication data, request parameters, file to upload, etc. The protocol type (HTTP or
HTTPS) is automatically detected from the URL: if the URL starts with “https://”, HTTPS is used,
otherwise HTTP is used.

The server responds to the request by sending something back: an HTML source, JSON or
XML data, or a file that is downloaded. The tool provides properties to manipulate this server
response. The server response is always saved as a file and the tool can inject this file into the
flow as a new job, attach it as metadata dataset to the incoming job or assemble it into a job
folder together with the incoming job.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow Elements
pane, the HTTP request element will be shown in the list:

• HTTP
• HTTPS
• POST
• PUT
• GET
• HEAD
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• DELETE
• download
• upload
• request

Connections

HTTP request supports outgoing traffic light connections:

• The 'Data' connections transfer the server response file as well as the input job (depending
on the property values specified for the flow element).

• The 'Log' connections transfer a generated text log file containing the request URL, the
finished status, the status code, the status description, the last error and other relevant
information. The log file name is generated from the input job file name by replacing the
input job extension with 'log'.

• The 'Success out' connections are used in case the request finished status is ‘Ok’ and the
HTTP request status code is in the range 100-299.

• The 'Error out' connections are used in case the request finished status is not ‘Ok’ or the
HTTP request status code is in the range 300-599. The input job may fail in case of some
internal tool error or invalid tool settings.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

URL The URL to fetch. The URL string must be URI-encoded (in
a URI-encoded string a space is shown as %20).

The tool detects the protocol to use for the request
automatically from the URL: if the URL starts with
'https://', the tool will use HTTPS, otherwise HTTP will be
used.

Example 1 (entered using the ‘Single-line text with
variables’ editor); assumes the job name can contain only
ASCII alphabetic characters and digits:

https://api-content.dropbox.com/1/files_put/auto/
[Job.Name]

Example 2 (entered using the 'Script expression' editor):

HTTP.encodeURI( "https://api-content.dropbox.com/1/
files_put/auto/" + job.getName() );

Request type The type of the request.

The supported request types are:

• PUT (used for uploading data)
• GET (used for downloading data)
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Property Description

• HEAD (used for retrieving response headers)
• POST (used for uploading with extra parameters)
• DELETE (used for removing resources on external

services)

Note:  The value for the "Content-Type" header in
the request is generated automatically depending
on the request type and other settings like MIME
encoding and defined parameters. In the HTTP
request tool, it is not possible to define the
custom header value. However in some cases it
is possible by writing a script that uses the HTTP
class from the Switch scripting API. More details
about the automatically generated value for the
"Content-Type" header and the ways to specify
a custom value for it, can be found in Switch
scripting reference.

Attached file This property is available only if Request type is POST or
PUT.

A file to append to request if the POST or PUT requests are
used. The file will be uploaded to the server.

Use MIME encoding This property is available only if Request type is POST.

To use MIME encoding, choose Yes; otherwise choose No
(default).

File variable This property is available only if Request type is POST and
Use MIME encoding is Yes.

The name of the HTTP form data variable that is used by
the receiving HTTP server to identify the correct file part
of the uploaded MIME package.

Authentication scheme The authentication scheme to use when server
authorization is required.

If the property is set to None (default), no authentication is
performed.

If this property is set to Basic, the User name and
Password properties must be set, and in this case the
element will attempt basic authentication.

If the authentication scheme is set to Digest, NTLM or
Negotiate, digest, NTLM or Negotiate authentication will be
attempted instead.

If the authentication scheme is set to Proprietary, the
authorization token must be supplied through the
Authorization property.

158



Switch

Property Description

If the authentication scheme is set to OAuth, the
authorization string must be supplied through
Authorization property.

User name This property is available only if Authentication scheme is
Basic, Digest, NTLM or Negotiate.

A user name if authentication is to be used.

Password This property is available only if Authentication scheme is
Basic, Digest, NTLM or Negotiate.

A password if authentication is to be used.

Authorization This property is available only if Authentication scheme is
Proprietary or OAuth.

The authorization string to be sent to the server.

Parameters The parameters to attach to the request. Each parameter
should be specified in a separate line by the string
'key=value' (without quotes).

The parameters are URI-encoded automatically. For the
POST and PUT requests, the parameters are included in
the HTTP request after the HTTP headers. For the HEAD
and GET requests, the parameters are appended to the
URL after the question mark ('?').

Example:

root=auto

path=[Job.JobState]

Headers The headers to attach to the request. Each header should
be specified on a separate line by the string key:value.

Example: Content-Type : text/plain

Response The response received from the server is always saved to
a file. This property defines how to handle this file:

• Inject as new job: the response is sent to the output data
connections as a new job.

• Attach as dataset: the response is attached to the input
job as an opaque dataset with the name specified
in the 'Dataset name' property ('HTTPResponse' by
default) and then the input job is sent to the output data
connections.

• Assemble in jobfolder: the response is assembled into
a new jobfolder together with the input job and the
jobfolder is sent to the output data connections. The
jobfolder name is the same as the name of the input
job (without the extension).
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Property Description

• Discard: the response is discarded. In this case the
input job is sent to the output data connections.

Dataset name This property is a subordinate property of Response if it is
set to Attach as dataset; it allows to specify a custom name
for the dataset.

File Name This property is available only if Response is Inject as new
job or Assemble in jobfolder.

The file name (with an extension) to use for the response
file.

Automatic: The tool will attempt to determine the file
name from the Content-Disposition header of the server
response. If the Content-Disposition header is missing
or does not contain a valid file name, the tool will use the
default file name "Response".

Input job This property is available only if Response is Inject as new
job.

Defines what to do with the input job in case the response
file is injected as a new job:

• Send to output: the input job is sent to the output data
connections as a separate job. In other words, the input
job and the response file are now two separate jobs.

• Attach as dataset: if the input job is a file, it is attached
as an opaque dataset with the name specified in the
'Dataset name' property ('HTTPInput' by default) to the
new job representing the response file. If the input job
is a folder then it is discarded and an error message is
logged.

Note:  If "Attach as dataset" is chosen, you'll
get an extra subordinate property (Dataset
name) allowing you to specify a custom name
for the dataset.

• Discard: the input job is discarded.

Response headers This property defines how to handle the response headers:

• Attach as dataset: the response headers are saved to
a text file (each header on a separate line in format
'key:value') and the file is attached to the output job
as an opaque dataset with the name specified in the
'Dataset name' property ('HTTPResponseHeaders' by
default).

• Discard: the response headers are discarded.
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Dataset name This property is a subordinate property of Response
headers if it is set to Attach as dataset; it allows to specify a
custom name for the dataset.

Webhook

Webhook is a producer that subscribes to specific incoming HTTP requests and injects the
received request content as a new job in the flow. The job file name is 'playload' and the file
extension is automatically generated from the 'Content-Type' header.

You can add this tool to your flow to accept notifications via HTTP/HTTPS protocol. The sender of
the notifications needs to know the URL that has the following format:

<protocol type>://SwitchServerAddress:<port>/<path>

Example: https://switchserver:8081/test/notify

The protocol and the port must be properly configured in the Webhooks category of the Switch
preferences.

Note:  With this flow element, periodic calls to third-party systems or services (such
as an MIS or CRM system) to check for changes are no longer needed. Instead, these
systems will now call Switch the moment something has changed (for example, a new
order that has been entered), and this will trigger Switch to do something (for example,
to create a new job based on this new order).

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow Elements
pane, the Webhook element will be shown in the list:

• Webhook
• HTTP
• HTTPS
• POST
• PUT
• DELETE
• URL
• request

Connections

Webhook does not support any incoming connections.

Webhook requires one outgoing connection.
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Property Description

Protocol type Defines the protocol.

Options are:

• Any (default)
• HTTP
• HTTPS

Request method Defines the request method.

Options are:

• Any (default)
• POST
• PUT
• DELETE

Path Defines the URL path.

This a mandatory field.

Example: 'test/notify'

Request metadata Defines how to handle the request metadata like
arguments, path, headers.

Options are:

• Discard: The request metadata is discarded.

• Inject: The request metadata will be injected as a new
job that is the file in JSON/XML format.

• Attach as dataset: The request metadata will be
attached as dataset with the name specified in the
Dataset name property ('Webhook' by default) to the
outgoing job.

Format This option is only available if Request metadata is set to
Inject.

Defines metadata file format: JSON(default) or XML

Make job folder This option is only available if Request metadata is set to
Inject.

• If set to Yes, a job folder is injected
• If set to No, the files are injected as separate jobs

Model This option is only available if Request metadata is set to
Attach as dataset.
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This option defines the dataset model: XML or Opaque
(default). If Opaque is selected, the dataset file will be in
JSON format.

Dataset name This option is only available if Request metadata is set to
Attach as dataset.

This option allows you to specify the name of the dataset.

Note:  This tool does not perform any HTTP authentication.

FTP receive

FTP receive is a producer that downloads jobs from an FTP site and injects them into the flow.
The syntax is similar to the syntax of a Submit hierarchy.

If your system environment requires FTP connections to pass through a proxy server, you need
to set up the FTP proxy preferences to provide Switch with the configuration details of the proxy
server. See Switch preferences: FTP proxy on page 35.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the FTP receive element will be shown in the list:

• Internet
• web
• FTP
• FTPS
• SFTP
• network
• communication
• transfer
• input
• download

Connections

FTP receive does not allow incoming connections.

FTP receive injects folder filter properties into its outgoing connections so that it is possible to
include/exclude certain subfolders in the incoming job folders for particular connections. Also
see the "skip folders" property described below.
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Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element

Server type Select FTP or SFTP or FTPS.

• If you select FTP, you have to set the subordinate
property Passive mode (see further).

• If you select SFTP, you have to choose the preferred
Authentication method (see further).

• If you select FTPS, you have to set two subordinate
properties (Passive mode and Ignore server certificate
errors) (see further).

Passive mode Only available if server type = FTP or FTPS

If set to Yes, FTP receive uses passive mode to
communicate with the FTP(S) server; otherwise it uses
active mode.

Ignore server certificate errors Only available if server type = FTPS

If set to Yes, the server certificate errors will be ignored
when connecting to the FTPS server. Examples of
certificate errors:

• Self-signed certificate
• Invalid host name
• Expired certificate

Authentication method Only available if server type = SFTP

You have two options:

• Password: Switch logs on to the server with the user
name and password filled in below.

• Public key: Switch logs on to the server using key pairs
(public key + private key) which can be generated with
the PuTTY Key Generator.

The public key is the key used on the server, which
must be configured to use public key configuration.

The private key is the key used by Switch. You must set
the following subordinate properties:

• Certificate store type: Format in which the key was
saved.
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Note:  If you want to use a PGP file (that
is a PuTTY key file) as the key file for the
SFTP server, you first need to convert it into
a PEM file (=file type that is supported by
the FTP tools in Switch). To perform the
conversion, you can use the PuTTY Key
Generator: open the PuTTY key file in the
utility and then export it, using the main
menu item Conversions >  Export OpenSSH
key.

• Certificate store path: Full path to the certificate
file, which contains the private key.

• Certificate store password: Password used to save
and encode the generated keys. If no password was
used, this field should remain empty.

Note:  Alternatively, you can set the authentication
method when selecting the FTP directory (See the

FTP directory property: click  and Choose FTP
directory).

User name The login name for the FTP server. For anonymous login,
use "anonymous" as user name.

Note:  If you're using the FTP proxy protocol,
append an @ sign and the target FTP site address
(domain or IP address) to the regular user name
(<ftpserverusername>@<ftpserveraddress>).

Password The password for the FTP server. For anonymous use,
enter an e-mail address as password.

This property is not available if you have chosen for Public
key as authentication method for the SFTP server.

FTP server address The URL or IP address of the FTP server from which jobs
are to be retrieved.

Note:  If you're using the FTP proxy protocol, this
should be the URL or IP address of the proxy
server.

Port The port used by the FTP server.

Default values:

• FTP and FTPS: 21
• SFTP: 22
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Note:  If port 990 is specified for the FTPS server,
the implicit FTPS mode is enabled. Using any other
port for the FTPS server enables explicit FTPS
mode (the STARTTLS command will be sent to
the server to set up the secure communication
channel).

FTP directory The directory on the FTP(S)/SFTP site from which jobs are
to be retrieved.

If the path starts with a forward slash "/", it is relative to
the user's home directory. If the path starts with a double
forward slash, it is relative to the FTP site's system root.
This is only useful if the user has access to the complete
file system on the FTP site.

Leave originals on server If set to Yes, incoming jobs are left untouched on the FTP
site; Switch never writes to the site so read-only access
rights suffice. For more details, refer to Leaving originals in
place on page 234.

If set to No (default), incoming jobs are removed from
the FTP site; Switch needs full access rights to rename,
create and remove files and folders on the FTP site.

Ignore updates The Ignore updates option is available only if Leave originals
on server is set to Yes.

If set to Yes, a job will only be processed once, regardless
of any changes to the file size or modification date. This
can be used for workflows where the input job is replaced
by the processing result, to avoid triggering endless loops.

If set to No, the job will be reprocessed when its file size
or modification date is different. This allows processing
jobs which have the same file name as previously
submitted jobs.

Minimum file size (KB) Used to set the minimum file size (in KB) limit before
Switch picks up the files or folders. To set no limits, leave
it empty.

Check every (minutes) The frequency of checking the FTP directory for new jobs.

Time-of-day window If set to Yes, the tool checks for new arrivals only during
a certain time of the day (specified in the subordinate
properties).

Allow from (hh:mm)

Allow to (hh:mm)

The time-of-day window during which to check for new
arrivals; the values are structured as "hh:mm" (hours,
minutes) indicating a time of day on a 24 hour clock; an
empty value means midnight; two identical values mean
that the tool always detects jobs.
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Day-of-week window If set to Yes, the tool checks for new arrivals only during
certain days of the week (specified in the subordinate
properties).

Allow from

Allow to

The days of the week (Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday, Sunday) during which to check
for new arrivals; two identical values mean that the tool
only checks for new arrivals on that specific day.

Day-of-month window If set to Yes, the tool checks for new arrivals only during
a certain day of the month (specified in the subordinate
properties).

Day The day in the month during which to check for new
arrivals, as a number in the range [1 . . 31]; the default
value of one means the first or the last day of the month
(depending on the following property).

Relative to Determines whether the day of the month is relative to
Start of month or End of the month.

Subfolder levels The number of nested subfolder levels considered to
be hot folders (as opposed to job folders); see also the
description on subfolders earlier.

Process these folders Defines the initial set of folders that should be processed.
This set can be adjusted by defining rules in the
subsequent properties.

Adjusted by (rule 1) .....(rule 5) This property defines a rule for adjusting the set of
folders to be processed, by including or excluding folders
matching or not matching a folder name. Different rules
can be applied and will be processed in the order as they
are specified.

Additional properties for this rule are:

• The Folder name used for matching.

• The Levels, limiting the range of subfolder levels on
which the rule applies.

• A Restriction, based on the folder name of the
parent or ancestors for the folder. If folder Y contains
subfolder X; Y is X's parent folder. If folder Z contains
subfolder Y; Z is one of X's ancestors. The folder that
contains folder Z is also one of X's ancestors, and so
on.

• Nesting, defining whether this rule operates on
subfolders of the target folder, which are deeper in the
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hierarchy than the defined level range. The matching
rule is also applied on these subfolders.

Options:

• Exclude/Include nested subfolders as well

• Don't exclude/include nested subfolders

Attach hierarchy info If set to Yes, (part of) a job's submit location is added to its
hierarchy location path as it is submitted in the flow; see
Using hierarchy info on page 237 for more details.

Include FTP name Only available if Attach hierarchy info is enabled.

If set to Yes, the name of the flow element is included at
the top of the remembered location path.

Include subfolder levels Identifies the number of hierarchy segments in the
hierarchy information.

Save top subfolders If set to Yes, the top-most subfolders are remembered in
the location path, otherwise the bottom-most subfolders
are remembered.

Attach email info E-mail addresses and body text specified with the editor
for this property are added to each job's e-mail info as
the job is injected in the flow; the information added can
vary depending on the subfolder in which the job was
located; see Using email info in Switch on page 238 for
more details.

Allow subfolder cleanup If set to Yes, empty subfolders in the hot folder will
be removed starting from the level defined in the next
property (Starting at level).

Note:  This option is useful if Process these
folders is set to No Folders (see higher), because
in that case only files are taken from the FTP,
while (empty) folders are left.

Starting at level The folder level (inside of the hot folder) where the folder
cleanup should start:

• Level 1 deletes all empty subfolders in the hot folder
• Level 2 deletes all empty subfolders of subfolders of

the hot folder
• etc.

In the example below, empty subfolders in the hot folder
(= Input (level2) ) will be removed.
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FTP send

FTP send is a processor (although conceptually it is a consumer) that uploads any incoming jobs
to an FTP site.

If your system environment requires FTP connections to pass through a proxy server, you need
to set up the FTP proxy preferences to provide Switch with the configuration details of the proxy
server. See Switch preferences: FTP proxy on page 35.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the FTP send element will be shown in the list:

• Internet
• web
• FTP
• FTPS
• SFTP
• network
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• communication
• transfer
• output
• upload

Connections

FTP send supports optional outgoing connections to provide in-flow feedback about the
operation and to keep the job around without extra copying. This allows multiple send
operations to be chained in an intelligent manner; for example:

• Successively upload the same job to multiple FTP sites.
• Provide a fallback operation when an upload fails (for example, upload to a secondary site).
• Send an email with the URL of a job that was successfully uploaded to an FTP site.

FTP send supports traffic light connections of the following types (other types are not allowed):

• Data error: carries the incoming job if the operation fails at the first attempt; if there are
no data error connections the tool keeps retrying the operation as specified in the user
preferences.

• Data success: carries the incoming job after the operation succeeds; if there are no data
success connections the output is simply suppressed (without logging a warning or error).

• Log success: carries a small log file in XML format after the operation succeeds; if there are
no log success connections the output is simply suppressed. The log file contains relevant
information about the operation such as destination, time sent, transfer time, list of files, etc.
See Processing results schema on page 459.

• Data with log success: carries both the job and the log file (as metadata), allowing access to
the results of the operation through variables or scripting.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Server type Select FTP or SFTP or FTPS.

• If you select FTP, you have to set the subordinate property
Passive mode (see further).

• If you select SFTP, you have to choose the preferred
Authentication method (see further).

• If you select FTPS, you have to set two subordinate
properties (Passive mode and Ignore server certificate errors)
(see further).

Authentication method Only available if server type = SFTP

You have two options:

• Password: Switch logs on to the server with the user name
and password filled in below.
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• Public key: Switch logs on to the server using key pairs
(public key + private key) which can be generated with the
PuTTY Key Generator.

The public key is the key used on the server, which must be
configured to use public key configuration.

The private key is the key used by Switch. You must set the
following subordinate properties:

• Certificate store type: Format in which the key was
saved.

Note:  If you want to use a PGP file (that is a
PuTTY key file) as the key file for the SFTP
server, you first need to convert it into a PEM
file (=file type that is supported by the FTP tools
in Switch). To perform the conversion, you can
use the PuTTY Key Generator: open the PuTTY
key file in the utility and then export it, using
the main menu item Conversions >  Export
OpenSSH key.

• Certificate store path: Full path to the certificate file,
which contains the private key.

• Certificate store password: Password used to save and
encode the generated keys. If no password was used, this
field should remain empty.

Note:  Alternatively, you can set the authentication
method when selecting the FTP directory (See the

FTP directory property: click  and Choose FTP
directory).

Passive mode Only available if server type = FTP or FTPS

If set to Yes, FTP receive uses passive mode to communicate
with the FTP server; otherwise it uses active mode.

In case of passive mode, the client initiates the data transfer
connections to the FTP server. This is the preferred mode if the
client is protected by a firewall.

Ignore server certificate
errors

Only available if server type = FTPS

If set to Yes, the server certificate errors will be ignored when
connecting to the FTPS server. Examples of certificate errors:

• Self-signed certificate
• Invalid host name
• Expired certificate
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User name The login name for the FTP server. For anonymous login, use
"anonymous" as user name.

Note:  If you're using the FTP proxy protocol,
append an @ sign and the target FTP site address
(domain or IP address) to the regular user name
(<ftpserverusername>@<ftpserveraddress>).

Password The password for the FTP server. For anonymous use, enter an
email address as password.

This property is not available if you have chosen for Public key
as authentication method for the SFTP server.

FTP server address The URL or IP address of the FTP server to which the jobs are
to be delivered.

Note:  If you're using the FTP proxy protocol, this
should be URL or IP address of the proxy server.

Port The port used by the FTP server.

Default values:

• FTP and FTPS: 21
• SFTP: 22

Note:  If port 990 is specified for the FTPS server, the
implicit FTPS mode is enabled. Using any other port
for the FTPS server enables explicit FTPS mode (the
STARTTLS command will be sent to the server to set
up the secure communication channel).

FTP directory The directory on the FTP site to which jobs are to be delivered.

If the path starts with a forward slash "/", it is relative to the
user's home directory. If the path starts with a double forward
slash, it is relative to the FTP site's system root. This is only
useful if the user has access to the complete file system on the
FTP site.

Subfolder levels The number of nested subfolder levels in the uploaded folder
hierarchy (similar to the behavior of the Archive hierarchy tool).

When this property is set to zero (default value) all jobs are
placed immediately inside the FTP directory specified in the
previous property.

Strip unique name If set to Yes, the unique name prefix added to the filename by
Switch is removed before placing the job in the FTP hierarchy;
the default is to strip the prefixes from jobs deposited in a FTP
hierarchy - leaving the prefixes in place avoids overwriting a
previously deposited job with the same name.

172



Switch

Property Description

Duplicates Determines what happens when Strip unique name is set to
Yes and a job arrives with the same name and location as a job
already residing on the FTP site:

• Overwrite: replace the existing job with the new one – this is
the default behavior.

• Keep unique name: preserve the new job's unique name
prefix, leaving the existing job untouched (without unique
name prefix).

• Add version number: add an incrementing version number
at the end of the filename body for the new job ("2", "3",
… "9", "10", "11"), leaving the existing job untouched. For
example, "job.pdf" will become "job1.pdf"," job2.pdf", ...

Optionally, you can add a separator between the filename
body and the version number, for example an underscore. In
that case, e.g. "job.pdf" will become "job_1.pdf"," job_2.pdf", ...
By default, the Separator property is empty.

You can also determine the width of the version number,
i.e. the number of digits used for the version number. For
example, if Width is set to "5", the version number will
consist out of 5 digits (e.g. job_00001.pdf), meaning that
leading zeros will be added as required.

• Fail: move the new job to the problem jobs folder, leaving
the existing job untouched.

• Discard: remove the new job, leaving the existing job
untouched

Mail receive

Mail receive is a producer that retrieves email messages from a POP3 and IMAP email
server (so that users can access email accounts like Gmail, Hotmail etc) and injects any file
attachments into the flow. Please note that Switch only accepts MIME encoded attachments.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow Elements
pane, the Mail receive element will be shown in the list:

• Internet
• web
• email
• e-mail
• POP3
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• IMAP
• network
• communication
• transfer
• input

Connections

Mail receive does not allow incoming connections.

Mail receive allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

Server type The type of server from which to retrieve mail. Choices are
POP3 and IMAP4.

Server address The URL or IP address of the server from which to retrieve
mail.

Tip:  You can find the POP3 or IMAP settings of your
mail provider (e.g. gmail) on the internet.

Port Editors in this property are numbers and it is empty by
default.

Accounts A list of accounts (names and corresponding passwords)
from which to retrieve mail.

Note:  POP3/IMAP must be enabled on your mail
account and some providers (e.g. gmail) require
that you enable "Allow less secure apps". For more
information, refer to the documentation of your mail
provider or search for an answer to your question in
our known issues and solutions database.

Use secure password
verification

Defines whether to log in to the mail server using secure
password verification.

If set to Yes, the Authentication method (used to establish
the connection to the mail server) should be specified. The
following secure authentication methods are supported:

• Automatic (The element will try the different methods one
by one until the connection can be established)

• SASL Plain
• NTLM
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• SASL DIGEST-MD5
• CRAM-MD5
• APOP

Note:  APOP can only be used with a POP3 mail
server.

Server requires secure
connection

Defines whether the mail server requires a secure
connection using the TLS protocol.

Leave originals on server If set to Yes, incoming messages are left untouched on the
server.

If set to No (default value), incoming messages are removed
from the server.

For more detailas, refer to Leaving originals in place on page
234.

Check every (minutes) The frequency of checking the email accounts for new
messages.

Time-of-day window If set to Yes, the tool checks for new arrivals only during
a certain time of the day (specified in the subordinate
properties).

Allow from (hh:mm)

Allow to (hh:mm)

The time-of-day window during which to check for new
arrivals; the values are structured as "hh:mm" (hours,
minutes) indicating a time of day on a 24 hour clock; an
empty value means midnight; two identical values mean the
tool always checks for new arrivals.

Day-of-week window If set to Yes, the tool checks for new arrivals only during
certain days of the week (specified in the subordinate
properties).

Allow from

Allow to

The days of the week (Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday, Sunday) during which to check
for new arrivals; two identical values mean the tool only
checks for new arrivals on that specific day.

Day-of-month window If set to Yes, the tool checks for new arrivals only during
a certain day of the month (specified in the subordinate
properties).

Day The day in the month during which to check for new arrivals,
as a number in the range [1 . . 31]; the default value of one
means the first or the last day of the month (depending on
the following property).

Relative to Determines whether the day of the month is relative to Start
of month' or End of the month.
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Attach hierarchy info If set to Yes, information about a file's origin (derived from
the email message as specified by the next property, see
below) is added to its internal job ticket as a location path;
see Using hierarchy info on page 237 for more details.

Base info on Defines how to derive the attached location path from the
email message; the path can be based on the contents of one
of the following: "Sender's email address", "Email account
name", or "Message subject".

Attach email info If set to Yes, the sender's address of the incoming email
message is added to the email information in the file's
internal job ticket ([Job.EmailAddress]); body text from the
incoming message is never copied into the email info; see
Using email info in Switch on page 238 for more details.

Attach extra email info If set to Yes, additional email info is added to the internal job
ticket as specified by the next two properties (see below); the
information added can vary depending on properties of the
incoming email message (see below); see Using email info in
Switch on page 238 for more details.

Base map key on Defines the "key" that is used to select the appropriate email
info from the table provided in the next property; the key can
be contents of: "Sender's email address", "Email account
name", or "Message subject".

Email info map Email addresses and body text specified with the editor for
this property are added to each file's email info as the file
is injected in the flow; the value of the key specified in the
previous property (for example, the sender's address of the
incoming email message) determines which entry of the
table is actually added.

Scan for nested
attachments

When set to Yes, user can scan all nested email until no
emails but real assets are found. The default value is No.

Nested attachments are files included in .eml files (i.e. saved
mail files) attached to the incoming mail.

Collect attachments Set to Yes to collect all attachments in a folder. Single file
attachments will also be stored in a job folder. The default
value is No.

Assemble message and
attachments

This is a sub property of Collect attachments and is available
only when the parent is set to Yes. Set to Yes to assemble
the injected message and the attachment(s) in the same job
folder. If there is no message to inject, this property will not
affect attachment handling. The default value is No.

Inject message as file Determines whether the email message itself (as opposed
to its attachments) is injected into the flow as a separate file.
Choices are:
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• No: Only attachments are injected in the flow.

• If no attachments: The mail message is injected as a
separate file only if it has no attachments.

• Always: The mail message is always injected as a
separate file.

The message will be saved as HTML or TXT with UTF8
encoding, depending on the value of the Convert HTML to
plain text property. The file will be named after the subject
line of the email message. If there is no subject line, the file
will be named 'No subject.txt' or 'No subject.html'.

Convert HTML to plain text If set to Yes, the HTML message body will be converted to
plain text before it is used to generate output data.

If set to No, the message body will remain in HTML format.
The message body can be injected into the flow as a new
job or attached as metadata to the jobs generated by the
incoming email (for example, jobs representing e-mail
attachments).

Example: receiving jobs from a gmail account

Mail receive properties:

Dialog where you should define your email accounts ("Accounts" property):
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Picking up e-mail metadata

The Mail receive tool automatically picks up the contents of incoming email messages as
metadata. This behavior cannot be configured or turned off (that is, there are no flow element
properties related to this behavior). See Picking up metadata on page 453 for more background
information.

For each incoming message the Mail receive tool creates a metadata dataset that contains the
relevant components of the message, such as the sender, to, cc, and reply-to addresses and the
complete email body text. This dataset is then associated with the job ticket for all files delivered
by the message under the standard dataset name "Email".

Refer to Email message schema on page 458 for details on the format of the generated
metadata.

Mail send

Mail send is a processor (although conceptually it is a consumer) that sends an e-mail message
to an SMTP e-mail relay server for each incoming job.

Some properties for this tool (such as the SMTP server details) must be set up in the global user
preferences, since these values are the same for all outgoing email. For more information, refer
to Switch preferences: Mail send on page 34.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Mail send element will be shown in the list:

• Internet
• web
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• email
• e-mail
• SMTP
• network
• communication
• transfer
• output

Connections

Mail send supports optional outgoing connections to provide in-flow feedback about the
operation and to keep the job around without extra copying. This allows multiple send
operations to be chained in an intelligent manner; for example:

• Successively mail and FTP the same job.

• Provide a fallback operation when a mail operation fails.

Mail send supports traffic light connections of the following types (other types are not allowed):

• Data error: carries the incoming job if the operation fails at the first attempt; if there are
no data error connections the tool keeps retrying the operation as specified in the user
preferences.

• Data success: carries the incoming job after the operation succeeds; if there are no data
success connections the output is simply suppressed (without logging a warning or error).

• Log success: carries a small log file in XML format after the operation succeeds; if there are
no log success connections the output is simply suppressed. The log file contains relevant
information about the operation such as destination, time sent, transfer time, list of files, etc.
See Processing results schema on page 459.

• Data with log success: carries both the job and the log file (as metadata in a dataset),
allowing access to the results of the operation through variables or scripting.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving your
cursor over the flow element.

Subject The subject line for the message.

To addresses The list of destination email addresses for the message. Email
addresses are separated by a semicolon or by a newline.

Include attached
addresses

If set to Yes, the email addresses from the job's internal job ticket are
added to the To addresses. For more information about attached email
info, refer to Using email info in Switch on page 238.

CC addresses A comma/semicolon/newline separated list of carbon-copy email
addresses for the message.
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Property Description

BCC addresses A comma/semicolon/newline separated list of blind carbon-copy email
addresses for the message.

SMTP server
authentication

Authentication parameters for the SMTP server. Remember that the
SMTP server address must be defined in the Switch preferences (Mail
send category).

If you want to use the email account specified in the Switch preferences
(Mail send category), choose Default.

If you want to use a different email account, make sure to choose
Custom and enter the user name and password linked to this account.

• User name: The login name for the SMTP server, for example:
user@gmail.com. Leave empty if none is required.

• Password: The password for the SMTP server. Leave empty if none is
required.

Sender name The sender's name for outgoing email messages.

If the value is empty or set to Default, the sender name specified in the
Switch preferences (Mail send category) will be used.

If you want to use a different sender name, enter the name of your
choice.

Sender address The sender's email address for outgoing email messages.

If the value is empty or set to Default, the sender address specified in
the Switch preferences (Mail send category) will be used.

If you want to use a different sender address, enter the email address of
your choice.

Reply address The email address(es) to which reply messages will be sent to.

If the value is empty or Default, the sender address specified in the
Sender address field is used (i.e. to the address that was used to send
mails).

Note:  The value of this property is used in the Reply-To SMTP
header that is normally used by email client applications to
send a reply. However, the From field of an email in the client
application does not display this address, instead it shows the
sender address specified in the Sender address field.

Message format The format of the message body, either Plain text or HTML. When set to
HTML, the email message has two bodies. The first is in HTML format
and the second is a plain text version of the HTML message.

Body template The location of the template of the email body.

• If set to Built-in, the text can be set in the Body text property. Using
the Include attached body text option, you can insert the body text
attached to the job as part of its email info, after the body text.
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• If set to Fixed file, a Template file can be set, referring to a plain text
or HTML file containing the template for the message body.

• A plain text body template must be a regular text file (preferred
extension ".txt") using Unicode (UTF-16 with proper BOM or
UTF-8). Other text encodings are not allowed.

• An HTML body template must be a valid HTML file (preferred
extension ".html") using Unicode UTF-8. The HTML file must
contain a tag specifying that it uses UTF-8 encoding. Other text
encodings (including UTF-16) are not allowed.

An HTML body template should not refer to any local resources
(since these will not be transmitted with the mail message). Any
references (including images) should point to public resources on
the worldwide web.

You can use Enfocus Switch variables in a plain text template or
an HTML template. An example with variables you could use in
your own template:

<span>Job size: [Job.ByteCount]</span>
<span>Flow name: [Switch.FlowName]</span>
<span>Current date: [Switch.Date]</span>

For more information on variables, refer to Known variables on
page 426

A sample HTML template is available at: http://www.enfocus.com/
manuals/Extra/Switch/mailtemplate.html.

• If set to Associated with job, the Template dataset (name of the
metadata dataset associated with the job containing a plain text or
HTML template) can be set. For more information about attached
email info, refer to Using email info in Switch on page 238.

Attach files If set to Yes, the incoming file or job folder is compressed (zipped) and
attached to the email message being sent.

Strip unique
name

If set to Yes, the unique name prefix added to the filename by Switch is
removed before emailing the job; the default is to strip the prefixes from
jobs before emailing them

This property affects both the actual attachments and the names of the
jobs listed in the email body.

Submit point

Submit point is a producer that serves to submit jobs into a flow through the Switch Web Portal
by a user with the appropriate access rights. See also Designing flows for use with the Switch Web
Portal on page 346.
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The backing folder for a Submit point is always auto-managed.

Note:  You can only use the Submit point flow element, if you have licensed the
SwitchClient and/or the Switch Web Services module.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Submit point element will be shown in the list:

• Internet
• web
• network
• communication
• transfer
• input
• client
• user
• upload
• metadata
• workstation

Properties

Property Description

Name The name of the flow element displayed in the canvas. By
default it is displayed as "Submit point".

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

Note:  The description entered here is not displayed
on the Web Portal (or client application): if you want a
description to be shown on the Web Portal (or client
application), use the 'Display description' field below.

Display name The name to be displayed on the Switch Web Portal (or
a different client application). If set to Default, the name
entered in the Name field is displayed.

Display description The description to be displayed on the Switch Web Portal
(or a different client application). If this field is empty, the
description will be: "No description available".

Thumbnail The image to be used as thumbnail for this Submit point on
the Switch Web Portal (in the top left corner of the dialog).
Allowed image types are PNG, BMP and JPEG.

Flow stage The stage assigned to the Submit point. This allows you to
check where jobs are in a flow. The flow stage of a job can
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Property Description

be viewed on the job boards on the Switch Portal. Refer to
Working with flow stages on page 101.

Attach hierarchy info If set to Yes, part of a job's submit information (as configured
with the next two properties) is added to its hierarchy location
path as it is injected in the flow; see Using hierarchy info on
page 237 for more details.

Include Submit point name If set to Yes, the name of this flow element is included at the
top of the remembered location path.

Include user name If set to Yes, the name of the user submitting the job is
included in the remembered location path.

Attach user as email info If set to Yes, the submitting user's e-mail address is added
to each job's email info as the job is injected in the flow; see
Using email info in Switch on page 238.

Attach extra email info E-mail addresses and body text specified with the editor
for this property are added to each job's email info as the
job is injected in the flow; the information added can vary
depending on the user submitting the job; see Using email info
in Switch on page 238.

Submit Choices are:

• Job and metadata: The Submit point accepts both job files
and metadata associated with the job. This option triggers
a number of subordinate properties (see further).

• Job only: The Submit point only accepts job files. Metadata
cannot be supplied.

• Metadata only: The Submit point only accepts metadata.
Note that in this case, a dummy job (*.dummy) moves
through the Switch flow. This option triggers a number of
subordinate properties (see further).

• Trigger: The Submit point triggers an action. The Submit
point acts like a button: when a user clicks it, a dummy job
(*.dummy) moves through the Switch flow and (depending
on the flow) this job can start a process, call a database, ...

The following properties are only available if metadata
submission is enabled:

Metadata fields Definitions for the metadata fields to be entered; see Defining
metadata fields on page 461 for more information.

Dataset name A name for the set of metadata entered here; see Picking up
metadata on page 453 for more information.
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Invalidate metadata cache
on user login

Determines whether or not the dynamic metadata cache will
be cleared when a user logs in. This property only applies to
the user cache; the common cache will not be cleared. For
more information, refer to the paragraph on 'Invalidating the
metadata cache' below this table.

Invalidate metadata cache
condition

Determines the condition on which the metadata cache
will be cleared, for example after a certain time. For more
information, refer to the paragraph on 'Invalidating the
metadata cache' below this table.

Requires Switch Helper This property is only available if "Submit" is set to "Job and
metadata" or "Job only".

If set to Yes, extra metadata, such as job origin* and file
creation date** will be attached to the submitted jobs.

This requires Switch Helper, so the users of the Portal or the
client application must have installed Switch Helper. Without
Switch Helper, they will not be able to submit jobs. Note that
Submit points with this option enabled will not accept jobs via
'drag-and-drop'; users will have to upload them by clicking
the Upload file or Upload folder button.

Switch Helper is available on the Enfocus website.

* Without Switch Helper, Switch doesn't know the location
of the submitted job, hence the value of job origin will be the
Submit point's backing folder. If Switch Helper is enabled, the
value of job origin will be the folder on the user's computer.

** Without Switch Helper, the creation date is (incorrectly)
replaced with the modification date.

For more information about job origin and the file creation
date, refer to Job group on page 436.

Picking up client fields as metadata

If a Submit point is configured to accept metadata (Submit set to Job and metadata or Metadata
only), the Submit point:

• Creates a metadata dataset containing the contents of the metadata fields entered by the
user.

• Associates this dataset with the job ticket for the submitted job under the dataset name
specified in the "Dataset name" property.

Refer to Client fields schema on page 466 for details on the format of the generated metadata.

Invalidating the metadata cache

In case of dynamic values, Switch can store the metadata in the user cache ("cache per user") or
in the common cache ("cache for all users"), so the values do not have to be recalculated each
time metadata is requested. For more information, refer to the "Cache dynamic values" property
in the topic on Defining metadata fields on page 461.
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Note that by default, the cache is not cleared unless you explicitly enable "Invalidate metadata
cache on user login" or define a condition for "Invalidate metadata condition".

Checkpoint

Checkpoint is a processor that holds jobs for human intervention. A user with the appropriate
access rights can review jobs in a Checkpoint through the Switch Web Portal and redirect them
along any of the Checkpoint's outgoing connections.

The name shown to the user for each outgoing connection is the name of the connection, or if it
is empty, the name of the target folder.

The backing folder for a Checkpoint is always auto-managed.

See also Designing flows for use with the Switch Web Portal on page 346.

Note:  You can only use the Checkpoint flow element, if you have licensed the
SwitchClient and/or the Switch Web Services module.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Checkpoint element will be shown in the list:

• Internet
• web
• network
• communication
• transfer
• interact
• client
• user
• route
• approve
• metadata

Connections

Checkpoint allows any number of outgoing move connections.

Properties

Property Description

Name The name of the flow element displayed in the canvas. Default
value is "Checkpoint".

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element.
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Property Description

Flow stage The stage assigned to the Checkpoint. This allows you to check
where jobs are in a flow. The flow stage of a job can be viewed
on the job boards on the Switch Portal. Refer to Working with
flow stages on page 101.

Allow multiple outputs If set to Yes, the user can send copies of a job along more than
one outgoing connection; otherwise the job is sent along exactly
one of the outgoing connections.

Enable report viewing If set to Yes, the user gets extra buttons to view or save a report
obtained by retrieving the metadata dataset named in the
property described below.

This feature is most often used with datasets picked up through
a traffic light connection by setting "Carry this type of files" to
"Data with log".

Report dataset name The metadata dataset name for the report to be viewed by the
client.

Allow replacing or
editing job

If set to Yes, an extra button is available allowing the user
to edit and/or replace jobs with a new version (presumably
edited on the client user's computer) before moving it out of
the Checkpoint; the original job is lost, but its metadata is
preserved.

Enter and display
metadata

If set to Yes, you can specify or display optional or required
metadata fields a user needs to review, update or fill in before
allowing the job to go through this Checkpoint.

Metadata fields Specify the metadata fields a user needs to review, update or

fill in. Click this  button to invoke the Define metadata
fields dialog box where you can specify the metadata fields.
For a full description, refer to Defining metadata fields on page
461.

Dataset name The name of the dataset in which the specified metadata fields
will be stored is entered here; see Picking up metadata on page
453 for more information.

Invalidate metadata cache
on user login

Determines whether or not the dynamic metadata cache will be
cleared when a user logs in. This property only applies to the
user cache; the common cache will not be cleared.*

Attach user as email info If set to Yes, the handling user's e-mail address is added to
each job's e-mail info as the job is moved along the flow.

In addition, the Checkpoint updates the "user name" attribute in
the internal job ticket as follows:
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• If this property is set to Yes, the "user name" attribute is
always set to the name of the Checkpoint client user moving
the job along, regardless of its previous value.

• If this property is set to No, the "user name" attribute is set
to the new name only if it was empty to begin with.

Fail jobs after timeout If set to Yes, jobs are failed after residing in the Checkpoint
for a certain period of time (specified in the subordinate
properties).

Failed jobs are moved to the outgoing connection specified in
the subordinate properties or to the problem jobs folder.

Unit Selects the unit for the subsequent property: Minutes, Hours,
Days

Timeout delay The timeout delay in the units indicated by the previous
property (0 means ‘no timeout')

Fail connection The name of the connection to which failed jobs must be moved.

If this property value is empty or if the specified name doesn't
match any of the outgoing connection names, failed jobs are
moved to the problem jobs folder.

Picking up client fields as metadata

The Checkpoint tool picks up metadata fields entered by the user when moving along a job.
Specifically, when a user moves along a job residing in a Checkpoint and the list of editable field
definitions in the Checkpoint's "Metadata fields" property is not empty, the Checkpoint creates a
metadata dataset and associates it with the job's job ticket under the specified dataset name.

Note that a Checkpoint always creates a completely new dataset, i.e. it does not update or
modify an existing dataset (even if the job was previously moved through the same or another
Checkpoint). If the job already has a dataset association with the same name, the reference to
the old dataset is removed and replaced by the new one.

Refer to Client fields schema on page 466 for details on the format of the generated metadata.

* In case of dynamic values, Switch can store the metadata in the user cache ("cache per user")
or in the common cache ("cache for all users"), so the values have not to be recalculated each
time metadata is requested. For more information, refer to the "Cache dynamic values" property
in the topic on Defining metadata fields on page 461.

Note that by default, the cache is not cleared, unless you explicitly enable "Invalidate metadata
cache on user login".

Checkpoint via mail
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Checkpoint via mail is a processor that allows implementing a simple Checkpoint via e-mail,
performing the following main functions:

• For each arriving job, send out an e-mail message that includes the unique name prefix of
the job and a list of possible "Checkpoint actions" (the names of the outgoing connections, or,
if no name is specified, the name of the target folders) – in addition to instructions on how to
operate the Checkpoint by return e-mail.

• Monitor e-mail messages coming back from users and parse those messages for the original
information about the job and for the Checkpoint action selected by the sender.

• When a matching response comes in, move the corresponding job along the specified
outgoing connection or (if no name is specified for the connection) to the specified target
folder.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Checkpoint via mail element will be shown in the list:

• Internet
• web
• email
• e-mail
• network
• communication
• transfer
• interaction
• client
• user

Connections

Checkpoint allows any number of outgoing move connections. Each connection defines a
"Checkpoint action".

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

Subject The subject line for the message that will be sent as soon
as a job arrives in the folder just before the Checkpoint via
email tool in the flow.

To addresses The list of destination e-mail addresses for the message.
E-mail addresses are separated by a semicolon or by a
newline.
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The to address typically contains the email address of the
customer who has to take a decision (e.g. accept or refuse
the file).

Include attached addresses If set to Yes, the email addresses from the job's internal job
ticket are added to the To addresses. For more information
about attached email info, refer to Using email info in Switch
on page 238.

SMTP server authentication Authentication parameters for the SMTP server. Remember
that the SMTP server address must be defined in the Switch
preferences (Mail send category).

If you want to use the sender specified in the Switch
preferences (Mail send category), choose Default.

If you want to use a different sender (as specified in the
Sender address and Sender name field), make sure to
choose Custom and enter the user name and password
linked to this sender.

• User name: The login name for the SMTP server, for
example: user@gmail.com. Leave empty if none is
required.

• Password: The password for the SMTP server. Leave
empty if none is required.

Sender name The sender's name for outgoing email messages.

If the value is empty or set to Default, the sender name
specified in the Switch preferences (Mail send category) will
be used.

If you want to use a different sender, enter the name of
your choice and do not forget to specify the custom SMTP
authentication parameters.

Sender address The sender's email address for outgoing email messages.

If the value is empty or set to Default, the sender address
specified in the Switch preferences (Mail send category) will
be used.

If you want to use a different sender, enter the email address
of your choice and do not forget to specify the custom SMTP
authentication parameters.

Reply address The e-mail address to which a receiver of the message
should send a reply.

If the value is empty or Default, the sender address specified
in the Sender address field is used (i.e. to the address that
was used to send mails).

Note:  The value of this property is used in the
Reply-To SMTP header that is normally used by
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email client applications to send a reply. However,
the From field of an email in the client application
does not display this address, instead it shows the
sender address specified in the Sender address
field.

Message format The format of the message that will be sent, either Plain text
or HTML.

Note:  Make sure to choose the correct format for
the selected body template (next field), e.g. if you
upload an HTML template, you should select HTML.

Body template The location of the template of the e-mail body:

• If set to Built-in, a built-in template is used and you can
enter the text of your choice in the Body text property.

Include attached body text allows you to insert the body
text attached to the job as part of its e-mail info, after the
body text.

Display metadata allows you to specify the Metadata fields
that should appear in the e-mail.

• If set to Fixed file, you can upload a Template file (HTML
or text) that contains the template for the message body.
Make sure to inform your customer in this message
about the required reply syntax (see below).

Tip:  To make it easier for your customers, you
could present the Checkpoint actions as buttons
and add a Submit button that automatically
generates the reply mail.

• If set to Associated with job, the Template dataset (which
is the name of the metadata dataset associated with the
job containing a plain text or HTML template for the email
body) will be used. For more information about attached
email info, refer to Using email info in Switch on page
238.

Attach files If set to Yes, the incoming job is attached to the e-mail
message that is sent out. This is useful if the customer
should review the job.

Enable report viewing If set to Yes, the metadata dataset indicated with the
subordinate property is attached to the e-mail message that
is sent out.

Report dataset name The name of the dataset to be attached to the e-mail
message.
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Report name suffix The name of the attached report is formed by adding this
suffix to the name of the job, before the file name extension.

Report name extension The file name extension for the report. Select "Data Model"
to automatically use XML, JDF or XMP depending on the data
model of the exported data set. For the Opaque data model,
the original backing file's extension is used.

Allow multiple outputs If set to Yes, the user can send copies of a job along more
than one outgoing connection; otherwise the job is sent
along exactly one of the outgoing connections.

Server type The type of server from which to retrieve email. Choices are
POP3 and IMAP.

Server address The URL or IP address of the server from which Switch
retrieves e-mail (to check the customer's reply).

Tip:  You can find the POP3 or IMAP settings of your
mail provider (e.g. gmail) on the internet. Note that
POP3/IMAP must be enabled on your mail account.
For more information, refer to the documentation of
your mail provider.

Port Specify the port to be used for communication with the
server (as specified in the POP3/IMAP settings of your mail
provider)

Accounts A list of accounts (names and corresponding passwords)
from which to retrieve e-mail. This is usally your own
account (as set in the Switch user preferences).

Use secure password
verification

Defines whether to log in to the e-mail server using secure
password verification.

If set to Yes, the Authentication method (used to establish
the connection to the mail server) should be specified. The
following secure authentication methods are supported:

• Automatic (The element will try the different methods
one by one until the connection could be established)

• SASL Plain
• NTLM
• SASL DIGEST-MD5
• CRAM-MD5
• APOP

Note:  APOP can only be used with a POP3 mail
server.
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Server requires secure
connection

Defines whether the e-mail server requires a secure
connection using the TLS protocol.

Check every (minutes) The frequency of checking the e-mail accounts for new
messages.

Fail jobs after timeout If set to Yes, jobs are failed after residing in the Checkpoint
for a certain period of time (specified in the subordinate
properties).

Failed jobs are moved to the outgoing connection specified in
the subordinate properties or to the Problem jobs folder.

Unit Selects the unit for the subsequent property: Minutes,
Hours, Days.

Timeout delay The timeout delay in the units indicated by the previous
property (0 means ‘no timeout').

Fail connection The name of the connection to which failed jobs must be
moved.

If this property value is empty or if the specified name does
not match any of the outgoing connection names, failed jobs
are moved to the Problem jobs folder.

Reply syntax

The user's reply message must specify the job ID and the selected Checkpoint action(s) in a
simple format. Specifically, Switch searches for the following character sequences:

• "Job identifier:" followed by the job ID (as specified in the original e-mail sent to the
customer).

• "Action:" followed by one of the Checkpoint action names, or a list of comma-separated
action names (in case multiple actions are allowed).

In both cases, the text is case insensitive. All other text in the message is ignored.

Example flow
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In the above example, jobs are submitted via a Submit point. They are preflighted using
Enfocus PitStop Server, and moved to two separate folders, depending on the outcome of the
preflighting.

Files that are preflighted OK, are moved to the Ready for review folder element and will be
presented to the customer for approval. This works as follows:

1. As soon as a job arrives in Ready for review, a message is sent to the customer (i.e. to the
email address in the To addresses property of Checkpoint via mail) - see the example mail
below.

2. The customer has the chance to review the job (optionally, the job files are attached to
the email) and sends back a reply that contains the job ID and the Checkpoint action of his
choice (Accept or Decline) in the specified format- see the example reply below.

3. As soon as Switch receives the reply, the job that was waiting in the Ready for review folder is
moved to the corresponding folder.

Example Mail

Example Reply

Pack job
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Pack job is a processor that packs a job and its associated metadata for transmission. The result
is always a single ZIP file that contains a globally unique identifier to identify it across multiple
Switch instances.

Pack job also stamps the internal job ticket of its output with the unique identifier so that
confirmations can be matched with the packed data without opening the ZIP file.

See Acknowledged job hand-off on page 245 for an example of how to use this tool.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Pack job element will be shown in the list:

• ZIP
• compress
• archive
• Internet
• web
• network
• communication
• transfer
• acknowledged
• hand-off

Connections

Pack job allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

Include internal metadata If set to Yes, the output archive contains internal job ticket
information for the job (including e-mail info, hierarchy info,
private data fields, etc.).

Include external metadata If set to Yes, the output archive contains a copy of the
external metadata (that is, all datasets) associated with the
job.

Embedded metadata is always included since it is part of the
job file itself.

Compress If set to Yes, the data in the output archive is compressed (the
default behavior).

If set to No, the data is stored in the output archive without
compression, dramatically reducing processing time; this
can be meaningful when speed is more important than size,
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or when the data does not compress well (as is the case for
JPEG images).

Password The password used for protecting the output archive, or
empty if no password protection should be used.

Unpack job

Unpack job is a processor that unpacks a job that was packed for transmission with Pack job.

Outgoing data success connections receive the unpacked job, with restored metadata (if it
was included in the packed archive). Outgoing log success connections receive a checksum-
protected XML file that can serve as a formal confirmation of successful receipt of the job,
recognized by the Monitor confirmation element.

Incoming jobs that do not have the appropriate format (or that were corrupted during
transmission) are sent to the data error connection or if there is no such connection, these jobs
are moved to the problem jobs folder.

See Acknowledged job hand-off on page 245 for an example of how to use this tool.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Unpack job element will be shown in the list:

• ZIP
• uncompress
• unzip
• archive
• Internet
• web
• network
• communication
• transfer
• acknowledged
• hand-off

Connections

Unpack job supports outgoing traffic light connections of the following types:

• Data success: carries successfully unpacked jobs, with restored metadata.

• Log success (optional): carries confirmation file that should be returned to the sender of the
packed job.

• Data error (optional): carries incoming jobs that cannot be unpacked; if there is no such
connection, these jobs are moved to the problem jobs folder.
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Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element.

Passwords A list of passwords used for opening the packed data, if
needed.

The script expression can be used to determine a
password dynamically, for example based on the sender of
the packed data.

Restore metadata If set to Yes, internal job ticket information and external
metadata associated with the job are restored from the
packed data (overwriting any metadata already associated
with the packed data).

Embedded metadata is always included since it is part of
the job file itself.

Email info Special options for email info in the internal metadata:

• Restore and replace

• Restore and merge

• Don't restore

Hierarchy info Special options for hierarchy info in the internal metadata:

• Restore and replace

• Restore and place at the top

• Restore and place at the bottom

• Don't restore

Fail duplicates If set to Yes, a packed data entity that comes in twice
(based on the unique identifier stored inside) is sent to the
error output; otherwise it is treated as usual.

In both cases the duplicate is logged to the execution log.

Keep info for (days) The list of identifiers already processed is kept for at least
this many days.
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Monitor confirmation

Monitor confirmation is a processor that monitors incoming receipt confirmations (generated by
Unpack job) and matches them against a copy of the packed data (generated by Pack job) waiting
in its input folder. When no confirmation is received after a certain amount of time, the tool can
be setup to retry the communication (that is, send another copy of the packed data).

See Acknowledged job hand-off on page 245 for an example of how to use this tool.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Monitor confirmation element will be shown in the list:

• Internet
• web
• network
• communication
• transfer
• acknowledged
• hand-off

Connections

Monitor confirmation supports outgoing traffic light connections of the following types to
support its various actions:

Action Connection type Comments

Success data When a matching confirmation is received, the
packed data is removed from the input folder
and sent along this connection.

Confirm

Success log When a matching confirmation is received, it
is sent along this connection.

Retry Warning data For each retry attempt (as specified by the
tool's properties) a copy of the packed data
is moved along this connection; the original
packed data stays in the input folder.

Error data After all retries have timed-out, the packed
data is removed from the input folder and sent
along this connection.

Reject

Error log When a confirmation is received that does not
match any of the waiting packed data files or
that is corrupt, it is sent along this connection.
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Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element

Retry count The number of retry attempts made when no confirmation is
received.

Retry delay The delay (in minutes) between each retry attempt and the
timeout after the last one.

Remote process

Remote process is a flow element that allows you to take Switch jobs out of the flow, process
them remotely (using the service of your choice) and put them back in the flow after processing.

The API to communicate with Switch is available on the Enfocus website.

Note:  The Remote process element is only available if you have licensed the Scripting
module.

Keywords

If you enter one of the following keywords in the Search field at the top of the Flow Elements
pane, the Remote process element will be shown in the list:

• HTTP
• HTTPS
• REST
• service

Connections

Remote process requires at least one incoming and one outgoing traffic light connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears
when moving your cursor over the flow element
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Property Description

Job notification URL The URL of the remote processing service that will be
called when a job arrives in the Remote process flow
element or when the flow is stopped and non-finished jobs
are aborted.

Both HTTP and HTTPS are supported (if enabled in the
Switch Preferences).

Example: http://www.myremoteprocessingservice.com

Send notification when flow
stops

When set to Yes, a notification is sent for each non-
finished job that is aborted when the flow is stopped.

Note that jobs that are finished in the time between the
actual flow stop and the time set in Release acquired slots
after (minutes), are not aborted, hence for such jobs no
"abort job" notification is sent.

How it works

Whenever a job arrives in this flow element, Switch sends a notification to the remote
processing service (of which the URL should be entered in the "Job notification URL" property
of the flow element). The remote processing service should respond with a status code in the
range of 100 to 299 to indicate that the notification was successfully received.

The notification, also known as a webhook, contains the necessary information for the remote
processing service to communicate with the Switch Service REST API. The remote service has
to download the job file from Switch, and optionally the metadata. At the end of the processing,
the remote process service has to inform Switch that the processing is finished and optionally
upload a modified file. Switch will then send the input job or the new job along the correct
outgoing connection.

When the flow is stopped, non-finished jobs are aborted and if "Send notification when flow
stops" is set to Yes, for each aborted job, a 'jobAborted' notification is sent to the remote
processing service.

The details of the information that is sent and more info about the available REST API calls can
be found in the Switch Web Services REST API documentation.

Note:

• Switch blocks a processing slot for the duration of the processing time.

Remark: When the flow stops while a job is being processed remotely, Switch waits for the
processing to complete. The wait time can be configured via Release acquired slots after
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(minutes). Only when remote processing was not completed in time, the job is aborted and a flow
stop notification is sent.

5.1.2.5.  Apps
This category is only available if you have installed at least one app. For more information about
working with apps, refer to the dedicated chapter: Working with apps in Switch on page 304.

5.1.2.6.  Configurators
In the Flow elements pane, click the Documentation... option in the contextual menu of a
configurator to view the documentation related to it.

For more information about working with the configurators, refer to the chapter about the
Configurator Module on page 379.

5.1.2.7.  Metadata
The flow elements in the Metadata category of the Flow elements pane are only available if you
have licensed the Metadata Module.

XML pickup

XML pickup is a processor that allows associating an arbitrary XML file with a job as metadata. It
supports the following pickup mechanisms:

• Metadata alongside asset

• Metadata in job folder asset

• Metadata refers to asset

• Metadata is asset

For more info see Pickup modes on page 455.

Keywords

Keywords can be used with the search function above the Flow elements pane.

The keywords for the XML pickup element are:

• metadata
• dataset
• asset

Data model

The metadata source must be a well-formed XML file with any schema. The dataset data model
is XML.
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Connections

XML pickup allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Dataset name A name for the set of metadata picked up by this tool; see
picking up metadata

Pickup mode The pickup mechanism; one of:

• Metadata alongside asset

• Metadata in job folder asset

• Metadata refers to asset

• Metadata is asset

Additional properties are shown depending on the selected pickup mode; see Pickup modes on
page 455 for the description of each pickup mode.

JDF pickup

JDF pickup is a processor that allows associating an JDF file (that is, a JDF job ticket) with a job
as metadata. It supports the following pickup mechanisms:

• Metadata alongside asset

• Metadata in job folder asset

• Metadata refers to asset

• Metadata is asset

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the JDF pickup element are:

• metadata
• dataset
• asset
• ticket
• adticket
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Data model

The metadata source must be a JDF file conforming to the JDF 1.3 specification. The dataset
data model is JDF.

Connections

JDF pickup allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Dataset name A name for the set of metadata picked up by this tool; see
picking up metadata

Pickup mode The pickup mechanism; one of:

• Metadata alongside asset

• Metadata in job folder asset

• Metadata refers to asset

• Metadata is asset

Additional properties are shown depending on the selected pickup mode; see Pickup modes on
page 455 for more information.

Adobe Acrobat JDF

The JDF pickup tool supports JDF files generated by Adobe Acrobat 7 or higher. If the JDF file
produced by Acrobat is delivered as a separate file it can be picked up with the "alongside asset"
or "in job folder asset" mechanisms. If the JDF file and the corresponding assets are delivered
as a single combined MIME file, the uncompress tool should be used in front of the JDF pickup
tool to extract the individual files into a job folder.

XMP pickup

XMP pickup is a processor that allows associating an XMP packet with a job as metadata. It
supports the following pickup mechanisms:

• Metadata embedded in asset (the default location for an XMP packet)
• Metadata alongside asset
• Metadata in job folder asset
• Metadata is asset
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Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the XMP pickup element are:

• metadata
• dataset
• asset
• ticket
• adticket

Data model

The metadata source must be an Adobe XMP packet or a standalone XMP file conforming to the
Adobe XMP specification dated June 2005. The dataset data model is XMP.

Connections

XMP pickup allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Dataset name A name for the set of metadata picked up by this tool; see
picking up metadata

Pickup mode The pickup mechanism; one of:

• Metadata embedded in asset

• Metadata alongside asset

• Metadata in job folder asset

• Metadata is asset

Additional properties are shown depending on the selected pickup mode; see Pickup modes on
page 455 for more information.

Locating XMP packets

The mechanism for embedding XMP packets in a file is also described in detail in the Adobe XMP
specification mentioned above.

There are two distinct methods to locate XMP packets embedded in a file:

• Scan the complete file for the magic markers at the head and tail of a packet: this works
for any file format, but may possibly locate the wrong packet in case a composite document
contains multiple packets.
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• Interpret the file format's structure to track down the packet: this guarantees that the
correct packet has been located and it is usually much faster, but it requires a specific
algorithm for each distinct file format.

The XMP pickup tool interprets the file format for a number of supported file formats, and scans
the complete file for all other file formats.

Synchronizing with EXIF and IPTC

For certain supported file formats the values of binary EXIF and IPTC tags can be merged
with the embedded XMP packet before it is picked up. See the "Synchronize EXIF/IPTC fields"
property for the embedded pickup mechanism.

XMP Inject

The XMP Inject Flow Element can be used for two main purposes:

• Inject an external dataset into the job

The data to be injected is linked to the incoming job as an external dataset and corresponds
to the XMP schema which is listed in the Switch jobticket.

For example, the dataset could have been created by the export metadata mechanism which
extracts information from a PDF.

A scenario where we can use this feature is when merging information from multiple PDF's
into a single PDF.

• Insert or update data to an existing XMP dataset

All kinds of Switch variables can be injected as data. For example, we can use this feature in
a GWG Ad Ticket to update the missing values.

Supported job types

• PDF
• Illustrator
• InDesign
• Photoshop
• TIFF
• JPEG
• PNG

Outgoing connections

The XMP Inject Flow Element requires at least one incoming connection. The outgoing
connection is a traffic light connection of the following type only:

• Data error: to carry the incoming job when the action fails.
• Data success: to carry the incoming job after the action is successfully performed.

Note:  The incoming files which have an external dataset will retain it even after passing
through the XMP Inject tool if the user has not specified in the settings, to discard
external dataset. There are no outgoing log connections.
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Script declaration

Property Value

Language C++

Incoming connections Yes; required

Outgoing connections Error vs success

Execution mode Serialized

Position Metadata category

Keywords Metadata, xml, insert, update

Properties

Property name Description

Action Select an action to perform on the incoming job. "Update XMP" and
"Inject XMP" options are available in this drop-down menu.

Dataset Select a dataset that contains the information. Make sure the dataset is
in XMP format. This property is visible only when you select "Inject XMP"
for Action.

Keep dataset Set to "Yes" to keep the external dataset after it has been injected. Select
"No" to discard the external dataset. This property is visible only when
you select "Inject XMP" for Action.

XMP fields This option allows you to select an XMP field and update its value in the
Update XMP data dialog box and is visible only when you select "Update
XMP" for Action.

Rule properties:

• Name: Enter the name of the rule.

• Description: A description of the flow element displayed in the canvas.
This description is also shown in the tooltip that appears when moving
your cursor over the flow element.

• XMP location path: Select or define the XMP location path.

• New value: The new value is interpreted according to the value type
selected in Value type drop-down menu. For example, if the value
type is "Date" then the new value must be a string representing
datetime in ISO 8601 as described here: http://www.w3.org/TR/NOTE-
datetime

• Value type: Select the value type from the options: String, Number,
Boolean, Date and Localized text

• If you select "Number" you have to specify the "Precision" in the
textbox of the same name.

• If you select "Localized text", two more textboxes, "Generic
language" and "Specific language" appear:

• Generic Language: Enter the name of the generic language.
Example: 'en'. Or choose Select from library option to view
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Property name Description

a list of languages to select from. This language is used if
the specific language does not match. Make sure the format
complies with the RFC 3066 standard or leave this field empty.

• Specific Language: Enter the name of the specific language.
Example: 'en-UK' or 'en-US'. Or choose Select from library
option to view a list of languages to select from. This language
will be selected when there is an exact match. Make sure the
format complies with the RFC 3066 standard or use 'x-default'
as artificial language to denote a default item in an alt-text
array. This field cannot be empty.

Note:  Before appending information to a job, user should ascertain that the job has an
external XMP dataset which conforms to the RDF schema, as it is not possible to inject
any arbitrary XML file. If the dataset conforms and matches the file type, it is injected
into the job and the job is routed through the Success out connection. The job is routed
to the error out connection if the dataset cannot be injected or if the specified dataset
cannot be found.

When updating values to an existing XMP dataset, select the node and add it to a list of
values that must be updated.

Injecting XMP from XML Data

XMP and JDF are both XML based languages. However, both these, as well as XML need to be
converted to the proper XML format for XMP injection, from other sources or from within other
Switch elements.

Within Switch, this can be done with the XSLT tool and custom style sheets to convert XML into
the XMP format before injection.

Opaque pickup

Opaque pickup is a processor that allows associating an arbitrary file with a job as metadata. It
supports the following pickup mechanisms:

• Metadata alongside asset

• Metadata in job folder asset

Keywords

Keywords can be used with the search function above the elements pane.

The keywords for the Opaque pickup element are:

• metadata
• dataset
• asset
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Data model

The metadata source can be any file (but not a folder). The dataset data model is Opaque.

Connections

Opaque pickup allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Dataset name A name for the set of metadata picked up by this tool; see
picking up metadata

Pickup mode The pickup mechanism; one of:

• Metadata alongside asset

• Metadata in job folder asset

Additional properties are shown depending on the selected pickup mechanism; see the
description of each mechanism for more information.

Export metadata

Export metadata is a processor that allows saving a metadata dataset associated with the
incoming job to a standalone file. The tool merely copies the dataset's backing file to the output
location without any transformations. The XSLT transform on page 152 tool can be used to
transform the exported metadata if needed.

The outgoing log connections carry the exported metadata; the outgoing data connections carry
the incoming job without change. If the incoming job has no dataset with the specified name, no
log output is generated.

Keywords

Keywords can be used with the search function above the Elements pane.

The keywords for the Export metadata element are:

• XML
• JDF
• XMP
• opaque
• metadata
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• dataset

Connections

Export metadata supports any number of outgoing traffic light connections.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when
moving your cursor over the flow element

Dataset name The name of the set of metadata (associated with the job) to
be exported; see Picking up metadata on page 453 for more
information

Filename body The filename for the generated metadata file (without filename
extension)

Filename extension The filename extension for the generated metadata file;
select "Data Model" to automatically use "xml", "jdf" or "xmp"
depending on the data model of the exported dataset (for
the Opaque data model, the original backing file's filename
extension is used)

Remove dataset If set to Yes, the job's dataset will be removed after the export.

5.1.2.8.  Database

Database connect

This tool helps in configuring certain settings in the databases (like selecting Datasource,
adding SQL statement etc) without the use of scripting. It is only available if you have licensed
the Database module.

Drag and drop the Database Connect to the workspace.

Keywords
If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Database Connect element will be shown in the list:

• SQL
• database
• metadata
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• xml
• export
• select
• insert
• update
• delete

Connections
Database Connect needs at least one incoming connection.

Property

Property Description

Name Provide a name for the flow element. This
name is displayed in the workspace.

Description A description of the flow element displayed
in the canvas. This description is also shown
in the tooltip that appears when moving your
cursor over the flow element

Select data source Select a data source from the list of
predefined data sources.

Note:  If the list is empty, you
should first set up a data source.
Refer to the ODBC data sources
option in the User preferences
dialog (See Setting up an ODBC
database connection on page 49).

SQL statement Specify SQL statements using any one of the
following three options:

• Edit multi-line text
• Define multi-line text with variables
• Define script expression

Note:  Please pay special attention
when using other variables and
make sure that the result of the
multi-line text is a valid SQL
statement.

Log name Specify the name of the log where the result
of the statement should be written by using
one of the following three options:

• Inline value
• Define single-line text with variables
• Define script expression
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Property Description

Binary data in opaque dataset If the result of the SELECT statement
returns binary data (for example: video
form), select Yes.

Otherwise, select No and configure the
subordinate properties.

Log type Only available if Binary data in opaque dataset
is set to No.

Format of the log (where the result of the
statement will be written). Options:

• CSV

• XML

Encode binary data Only available if Binary data in opaque dataset
is set to No.

Defines the way binary data is converted.

• Encode with Base64: default

• Keep as is: Use this option if the ODBC
driver returns binary table fields. This is
for example the case when you're using
FileMaker in combination with Switch.

Note:  Be careful with this
option; it may lead to a
corrupted logfile.

At present there is no SQL editor available. Therefore, copying statements generated by the
variables, multi line text with variables, database group and build SQL statement dialog box may
result in errors.

Note:  Refer this site for an SQL Tutorial.

5.1.2.9.  Legacy

Compress

Compress is a processor that places the incoming file or a job folder into a compressed ZIP
archive. All files in a job folder are placed in a single archive. The archive is named as the
incoming file or job folder with a ".zip" extension.

210

http://www.w3schools.com/sql/default.asp


Switch

Note:  This tool is outdated and should only be used for maintenance reasons. Please
use the new Archive on page 127 tool, which provides proper support for Unicode
based on zip file format specification.

Keywords

Keywords can be used with the search function above the Flow elements pane.

The keywords for the Compress element are:

• ZIP
• archive

Connections

Compress allows only a single outgoing connection.

Properties

Property Description

Name The name of the flow element displayed in the canvas

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element

Compress If set to yes, the files in the ZIP archive are compressed (the default
behavior)

If set to no, the files are stored in the ZIP archive without
compression, dramatically reducing processing time; this can be
meaningful when speed is more important than size, or when the
files will not compress well anyway (example: JPEG images) – but
you still want a single archive containing all files

Use password If set to yes, all created archives are password-protected

Password The password used for protecting archives

Note:  Switch uses zlib which does not support the AES encryption, therefore Switch
cannot read passwords which use the AES encryption. Hence, the Uncompress tool
cannot read passwords which have been encrypted using the AES encryption. As a
workaround, users can try using a third-party archiver as a command line application
from Switch.

Uncompress

Uncompress is a processor that extracts files from an archive in one of the following formats:
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• ZIP

• RAR

• MIME

Any files that are not recognized as an archive are passed through the Uncompress tool without
change.

Note:  This tool is outdated and should only be used for maintenance reasons. Please
use the new Unarchive on page 129 tool, which provides proper support for Unicode
based on the zip file format specification.

Keywords

Keywords can be used with the search function above the elements pane.

The keywords for the Uncompress element are:

• ZIP
• RAR
• MIME
• archive
• compress
• decompress
• unzip

Filenames and folder structure

The following table describes the resulting file or folder structure and the corresponding
naming conventions.

Multiple files from the same archive are always placed in a job folder. If the intention is to inject
these files into the flow as separate jobs, a job dismantler should be placed directly after the
uncompress flow element.

Archive contents Uncompress result

Single file The file (named as specified in the archive).

Multiple files or folders with a
common root folder

A job folder (named as the nearest common root folder)
containing all files and folders (named as specified in the
archive).

Multiple files or folders
without a common root folder

A job folder (named as the archive after stripping the
extension) containing all files and folders (named as
specified in the archive).

Connections

Uncompress allows only a single outgoing connection
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Properties

Property Description

Name The name of the flow element displayed in the canvas.

Description A description of the flow element displayed in the canvas. This
description is also shown in the tooltip that appears when moving
your cursor over the flow element.

Passwords A list of passwords for opening password-protected archives; each
of the passwords in the list will be tried in turn.

The script expression can be used to determine a password
dynamically, for example based on the sender of the packed data.

Note:  The result of the script expression evaluation must
be a string containing one password or a list of passwords
separated by a newline character ('\n').

Example:

var thePasswords = new Array();
thePasswords.push( "password" );
thePasswords.push( "password2" );
thePasswords.join( '\n' );

Remove redundant
folders

If set to Yes, for archives where the files or job folders are
contained in deeply nested subfolder structures, removes all but
the deepest subfolder level while uncompressing

Example: A PDF file that is compressed as "Folder 1\Folder
2\Folder 3\Test.pdf" is uncompressed as "\Folder3\Test.pdf", if
this option is enabled.

Note:  The Uncompress tool cannot read passwords which have been encrypted using
the AES encryption. Switch uses zlib which does not support the AES encryption. As a
workaround, users can try using a third-party archiver as a command line application
from Switch.

5.1.2.10.  Flow elements matrix
The following table provides an overview of the flow elements offered by each module.

Flow element Switch
Core
engine

Config
module

Meta
data
module

Data
base
module

Scripting
module

Switch
Client
module

Basics

Connection  
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Flow element Switch
Core
engine

Config
module

Meta
data
module

Data
base
module

Scripting
module

Switch
Client
module

Folder  

 

Problem jobs  

 

Submit hierarchy  

 

Archive hierarchy  

 

Set hierarchy path  

 

Job dismantler  

 

Ungroup job  

 

Split multi-job  

 

Assemble job  

 

Generic application  

 

Execute command  

 

Tools

Sort by preflight state  

 

Archive  
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Flow element Switch
Core
engine

Config
module

Meta
data
module

Data
base
module

Scripting
module

Switch
Client
module

Unarchive  

 

Split PDF  

 

Merge PDF  

 

Hold job  

 

Inject job  

 

Rename job  

 

File type  

 

Sort job  

 

Log job info  

 

Sort files in job  

 

XSLT transform  

 

Recycle bin  

 

Scripting

Script element  
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Flow element Switch
Core
engine

Config
module

Meta
data
module

Data
base
module

Scripting
module

Switch
Client
module

Communication

HTTP request  

 

Remote process  

 

Webhook  

 

FTP receive  

 

FTP send  

 

Mail receive  

 

Mail send  

 

Submit point  

 

Checkpoint  

 

Checkpoint via mail  

 

Pack job  

 

Unpack job  

 

Monitor confirmation  
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Flow element Switch
Core
engine

Config
module

Meta
data
module

Data
base
module

Scripting
module

Switch
Client
module

Apps

Various apps
purchased through
the Enfocus Appstore

See also Working with
apps in Switch on page
304.

 

 

Configurators

Various configurators

See Configurator
overview on page
382

 

 

Metadata

XML pickup  

 

JDF pickup  

 

XMP pickup  

 

XMP inject  

 

Opaque pickup  

 

Export metadata  

 

Database

Database connect  

 

Legacy
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Flow element Switch
Core
engine

Config
module

Meta
data
module

Data
base
module

Scripting
module

Switch
Client
module

Compress  

 

Uncompress  

 

5.2.  Working with flows
Working with Switch means creating, designing and running flows for the processes you want to
automate.

5.2.1.  About working with flows in Switch
Working with flows consists of the following steps:

1. First you have to create a new flow. You can start from scratch (blank flow) or from a
sample flow.

2. Next, you have to design your flow, by dragging the required flow elements to the canvas.
You must configure the properties of the different flow elements and connectors.

3. Finally, you must activate the flow, and test it, using test files, until you are happy with the
result.

For a step by step explanation, refer to the Switch Quick Start Guide on the Enfocus website.

For a detailed description of everything you can do with Switch flows, refer to the topics below.

5.2.2.  Creating a new blank flow
Use this procedure, if you want to create a blank flow with an empty canvas. You'll have to add
all flow elements yourself.

To create a blank flow

1. Do one of the following:

•

In the toolbar at the top of the screen, click .
• From the menu, select Flow > New Flow....
• In the Flows pane, right-click and select New Flow.

A new flow is created. By default it is called "New flow" (followed by a number if it's not your
first "New flow").
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2. Enter a meaningful new name for your flow.

Your cursor will automatically focus on the flow name in the Flows pane, so you can
immediately type a new name. If you click outside the name field, the name will be displayed
in italics and it will have an asterisk next to it, to indicate that the flow hasn't been saved yet.

You can now add flow elements as required.

5.2.3.  Creating a new flow based on a sample flow
Use this procedure, if you want to start from one of the Switch sample flows. These flows come
with the default Switch installation and are available through the Flows menu.

To create a flow starting from a sample flow

1. From the menu, select Flow > Import sample flows....

2. Select the flow(s) you want to start from.

• To select all flows in one go, click Select all.
• To clear the checkboxes of all already selected flows, click Clear selection.
• To select one or more flows, select the corresponding checkbox(es).

Note:

• For a description of the available flows, click a flow name. The description
appears in the lower part of the dialog.

• You can select more than one flow, for example to have a look at the differences
or to see if they are similar to what you need. All the flows you select will become
available in the Flows pane.

3. To import the selected flow(s), click OK.
The Flows pane shows the imported sample flow(s). You can modify and expand the flow(s)
as required. See Designing flows on page 219.

5.2.4.  Designing flows

5.2.4.1.  Working with the canvas
The canvas is the central workspace area that allows viewing and editing flows. The canvas
always displays the flows selected in the Flows pane.

Single flow at full size
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When a single flow is selected, the canvas displays it at full size and scroll bars appear if the
flow design is larger than the visible area. In this mode the flow is editable (assuming that it is
inactive and unlocked); see Editing a flow on page 221.

Multiple flows as tiles
 

 

When two or more flows are selected, the canvas displays a tile for each flow. A tile is a scaled-
down version of the flow design similar to a thumbnail. Tiles can't be edited. However you can
select a particular tile and edit its flow properties in the Properties pane.

In tile mode the canvas never shows horizontal scroll bars. Instead the size of the tiles is
adjusted so that a predefined number of tiles fit on a row. The maximum number of tiles shown
can be set as well.

• To adjust the number of tiles in a row, choose the "Tiles in a row" menu item in the canvas
context menu and select one of the choices 1 through 9 in its submenu (this context menu
item is present only while the canvas displays tiles).

• To return one of the displayed flows to full size:

• Double-click the tile in the canvas; or
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• Select the tile in the canvas and choose the "Show at full size" menu item in the canvas
context menu; or

• Select the flow in the Flows pane (without selecting any other flows).
• To change the maximum tiles shown, select the "Maximum tiles" menu item in the context

menu and select the desired value. If more flows are selected than this maximum number,
the canvas will show a message instead of the tiles.

Single flow scaled to fit
• To display a large flow design (that doesn't fit the current Canvas pane) as a tile that fits the

visible area of the canvas:

• Select the flow and choose the "Scale to fit" menu item in the canvas context menu (this
context menu item is present only if the canvas shows a scroll bar).

• To return the scaled-down flow to full size, perform one of these steps:

• Double click the tile in the canvas; or
• Select the tile in the canvas and choose the "Show at full size" menu item in the canvas

context menu.
• You can also zoom in and zoom out the canvas area to enlarge or minimize the selected flow:

• On Windows OS, press the Ctrl button and scroll with your mouse.
• On Mac OS, press the Command button and scroll with your mouse.

Editing a flow
Before making changes to a flow:

• Ensure that the flow is inactive and unlocked; an active or locked flow is displayed with a
darkened background and cannot be edited.

Note:  Are you viewing the flow with a Remote Designer? In that case, a darkened
background may indicate that you don't have the right to edit the flow (read-only
access). Refer to the section about user configuration for Remote Designer, for
example: Configuring a user on page 58 (last step).

• Select the flow in the Flows pane without selecting any other flows; when multiple flows are
selected the canvas shows tiles which cannot be edited.

5.2.4.2.  Working with flow elements
A flow design (as displayed in the canvas) consists of a number of interconnected flow elements.
Switch offers a range of flow elements, including:

• Connection: a special flow element used to connect other flow elements; connections
determine how jobs can travel along a flow.

• Folder: a central flow element used to (temporarily) store or modify jobs in between
processes.

• Various flow elements types to produce, process and consume jobs.
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Adding new flow elements
To add a new flow element to the canvas

Do one of the following:

• Drag the icon for the desired flow element type from the Flow elements pane onto the
canvas in the desired location.

• Right-click a blank area of the canvas and select Add > <category> > <desired flow
element>.

For flow elements that are used often, you can use the following shortcuts:

• To add a Folder flow element, you only need to double-click in the canvas where you want
the Folder to be added.

• To add a favorite flow element, you can use the following keyboard shortcuts: ctrl
+<number> (Windows) or cmd+<number> (Mac). The number (1-9) refers to the position of
the flow element in the Favorites category (first in the list = 1, second = 2, etc). The flow
element is placed in the middle of the canvas.

Connecting flow elements
To connect two flow elements that are already present on the canvas

Do one of the following:

• Drag the Connection icon from the Flow elements pane and drop it onto the first flow
element; then click the second flow element.

• Double-click the first flow element; then click the second flow element.
• Right-click the first flow element and select Start connection; then click the second flow

element.

A connection line connects the two flow elements.

Inserting a folder between two non-folder flow elements
In Switch, you cannot make a connection between two non-folder flow elements, without having
a folder in between.

For this reason and to save time, when dragging a connection between two non-folder flow
elements, Switch automatically adds a folder in between and creates a double connection (from
the first flow element to the folder, and from the folder to the second flow element).

You can see that a folder is added upon creating the connection as the drag line includes the
outline of a folder between source and destination, and the cursor changes to "allowed".

This insertion of a folder does not take place if,

• There is not enough room in between the two flow elements to insert a folder.

• Inserting a folder does not result in valid connections.
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Inserting a flow element on an existing connection
You can insert a flow element on an existing connection by dragging and dropping the new flow
element on the connection between two other elements.

The flow element that you insert can be dragged from the Flow elements pane, or you can drag
and drop an existing flow element from the canvas, if it does not have any connections yet.

The connection from the original "source" flow element will go to the newly inserted flow
element and a new connection from the newly inserted element to the "original" target element
will be established.

If necessary, a folder will be added in between, just as when connecting two flow elements. See
Inserting a folder between two non-folder flow elements on page 222.

You can see that the flow element will be added on the existing connection as the outline of the
element is shown between source and destination.

This insertion on a connection will not take place if:

• There is not enough room in between the two flow elements to insert the flow element (and a
folder if necessary).

• Inserting the element doesn't result in a valid connection.

Manually changing connections
You can manually change connections by clicking and dragging the start or end of a connection
from one flow element onto another one.

To manually change connections

1. Select the connection you want to change.

2. Hover the cursor over the source or target end of the connection you want to change. A grab
handle (red circle) appears, similar to the grab handle for the corner point, as shown below:
 

 

3. Click and drag the connection on another flow element, for which the new configuration is
allowed:

• For the target of the connection, this is similar to creating a new connection.
• For the source, the new source flow element must accept outgoing connection of the

same type and with the same injected properties.

Note:  To copy the connection instead of moving it, press the Ctrl key (for
Windows) or Alt key (for Mac OS).
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Warnings when adding new flow elements
After adding a new flow element to the canvas, the flow element may display an alert icon ( )
indicating a problem with the flow design.

This usually refers to missing connections, since many flow elements require at least one
incoming and/or outgoing connection. For more information, hover your cursor over the icon to
display a tooltip.

Example:

After adding a "Submit hierarchy" and a "Folder" the flow design looks as follows:

 

 

The tooltip for the Submit hierarchy 1 element states: The flow element requires at least one
outgoing connection.

After adding a Connection element, the warning will be gone.

 

 

Selecting flow elements

Note:  You can select multiple flow elements as required. However, a connection and
other flow elements cannot be combined in one selection.

To select flow elements

1. To select one flow element at a time, click the flow element in the canvas.
In the canvas, you can see which element is selected:

• Selected flow elements are surrounded by a gray rectangle.
• Selected connections have a darker color.

2. To select multiple flow elements at the same time, do one of the following:

• Drag a selection rectangle around the flow elements in the canvas.
• Click a first flow element, and then expand the selection by clicking other flow elements,

while holding down the Ctrl key (on Windows) or Command key (on Mac OS).
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Example of a selected flow element and a selected connection.

 

 

 

 

Moving flow elements
To move flow elements on the canvas

1. Select one or more flow element as required.

See Selecting flow elements on page 224.

2. Use the arrow keys or drag and drop the selected flow element to the preferred place on the
canvas.

Note:  If you're about to place two elements on top of each other, a warning icon
appears. Move the element a little bit, to avoid that one of the two gets hidden.

 

 

Configuring flow elements
Each flow element (including the Connection flow element) offers one or more properties that
help determine the flow element's behavior. You should set an appropriate value for each
property (or use the default value) to fully configure a flow.

For a detailed description of the properties offered by each flow element, refer to Flow elements:
overview on page 90.
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Editing the name of a flow element
All flow elements (including the Connection flow element) offer at least one property: the
name of the flow element as displayed in the canvas. When you add a new flow element, Switch
provides it with a default name inspired by the flow element type. By default, a connection does
not contain a name.

You can edit the Name property in the Properties pane, just like other properties (See Changing
flow element properties on page 226), or you can edit the name directly on the canvas, as
explained below.

Tip:  For a better overview, we recommend using meaningful names!

To edit the name of a flow element directly on the canvas

1. On the canvas, select the flow element.

Ensure only one flow element is selected.

2. Click the name of the flow element (on the canvas).

3. Enter the new name or adjust the existing name.

 

 

Changing flow element properties
Switch provides you with default values for the flow elements, but you can change the defaults
as required.

Note:  You can only change the properties if the flow is not active and not locked.

To change the properties of flow elements

1. Select the flow element of which you want to change the properties.

Note:  If you select multiple (similar) flow elements at the same time, you can
change the common properties.

The properties of the selected flow element(s) are displayed in the Properties pane.
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2. Click the property you want to change.
Depending on the selected property, a text box, a button, or a drop-down menu appears.

3. Make the required changes:

If ... appears Do the following:

A text box Type the text in the displayed text field.

A drop-down
menu

Select the appropriate option.

1. In the the property editor dialog that pops up, update the field(s)
as required.

2. Click OK.

1. From the pop-up list, select one of the options.

 

 

Depending on the selected option, an inline editor or a dialog
appears.

2. Configure the desired values.

For an overview of the properties and their meaning, see Flow elements: overview on page
90.

Your changes are applied immediately.

Resetting flow element properties
You can reset the property values to the factory defaults, as when creating a new flow element
on the canvas.

To reset property values

1. Select the flow element.

2. Right-click the flow element, and select Reset property values.

Copying flow element properties
For all flow elements, including connections, you can copy and paste the property values.

Note:  Property values can only be pasted to flow element(s) of the same (or a similar)
type.

To copy flow element properties

1. Right-click the flow element, from which you want to copy the property values.
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2. From the contextual menu, choose Copy property values.

3. Select the flow element(s) you want to paste the property values on.

4. Right-click the flow element(s), and select Paste property values.

Warnings when editing flow element properties
If property values are invalid or missing, you are informed in two ways:

• The flow element is displayed with an alert icon ( ).

For more information, hover your cursor over the icon to display a tooltip.

• The invalid property is displayed in red in the Properties pane.

Example:

After adding and connecting an FTP receive flow element, the canvas and the Properties pane
look as follows:

 

 

The tooltip for the FTP receive element states: Required fields are not valid: FTP server address,
User name, Password.

After entering the missing information, the warning will be gone and the properties will be
displayed in black again.

Adjusting the layout of the flow design
To adjust the layout of the flows design, select one or more flow elements (other than
connection) and drag the selection around, or use the arrow keys to "nudge" the selection to the
indicated direction in small steps. Connections automatically adjust to the new layout.

Aligning flow elements horizontally
To align flow elements horizontally

1. Select the flow elements to be aligned.

2. Do one of the following:
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• On Windows OS:

Select Edit > Align Horizontally, or press Ctrl + Shift + H.
• On Mac OS:

Select Enfocus Switch > Align Horizontally, or press Command + Shift + H.

Aligning flow elements vertically
To align flow elements vertically

1. Select the flow elements to be aligned.

2. Do one of the following:

• On Windows OS:

Select Edit > Align Vertically, or press Ctrl + Shift + V.
• On Mac OS:

Select Enfocus Switch > Align Vertically, or press Command + Shift + V.

Adjusting the layout of a connection
By default, connections are drawn as straight lines between two flow elements. You can
however adjust these lines to make a well-arranged design.

1. To draw the connection along the sides of a rectangle (with a rounded corner)

a. Select the connection.
b. Do one of the following:

• Right-click the connection and select Vertical, then horizontal or Horizontal, then
vertical.

• In the Properties pane, set the connection's Corner angle to -90 or +90.

2. To draw the connection along a route somewhere in between these extremes

a. Select the connection.
b. Do one of the following:

• Move your cursor over the connections's corner until a drag handle (blue circle)
appears, and drag the handle to the desired direction.

• In the Properties pane, set the connection's Corner angle to a value between -90 or
+90.
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Adjusting the colors of folders and connections
To make it easy to distinguish between different folder or connection types, for example
between network and input folders, you can change the default color for folders (yellow) and
connections (gray).

To adjust the colors of folders and connections

1. Select one or more connections or folders.

Note:  You cannot combine connections and folders in one selection.

2. Right-click to open the context menu.

3. Click Choose color and select the appropriate color from the list of predefined colors.

You can choose one of the following colors:

• Gray (default), Yellow, Green, Cyan, Blue, Magenta for connections.

• Yellow (default), Orange, Green, Cyan, Blue, Magenta for folders.

• Or click "Custom" and select the color of your choice using the color picker.

Alternatively, you can set the color via the Properties pane.

Keep in mind that "conditional" colors (e.g. orange for connections on hold) will take priority
over custom colors.
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For example, even if you have chosen green for a particular connection, its color will change to
orange when the connection is set on hold. When the connection is released, the chosen color
(green) will be restored.

Copying and deleting flow elements
You can copy and paste flow elements within the same flow or to another flow. The copy
includes all selected flow elements plus any connections between them. Connections to flow
elements outside of the selection are not included. It is not possible to copy a connection on its
own.

When pasting flow elements into a flow, Switch renames the new flow elements if needed to
avoid name clashes between backing folders.

• To copy one or more flow elements to the pasteboard, select the flow elements and

• Choose the Edit > Copy menu item, or
• Choose the Copy menu item in the canvas context menu.

• To paste previously copied flow elements from the pasteboard into a flow, select the target
flow and

• Choose the Edit > Paste menu item, or
• Choose the Paste menu item in the canvas context menu.

• To delete one or more flow elements from a flow, select the flow elements and

• Choose the Edit > Delete menu item, or
• Choose the Delete menu item in the canvas context menu, or
• Press the Delete key.

Undoing flow editing operations
Switch remembers flow editing operations (including changes to flow element properties) since
it was last started, and allows undoing these operations in reverse order.

There is a separate undo stack for each flow.

• To undo the most recent edit operation for a flow, select the flow and perform this step:

• Choose the Edit > Undo menu item.
• To redo the most recently undone edit operation for a flow, select the flow and perform this

step:

• Choose the Edit > Redo menu item.

5.2.4.3.  Advanced topics for designing flows

Working with folders
Working with individual files in Switch is quite straightforward. When files are grouped into
folders (and sometimes in nested folder structures), you need to take the following information
into consideration.
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Switch distinguishes between two important concepts related to (and implemented by) folders:

• Subfolder hierarchies provide structure to file submissions and to final processing results by
placing files in appropriately named subfolders (for example, a subfolder for each customer).

• Job folders represent file sets that move along the flow as a single entity, for example a page
layout with its accompanying images and fonts, or the individual pages in a book.

Since both concepts are implemented with regular file system folders, Switch needs a way to
know what it is looking at when it sees a folder. This is accomplished as follows:

• Subfolders in a regular folder are always treated as a job folder; i.e. the subfolder and its
contents are moved along as a single entity.

• Certain flow elements (such as Submit Hierarchy and Archive Hierarchy) have special
provisions to support a mixture of subfolder hierarchies and job folders; these provisions are
configured through the flow element's properties.

Thus the complexity of dealing with both concepts at the same time is limited to those special
flow elements.

Working with subfolders

Submit hierarchy

The "Submit hierarchy" tool (and its sibling FTP receive) can be used to fetch files that are
delivered in a hierarchy of subfolders. The tool looks for files in the nested subfolder structure
up to a certain level (specified in a property), and injects those files into the flow along its
output connection(s). The injected files are placed in the output folder(s) at the highest level,
in effect flattening the subfolder hierarchy. However, if so requested, the original location in
the hierarchy is stored with the file (in its internal job ticket) so that it can be retrieved later to
recreate the hierarchy. See Using hierarchy info on page 237 for more details.

If a subfolder occurs in the hierarchy on a deeper nesting level than what is specified in the
"Subfolder levels" property, it is treated as a job folder (i.e. it is moved along as a single entity).
Thus, in effect, the "Subfolder levels" property determines which subfolders in the hierarchy
should be treated as "hierarchy folders" and which should be treated as job folders.

In the example below you can see the input folder and the corresponding output folder, using
Subfolder levels set at 2.
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If you do not want to support job folders, set the "subfolder levels" property to a very high value
(for example, 999). This will cause all files to be processed separately, regardless of their
nesting level in the hierarchy.

Using the Submit Hierarchy function eliminates the need to set up individual input folders on a
user by user basis. In the example above, by just adding another sub folder for "Customer C",
any job files or folders put in that folder would be seen and processed by Switch without any
additional changes to that workflow.

Archive hierarchy

When archiving files (or job folders), you might want to recreate the subfolder hierarchy that
was used to deliver them, or you may want to create a different subfolder hierarchy based
on which route files took in a flow. Even though the files have been retrieved from different
locations and have been moved along the flow through various processing steps, the internal
job ticket for each file can remember the information needed to place the file in its appropriate
location in the hierarchy.

The archive hierarchy tool extracts this information and creates the corresponding hierarchy
(you can still limit the number of subfolder levels to be recreated regardless of the information
stored in the internal job ticket). See Using hierarchy info on page 237 for more details.

Working with job folders
Any folder (and its contents) that should be processed as one entity is considered to be a job
folder. A job folder usually contains files and/or subfolders (which can contain other files and
folders, recursively). Examples include a page layout with its accompanying images and fonts,
and the individual pages in a book.

To inject a job folder in a flow, you need an active flow. Otherwise it will take the folder path
of this folder as its new input folder and will treat all files as single jobs. The job folder will be
moved along the flow and processed as a single entity.

It is also possible to submit job folders through a "Submit hierarchy". In that case you need to
make sure that the "Subfolder levels" property is set correctly, as explained in working with
subfolders above. For example, if you have a subfolder for each of your customers and these
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subfolders contain the jobs, the "Subfolder levels" property should be set to 1. If you would set
this property to 2, the job folder would be treated as yet another subfolder level and the files in
the job will be processed as separate files.

Job dismantler

In some situations you need to dismantle a job folder and continue with the job's files as
separate entities. Often this is because the files arrived inside a folder, but in reality they are not
part of a single logical entity. Sometimes you just want to deal with (some of) the components of
a job.

For example:

• Customers submit a "job folder" that contains a number of related PDF files, but you really
want to preflight each of them separately.

• You use the uncompress tool to unzip a zip archive, resulting in a job folder that contains all
of the files from the ZIP archive.

• You want to review each of the images inside a page layout job (outside of the job's context).

In these situations you can use the job dismantler to retrieve the individual files from the job
folder.

When you dismantle a job, you need to set the "Subfolder levels" property correctly. This
property behaves in the same way as what is explained above for Submit hierarchies i.e. it
determines how many levels Switch will search for individual files from the job.

Job assembler

Vice versa, sometimes you need to gather a number of files and keep them together through the
rest of the flow.

For example:

• You need to group individual PDF files that will have to be merged into a single document.
• You want to send out an email for every 10 files that arrived in some input folder.
• You would like to insert a file (for example, a preflight report) into an existing job folder.

The job assembler supports various ways of determining which files go together in a job:

• Merge by file name: the file names must contain a numbering scheme (e.g. "page X of Y")
• Complete job every N files: a job is created when N files are collected.
• Complete job every N minutes: a job is created every N minutes.

By default all newly created job folders are named "Job" followed by a running count.

To create a job with (nested) subfolders, you can use the same mechanisms as described above
for archive hierarchies. See Using hierarchy info on page 237 for more details.

Leaving originals in place
By default, Switch moves incoming jobs out of the input folder when injecting them into a flow.
Therefore, Switch needs full access rights to rename, create and remove files and folders in the
input folder.

However, a number of key flow elements (Folder (user-managed input), Submit hierarchy,
FTP receive and Mail receive) also support a read-only mode, activated by setting the Leave
originals in place property for the flow element to Yes. In that case, Switch does not write
anything to the input folder, so read-only access rights suffice.
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Ignore updates

Leave originals in place has "Ignore updates" as subordinate option.

If Ignore Updates is set to Yes, Switch processes a job only once, ignoring any changes to the
job's file size or modification date after it was initially processed. This can be used in workflows
where Switch replaces the input job by a processing result, without triggering an endless loop.

If set to No, Switch will reprocess a job when its file size or modification date changes. This can
be useful when submitting a job with the same name of a previously submitted job. In this case,
Switch will use the list of already processed jobs (see below).

How it works

For each flow element operating in read-only mode, Switch maintains a list of all files/ folders in
the input folder that were already processed (i.e. actually injected in the flow or skipped due to
filters).

Switch automatically updates the list at regular intervals as follows:

• Items that are updated or replaced in the input folder are reprocessed if "Ignore Updates"
is set to "No"; changes are detected by looking at the byte count and at the most recent of
creation date and modification date.

• Items that disappear from the input folder are removed from the list (to keep its size down).

Reprocessing originals

The user can manually clear the list of jobs already processed as follows:

• Choose the Reprocess originals context menu for the relevant flow element. This causes all
remaining original items to be reprocessed when the flow is next activated.

• Certain flow design changes (e.g. set Leave originals in place to No; change backing folder)
automatically clear the list when the flow is next activated.
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Configurators
A configurator is a Switch flow element that connects to a third-party application from within a
Switch flow. The application must be installed on the same computer as Switch (and it will also
be launched on that computer).

You can only use configurators, if you have licensed the Configurator Module.

Note:  There is one exception: if you have an active PitStop Sever license, the PitStop
Server and the PitStop Server PDF2Image Configurator are always available.

Benefits of a configurator

Depending on the application's characteristics, a Switch configurator provides a lot of benefits:

• The application's settings are configured from within Switch through the configurator's
properties, providing a single point of setup for all steps in a flow.

• Interactive applications offering no or limited automation capabilities are turned into fully
automated solutions.

• Multiple configurations for the same application can be used in parallel without the need for
complex hot folder structures.

• Switch automatically launches the application when it is needed.
• Switch controls all file movement to and from the application, fully integrating its operation

with all Switch features including job tracking and logging, processing statistics, and so
forth.

• The application's function is documented in the context of the complete flow.

Interacting with other applications

Switch includes configurators for a number of frequently-used applications.

While Enfocus intends to add more configurators in future versions of Switch, it is not feasible
to include every relevant application on the market. Switch offers some important options to
automate or interact with third-party applications for which there is no configurator:

• The Generic application tool allows to control any third-party application that supports hot
folders.
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• Execute command allows to configure command-line applications through the regular Switch
user interface (rather than console commands and options).

• The scripting capabilities of Switch allow interaction with the host operating system and with
any application that allows scripting.

For more information, refer to the section about the Configurator Module on page 379.

Using hierarchy info
A key feature of Switch is its ability to

• Remember a job's origin and routing information, and

• Use this information when placing the job in a folder hierarchy (Example: for archiving).

This information is called hierarchy info. It is stored in the job's internal job ticket under the
form of a hierarchy location path, as described below.

See also Working with folders on page 231.

Hierarchy location path

The hierarchy location path (stored in a job's internal job ticket) consists of zero or more
segments, and each segment represents the name of a (sub)folder in a nested folder structure.
The first segment represents the top-level folder.

For example, the hierarchy location path consisting of the segments "CustomerA", "Input" and
"PDF", in that order, represents the following folder structure:

 

 

Remembering hierarchy info

Most producers allow remembering hierarchy info depending on a job's origin, and provide
properties to configure what's remembered. For example, a "Submit hierarchy" element
allows remembering its own name and/or the relative path to the subfolder where the job was
submitted.

A folder allows adding the folder name to the location path (at the top or at the bottom). This can
be used to create additional hierarchy levels. For example, separating input and output jobs for
each customer.

Using hierarchy info

Some elements, and most notably the archive hierarchy, use the hierarchy information
remembered for each job to place the job in an appropriate nested folder structure.

Switch automatically creates any folders needed for the (nested) hierarchy.

Example

For example, consider this flow:
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And the following configuration details:

• Submit is configured to remember one level of subfolders, and those subfolders are named
for different customers.

• Downsample is configured to produce a JPEG thumbnail of the incoming image file.
• Proof and Original are configured to add their own folder name at the bottom of the hierarchy

location path.
• Archive is configured to accept two subfolder levels.

Then the following Submit hierarchy:

 

 

Will result in this Archive hierarchy:

 

 

Specifically, submitting a file named "File.tif" in folder Submit/CustomerA will result in two
archived files (in addition to the proof being mailed out):

• The original "File.tif" will be placed in Archive/CustomerA/Original.
• The downsampled copy "File.jpg" will be placed in Archive/CustomerA/Proof.

And naturally submitting a file in folder Submit/CustomerB will result in two archived files under
the Archive/CustomerB/... structure.

Using email info in Switch
A key feature of Switch is the ability to attach email information to the jobs that are being
processed and use this info to send notifications or receipts.

For example:
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• If jobs are submitted through e-mail, Switch can use the sender's email address to send him/
her a receipt.

• Additional email info (email addresses or body text) may be attached to a job, e.g. to also
inform customer sales representatives or operators of new jobs that were injected in the
flow.

• If jobs are submitted in a folder hierarchy, notifications can be sent based on the folder the
job is in. This is useful if the folders have the name of the customers or refer to the type of
job being submitted.

"Email info" in Switch refers to both (a list of) email addresses and body text. This information
is stored in the job's internal job ticket, so it can move along the Switch flows as metadata and be
retrieved through variables ([Job.EmailBody] and [Job.EmailAddress]).

Note that Switch combines new email information with any email information already present.
Email addresses are added to the list, and body text is appended to what's there (inserting a line
break if needed). Existing email info is never removed.

The following topics explain how you can attach email info to a job in Switch and how this info
can be used to send the appropriate email message to the appropriate recipient. This is also
illustrated in the following example flow:

 

 

1. Email info is attached when the job comes in. In this example, jobs are submitted via a
Submit point and for example the email address of the user submitting the job is attached.

2. Extra email info is attached when the job is moving along the flow. In this example, the
preflight status is added as email info.

3. The attached email info is used when (part of the) processing is finished to notify operators,
customers or sales representatives. The Mail send tool is needed to send the notifications.

Attaching email info to a job - flow elements
Associating email information with jobs submitted to Switch is possible through the
configuration of the relevant flow element properties. Not all flow elements support email
information; only the ones that have properties related to email info. These properties must be
configured appropriately as described further in this document.

Note:  Remember that the (email) info attached to the job can be used by other flow
elements that support variables.

The following table gives an overview of the flow elements that allow you to attach email info to
the job's internal job ticket.
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Flow element Properties

Mail receive (submitted jobs) • Attach email info: if enabled, the sender's email address
(not the body text!) is copied to the job's metadata.

• Attach extra email info: allows you to add extra email
addresses or body text to the job's metadata. You can
define different email info depending on who's the sender
(email address or email account name), or what's in the
message subject line. For example, you could attach
mail X to jobs from customer X and mail Y to jobs from
customer Y. How to do this is explained in Attaching email
info - the email info map on page 241.

FTP receive (submitted jobs) Attach email info: allows you to associate email addresses
and body text based on the name of the folder on the FTP
server that holds the job. This is useful if the folder name
reflects the type of job, or if it refers to the customer.

Submit hierarchy (submitted
jobs)

Attach email info: allows you to associate email addresses
and body text based on the name of the folder the job resides
in. This is useful if the folder name reflects the type of job, or
if it refers to the customer.

Folder (submitted jobs +
jobs moving along the flow)

• Attach email addresses: allows you to add one or more
email addresses.

• Attach email body text: allows you to add an email
message.

Note that here it is not possible to differentiate between
jobs; all jobs will get associated with the same list of
addresses and with the same body text.

Some use cases:

• Accumulate an audit trail of status messages in the email
body text as a job moves along a flow, and email the audit
trail to a supervisor at the end of the flow.

• Associate a different email address with a job depending
on its status in the flow (e.g. passed preflight test or not).

• Sort jobs based on filename (or any other criteria) and
then associate a different email address with a job
depending in how it was sorted.

Job Dismantler (jobs moving
along the flow)

Attach email info: allows you to associate email addresses
and body text based on the folder name the job belongs to.
This is useful if the folder name reflects the type of job, or if
it refers to the customer.

Flow elements that become available if you have licensed the SwitchClient Module also allow
attaching email info, as shown in the table below. For more info, refer to the SwitchClient Module
on page 484.
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Flow element Properties

Submit point • Attach user as email info: allows you to add the email
address of the user that submits the job to Switch.

• Attach extra email info: allows you to add extra email
information. The information added can vary depending
on the user submitting the job.

Checkpoint Attach user as email info: allows you to add the email
address of the user that handles the job.

Attaching email info - the email info map

How it works

In order to differentiate between the different jobs and the email addresses/messages that have
to be associated with them, you must build a mapping table (called email info map).

Each entry in that map consists out of three elements:

• A key, used to identify the job and to determine which message/address(es) must be
attached.

• In case of FTP receive, Submit hierarchy, Folder and Job dismantler, this is a folder
name.

• In case of a Submit point, this is the name of the Switch user that submits the job.
• In case of Mail receive, this is the sender's email address or email account or a key word

that must be present in the mail subject line (depending on what you select in the Base
map key on property (subordinate property of Attach extra email info).

By default, the mapping table contains an entry for the special key <all>. This entry allows you
to specify email info that should be added to all jobs, regardless of their key. If this key is
left empty, however, it will be ignored.

• One or more email addresses that will be attached to the job. Make sure to use semicolons
(not surrounded by spaces) to separate the email addresses.

• An email message consisting of one or more paragraphs. You can use Switch variables in
your body text, for example to refer to the name of the job.

The email info map can contain as many entries as you need. Note that the order of the entries
in the map is not important.

Example 1: Attaching email info through FTP receive

Let's say that you've set up an FTP site where your customers submit jobs.There is a separate
subfolder for each of your customers (with the appropriate access rights) and you want to make
sure that the responsible account manager is informed.

To achieve this:

1. Configure an FTP receive flow element. Make sure to check all the relevant subfolders (see
"Subfolder levels" property).

2. Click Attach email info and create an email info map, mapping the name of the customer's
subfolder (the "key") to the responsible account manager's email address, as shown below.
Note that you could enter the customer's email address as well, as required.

3. Further in the flow, configure a Mail send flow element (see Using attached email info on
page 243 ).
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Note:

• FTP receive always uses subfolder names as the key, whereas as Mail receive allows
selecting the basis for the key ("base map key on").

• It is possible to have multiple key matches for the same job. For example, if a job
is submitted in a nested subfolder some levels deep, FTP receive uses each of the
subfolder names in the nested subfolder path as a key in the mapping table. The
email information for all matches is combined and associated with the job. This is
also the case for the <all> key.

Example 2: Attaching email info through Mail receive

Suppose the jobs in your flows are submitted through mail. You want to attach the sender's
email address (for future reference) as well as the account manager's email address.

In order to achieve this:

1. Configure a Mail receive flow element.
2. Set Attach email info to Yes, to make sure the sender's email address is stored.
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3. Set Attach extra email info to Yes and configure the subordinate properties:

• Base map key on Sender's email address.

• Create an email info map, making sure the keys are your customer's email addresses.
Note that the email address in the map key can be either the complete email address or
only the part in front of/following the @ sign.

 

 

Note:  In the above example, jobs from customers that are NOT in the list will match the
<all> key. Jobs from customers that are listed, will be associated with the corresponding
email address info AND with the info behind the <all> key.

Using attached email info
There are two ways to use email info attached to jobs in Switch:

• You can use the variables related to email, such as [Job.EmailAddress] and [Job.Emailbody],
at any stage in the flow.

• You can use the attached info email in the Mail send flow element, using the following
properties:

• Include attached addresses

• Include attached body text

Example

Properties:
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Below is an example of a mail sent via a Mail send flow element with the properties shown higher:

• The email address in the From field is the address specified in the Switch Mail send
preferences (User name property).

• The To field contains the email address(es) entered in the To addresses property (of Mail
send) and the addresses attached to the job concerned.

• The Subject is the one specified in Mail send - Subject.

• The job file is attached.

• The body text contains the phrase "This is an automatically generated message" followed by
the email message that was attached to the job earlier in the Switch flow.
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Note that this message contains two variables that were selected when configuring the email
message: [Job.Origin] and [Switch.Date:TimeZone="UTC"].

Note:  Users of the Switch Web Portal can use the attached email info in a similar way
with Checkpoint via mail on page 187 to send reply messages for jobs arriving in the
Checkpoint.

Acknowledged job hand-off
The Pack job, Unpack job, and Monitor confirmation tools can be used to implement
acknowledged hand-off of jobs between instances of Switch running on separate computers,
regardless of the communication channel used to transfer the data. The involved instances of
Switch may reside on the same local network, or they may be in remote locations connected
through the Internet (or any other communications channel).

Furthermore, Pack job and Unpack job can carry over any Switch metadata associated with
the job, including internal job ticket information (such as email and hierarchy information),
external metadata and (of course) embedded metadata. This feature can be used with or without
acknowledged hand-off.

Example flow on sender's side
 

245



Switch

 

Example flow on receiver's side
 

 

Specifying file filters
Several Switch tools offer file or folder filter properties, including for example:

• the "Include/exclude these jobs" properties on connections leaving a folder.
• the "Include/exclude these folders" properties on connections leaving an FTP receive

instance.

Each of these properties can be set to a particular file or folder filter that "matches" a certain
category of jobs based on the filter's characteristics.
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File filters
A file filter is applied to a job (file or job folder) being submitted to or moving along a flow. The
following table lists the various supported filter types.

Filter type Description

All jobs Matches all files and job folders; is used as the default for
"Include" properties

No jobs Matches no files or job folders; is used as the default for
"Exclude" properties

All other jobs Matches all files and job folders not moved by any other
connection (see All other files for more details)

Define file types A predefined list of cross-platform file types.

A file matches the filter if its Mac file and creator types and/or
its filename extension match any of the specified types

A job folder matches the filter if any of the files at the topmost
level inside the folder match any of the specified types (or if
the list of types contains the special "Folder" type)

Define file patterns A list of filename pattern strings entered in a dialog; a pattern
includes one or more of the following wildcard characters (in
addition to regular characters that must match exactly):

• * (asterisk): matches zero or more arbitrary consecutive
characters

• ? (question mark): matches exactly one arbitrary character

A file matches the filter if its filename matches any of the
patterns in the list.

A job folder matches the filter if its folder name matches any
of the patterns in the list.

Define regular expression A regular expression (i.e. a more complex pattern; see Regular
Expressions on page 253 for more details)

A file matches the filter if its filename completely matches the
regular expression.

A job folder matches the filter if its folder name completely
matches the regular expression.

Define condition with
variables

A condition expressed through variables; see Defining a
condition with variables on page 411
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Filter type Description

Define script expression A script expression that returns a Boolean result (true or
false)

All other files

A common problem while creating connections from a flow element is how to capture those
files or job folders not matched by any other connection. The "All other jobs" filter addresses
this problem; all files or job folders that do not match one of the connections with another filter
(example: file type, file pattern, regular expression) are matched by this filter.

For example: imagine a flow element with one connection that matches all PDF files and a
second connection that matches all PostScript files. Adding a third connection where the
"Include these jobs" property is set to "All other jobs" causes all files that are not PDF or
PostScript to be matched (i.e. moved through this third connection).

A flow element can have more than one outgoing connection that uses the "All other jobs"
filter. In that case all of these connections match the same set of files and job folders: those not
matched by other connections using e.g. file type, file pattern or regular expression filters.

Folder filters
A folder filter is applied to a subfolder of the folder hierarchy from which files are being
retrieved.

Filter type Description

All folders Matches all folders; is used as the default for "Include"
properties

No folders Matches no folders; is used as the default for "Exclude"
properties

All other folders Matches all folders not matched by any other connection; the
semantics are similar to the "All other jobs" file filter (see All
other jobs for more details)

Folder patterns A list of folder name pattern strings entered in a dialog;
a pattern includes one or more of the following wildcard
characters (in addition to regular characters that must match
exactly):

• * (asterisk): matches zero or more arbitrary consecutive
characters

• ? (question mark): matches exactly one arbitrary character

A folder matches the filter if its folder name matches any of
the patterns in the list

Regular expression A regular expression (i.e. a more complex pattern; see the
separate topic for more details)
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Filter type Description

A folder matches the filter if its folder name completely
matches the regular expression

Script expression A script expression that returns a Boolean result (true or
false)

Process these folders
The objective is to offer more flexibility for defining the subset of the folder hierarchy to be
processed. This is accomplished by offering a variable list of powerful rules.

Properties

The tool offers the following new properties:

Property name Description Editors Default

Process these folders Defines the ‘initial' set
of folders that should
be processed by the
submit hierarchy tool;
this set can be adjusted
by defining one or more
rules in subsequent
properties

Possible values are:

• All folders
• No folders

Dropdown list All folders

Adjusted by (rule 1) Defines a rule for
adjusting the set of
folders that should be
processed by including
or excluding folders

Possible values are:

• Including folders
named

• Including folders not
named

• Excluding folders
named

• Excluding folders not
named

Dropdown list None

.. Folder name A pattern for the folder
name to be included or
excluded

Folder patterns
Regular
expression
Script
expression

Empty
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Property name Description Editors Default

.. On levels The level or range of
levels to which this
rule applies, in the
same format as the
old "Subfolder range"
property

Single-line text Empty

.. Restriction Defines an optional
restriction on the parent
or ancestors for the
folder in this rule

Possile values are:

• None
• With immediate

parent named
• With no immediate

parent named
• With any ancestor

named
• With no ancestor

named

Dropdown list None

.... Parent name or

.... Ancestor name

A pattern for the folder
name of the parent or
ancestor

Folder patterns
Regular
expression
Script
expression

Empty

.. Nesting Defines whether this
rule operates on
subfolders of the target
folder, which are deeper
in the hierarchy than
the defined level range.
The matching rule is
also applied on these
subfolders.

Possible values for
"including" rule are:

• Include nested
subfolders as well

• Don't include nested
subfolders

Possible values for
"excluding" rule are:

• Exclude nested
subfolders as well

• Dont exclude nested
subfolders

Dropdown list "Don't
include…" or
"Exclude…"
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Property name Description Editors Default

Adjusted by (rule 2)

....

Adjusted by (rule 5)

Same as rule 1 with
an identical set of
dependent properties

Applying rules

The rules are applied in the same order as they are specified. It is perfectly possible for a rule to
exclude folders that were included by a previous rule, or vice versa.

For example, consider a hierarchy with two levels (in addition to the root folder) and where each
level has three folders called A, B, C. Now, consider the following rules:

• Start with no folders
• Include folders named C on level 2 (with or without nesting)
• Exclude folders named C on level 1 (with nesting)

These rules will process all jobs in folders A/C and A/B, but not in folder C/C (because it was
excluded in the second rule), and not in any of the other folders (because they were never
included to begin with).

Reversing the order of the rules would change the result (files in folder C/C will be processed as
well), because excluding something from an empty set has no effect.

Upgrading

When upgrading from a previous version of Switch, the new properties are initialized as follows:

• The new "Process these folders" property is set to "All folders"
• If the old "Process only these folders" property is not set to "All folders", a rule is created as

indicated in the following table
• If the old "Skip these folders" property is not set to "No folders", a rule is created as

indicated in the following table

If both old properties are present, the rules are listed in the order presented above (although
the order is not important).

Property name Value for "Process only
these folders"

Value for "Skip these
folders"

Adjusted by "Excluding folders not
named"

"Excluding folders named"

.. Folder name The value of the "Process
only these folders" property

The value of the "Skip these
folders" property

.. On levels The value of the
corresponding dependent
property

The value of the
corresponding dependent
property

.. Restriction "None" "None"

.. Nesting "Exclude nested subfolders
as well"

"Exclude nested subfolders
as well"

These values should produce the same behavior as in the previous Switch version.
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Unique name prefixes

Internal job tickets

A key feature of Switch is its ability to remember information about a job (file or job folder) while
it is being processed through a flow. This information is stored in an internal job ticket managed
by Switch.

The internal job ticket for each job contains housekeeping information (such as where the job
was last located) in addition to information about the job's origin and routing.

For example, a job's hierarchy info and email info (attached by specific tools) are stored in its
internal job ticket.

Switch needs a way to associate a particular internal job ticket with its corresponding job, and
vice versa. To maximize flexibility and transparency for the user, Switch uses the filename as
the basis for this mechanism rather than hiding jobs in some database. However Switch may
be handed two or more jobs with the same name (in different input folders, or even in the same
input folder after the first job was moved along).

Thus Switch employs a "trick" to keep similarly named jobs apart: unique name prefixes.

Unique name prefixes

A job is associated with its internal job ticket by prefixing the file or folder name with a unique
identifier that consists of five letters or digits preceded and followed by an underscore.

For example: "myjob.txt" may become "_0G63D_myjob.txt".

Note that the files inside a job folder are not renamed; only the job folder name receives the
unique name prefix. When a job folder is disassembled into separate files, each of the files of
course receives its own unique name prefix.

For the technically-minded: each of the five characters in the unique name prefix can be a digit
(0-9) or an uppercase letter (A-Z). This allows 36^5 or about 60 million combinations. A different
unique name prefix can be generated every second for about 23 months.

Switch generates a new unique name prefix (and a corresponding internal job ticket) when:

• It detects a job in a folder or in a submit hierarchy.
• It makes a copy of a job.
• A producer (such as email receive) injects a new job in the flow.
• A processor produces a secondary output job that is injected in the flow.

The primary output of a processor (i.e. the incoming job with any changes applied by the
processor) retains the same unique name prefix as the incoming job.

When a job loses its unique name prefix (for example because the "strip unique name" property
is set for an archive or a final folder), it also loses the association with its internal job ticket.

Handing over jobs between flows

Switch can pass along a job from one flow to another without loosing the job's association
with its internal job ticket (assuming both flows are being executed by the same instance of
Switch; hand-over between different instances of Switch does not preserve the internal job
ticket information at this time).

This feature enables splitting up a complex flow in smaller segments without losing any
information.
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To hand over jobs from flow A to flow B:

• In flow A, create a user-managed folder with no outgoing connections and make sure its
"strip unique name" property is set to No.

• In flow B, create a user-managed folder with the same backing folder (the folder in flow B
may or may not have incoming connections).

 

 

Remark:

The following configuration is currently not supported:

• In flow A, the "strip unique name" property of the user-managed folder set to No.
• In flow B, the "leave originals in place" property of the user-managed folder with the same

backing folder set to Yes.

Note:  Switch cleans up job tickets in end folders at a regular interval as set in the
Application Data preference. Make sure that the job ticket is handed over to the second
flow in a timely manner.

Regular Expressions

Note:  The contents of this topic is adapted from documentation provided by Trolltech.

Introduction

Regular expressions, or "regexps", provide a way to find patterns within text. This is useful
in many contexts, for example a regexp can be used to check whether a piece of text meets
some criteria. In Switch a regular expression can be used to sort files based on some naming
scheme: only files with a name that matches the regular expression are allowed to pass through
a certain connection.

While this is almost surely of no concern for the use of regexps in Switch, it is good to know
that not all regexp implementations are created equal. Most implementations provide identical
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results for basic expressions, but the results for more advanced expressions and matches may
differ in subtle ways.

The Switch regexp language is modeled on Perl's regexp language, A good reference on regexps
is Mastering Regular Expressions: Powerful Techniques for Perl and Other Tools by Jeffrey
E. Friedl, ISBN 1565922573. Several web sites offer tools for working with regexps or provide
libraries with examples for matching all sorts of patterns. One simple tool to start playing with
regexps can be found at http://www.roblocher.com/technotes/regexp.aspx.

Brief tutorial

Regexps are built up from expressions, quantifiers, and assertions. The simplest form of
expression is simply a character, example, x or 5. An expression can also be a set of characters.
For example, [ABCD] will match an A or a B or a C or a D. As a shorthand we could write this as
[A-D]. If we want to match any of the capital letters in the English alphabet we can write [A-Z]. A
quantifier tells the regexp engine how many occurrences of the expression we want, e.g. x{1,1}
means match an x which occurs at least once and at most once. We will look at assertions and
more complex expressions later.

We will start by writing a regexp to match integers in the range 0 to 99. We will require at least
one digit so we will start with [0-9]{1,1} which means match a digit exactly once. This regexp
alone will match integers in the range 0 to 9. To match one or two digits we can increase the
maximum number of occurrences so the regexp becomes [0-9]{1,2} meaning match a digit at
least once and at most twice. However, this regexp as it stands will not match correctly. This
regexp will match one or two digits within a string. To ensure that we match against the whole
string we must use the anchor assertions. We need ^ (caret) which when it is the first character
in the regexp means that the regexp must match from the beginning of the string. And we also
need $ (dollar) which when it is the last character in the regexp means that the regexp must
match until the end of the string. So now our regexp is ^[0-9]{1,2}$. Note that assertions, such
as ^ and $, do not match any characters.

If you have seen regexps elsewhere, they may have looked different from the ones above.

This is because some sets of characters and some quantifiers are so common that they have
special symbols to represent them. [0-9] can be replaced with the symbol \d.

The quantifier to match exactly one occurrence, {1,1}, can be replaced with the expression
itself. This means that x{1,1} is exactly the same as x alone. So our 0 to 99 matcher could be
written ^\d{1,2}$. Another way of writing it would be ^\d\d{0,1}$, i.e. from the start of the
string match a digit followed by zero or one digits. In practice most people would write it ^\d
\d?$. The ? is a shorthand for the quantifier {0,1}, i.e. a minimum of no occurrences and a
maximum of one occurrence. This is used to make an expression optional. The regexp ^\d\d?$
means "from the beginning of the string match one digit followed by zero or one digits and then
the end of the string".

Our second example is matching the words 'mail', 'letter' or 'correspondence' but without
matching 'email', 'mailman', 'mailer', 'letterbox' etc. We will start by just matching 'mail'. In
full the regexp is m{1,1}a{1,1}i{1,1}l{1,1}, but since each expression itself is automatically
quantified by {1,1} we can simply write this as mail; an m followed by an a followed by an i
followed by an l. The symbol | (bar) is used for alternation, so our regexp now becomes mail|
letter|correspondence which means match 'mail' or 'letter' or 'correspondence'. Whilst this
regexp will find the words we want it will also find words we do not want such as 'email'.

We will start by putting our regexp in parentheses, (mail|letter|correspondence).

Parentheses have two effects, firstly they group expressions together and secondly they identify
parts of the regexp that we wish to capture for reuse later on. Our regexp still matches any of
the three words but now they are grouped together as a unit. This is useful for building up more
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complex regexps. It is also useful because it allows us to examine which of the words actually
matched.

We need to use another assertion, this time \b "word boundary": \b(mail|letter|
correspondence)\b.

This regexp means "match a word boundary followed by the expression in parentheses followed
by another word boundary". The \b assertion matches at a position in the regexp not a character
in the regexp. A word boundary is any non-word character such as a space, a newline or the
beginning or end of the string.

Characters and abbreviations for sets of characters

Element Meaning

c Any character represents itself unless it has a special regexp meaning.
Thus c matches the character c.

\c A character that follows a backslash matches the character itself except
where mentioned below. For example if you wished to match a literal caret
at the beginning of a stringyou would write \^.

\a This matches the ASCII bell character (BEL, 0x07).

\f This matches the ASCII form feed character (FF, 0x0C).

\n This matches the ASCII line feed character (LF, 0x0A, Unix newline).

\r This matches the ASCII carriage return character (CR, 0x0D).

\t This matches the ASCII horizontal tab character (HT, 0x09).

\v This matches the ASCII vertical tab character (VT, 0x0B).

\xhhhh This matches the Unicode character corresponding to the hexadecimal
number hhhh (between 0x0000 and 0xFFFF).

\0ooo (i.e. zero ooo) This matches the ASCII/Latin1 character corresponding to
the octal number ooo (between 0 and 0377).

. (i.e. period) This matches any character (including newline).

\d This matches a digit.

\D This matches a non-digit.

\s This matches a whitespace.

\S This matches a non-whitespace.

\w This matches a word character (letter or number or underscore).

\W This matches a non-word character.
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Element Meaning

\n This matches the n-th backreference, e.g. \1, \2, etc.

Sets of characters

Square brackets are used to match any character in the set of characters contained within
the square brackets. All the character set abbreviations described above can be used within
square brackets. Apart from the character set abbreviations and the following two exceptions no
characters have special meanings in square brackets.

Character Meaning

^ The caret negates the character set if it occurs as the first
character, that is immediately after the opening square
bracket. For example, [abc] matches 'a' or 'b' or 'c', but [^abc]
matches anything except 'a' or 'b' or 'c'.

- The dash is used to indicate a range of characters, for
example, [W-Z] matches 'W' or 'X' or 'Y' or 'Z'.

Using the predefined character set abbreviations is more portable than using character ranges
across platforms and languages. For example, [0-9] matches a digit in Western alphabets but \d
matches a digit in any alphabet.

Note that in most regexp literature sets of characters are called "character classes".

Quantifiers

By default an expression is automatically quantified by {1,1}, i.e. it should occur exactly once. In
the following list E stands for any expression. An expression is a character or an abbreviation for
a set of characters or a set of characters in square brackets or any parenthesized expression.

Quantifier Meaning

E? Matches zero or one occurrence of E. This quantifier means "the
previous expression is optional" since it will match whether or not
the expression occurs in the string. It is the same as E{0,1}. For
example dents? will match 'dent' and 'dents'.

E+ Matches one or more occurrences of E. This is the same as E{1,}.
For example, 0+ will match '0', '00', '000', etc.

E* Matches zero or more occurrences of E. This is the same as E{0,}.
The * quantifier is often used by mistake. Since it matches zero or
more occurrences it will match no occurrences at all. For example
if we want to match strings that end in whitespace and use the
regexp \s*$ we would get a match on every string. This is because
we have said find zero or more whitespace followed by the end of
string, so even strings that don't end in whitespace will match. The
regexp we want in this case is \s+$ to match strings that have at
least one whitespace at the end.
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Quantifier Meaning

E{n} Matches exactly n occurrences of E. This is the same as repeating
the expression n times. For example, x{5} is the same as xxxxx. It
is also the same as E{n,n}, e.g. x{5,5}.

E{n,} Matches at least n occurrences of E.

E{,m} Matches at most m occurrences of E. This is the same as E{0,m}.

E{n,m} Matches at least n occurrences of E and at most m occurrences of
E.

If we wish to apply a quantifier to more than just the preceding character we can use
parentheses to group characters together in an expression. For example, tag+ matches a 't'
followed by an 'a' followed by at least one 'g', whereas (tag)+ matches at least one occurrence of
'tag'.

Note that quantifiers are "greedy". They will match as much text as they can. For example, 0+
will match as many zeros as it can from the first zero it finds, e.g. '2.0005'.

Capturing text

Parentheses allow us to group elements together so that we can quantify and capture them. For
example if we have the expression mail|letter|correspondence that matches a string we know
that one of the words matched but not which one. Using parentheses allows us to "capture"
whatever is matched within their bounds, so if we used (mail|letter|correspondence) and
matched this regexp against the string "I sent you some email" we would capture 'mail'.

We can use captured text within the regexp itself. To refer to the captured text we use
backreferences which are indexed from 1. For example we could search for duplicate words in
a string using \b(\w+)\W+\1\b which means match a word boundary followed by one or more
word characters followed by one or more non-word characters followed by the same text as the
first parenthesized expression followed by a word boundary.

If we want to use parentheses purely for grouping and not for capturing we can use the non-
capturing syntax, e.g. (?:green|blue). Non-capturing parentheses begin '(?:' and end ')'. In
this example we match either 'green' or 'blue' but we do not capture the match so we only
know whether or not we matched but not which color we actually found. Using non-capturing
parentheses is more efficient than using capturing parentheses since the regexp engine has to
do less book-keeping.

Both capturing and non-capturing parentheses may be nested.

Anchors

Anchors match the beginning or end of the string but they do not match any characters.

Regular expressions entered in the Switch user interface always match the complete string. In
other words the regexp is automatically anchored at the beginning and at the end of the string,
and you shouldn't specify explicit anchors. (Regular expressions specified in a Switch JavaScript
program should include explicit anchors as needed).
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Anchor Meaning

^ The caret signifies the beginning of the string. If you wish
to match a literal ^ you must escape it by writing \^. For
example, ^#include will only match strings which begin with the
characters '#include'. (When the caret is the first character of a
character set it has a special meaning, see Sets of Characters.)

$ The dollar signifies the end of the string. For example \d\s*$
will match strings which end with a digit optionally followed by
whitespace. If you wish to match a literal $ you must escape it by
writing \$.

Assertions

Assertions make some statement about the text at the point where they occur in the regexp but
they do not match any characters. In the following list E stands for any expression.

Assertion Meaning

\b A word boundary. For example, the regexp \bOK\b means match
immediately after a word boundary (example: start of string or
whitespace) the letter 'O' then the letter 'K' immediately before another
word boundary (example: end of string or whitespace). But note that
the assertion does not actually match any whitespace so if we write
(\bOK\b) and we have a match it will only contain 'OK' even if the string
is "It's OK now".

\B A non-word boundary. This assertion is true wherever \b is false. For
example, if we searched for \Bon\B in "Left on" the match would fail
(space and end of string are not non-word boundaries), but it would
match in "tonne".

(?=E) Positive lookahead. This assertion is true if the expression matches at
this point in the regexp. For example, const(?=\s+char) matches 'const'
whenever it is followed by 'char', as in 'static const char *'. (Compare
with const\s+char, which matches 'static const char *'.)

(?!E) Negative lookahead. This assertion is true if the expression does
not match at this point in the regexp. For example, const(?!\s+char)
matches 'const' except when it is followed by 'char'.

Note:  Positive and negative lookbehind are currently not supported.

Case insensitive matching

You can make the complete regexp case insensitive by surrounding it by the /.../i constuct. More
precisely, if the regexp starts with a forward slash and ends with a forward slash followed by the
letter i, then matching for the complete regexp is case insensitive.

For example:
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Regexp Matches these strings

ABC ABC

abc abc

/ABC/i ABC, abc, Abc

/ABC/ /ABC/

JavaScript for applications

Introduction

The Adobe Creative Suite applications (Acrobat, Photoshop, Illustrator and InDesign) can be
extensively scripted through JavaScript (a scripting language interpreted and executed by the
application). All four applications offer a similar overall interface for working with JavaScript,
although each application offers a different set of JavaScript functions to actually control the
application's functionality

The JavaScript programming interface for each application is documented in the application's
software development toolkit which can be found on the Adobe web site. The Adobe Creative
Suite bundle includes the "ExtendScript Toolkit" application which is extremely useful for
developing and debugging JavaScript scripts for Adobe Creative Suite applications.

The Switch configurators for the four applications mentioned above allow posting a JavaScript
script to the application for execution. Combined with Switch's built-in capabilities this provides
powerful control of the Adobe Creative Suite applications.

Note:  In the remainder of this topic "application" means one of the four Adobe Creative
Suite applications mentioned above, and "configurator" means the Switch configurator
that controls the application under consideration.

Stages

A configurator defines the action to be executed by its corresponding application in the form of
three consecutive stages:

• Open the file and make it the currently active document.

• Perform a command on the currently active document.

• Save the currently active document and close it.

The desired action for each stage is defined independently, and can be selected from:

• One of the built-in actions listed by name.

• A user-provided script (which is specified by browsing to a JavaScript text file).

Depending on the selected action a number of subordinate properties are shown to further
configure the action. In other words, each choice has its own set of properties.

The properties for the "Use script" choice are described below; those for built-in choices are
described for each configurator separately.
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Properties for specifying a user script

The following set of properties is shown for an action stage if the "Use script" option is selected
for the stage.

Property Description

Script file The text file that contains the JavaScript script to be executed
by the application for this stage

Argument 1 The first argument to be passed to the script (or empty)

Argument 2 The second argument to be passed to the script (or empty)

Argument 3 The third argument to be passed to the script (or empty)

Argument 4 The fourth argument to be passed to the script (or empty)

Argument 5 The fifth argument to be passed to the script (or empty)

There are always five arguments because there is no mechanism to determine how many
arguments are actually needed by the script.

Writing a user script

To write a user script, simply provide the JavaScript statements that should be executed in the
main body of the script file. If your script encounters an error, it should set the $error variable
to the appropriate error message; otherwise it should leave the $error variable alone. See
below for a typical coding pattern.

The following special global variables are defined before your script executes, and thus their
value can be used in your script; in some cases (noted in the variable's description) your script
should also set or update the contents of the variable.

Variable Description

$arg1 The first argument passed to the script (or the empty string if
there is none)

$arg2 The second argument passed to the script (or the empty string if
there is none)

$arg3 The third argument passed to the script (or the empty string if
there is none)

$arg4 The fourth argument passed to the script (or the empty string if
there is none)

$arg5 The fifth argument passed to the script (or the empty string if
there is none)

$infile The absolute path of the input file, including name and extension;
this is used mostly in a script attached to an "open" action
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Variable Description

$doc The currently active document, that is, the document that was
opened by the "open" action; $doc is null for a script attached to
an "open" action (or when the "open" action failed)

Note:

• Use $doc instead of "this" to refer to the currently
active document.

• If you're using a custom 'open' script for the InDesign
or InDesign Server Configurator to open or to create
more than one document, the script must explicitly
set the value for $doc. This is necessary to make
sure the Configurator processes the right document.
For other Adobe applications, the $doc variable is
automatically set to contain the active document.

$outfolder The absolute path of the folder in which to place the output; this
is used mostly in a script attached to a "save" action

$filename The filename (without extension) of the input (and output) file

$extension The filename extension of the input file, or if it does not have one,
the filename extension corresponding to the Mac file types of the
input file

$outfiles The incoming value of this variable is irrelevant

If your script is attached to a "save" action, it should set the
contents of this array variable to the absolute paths of the output
files generated by the script

$jobfolder The incoming value of this variable is irrelevant

If your script is attached to a "save" action, it should set the
contents of this variable as follows:

• The empty string: each output file is moved along the outgoing
connection as a separate job

• The desired name of the job folder: all output files are placed
inside a single job folder with the specified name

$error If an error occurred during the execution of an earlier stage,
or while preparing for the execution of this stage, this variable
contains an appropriate error message: otherwise its value is
null (NOT the empty string; an empty string signifies that an error
indeed occurred but no meaningful error message was generated
-- this is considered bad practice but it may happen)

If your script encounters an error, it should set the $error
variable to the appropriate error message (that is, a non-empty
string); otherwise it should leave the $error variable alone.
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Variable Description

Note:  If $error is set, the script will fail the job and
move it to the 'Error' level data output connections. If
there is no error connection, the job will be moved to the
Problem jobs folder.

Note however that it's possible to explicitly determine
where the job should go to (either to the Error connection
or to the Problems jobs folder) by setting the $status
variable. For more information, refer to the explanation
below.

$status $status allows you to control the output behavior of the error
jobs, by specifying where the error out job must be moved to. You
can also specify to stop the script from further processing in case
of a critical failure.

Note:  The value of $status is ignored if $error is ‘null’.

Possible values:

• error (default value): Failed jobs will be moved to the Error
connection; if no Error connection is found, the jobs are moved
to the Problems folder.

• failJob: Failed jobs are sent to the Problems folder.

• failProcess: In case of problems, all processing is stopped.

Error handling

Here's a typical coding pattern to correctly handle errors in a user script attached to the
command action:

if ($error == null) 
{ 
    try 
    { 
        // statements to be executed by this script 
        // $doc.ApplicationDependentFunction(); 
    } 
    catch( e ) 
    { 
        $error = e.description; 
        $status = failJob;
        // This will move the failed job to Problem Jobs folder. If not set, the
          default is the “Error” level data connection.
        $doc.closeDoc( Application Specific Parameters ); 
        // close any other resources used in the try block 
    }
}

The InDesign and Illustrator configurator produce an XML log file. This is an example:

<AdobeConfiguratorLog>       
 <FlowElementName>ConfiguratorFlowElementName</FlowElementName> 
   <Job>     
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     <Name>NoFontPackage</Name>     
     <Status>Error</Status>
     <StatusMessage>Error Message String</StatusMessage>
     <MissingFonts>             
        <Font>Somora</Font>             
        <Font>XBAND Rough</Font>     
      </MissingFonts> 
   <Job>
</AdobeConfiguratorLog> 

Note:  The log is an XML file named after the incoming job name.

Here's a typical coding pattern to correctly handle errors for Adobe Acrobat application:

// Acrobat is used to make a summary of the annotations resulting in a file that shows
 you the page 
// content and the annotations per page.
// No arguments are required.

if($error == null)
{
 
 try
 {
  var title = $doc.documentFileName + " summary"
  $outfile = $outfolder + '/' + $filename + "_summary.pdf";
  $doc.ANsummarize($doc, title, ANSB_Page, null, $outfile, null, false, true, false,
 false, false, false);
  $outfiles.push($outfile);
 }
 catch(theError)
 {
  $error = theError;
  $doc.closeDoc( {bNoSave : true} );
 }
}

$error

More info needed?

For more information about scripting, refer to the documentation on the Enfocus website.

5.2.5.  Managing flows

5.2.5.1.  Organizing flows

The Flows pane

The Flows pane lists all flows currently known to Switch. It allows organizing these flows in a
hierarchy of groups and subgroups, and provides a context menu for managing flows in various
ways.
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Groups and subgroups

Groups and subgroups are marked with small icons, indicating whether or not the group is
collapsed (so you don't see the flows) and/or the flows are activated.

Icon Meaning

This group is collapsed.

This group is expanded.

• If preceding a group: at least one of the flows of this group is activated.
• If preceding a flow: this flow is activated.

Example:

In the example below, one group with 2 subgroups has been defined.

Group1 and Subgroup1 are expanded; you can see the flows belonging to those groups.

Subgroup2 is collapsed.

Only Flow1 is activated.
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Selecting flows
You can select any number of flows in the Flows pane at the same time.

Note:  When you select a group, all flows and groups in that group are automatically
selected as well, regardless of whether the group is displayed open or closed.

To select one or more flows:

1. To select one flow, in the Flows pane, click it.
The selected flow is shown in the canvas.

2. To select more than one flow at a time, in the Flows pane, click the preferred flows while
holding down the Ctrl or the Shift key.

The selected flows do not have to be consecutive.

All selected flows are shown as tiles in the canvas. Tiles cannot be edited. However, you
can select a particular tile and edit its flow properties in the Properties pane. For more
information, refer to Multiple flows as tiles on page 220.

Adding a group in the Flows pane
You can use groups to organize your flows into a tree-like structure, much like files in a folder
tree. A group can contain flows and other groups, up to any nesting level.

To add a new group in the Flows pane:

1. In the Flows pane

• To add a new group, select the flow after which the new group should be inserted.
• To add a new subgroup, select the group in which the new group should be inserted.

2. Right-click and select New group.

3. In the Properties of the newly inserted group, click the Name field and type an appropriate
name for the group.

The new group is empty. You can move existing flows to the group (see Organizing flows on page
263) or create new flows for that group.

Reorganizing flows in the Flows pane
You can reorganize the order and nesting structure in the Flows pane by dragging the flows
around.

Note:  You can move flows as well as groups; when moving groups, all flows belonging
to that group are moved to the new location.

To move flows to a different location in the Flows pane

1. Select the flow(s) you want to move.

To select multiple flows, hold down the Ctrl key while selecting the flows.
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2. Drag the selected flows to the target location. You can:

• Drop them in between two flows to move them between those flows, or
• Drop them on top of a group to place them inside that group. This works, even if the

group is collapsed.

Ordering flows in the Flows pane
The Flows pane supports three row ordering modes, i.e. three ways to sort the flows:

• Manual ordering: The flows are ordered by manually dragging them into the appropriate
position.

• Sorted by name: At each level in the tree, flows are sorted on the name column (case
insensitive, and regardless of whether they are groups or flows).

• Sorted by marker: At each level in the tree, flows are sorted on the marker column (see
Setting flow markers on page 266), and then on the name column (so that the order is
predictable when rows have the same marker).

To change the sort order in the Flows pane

1. Do one of the following

• To order the flows manually, drag them into the appropriate position.
• To sort by name, click the column header of the Name column.
• To sort by marker, click the column header of the Marker column (small flag icon).

Note:  If the Marker column is not visible, right-click the column header of the
Name column and select Marker column.

2. To toggle between ascending and descending order, click the column header (of the column
you're sorting by).

Setting flow markers
The rightmost column in the Flows pane can display a marker icon selected from a pre-defined
list of icons (including colored flags, priorities, and level of completeness indicators).

The markers have no meaning to Switch. They can be useful to sort flows, for example by
priority or by level of completion.

Flow markers are preserved when exporting and importing flows.

Example Flows pane with markers
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Available icons

Custom image

You can also upload your own custom image and use it as a flow marker.

Groups

Groups only have a marker if all flows belonging to that group have the same marker. For
example, if all flows in a group are marked as Priority 1, the group will be marked as Priority 1
as well.

In all other cases (if none of the flows have a marker, or they have different markers), no marker
is displayed at group level.

Setting a marker for a flow
To set the marker for one or more flows

1. Select the flows you want to mark (with one particular marker).

2. Right-click and select Mark flow.

3. Select the appropriate marker or upload a custom image.
The selected marker icon is displayed next to the flow, in the Marker column. In the
properties of the flow, the Marker image property holds the name of the marker (e.g.
Priority 4) or the name (and path) of the custom image (e.g. /Users/<userX>/my_image.png).

Note:  If the Marker column is not visible, right-click the column header of the Name
column and select Marker column.
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Clearing a marker for a flow
To clear the marker for one or more flows

1. Select the flow(s) for which you want to clear the marker.

2. Right-click to open the context menu.

3. Select Mark flow.

4. Select No marker.
The marker is removed from the Flows pane. In the flow properties, the Marker image
property is set to None.

5.2.5.2.  Changing flow properties
After you have created a flow, you can still make a number of changes. You can for example:

• Rename the flow.
• Add a background and/or a header image.
• Tune the performance of Switch, by overruling a number of default settings for concurrent

job processing (Refer to Allowing advanced performance tuning in Flow properties on page
269).

To change the flow properties

1. In the Flows pane, select the flow of which you want to change the properties.

Note:  Make sure that none of the flow elements in the canvas are selected.
Otherwise, you might see the properties of the element, rather than the properties of
the flow.

The properties of the selected flow are displayed in the Properties pane.

2. Click the property you want to change.
Depending on the selected property, a text box, a button, or a drop-down menu appears.

3. Make the required changes:

If ... appears Do the following:

A text box Type the text in the displayed text field.

A drop-down
menu

Select the appropriate option.

1. In the the property editor dialog that pops up, update the field(s)
as required.

2. Click OK.

1. From the pop-up list, select one of the options.
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If ... appears Do the following:

 

Depending on the selected option, an inline editor or a dialog
appears.

2. Configure the desired values.

For an overview of the properties and their meaning, see Flow properties on page 269.

Your changes are applied immediately.

Flow properties
The following properties are displayed in the Properties pane, when you select a particular flow.

Property Description

Name The name of the flow as it is shown in the Flows pane.

Description A description of, or comments about the flow; the text in this field
may have multiple lines. The creation date and time are filled in
automatically (but can be removed as required).

Background
image

A PNG or JPG image to be shown in the background of the flow design.

• The background image is placed at its effective resolution.
• If the image is too small to fill the canvas, it is repeated (as tiles).
• When the flow is not editable (because it is locked or active), the

background image is darkened.

The background image is a kind of wallpaper on which the flow design is
drawn. Light colors or sober patterns work best.

Header image A PNG or JPG image to be shown in the upper-left corner of the flow
design, on top of the background image.

• The header image is placed at its effective resolution.
• The header image is not repeated to fill the canvas.
• When the flow is not editable, the header image is not darkened.

The header image is intended to mark a flow with a company or brand
logo.

Small images work best (avoiding overlap with the actual flow design).

Marker image If a flow marker is set: the name of the marker (e.g. Priority 4) or the
name (+path) of the uploaded custom image (e.g. /Users/<userX>/
my_image.png).

If no flow marker is set: the value is None.

269



Switch

Property Description

Allow advanced
performance
tuning

Performance settings are configured in the Switch Preferences (Switch
preferences: Processing on page 39). They apply to all flows and all flow
elements.

However, to improve the performance of a particular flow, you can
overrule two default settings by enabling the Allowing advanced
performance tuning option in the properties of that flow. As a result,
all flow elements (used in that particular flow) that can process jobs
concurrently, will have two additional properties that can be changed:

• Number of slots : Number of slots available for concurrent
processes.

• Idle after job (secs) : Idle time-out after each job.

Time-of-day
window

If set to Yes, the flow will be active during a particular time of the day, as
specified in the following properties (only available if Time-of-day window
is enabled):

• Allow from (hh:mm): Start time, for example: 09:00

• Allow to (hh:mm): End time, for example: 11:00

Day-of-week
window

If set to Yes, the flow will be active during a couple of days of the week,
as specified in the following properties (only available if Day-of-week
window is enabled):

• Allow from: Day of the week the flow will be activated, for example:
Tuesday

• Allow to: Day of the week the flow will deactivated, for example:
Friday

Day-of-month
window

If set to Yes, the flow will be active during a particular day of the month,
as specified in the following properties (only available if Day-of-month
window is enabled):

• Day: Day of the month during which to keep the flow active. Use a
number between 1 and 31. For example, "1" (default) means the first
or the last day of the month (depending on the value in Relative to).

• Relative to: Choose between: Start/end of the month.

Note:  If you have enabled the Time-of-day, Day-of-week or Day-of-month window, when

activating the flow manually, it will be preceded by a small icon . This indicates that
the flow is scheduled and will be active during the time specified in the Flow properties.

5.2.5.3.  Adding and removing flows
The Flows pane lists all flows known to Switch at the present time.
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Adding flows
•

 See Creating a new blank flow on page 218 or Creating a new flow based on a
sample flow on page 219

•

 See Importing a flow or a flow group on page 277

Duplicating flows
To make a copy of one or more existing flows

1. Select the flow(s) in the Flows pane.

2. Do one of the following: menu item, or

• Select Flow > Duplicate Flow(s).
• Right-click and select Duplicate Flow(s).
• Drag the selected flow(s) to a different location in the Flows pane.

You must hold down the appropriate modifier key to select and move multiple flows.

The suffix "[Copy]" is added to the names of the duplicated flows.

Note:  You can duplicate a flow even while it is active; the new copy will be inactive.

Deleting flows
To delete one or more flows

1. In the Flows pane, select the flow(s) you want to delete.

Make sure the flows are inactive, as it is not possible to delete an active flow.

2. Do one of the following:

•

In the toolbar, click the Delete Flow button .
• From the menu, select Flow > Delete Flow.
•

In the Flows pane, click  and select Delete Flow.
• Press the Delete key.

3. Confirm your choice.

271



Switch

Remember that deleting a flow is permanent and cannot be undone.

5.2.5.4.  Saving and reverting flows
As long as a flow hasn't been saved, in the Flows pane, its name is displayed in italics and
followed by an asterisk. The unsaved changes are stored in the local cache on disk on the
Designer side.

Note:  You can have several flows with unsaved changes in your design. It is also
possible to switch between flows without saving. However, if you want to exit the
application, or if you want to activate a flow, you will be asked to save your changes.

Saving flows
Before you can activate one or more flows, you must first save them. In the Flows pane, unsaved
flows are displayed in italics, followed by an asterisk.

Note:  If you forget to save your flow, a warning pops up. Note that clicking Save, will
save all flows with unsaved changes. If you do not want to save all unsaved flows, click
Cancel and manually save the flows as required.

To save flows

1. In the Flows pane, select the flow(s) you want to save.

2. Do one of the following:

•

In the toolbar at the top of the screen, click .
• In the Flows pane, right-click and select Save Flow(s).
• From the menu, select Flow > Save Flow(s).

In the Flows pane, the flow names are no longer displayed in italics and the asterisk has
disappeared. You can now activate the flow(s) as required.

Reverting flows
As long as a flow hasn't been saved, you can go back to the previously saved version. You can do
this for one flow at a time, or for several flows at the same time.

To revert flows

1. In the Flows pane, select the unsaved flow(s) you want to revert.

Flows with unsaved changes are displayed in italics and followed by an asterisk.

2. Do one of the following:

•

In the toolbar at the top of the screen, click .
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• In the Flows pane, right-click and select Revert Flow(s).
• From the menu, select Flow > Revert Flow(s).

A warning appears.

3. Click Yes to confirm.
In the Flows pane, the flow names are no longer displayed in italics and the asterisk has
disappeared. You can now activate the flow(s) as required.

5.2.5.5.  Locking and unlocking flows
A flow in the Flows pane can be locked for editing.

When a flow is locked, the Flows pane shows the  state icon when the flow is inactive and
no changes can be made to the flow design or to the flow's properties. The flow can still be
activated as usual. The icon is not visible when you activate the flow but the flow remains locked.

The locking status is preserved when the flow is exported and re-imported.

Locking flows without password
When a flow is locked without a password, it can be unlocked without providing a password (i.e.
no password is requested). This is useful to guard against accidental editing without protection
against interference by another user.

To lock one or more flows without password

1. In the Flows pane, select the flows you want to lock.

2. Do one of the following:

• From the menu, select Flow > Lock.
• In the Flows pane, right-click the selected flow(s) and choose Lock.
•

In the Flows pane, click  and select Lock.

Switch displays a dialog requesting a lock password.

3. Leave the password blank.

4. Click OK.

Locking flows with a password
When a flow is locked with a password, the password must be provided to unlock it. The
password is stored in the flow definition in an encrypted form.

Note:  There is no way to recover the password when forgotten!

To lock one or more flows with a password

1. In the Flows pane, select the flow(s) you want to lock.
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2. Do one of the following:

• From the menu, select Flow > Lock.
• In the Flows pane, right-click the selected flow(s) and choose Lock.
•

In the Flows pane, click  and select Lock.

Switch displays a dialog requesting a lock password.

3. Enter the same password twice.

4. Click OK.

Note:  Certain Enfocus employees have access to a mechanism that bypasses the
password protection (because Switch defines the password encryption). While Enfocus
does not intend to open password-protected flows, and does not intend to publish the
bypass mechanism, the company does not legally guarantee that this will never happen.
It is important for flow designers to understand the limitations of the protection.

Unlocking flows
To unlock one or more flows

1. In the Flows pane, select the flow(s) you want to unlock.

2. Do one of the following:

• From the menu, select Flow > Unlock.
• In the Flows pane, right-click the selected flow(s) and choose Unlock.
•

In the Flows pane, click  and select Unlock.

If the flow is password protected, Switch displays a dialog requesting the password.
Otherwise, the flow is unlocked immediately.

3. Enter the password.

4. Click OK.

5.2.5.6.  Activating and deactivating flows
A flow can be in different states:

• An inactive flow is in "design mode": you can change the flow and the flow element
properties. An inactive flow cannot process jobs.

• An active flow is currently being executed by the Switch Server, that is, it is processing jobs.

An active flow cannot be edited. This state is indicated by the  icon next to the flow name in
the Flows pane, and by the darkened background in the canvas.

For an overview, refer to Flows pane on page 79 (Table "State").
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Activating flows
If you want a flow to start processing jobs, you must activate it. Note that you can activate
several flows in one go.

To activate flows

1. In the Flows pane, select the (inactive) flow(s) you want to start.

2. Do one of the following:

•

In the toolbar at the top of the screen, click .
•

In the Flows pane, click  and select Activate Flow(s).
• In the Flows pane, right-click and select Activate Flow(s).
• In the Flows pane, double-click the selected flow (only possible in case of a single flow).
• From the menu, select Flow > Activate Flow(s).

If you haven't saved your flow yet and you haven't enabled automatic flow saving in the user
interface preferences, a warning pops up. Note that clicking Save, will save all flows with
unsaved changes. If you do not want to save all unsaved flows, click Cancel and manually
save the flows as required.

The background of the flow is darkened. In the Flows pane, you can see an icon  next to
the name of the flow. The flow is now active and waits for input jobs to appear.

Note:  If the flow has been scheduled, an icon  appears. The flow will become
active at the time specified in the Flow properties (See Flow properties on page
269).

Deactivating flows
If you want a flow to stop processing jobs, you must deactivate it. Note that you can deactivate
several flows in one go.

To deactivate flows

1. In the Flows pane, select the (active) flow(s) you want to stop.

To select multiple flows, hold down the Ctrl or Shift key while selecting.

2. Do one of the following:

•

In the toolbar at the top of the screen, click .
•

In the Flows pane, click  and select Stop Flow(s).
• In the Flows pane, right-click and select Stop Flow(s).
• From the application menu, select Flow > Stop Flow(s).
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The processing is terminated. You can now edit the flow as required.

5.2.5.7.  Importing and exporting flows
If you want to make a backup of your flows, or if you want to share them with someone else, you
can export the flows concerned. Likewise if you have an exported flow, you can import that flow
into your copy of Switch and have the flow appear in the Flows pane.

You can do this for single flows, but you can also import and export flow groups as a whole (to
maintain the hierarchy and the order of the flows).

Exported flows are saved as files with the "sflow" filename extension; exported flow groups have
the "sflows" filename extension.

Note:  Flows cannot be exported to or imported from folders that are shared such as
the Desktop folder and the Downloads folder. This is also the case for folders that are
redirected from shared folders.

References to external files

If a flow which contains a link to an external file (for example an XSLT stylesheet) is exported,
both the location of this file and the file itself are stored inside the flow file.

When the flow is imported again, Switch will search for this file in the same location. However,
if the external file is not available (e.g. because the flow is imported on another system, which
doesn't have this file), Switch will use the file that is stored in the flow and link the value of the
property to that file.

Tip:  To make sure flows are kept in sync on different computers, we recommend
copying all external files to all systems. This way, you don't have to worry about files
stored in the internal Switch structure.

For more details, refer to Compatibility considerations on page 278.

Exporting a flow or a flow group
To export one or more flow or flow groups

1. In the Flows pane, select the flow(s) or flow group(s) concerned.

2. Do one of the following:

• From the menu, select Flow > Export Flow(s)...
• Right-click the selected flow(s) and choose Export Flow(s)...
•

Click  and select Export Flow(s)...

3. Choose a location and a name (in case of a single flow) or a destination folder (in case of flow
groups or if you selected more than one flow).
The selected flows and flow groups are exported and saved in the chosen location. If you
have exported several flows, the flows are saved in the destination folder, one file per flow,
and they are named after the flow. For example, a flow called DemoFlow will result in a file
called DemoFlow.sflow.
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Flow groups are saved with file extension "sflows", for example CustomerXflows.sflows.

Exporting all flows in the Flows pane (for a backup)
Use this function if you want to create a quick backup of your flows, being sure that all flows are
exported.

To export all flows in the Flows pane

1. Do one of the following:

• From the menu, select Flow > Export all....
•

In the Flows pane, click  and select Export all....

2. Select a destination folder.
The flows are exported and saved in the chosen location. The grouping structure of the flows
in the Flows pane is not exported. There is no way to do this.

Importing a flow or a flow group
To import one or more flows from an external ".sflow" file (in case of single flows) or ".sflows"
file (in case of flow groups)

1. Determine where you want your flow(s) or flow group(s) to be placed in the Flows pane.

The flow(s) /flow group(s) will be placed at the same level as the flow that is have currently
selected. If no flows are selected, they will be placed at the root level (highest level).

2. Do one of the following:

• From the menu, click Flow > Import Flow....
• In the Flows pane, right-click somewhere and choose Import Flow....
•

In the Flows pane, click  and select Import Flow....

3. Select the external file(s) you want to import.

You can select multiple files at the same time by holding down the Ctrl or Shift key.

4. Click Open.

If problems occur, a message will appear, for example to warn you about unsupported flow
elements (See Importing a flow with unsupported flow elements on page 278).

If everything goes well, the flow(s) or flow group(s) will appear in the Flows pane. The
hierarchy and the order of the flows in the the flow groups are preserved.

Alternative ways to import files:

Alternatively you can locate the external ".sflow(s)" file using the Windows Explorer (on
Microsoft Windows) or Finder (on Mac) and:

• Double-click the file; this will launch Switch if it is not yet running and import the flow or flow
group.

• Drag and drop the file onto the Flows pane in Switch; this will import the flow or flow group.
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Importing a flow with unsupported flow elements
When you import a flow in which some of the flow elements are not supported by the current
configuration of Switch (for example, the flow element may belong to a module which you have
not licensed), the following message will be displayed:

 

 

When you click Close in the above dialog box, the flow is imported along with the unsupported
flow elements, but the unsupported flow elements will display a small triangle with an
exclamation mark. When you hover your mouse over this triangle, a pop-up also displays the
message about the unsupported flow element.

Compatibility considerations
When exporting a flow, Switch stores a maximum amount of information in the exported flow
file:

• The list of flow elements and connections as they are shown in the canvas, including the
geometry.

• The values of all properties, including references to backing folders and configuration files

• A copy of any referenced configuration files.

Sometimes a property value refers by name to configuration data stored internally by a third-
party application. In those cases it is not possible to include the configuration data itself (the
reference by name is still included).

When importing a flow, Switch ensures that all encountered flow elements and properties
are supported by this version of Switch. If not, any issues are reported to the user and the
unsupported items are omitted from the imported flow. Switch also copies configuration files
from the flow file being imported into a special location under its application data root, and
changes the corresponding references to point to these new copies.

Further validation of property values is performed when the flow is activated (for example,
ensuring that all backing folders have a valid path).

Auto-managed backing folders are automatically created where necessary. For user-managed
backing folders the original paths are preserved without change. In most cases this means that
you must create and assign new backing folders (i.e. unless the backing folders already exist
because you are importing a flow that was previously created on your own system).
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5.2.5.8.  Generating flow documentation
For a good overview of a flow and its flow elements, it may be handy to generate an HTML page
that contains all this information. You can afterwards save this HTML as PDF (using the print
function of your browser) as required.

To generate flow documentation

1. In the Flows pane, select the flow(s) for which you want to generate the documentation.

Note that it is also possible to generate documentation for all flows in one go. To do so, no
need to select anything, just select Flow > Document all.

2. Do one of the following:

•

In the toolbar at the top of the screen, click .
• In the Flows pane, right-click and select Document Flow(s).
• From the menu, select Flow > Document Flow(s).

The flow documentation is generated and shown immediately in your default browser. It
provides you with details of the flow itself (e.g. name and description, if a background image is
used, ...), a graphical representation of the flow (as shown on the canvas), and an overview of all
properties of all flow elements. Note that you can click the elements in the flow image, to see
the corresponding properties. The arrow allows you to return to the top of the HTML page.

5.2.6.  Monitoring flows

5.2.6.1.  Viewing an active flow
Active flows are flows which have jobs that are currently being processed by the Switch Server.
The active state is indicated by the icon next to the flow name in the Flows pane, and by the
darkened background in the canvas. See Activating and deactivating flows on page 274 and
Flows pane on page 79.

While executing a flow the canvas provides visual feedback about the number of jobs residing in
each backing folder, and about problem jobs and problem processes, as described in this topic
below.

More extensive feedback about flow execution is provided elsewhere; for more information see:

• Viewing log messages on page 285

• Viewing processes in the Progress pane on page 292

• Viewing flow problems in the Dashboard pane on page 293

Number of jobs
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When a flow is active, the canvas attaches a small rectangle to each flow element that has
a backing folder, as shown above. The number in the rectangle reflects the number of jobs
residing in the flow element's backing folder.

For performance reasons Switch stops counting at 100 jobs. When a backing folder contains 100
or more jobs, the rectangle displays the symbol for infinity.

Scanning user-managed folders and checking Mail / FTP

Switch automatically scans the contents of user-managed folders and checks Mail and FTP
in an active flow at regular intervals. The interval between scans is governed by global user
preferences; see Switch preferences: Processing on page 39.

When testing a flow it is sometimes impractical to wait for the next interval scan. Therefore,
when a flow is active, you can use an option in the context menu to immediately scan the folders
concerned:

• The Scan now context menu for Folder and Submit hierarchy elements causes Switch to
immediately scan the corresponding folder.

• The Check now context menu for Mail Receive and FTP receive causes Switch to immediately
check for jobs arrived by mail or FTP .

• The Scan folders now context menu for the canvas causes Switch to immediately scan all
backing folders in the currently displayed flow.

• The Check FTP now context menu for the canvas causes Switch to immediately check for
arrived jobs with all FTP receive flow elements in this flow.

• The Check Mail now context menu for the canvas causes Switch to immediately check for
arrived jobs with all Mail receive flow elements in this flow.

Problem jobs
 

 

When the Problem jobs flow element contains at least one problem job, it displays a red error
mark as shown above. This feedback is provided for both active and inactive flows.
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See also Handling problem jobs on page 297.

Problem processes
 

 

When a flow is active, flow elements that correspond to a problem process display a red error
mark (as shown above for FTP send). This feedback is provided only for active flows since, by
definition, an inactive flow can't have problem processes.

See also Handling problem processes on page 299.

5.2.6.2.  Putting connections on hold
Most connections offer a Hold property. If this property is enabled, jobs are not allowed to move
through the connection. This is mostly used to temporarily hold jobs (for example because there
is a problem with a process downstream).

The canvas displays connections on hold as an orange dashed line.

Although editing in the Properties pane is disabled while a flow is active (see Activating and
deactivating flows on page 274), the status of the Hold jobs property can be modified at any
time through the context menu of the connection.

Note:  Note that, when the flow is running while you're putting a connection on hold,
the jobs that are already present in the folder just before the 'on hold' connection will
still move through the connection. The reason is that those jobs, although visually still
present in the folder, are already being moved by Switch in the background.

Putting a connection on hold
Sometimes it's useful to temporarily hold jobs, i.e. stop them from moving through the
connection, for example because there is a problem with a process downstream.

To put a connection on hold

1. Select the connection in the canvas.

2. Do one of the following

• Right-click the connection and select Hold.

Note:  This works, even if the flow is active. Note that jobs already present in the
input folder (the folder just before the connection) when enabling this setting will
still move through the connection.

• In the Properties pane, set the value of the Hold jobs property to Yes.
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Note:  This does not work if the flow is active.

In some cases, a (partial) hold is not possible, for example because jobs are moved under
an external application's control. In other cases, if setting one connection on hold, all other
connections originating from the same tool are automatically set on hold as well.

For more information, refer to Examples of connections on hold on page 283.

Once put on hold, the connection is displayed in the canvas as an orange dashed line.
 

 
When the flow is active, the icon in the Flows pane that refers to the flow state will change from

 to  to indicate that one or more of the connections are put on hold. Refer to Flows pane on
page 79.

Releasing a connection
If a connection is set on hold, no jobs can move through the connection, until the connection is
released. The connection is displayed in the canvas as an orange dashed line.

To release a connection

1. Select a connection in the canvas.

2. Do one of the following

• Right-click the connection and select Release.

Note:  This always works, even if the flow is active.

• In the Properties pane, set the value of the Hold jobs property to No.

Note:  This does not work if the flow is active.

In some cases, if releasing one connection on hold, all other connections originating from
the same tool are automatically released as well. For more information, refer to Examples of
connections on hold on page 283.
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The connection is displayed in the canvas as a continuous line. The color depends on the
color set in the Color property of the connection (blue in the image below). The default color
is gray.
 

 

Note:  It is also possible to release all connections in one go, using the Release all
option in the context menu of the canvas.

Examples of connections on hold

Hold job example
 

 

In this example, the Hold job flow element is used to distribute jobs evenly across three
printers. The connections for printers A and B have been put on hold because the printers are
temporarily off line. This causes the Hold job to send all jobs to printer C.
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Folders example
 

 

In this example, the connections are set up to duplicate the incoming job (one copy in each
output folder). When the first connection is put on hold, the copies for that connection are held
in the input folder until the connection is released. The copies for the other connection proceed
without interruption.

FTP receive example
 

 

In this example, file filters have been set up for the connections leading from the FTP receive
tool. PDF files are sent to Folder 1 and all other jobs are sent to Folder 2.

When the PDF files connection is put on hold, the other connection is automatically put on hold
as well, effectively disabling the FTP receive tool. The connections are linked in this respect
because implementing a "partial hold" on the remote connection would be tricky.

Once the connections are on hold, maintenance can happen on the FTP server without affecting
the rest of the flow.
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Traffic light example
 

 

Traffic light connections carry data or log information for the same job, so it does not make
sense to put a single connection on hold independently. When one of the connections is put
on hold, all other connections are automatically put on hold as well, effectively disabling the
originating tool.

Generic application example
 

 

In this example, the Generic application tool is used to integrate an external hotfolder
application in the flow. The connections can't be put on hold because the jobs are moved under
the external application's control.

5.2.6.3.  Viewing log messages
This topic describes how you can open the log messages overview from within Switch.
Alternatively, the message overview can be opened through the Switch Web Portal (see: Viewing
log messages through the Switch Web Portal on page 317).
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To view the log messages

In Switch, do one of the following:

• Click View > Messages.
• Press F6.
• Click the Messages button in the Switch toolbar.

Depending on the configuration in the User interface category of the Switch preferences, the
messages view will open either inside Switch Designer or outside Switch, in a browser
window. In both cases, the message overview contains the same information.

You can now show more messages or filter out the messages you're not interested in, or export
the messages to a csv file. Refer to Filtering log messages on page 290 and Exporting log
messages  on page 292.

The Messages overview
This topic describes the Messages overview.

You can open this overview

• Through the Switch Web Portal.
• From within Switch, by clicking the Messages button in the toolbar of the Switch Designer.

Alternatively, you can press F6 or select View > Messages.

Note:  If opened from within Switch, it's possible to have the messages shown inside
the Switch Designer (For more info, refer to User interface category of the Switch
preferences(last setting)).

Buttons and menus

The table below explains the meaning of the main buttons, labels, icons and menus in the
Messages overview.
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Button/menu Description

Shows the name of the user that logged in.

If you click the icon , you'll get a menu where you can
change the language and sign out as required.

See Changing the language of the Switch Web Portal on page
316.

Note:  If you open the Messages overview from
within Switch, this option is not available. In that
case, the Messages overview is displayed in the
language of the Switch Designer.

Indicates the date(s) on which the shown messages were
issued, and allows you to select a different date or date
range.

• : Show messages of the previous day

• : Show messages of the next day

• : Show messages of a particular date or date range.
You can also choose "Full history", i.e. all messages
since the last message cleanup (as defined in the
Switch preferences (Application data category)).

Indicates the time frame in which the shown messages
were issued. You can move the blue arrows to enlarge or
reduce the time frame.

The red vertical lines represent error messages. This
way you can immediately see when error messages were
issued.

 

 

The applied filters are listed right above the Search field.
When two different filters are applied, all log messages
that match one of the strings are shown (in this example:
messages that have "PitStop Server" OR "ScriptExecutor"
in the description).

This part of the overview allows you to configure filters,
to select messages that contain certain strings (in the
message itself, in the name of the flow, the name of the
job, …) Refer to Filtering log messages on page 290.

Opens a menu with the following options:

• Flow, Job, Module, Element, Prefix: Refers to the
columns in the overview. Click to hide or show columns
as required.

• Reset view: Allows you to reset the columns to their
default size and position: only Flow, Job and Element
are shown by default.
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Button/menu Description

• Export: Allows you to export the filtered log messages
to a .csv file. You can either open the file or save it
locally.

• Clear all: Allows you to remove all log messages from
the log database. Note that there is no undo for this
action!

Message types, indicating the severity level of the
message.

If colored, the messages of that type are displayed in the
overview, in a background with the corresponding color. In
the example, info, warning and error messages are shown,
whereas debug messages are hidden (default). You can
click a message type to switch from hidden to shown and
vice versa, or you can click the arrow to the right, to only
show the messages of that particular type.

Note:  Info messages are displayed in a white and
gray background.

Note that the Debug button also shows or hides assert
messages. See also the table below (Message types).

By default, the page refreshes automatically, so you
always have an up-to-date overview.

You can turn off this option by clicking the auto refresh

button , which will turn into a blue arrow .

Columns

The following table describes the columns in the Messages overview.

Remember that you can hide columns as required via the icon  just below the search field. It's
also possible to resize the columns.

Column Description

Time Time when the message was triggered.

Flow The name of the flow that triggered the message.

Job The name of the job for which this message was issued.

Module The Switch module (such as Control) or type of flow element (such as
folder, Mail receive, ...) that triggered the message.

Element The name of the flow element that triggered the message.

Prefix The unique name prefix of the job referred to in the message, or blank if
there is no unique name prefix.
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Column Description

Message The message itself.

Message types

The following table describes the different types of messages that can appear in the Type
column of the Messages overview.

Type Description

Info An informational message that has no other purpose than to inform the
user of a certain occurrence.

Info messages are always shown in the Messages overview (unless a filter is
applied).

The Messages overview displays all types of info messages (related to
Switch Server and to Switch Designer).

Warning A warning message that informs the user of a recoverable problem or non-
fatal error.

Warnings are always shown (in orange) in the Messages overview (unless a
filter is applied).

Error An error message that informs the user of a fatal error.

Errors are always shown (in red) in the Messages overview (unless a filter is
applied).

Debug An informational message solely intended for debugging purposes (often
generated by configurators).

Debug messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Switch Preferences: Logging.

Assert A message solely intended for debugging purposes that is issued only when
a coding error is discovered.

Assert messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Refer to Switch Preferences: Logging.

Note:  Scripters have access to all messages, to be able to debug their scripts.

289



Switch

Filtering log messages
By default, all info, warning, and error messages issued on the current date are shown in
the Messages overview. You can however change this and only display the messages you're
interested in.

To filter the log messages

1. Pick the date(s) of which you want to see the messages.

By default, today's messages are shown.

To ... Do the following ...

Show messages of the previous
day

Click 

Show messages of the next day Click 

Show messages of a particular
date or date range

Click 

Show messages of a particular
date or date range

Click  and select the appropriate option
from the menu:

• Today
• Yesterday
• Choose date(s): Opens a calendar. Click

the date you want to select. In case of
a date range, click the first and the last
date.

• Full history: Displays all messages since
the last messages cleanup (as defined in
the Switch preferences (Application data
category)).

2. Pick the appropriate time frame:

• To indicate the start time, click the blue indicator to the left of the slider and drag it to the
time of your choice.

• To indicate the end time, click the blue indicator at the right of the slider and drag it to
the time of your choice.

By default, the messages of the current date are shown. The blue part indicates the
currently shown time. The red vertical lines indicate when time error messages were
issued.

Note:  If the end time is not the current time, the auto refresh is disabled and the
auto refresh button will turn into a blue arrow. If you click this blue arrow, auto
refresh is turned on again and the end time is reset to the current time.

3. Pick the type of messages you want to see in the overview:
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• Click the name of the message type to show or hide it in the overview. If the name is
shown in a colored background, the messages are shown in the same background color,
if the name is shown in white, the messages are hidden. Note that info messages are
shown in a white and grey background.

• Click the small arrow next to the message type to open a menu with two options:

• Hide messages of this type
• Only show messages of this type

By default, all types except for debug messages are shown.

4. Set a filter as required:

a. Select the column in which you want to search for a particular string. If the column
doesn't matter, choose Any.

b. In the search field, enter one or more strings to only view the messages that contain
those strings. The case of the entered strings is not taken into account.

c.
Press enter or click the  button.

The filter is applied immediately. The messages that match the filter are shown, and the
filter definition is displayed just above the filter field.

Remarks:

• Alternatively, you can select a string somewhere in the overview and click Search this
(which appears automatically). The filter is configured and applied automatically.

Example:

 

 
Resulting filter:
 

 

• To view messages that contain several strings in one entry (e.g. configurator AND
workflow), type those strings in one filter field.
 

 

• To view messages that contain either string x or string y (e.g. configurator OR workflow),
type those strings in two different filter fields (see screenshot).
 

 

5. To clear a filter, click the cross button in the filter label.
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The label is removed and the messages overview is updated immediately.

Note:  Remark for Web Portal users only: You can save your message filters by clicking
the + Save current filter button in the blue sidebar/navigation area.

Exporting log messages
Log messages can be exported to a CSV file for processing by third-party tools. If you have set
filters, these filters are taken into account; only the messages that are shown will be exported
to a file.

To export log messages

1. Open the Log messages overview.

2. Click the icon  below the search field.

3. Click Export.
A log.csv file is created.

Clearing log messages
Log messages are stored in a database on disk and thus remain available after quitting and
restarting Switch. The application data preferences determine for how long messages are
retained.

To permanently clear all log messages

1. Open the Log messages overview.

2. Click the icon  below the search field.

3. Click Clear all.
A confirmation dialog appears. If you click Clear, all messages will be removed from the log
database. Note that there is no undo for this action!

5.2.6.4.  Viewing processes in the Progress pane
The Progress pane displays a list of currently executing processes (for all active flows) with their
progress information.

Concurrent processes

Depending on the value of the processing preferences, there may be more or less concurrent
processes.

Stopping and starting processing

• To cause the Switch Server to stop processing, choose File > Stop processing.

• To resume processing, choose File > Start processing.

When you stop processing, operation of all active flows is halted and flows are de-activated
temporarily. When you subsequently start processing, all active flows are simply resumed.
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To stop processing is sometimes useful while designing and testing a flow that interacts with
a third-party application. Stopping processing suspends Switch's interaction with the external
application (and with the file system), so that you can, for example, change a setting in the
external application without the need for deactivating the flow.

When in doubt, deactivate and reactivate the flow rather than stopping and restarting
processing.

5.2.6.5.  Viewing flow problems in the Dashboard pane
The Dashboard pane (displayed by clicking View > Show panes > Dashboard) displays an
overview of current flow execution problems at any given time. This is in contrast with the
Messages overview, which provides an audit trail of what happened in the past.

Furthermore, the Dashboard allows relevant actions to be taken for certain problem types, such
as retrying a problem job.

 

 

Wrap text

To display long messages on multiple lines (i.e. "wrapped" rather than chopped off), choose the
"Wrap text" menu item in the context menu of the Dashboard pane.

Problem categories
Switch distinguishes in the Dashboard pane between problem jobs (which cannot be processed
because of an issue with the job itself) and problem processes (where jobs cannot be processed
because of a general issue with the process). Processes are further divided in file transfers and
external processes.

Category Description Switch action

Problem job A process failed to handle this job
because of an issue that does not
affect other jobs; human intervention
is required for this specific job but
processing can continue for other jobs.

Move the problem job to the
Problem jobs folder

See Handling problem jobs on
page 297
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Category Description Switch action

File transfer A Mail, FTP or local network operation
cannot transfer any jobs because
there is a communication problem;
human intervention may be required,
or communication may be restored "by
itself".

External
process

A built-in tool (such as Compress),
a script or a third-party application
under the control of a configurator
cannot continue processing jobs due
to a problem with the process; human
intervention is most likely required.

Make all jobs in front of the
process wait "inline" in the
flow until the problem is
resolved

See Handling problem
processes on page 299

Information in the Dashboard pane
The information in the Dashboard pane is updated dynamically. A problem item appears as soon
as it is detected and disappears as soon as the problem is solved or handled.

Rows

The Dashboard pane shows a header row for each problem category indicating the number of
items in the category. The triangle in front of the header row serves to expand or collapse the
category. The items in each category may be grouped per flow; grouping can be turned on and
off for all categories at the same time through the Grouping on menu item in the Dashboard
context menu.

Group nodes, if present, are sorted on flow name. The order in which items are sorted within
each group (or within the category if there are no groups) can be configured by clicking the
column headers in the table.

Columns

The following table describes the columns in the Dashboard pane. You can resize and reorder
the columns by dragging the column headers.

Column Description

Time stamp The moment in time when the problem was detected.

Module The Switch module (such as Control) or type of flow element from
which the problem originated.

Flow The name of the flow in which the problem originated (this column is
absent when grouping is turned on).

Flow element The name of the flow element from which the problem originated.

Job Prefix The unique name prefix of the job referred to in the message, or is
left blank if there is no unique name prefix.
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Column Description

Job The name of the problem job, or the name of the job for which the
process problem was detected, or blank if there is no job context.

Message A message that describes the problem.

Researching problems
The Dashboard pane offers assistance with researching a problem through the following context
menu items:

Context menu item Description

Show flow element Causes the canvas to select the flow and the flow element listed in
the selected problem item.

Show job Causes the canvas to select the flow and the flow element in which
the job listed in the selected problem item currently resides (i.e. a
problem jobs folder for the "jobs" category and a regular folder for
the other categories).

Causes the files pane to show the backing folder of the previously
mentioned flow element, and to select the job under consideration.

Retrying problems
The Dashboard pane offers assistance with retrying a problem through the context menu items
described in the following table. For more information on retrying problems, refer to Handling
problem jobs on page 297 and Handling problem processes on page 299.

Context menu item Description

Retry item Retries the job or process associated with the selected row.

Retry group For a group row, retries all items in the associated group.

For an item row, retries all items in the group that contains
the selected row.

Retry category For a category row, retries all items in the associated
category.
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Context menu item Description

For a group or item row, retries all items in the category that
contains the selected row.

5.2.6.6.  Viewing statistics

About Statistics in Switch

Switch allows you to collect information on how long jobs reside in certain folders or states
while being moved along a flow. This can be useful to identify performance bottlenecks.

There are two types of statistical data:

• Folder statistics calculate the average time jobs reside in a folder for which statistics have
been enabled.

• State statistics calculate the average time jobs reside in a particular state. A state can be
attached to a job folder via the Folder property "Attach job state", and allows you to combine
information about several folders having the same function, for example "coming in" or "in
progress".

Statistics are not limited to a single flow: Switch combines all statistics-enabled folders from
all active flows in a single set of statistics. If two or more folders (used in different flows) have
the same name, the statistics for these folders are combined in one single entry.

Tip:  To receive meaningful results, we recommend calculating statistics only for folders
leading to heavy processes, i.e. processes forming a potential bottleneck for resources,
such as CPU time or communication bandwidth.

Setting up statistics

• To gather Folder statistics, you must enable the Show in statistics property of the folder
concerned.

• To gather State statistics, you must fill out the Attach job state property of the folder
concerned.

You can only gather statistics for a folder that has outgoing connections. Folders at the end of
the flow do not have the Show in statistics and Attach job state property, because Switch has no
control over the time the jobs reside in such a folder.

Remark

• In case of Folder statistics, the calculated time is the queuing time between the moment
the job is detected and the the moment the job is handed over for processing on an outgoing
connection.

• In case of State statistics, this is the queuing and processing time between two different job
states. Note that, due to the fact that statistics are only logged when the job state changes, it
is necessary to introduce an extra dummy state (which will never be logged) at the end of the
last flow element of interest or just before the last folder of the flow (as the last folder has
no Attach job state property, hence the job state cannot change). In the following example,
the time spent in the "Set to MyState" includes the queuing time in the first folder and the
processing time in the generic application ("Process"). The second folder was introduced to
change the job state to a dummy value.
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Note:  The time during which a job is blocked (e.g. because the relevant flow was not
active or Switch was not running) is also included in the statistics.

Displaying statistics

To display the Statistics pane, click  in the Switch toolbar or go to View >  Statistics.

Important:  Do not forget to refresh the statistics ( by selecting View > Refresh Statistics
), to make sure the most recent information is displayed.

You can display up to three statistics panes (by clicking View >  Show panes >  Statistics 2  or
Statistics 3) at the same time. This allows you to display a second and third set of statistics (e.g.
sorted in a different way).

For more information about this pane, refer to Statistics pane on page 83.

Resetting statistics

To remove the collected information, i.e. to set all counters to zero, go to View >  Reset
Statistics. Switch will start gathering statistics from scratch.

5.2.7.  Handling execution problems

5.2.7.1.  Handling problem jobs
While executing a flow, Switch executes processes and moves jobs between processes
according to the specifications in the flow definition. However there are situations where a
process fails to handle a job properly and it no longer makes sense for the job to move along
the flow in its usual fashion. In those cases, Switch moves the job to the Problem jobs folder, a
central location for jobs that require human intervention.

Important examples of why a job may be moved to the Problem jobs folder include:

• The job has an invalid file format causing a third-party application to issue a fatal error
message.

• The job matches none of the file filters set on the outgoing connections of a particular folder.

Switch offers a number of facilities for handling problem jobs, from detecting their presence to
re-injecting them in the flow after the problem has been resolved.

Detecting problem jobs
There are various ways to detect the existence of problem jobs in Switch:
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• The Problem alerts user preferences allow specifying that a notification email should be sent
to the system administrator when a job is moved to the Problems folder.

• The Problem jobs flow element can be placed on the canvas right inside a flow design; its
icon displays a red error mark when there are problem jobs present (see Viewing an active
flow on page 279).

• The Dashboard pane displays an overview of the current problem jobs at any given time. See
Viewing flow problems in the Dashboard pane on page 293.

Researching problem jobs
Switch assists with locating and researching problem jobs in various ways:

• When you select the Problem jobs flow element in the canvas; the Jobs pane displays a list
of the problem jobs (for this flow or for all flows depending on how the Problem jobs flow
element is configured).

• The context menu for the Dashboard pane provides options to locate the flow element
causing the problem in the canvas, and to show the problem job in the Jobs pane. See
Viewing flow problems in the Dashboard pane on page 293.

• The Messages overview shows all messages issued by Switch and the processes under its
control; use the overview's filtering capabilities to pinpoint the messages issued for the
problem job or by the process(es) involved in the problem; this may provide some context
in case the problem was really caused by an occurrence further upstream. See Viewing log
messages  on page 285.

Retrying problem jobs
When Switch moves a job to the Problem jobs folder, it remembers the original location of the
job in its internal job ticket. This makes it possible to move the job back to the location where it
left the flow for another attempt at successful processing, without losing any of the job's history
(which is also stored in the internal job ticket). The process of moving the job back in the flow is
called retrying the job.

It is meaningful to retry a job only after you have fixed the problem (or at least believe you did) by
reconfiguring a process, adjusting the flow design, or tweaking the job itself.

Note:  Leave the job in the Problem jobs folder and leave its file name intact (including
unique name prefix and file name extension); if you change the location or the file name
Switch may lose the connection with the job's internal job ticket and it can no longer
retry the job.

 

 

Switch offers various ways to retry a job:

• When you select the Problem jobs flow element in the canvas (and if it contains problem
jobs), the Retry button in the tool bar is enabled. Click the Retry button to retry all jobs in the
selected Problem jobs flow element.
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• The context menu for the Problem jobs flow element also offers a Retry all jobs option.
• When the Jobs pane displays a list of problem jobs (because the Problem jobs Flow element

is selected), its contextual menu offers a Retry job option that retries only the selected job(s).
• The context menu for the Dashboard pane provides options to retry one or more of the listed

jobs. See Viewing flow problems in the Dashboard pane on page 293.

5.2.7.2.  Handling problem processes
While executing a flow Switch causes processes to be performed and jobs to be moved between
processes according to the specifications in the flow definition. However there are situations
where a process is no longer able to continue processing jobs due to some problem with the
process itself. In those cases, Switch makes all jobs in front of the process wait "inline" in the
flow until the problem is resolved (it makes no sense to move these jobs to the problem jobs
folder since there is nothing wrong with the jobs).

Important examples of why a process may fail include:

• There is a network communication problem so jobs can no longer be transferred.

• A property for the process is set to an improper value (Switch attempts to detect invalid
properties when a flow is activated but this can never be foolproof in all cases).

Switch offers a number of facilities for handling problem processes, from detecting their
presence to re-enabling them once the problem has been resolved.

Detecting problem processes
There are various ways to detect the existence of problem processes in Switch:

• The Problem alerts user preferences allow specifying that a notification email should be sent
to the system administrator when communication (Email, FTP, local network) is down for
more than a specified time, or when an external process fails.

• The flow element corresponding to a problem process is shown in the canvas with a red
error mark, providing obvious feedback on its problem state (see Viewing an active flow on
page 279).

• The Dashboard pane displays an overview of the current problem processes at any given
time. See Viewing flow problems in the Dashboard pane on page 293.

Researching problem processes
Switch assists with locating and researching problem processes in various ways:

• The context menu for the Dashboard pane provides options to locate the flow element
causing the problem in the canvas. See Viewing flow problems in the Dashboard pane on page
293.

• The Messages overview shows all messages issued by Switch and the processes under its
control; use the overview's filtering capabilities to pinpoint the messages issued for the
process(es) involved in the problem; this may provide some context in case the problem is
caused by interrelated processes. See Viewing log messages  on page 285.
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Retrying problem processes
The process of re-enabling a process (or at least attempting to do so) is called retrying the
process.

It is meaningful to retry a process only after you have fixed the problem (or at least believe you
did) by reconfiguring the process, adjusting the flow design, or resolving any relevant issues
outside of Switch.

Automatic retry
The Error handling user preferences allow automatically retrying a problem process after a
specified time interval. Separate values can be specified for different categories of processes.

Automatic retry is especially meaningful for communication processes since a network problem
is often resolved by external influences.

Manual retry
Switch offers various ways to manually retry a problem process:

• When you select the flow element in the canvas that corresponds to a problem process, the
Retry tool button is enabled. Pressing the Retry tool button retries the process.

• The context menu for the flow element in the canvas that corresponds to a problem process
also offers a "Retry" menu item.

• The context menu for the Dashboard pane provides options to retry one or more of the listed
processes. See Viewing flow problems in the Dashboard pane on page 293.

• When you deactivate and reactivate a flow, all of its problem processes are implicitly retried.
• When you quit and restart Switch, all problem processes are implicitly retried.

5.2.8.  Advanced topics for running flows

5.2.8.1.  Scheduling jobs

Objectives for scheduling jobs
The Switch job scheduler has the following (sometimes conflicting) objectives, in order of
importance:

• Maximize overall throughput, that is, process as many jobs as possible in a given amount of
time.

• Allow users to specify individual job priorities: a task for a job with a higher priority should be
executed first. This can be used to "rush" a particular job through a flow, or to define a high-
priority flow (by assigning a priority to all jobs in the flow).

• Process jobs in order of arrival, that is, jobs should arrive at the end of a flow in the order
they were placed in the flow to begin with (FIFO = first-in/first-out).
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These objectives are not absolute: enforcing some particular order of execution to the letter
would sacrifice throughput and/or overly complicate the implementation.

Internal job ticket
To support these objectives, the internal job ticket for each job stores the following fields:

• Job priority: a signed integer number that determines the priority of the job; a higher number
indicates a higher priority; the default priority is zero.

• Arrival stamp: an unsigned integer number that indicates the order in which this job first
arrived in a flow, as compared to other jobs.

Execution slots
The scheduler manages a number of slots in which tasks can be executed in parallel. The
maximum number of concurrent slots is determined for each category of tasks as described in
the following table.

Note:  For an overview of the flow elements belonging to each of these categories, refer
to Switch performance tuning on page 495.

Task category Task types in this category Maximum concurrent slots
for this category

Disk File handling tasks, such as copying
& moving jobs

5

Network Network transfer tasks, including
FTP send/receive, Mail send/
receive, Checkpoint via mail.

Determined by the value of the
"Concurrent network transfer
tasks" preference (See Switch
preferences: Processing on
page 39)

Processor File processing tasks, executed
by configurators and apps and
flow elements such as archive,
unarchive, 'heavy' scripts,... Note
that light scripts belong to a
separate category (see paragraph
below).

Determined by the value of
the "Concurrent processing
tasks" preference (See Switch
preferences: Processing on
page 39)

Light script Light scripts used in the Script
element (see paragraph below)

5 + value of the "Concurrent
processing tasks" preference
(See Switch preferences:
Processing on page 39)

Timer Any timerFired entry point
invocation

Minimum: 2

Maximum: twice the value of
the "Concurrent processing
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Task category Task types in this category Maximum concurrent slots
for this category

tasks" preference (See Switch
preferences: Processing on
page 39)

Webhook Any webhookTriggered entry point
invocation

Minimum: 2

Maximum: twice the value of
the "Concurrent processing
tasks" preference (See Switch
preferences: Processing on
page 39)

Flow stop Any flowStopTriggered entry point
invocation

Minimum: 2

Maximum: twice the value of
the "Concurrent processing
tasks" preference (See Switch
preferences: Processing on
page 39)

Within each category concurrency is further limited by the serialization needs of each task type.
Thus even when a slot is available for a particular category, a task in that category may not
match the slot because, for example, another task of the same type is already executing and the
task type has the serialized execution mode.

Light and heavy scripts

Scripts include many of the tools built-in to Switch, and all third-party script packages.

Initially a script is heavy. If its entry points consistently complete quickly (in less than 1 second
for 5 consecutive times) the script becomes light, until it violates this "trust" by not completing
within 1 second once – it then becomes heavy again.

Scheduling tasks
The scheduler removes tasks from the task queue and schedules them for execution in one of
the available slots. The scheduler attempts to schedule a task:

• Each time a new task is queued (because a slot may be available that does not match the
previously queued tasks).

• Each time an execution slot becomes available because a task has completed (because there
may be a queued task that matches this slot).

The scheduler selects a task for execution by narrowing down the set of queued tasks using the
following steps:

1. Start with the set of all tasks on the queue that match any available execution slot.

2. Narrow down to tasks for jobs that have the highest job priority in the task set.

3. Narrow down to the task that was placed on the queue first.
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The selection process ends as soon as the result set contains a single task (in which case the
task is scheduled for execution) or is empty (in which case no action can be taken). The last step
selects a single task so the selection process always ends.

5.2.8.2.  Job priorities
The internal job ticket for each job contains a field that determines the priority of the job.

Tasks for jobs with a higher priority are executed first (unless the higher-priority task has
no matching execution slot; see Scheduling jobs on page 300). This can be used to "rush" a
particular job through a flow, or to define a high-priority flow (by assigning a higher priority to
all jobs in the flow).

A job priority is a signed integer number (in the range that can be represented with 32 bits). A
higher number indicates a higher priority. The default priority is zero; relative to the default a
priority can be higher (positive numbers) or lower (negative numbers).

A job's priority can be set through one of the properties of the folder flow element and through
the scripting API.

5.2.8.3.  Arrival stamps
The internal job ticket for each job contains a field that records the job's arrival stamp.

Unless job priorities dictate otherwise, Switch processes jobs in order of arrival (if there is a
matching execution slot). Switch uses the arrival stamp to determine which job arrived first. See
Scheduling jobs on page 300.

An arrival stamp is an unsigned integer number (in the range that can be represented with
32 bits). It indicates the order in which a job first arrived in a flow, as compared to other jobs.
Switch maintains a persistent and global arrival count that gets incremented each time a new
arrival stamp is handed out. Thus a higher number indicates a more recent arrival.

Several jobs may have the same arrival stamp. This happens when multiple jobs are generated
from the same original job, or when for some reason no arrival stamp was assigned to a job.

Stamping jobs

Switch assigns a new arrival stamp to a job when it first detects the job in a folder or submit
hierarchy, or when a producer (such as FTP receive or Mail receive) first injects the job into a
flow. A job's arrival stamp is not affected while the job is moving along a flow. Results generated
for a job (such as a preflight report, or a duplicate of the job) retain the original job's arrival
stamp.

In certain situations a job's arrival stamp needs to be refreshed (that is, assigned a fresh stamp)
so that the job is not unduly processed before other jobs. For example, a Checkpoint refreshes
the arrival stamp when moving a job along one of its outgoing connections.
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5.3.  Working with apps in Switch

5.3.1.  About the Switch apps - an introduction

What are Switch apps?

Apps are small applications that can be used as flow elements in Switch, without the need for a
license for the Configurator module. They are available through the Enfocus Appstore and not
linked to any Switch release: therefore, you can immediately install and use them in Switch.

Where to find apps?

You can search for Switch apps in the Enfocus Appstore (our webshop) or from within Switch,
through the search function in the Flow elements pane. The apps matching your search results
are displayed in the bottom part, together with a link to the Enfocus Appstore, where you can
buy them and immediately use them in your flows (even without restarting Switch!). For the
detailed procedure, see Finding apps on page 307.

Purchasing apps

Apps are sold through the Enfocus Appstore. Some apps are free, some are sold for a fixed
price (traditional/perpetual license), but for most apps you have to pay a subscription fee. See
Purchasing an app on page 308. If your subscription is about to expire, you'll receive an email
and a notification in Switch. Make sure to pay the subscription fee in time, so your flows remain
valid.

Not sure if a particular app suits your needs? You can download a free trial. See Trying an app for
free on page 307.

Note:  Sometimes the people who buy apps are not the people who use them. Is this
the case for you? Make the person who buys the apps a "Switch manager" of the Switch
installation on which the app will be used. See Adding a Switch manager on page 312.

Using apps on different Switch installations

Apps are linked to a Switch installation. You can however assign an app to a different Switch and
use it there without having to buy an additional license. If you want to use your apps on different
Switch installations at the same time, you need of course multiple licenses.

For more details, refer to see Assigning an app to a different Switch installation on page 311.

New versions

As soon as there are new versions of the apps you have purchased, you'll receive a notification in
Switch and you're entitled to use this new version immediately. For the detailed procedure, see
Installing a new version of an app on page 309.

Note that you're never obliged to switch to a newer version, and that you can go back to a
previous version as required.
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Notifications

As soon as you start working with the Enfocus Appstore, you'll get notifications. They are
displayed in the top right corner of the application. They inform you about newly installed apps,
new versions, the status of your license (e.g. apps that are about to expire,...)

If a notification is available, you will see a "bell" icon. The number indicates the number of new
(unread) notifications that are waiting for you.

 

 
You can open the notifications by clicking the icon and closing them again by clicking anywhere
in Switch. However, if you don't want to see the message anymore, you should click the cross
icon, and the notification will disappear.
 

 

Apps versus configurators

Apps are similar to configurators, yet there are a number of differences as explained in the table
below.

Apps Configurators

Purchased through the Enfocus Appstore Installed with Switch

You can only buy the apps you need Fixed set of configurators

Not linked to a Switch release Linked to Switch release

Subscription model (for most apps) License model (included in the Configurator
Module)

Can be used with the Switch Core Engine Configurator Module required

305



Switch

Apps Configurators

Can have all kinds of functionality Connect to third-party software

5.3.2.  About the Enfocus Appstore

The Enfocus Appstore

The Enfocus Appstore is the Enfocus webshop where you can purchase apps for use in Switch,
developed by third-party app creators.

The Enfocus Appstore is available via https://appstore.enfocus.com or from within Switch, by
clicking the Go to the Enfocus Appstore button in the Flow elements pane.

There you'll find an overview of all Switch apps currently available. For more information about
a particular app, simply click the logo or description. On the detail page, you can find detailed
information about the way the app works, the required Switch version or platform, support info,
how much it costs,... Starting from this page, you can also install a free trial or buy the app.

My Appstore

If you want information about the apps you have purchased and/or tried, you have to sign in to
the Enfocus website with your Enfocus ID. Clicking your username (in the top right corner of the
screen) gives access to a menu of which "My Appstore" is one of the options. My Appstore gives
access to the following sections:

• My apps lists all apps you have purchased. Here you can also find the status of your apps:

• Unassigned apps are apps for which you have a valid license, but that are not assigned to
a particular Switch installation yet. Refer to Assigning an unassigned app on page 310.

• Expired apps cannot be used anymore because the license has expired. You have to pay
the subscription fee in order to be able to use them again. To do so, click the Buy now
button.

• My Switch provides information about the Switch installation(s) linked to your Enfocus ID.
There are two ways to link a Switch installation to an Enfocus ID:

• When you sign into Switch using an Enfocus ID, that Switch installation is registered
automatically in the background. Note that the name mentioned in the list is determined
by the name set in the Switch preferences (Internal Communication).

• When another user wants to allow you to buy and assign apps to his/her Switch
installation as well, he can add you as a Switch manager for that Switch installation. In
that case, that Switch installation will also be linked to your Enfocus ID and you'll see it
under My Switch.

Here you can also add extra Switch managers for your Switch installation: people allowed
to buy and assign apps to your Switch installation. You are automatically a Switch manager
of your own Switch (registered as such when you sign into your Switch), and you can add
as many other people as you want to, by adding their email addresses. Note that Switch
managers have also access to the Switch Insight Dashboard. See also Adding a Switch
manager on page 312 and The Switch Insight Dashboard on page 486.

The apps that can be used on your Switch are called "assigned apps".
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Note:  On this page, you also find a Forget Switch installation link. Use this link only
if your Switch Server is no longer accessible, e.g. due to hardware issues and you
cannot uninstall the apps in Switch. Using this link, all apps will be uninstalled in
one go and all flows using apps will stop running. Your apps will become available
again under My apps, and you can re-assign them to another Switch installation as
required.

• My payments lists the apps you have purchased yourself.

5.3.3.  Finding apps
This topic describes how you can find an app using the search function in Switch.

Note:  Alternatively, you can directly go to the Enfocus Appstore by clicking the blue Go
to the Enfocus Appstore button (at the bottom of the Flow elements pane).

To find an app in Switch

1. In the Flow elements pane, enter (part of) a keyword in the search field at the top of the
pane.
The matching configurators are shown in the upper part of the pane, whereas the matching
apps are shown at the bottom, in the Enfocus Appstore section.

2. To know what the listed apps can do, hover over the items in the Enfocus Appstore section
and check the tooltip.

3. For a detailed explanation, click the app in the list.
You're redirected to the Enfocus Appstore, where you get detailed information about the
app, for example a full description, compatibility and version info, the name of the author,
screenshots, the subscription fee, ... On this page, you can start a trial or buy a license. See
also Trying an app for free on page 307 and Purchasing an app on page 308.

Note:  Enfocus does not offer support for apps that were developed by third-parties.
In case of problems, please contact the app creator (mentioned on the app detail
page in the Enfocus Appstore, under Support).

5.3.4.  Trying an app for free
If you have found an app that is interesting to you, you can start a free one-month trial.

To start a trial

1. On the detail page of the app in the Enfocus Appstore, click the Try it for free button.

2. Sign in with your Enfocus ID and password as required.

3. Assign the app to the Switch installation that you will use to work with the app.

By default, if you have more than one Switch, the app is assigned to all your Switch
installations. If you don't want this, clear the checkbox(es) as required.

4. Click Start free trial.
The app is downloaded to the assigned Swith installation(s).
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5. Do one of the following:

• If Switch is running, you can start using the app immediately by clicking the Refresh apps

button  in the top right corner of the Flow elements pane. This will install the app in
your local Switch.

Note:  If you don't click the Refresh apps button, the app will be installed
automatically next time you start Switch.

• If Switch is not running, next time you sign into Switch, the app is installed automatically
in the background. You don't have to do anything.

Note:  If you start Switch without being signed in, the app will not be installed.

You'll find the new app in the Apps category of the Flow elements pane. Note that you'll
also get a notification to inform you that the app has been downloaded and installed on your
system.
 

 

You can now use the app just like any other flow element. You can use it in your flows, define its
properties, ... Apps also have a context menu (similar to the context menu of the configurators)
that you can use to check the app details, to manage your subscription, ... When your trial is
about to expire, you'll get a notification. If you want to continue using the app, you'll have to buy
a license. See Purchasing an app on page 308.

5.3.5.  Purchasing an app
Apps are sold through the Enfocus Appstore. Most apps are sold via yearly subscriptions, some
are free of charge.

To purchase an app

1. On the detail page of the app in the Enfocus Appstore, click the Buy now button.

2. Sign in with your Enfocus ID and password as required.

3. Follow the payment and registration instructions.

4. Assign the app to the Switch installation that you will use to work with the app.
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Note:

• If you have bought several licenses for the same app, you can assign each license
seat to a particular Switch installation.

• If you don't want to assign the app yet to a particular Switch, click .. or assign
all later. The app will not be installed locally (hence it cannot be used), but it
remains available in the Enfocus Appstore (under My apps).

5. Click Assign now.
The app is downloaded to the assigned Swith installation(s).

6. Do one of the following:

• If Switch is running, you can start using the app immediately by clicking the Refresh apps

button  in the top right corner of the Flow elements pane. This will install the app in
your local Switch.

Note:  If you don't click the Refresh apps button, the app will be installed
automatically next time you start Switch.

• If Switch is not running, next time you sign into Switch, the app is installed automatically
in the background. You don't have to do anything.

You'll find the new app in the Apps category of the Flow elements pane. Note that you'll also
get a notification in Switch to inform you that the app has been downloaded and installed on
your system.
 

 

You can now use the app just like any other flow element. You can use it in your flows, define its
properties, ... Apps also have a context menu (similar to the context menu of the configurators)
that you can use to check the app details, to renew your subscription, or to uninstall the app if
you don't need it anymore. See also Uninstalling an app on page 311.

5.3.6.  Installing a new version of an app
If a new version is available, you can update the app for free (but you are not obliged to do so).
You can also downgrade as required.
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Proceed as follows:

1. Do one of the following:

• When a new version of an app is available, you will get a notification in Switch. To get
more information about this new version, click the notification.

• Alternatively, go to the My Apps page via My Appstore. Search the app concerned, and
click Change version beside its name.

The Change Version page appears.

2. Select the version you would like to install.

3. Check the release notes and the compatibility section on the lower part of the page.

4. If you're sure you want to install the new version, click Change version.

5. Do one of the following:

•
If Switch is running, click the Refresh apps button  in the top right corner of the
Flow elements pane. This will update the app in your local Switch.

• If Switch is not running, next time time you log into Switch, the app is updated
automatically in the background. You don't have to do anything.

In Switch, you'll see a dialog with information about the version change.

6. Click OK.

You can still cancel the update if necessary.

All flows are temporarily deactivated, the app is updated, and finally the flows are re-
activated automatically. You can go on using the updated version of the app.

5.3.7.  Assigning an unassigned app
In order to use an app, it must be assigned to a Switch installation. Apps that were purchased
but not assigned to a Switch installation are "unassigned" apps. They remain available via your
account section on our website.

To start using them, proceed as follows

1. Go to http://www.enfocus.com.

2. In the top right corner of the screen, click Sign in and sign in with your Enfocus ID.

3. Click your username and select My Appstore > My apps.

4. Go to your unassigned apps.

5. Select one of your Switch installations from the Assign to list.

6. Click Assign.
The app is downloaded and installed on the selected Switch device.

7. Do one of the following:

• Start the Switch installation selected in step 3 and sign in.
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• If Switch (on the device selected in step 3) is running and you're signed in already, click
the Refresh apps button.

The app is shown in the Apps category of the Flow elements pane.

5.3.8.  Uninstalling an app
Uninstalling an app means that you remove the app from your local Switch. It will be no
longer shown in the Flow elements pane and it's no longer assigned to your Switch device,
but it remains available in the Enfocus Appstore (under My Apps) (as long as you've paid the
subscription fee).

There may be several reasons to uninstall an app, for example:

• You want to use the app on another Switch installation. In that case, you first have to
unassign it from one system and then reassign it to the other system.

• You want to remove an expired app (displayed in gray in the Flow elements pane) from your
Switch.

To uninstall an app

1. Launch Switch on the device on which you don't want to use it anymore.

2. In the Flow elements pane, in the Apps category, search for the app you want to uninstall.

3. Open the context menu.

4. Click Uninstall.
A warning appears.

5. Click OK.
If the app is used in an active flow, the flow will be deactivated. It will not be possible
anymore to activate the flow (unless you remove the app from the flow).

5.3.9.  Assigning an app to a different Switch installation
You can use an app with a different Switch installation than the one that it's currently assigned
to.

To do so

1. Uninstall the app you want to reassign..
The app will no longer be linked to the Switch installation you're currently using.

2. Go to http://www.enfocus.com.

3. In the top right corner of the screen, click Sign in and sign in with your Enfocus ID.

4. Click your username and select My Appstore > My apps.

5. In the section about unassigned apps, assign the app you just uninstalled to the Switch
installation of your choice.

Note:  If it does not appear in the list, you are not a Switch manager for that
installation, so you don't have the right to assign apps. Ask the owner of the Switch

311

http://www.enfocus.com


Switch

installation to add you as a Switch manager or sign into the Switch installation, to
link it to your Enfocus ID.

6. Sign into the Switch installation selected in step 5.

If you were already logged in, make sure to click the Refresh apps button in the Flow
elements pane.

The app is listed in the Apps category and is ready for use.

5.3.10.  Adding a Switch manager
If you want someone else to buy and install apps for you, you must make this person "Switch
manager" for your Switch installation.

Note that this user will also have access to the Insight Dashboard for your Switch (if enabled).

To add a Switch manager

1. Go to http://www.enfocus.com.

2. In the top right corner of the screen, click Sign in and sign in with your Enfocus ID.

3. Click your username and select My Appstore > My Switch.
Here you will see all information concerning the Switch installation(s) linked to your Enfocus
ID, such as the name, the Switch version and the Switch managers. Note that all users
having signed into the Switch installation concerned have been registered automatically as
Switch managers. You can add or remove Switch managers as required.

4. Beside Switch managers, click edit.

5. Enter the email address of the person that should have the right to buy and assign apps to
your Switch installation.

6. Click Add.

7. Click Save.

The person that you have added as Switch manager will now see your Switch installation under
My Switch in the Enfocus Appstore. When this person buys apps in the Enfocus Appstore he will
be able to assign them to your Switch installation.

5.4.  Using the Switch Web Portal
The Switch Web Portal allows users to access the Switch Server through a web browser. This
means that users can access the Switch Server from another computer than the one that is
running the Switch Server, without the need for a Switch Designer.

Currently, the following functionality is available:

• Viewing log messages issued by the Switch Server. This includes customizing the messages
overview (sorting, filtering, etc) and exporting and clearing messages as required.

• Viewing and finding jobs processed by the Switch Server. This includes creating your own job
board(s), which allows you to visualize the jobs present in certain flows and with certain flow
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stages. If you have purchased a Reporting Module license, you can use the data on these job
boards to create dashboards with counters and graphs.

• Submitting and checking jobs, on condition that you have licensed the SwitchClient Module.

Note that users should be granted access via the Users pane.

The connection can be encrypted as required (HTTPS); this can be configured through the user
preferences (Switch preferences: Web Services).

5.4.1.  Signing in to the Switch Web Portal
To sign in to the Switch Web Portal

1. Open a browser.

Google Chrome, Safari, Edge and Firefox are supported.

2. Enter the IP address or the hostname of the computer running the Switch Server followed
by ":" and the port number for the Switch Web Portal (as set in the Switch Preferences (Web
Services category)). The default port number is 51089.
For example:
 

 
A login screen appears. The first time you'll see a banner stating that cookies on the site are
used to enhance the user experience.

3. In the banner, click Accept to allow Switch to save your preferences.
If you accept cookies, your preferences are saved by the browser. As a consequence, you
don't have to set your preferences next time you sign in; they are remembered. If you click
Do not use cookies, you can continue to work, but you will have to set your preferences
again next time you log in.

4. Enter your user name and password.

5. Optionally, select the Remember me checkbox.

This way, you don't have to log in each time you close your browser. If enabled, you remain
logged in for 24 hours.

6. Click Sign in.

The Switch Server must be running, otherwise you will not be able to sign in.

The Switch Web Portal start page appears. What you can see and do, depends on your
permissions (as configured by the Switch administrator through the Users pane). Refer to
The Switch Web Portal page layout on page 313.

5.4.2.  The Switch Web Portal page layout
The Web Portal page layout consists of 3 parts: the header (1), a navigation area (2) and a
workspace with the selected view (3). Each part is described below.
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1. The header

In the top right corner, the home icon  gives access to the homepage of your choice.

Next to that, you'll find your Switch username and a small arrow icon. Clicking this icon will
open a menu with language choices, and two extra options: Set as homepage and Sign out. For
more information, refer to Changing the language of the Switch Web Portal on page 316 and
Setting a homepage on page 317.

2. The navigation area
The sidebar can be collapsed (to have more space on the screen) or expanded by clicking the

menu button . It consists of a number of buttons above and below a divider. The buttons
above the divider give access to particular views (such as the Messages view, the Boards view,
…), the buttons below the divider give access to extra functionality of the active view.

The view that is active is highlighted; in the example below, that is the Submit jobs view. The +
Manage button below the divider enables to manage Submit point URLs.

Note:  Your permissions determine which and how many views you have on the Portal.
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Navigation area Description

1. Button to expand or collapse the menu.

2. Buttons to display the different views (see
below)

3. Buttons to access extra functionality of the
highlighted view.

4. Gear wheel to get more info. When you click
the gear wheel, a new dialog is opened with links
to:

• The Switch documentation on the website
• The Enfocus Support Portal (to report a

problem)
• The Support page on the Enfocus website
• The Switch system requirements.

3. The selected view

The view chosen in the navigation determines what's shown in the right part of the screen. In the
table below you get more info about each of the views.

Through
this view

You can... More info

Access the pages for administrators. Here you can:

• Remotely start and stop your flows, view the flow design,
print the flow documentation, and add annotations.

• Get system info
• View the number and identity of active users
• Customize the logo on the Portal

Using the
Web Portal
Admin view
on page
370

Submit jobs remotely via a Switch Submit Point. Submitting
and
checking
jobs through
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Through
this view

You can... More info

the Switch
Web Portal
on page
345

Check jobs that arrive in a Switch Checkpoint. Submitting
and
checking
jobs through
the Switch
Web Portal
on page
345

View the log messages issued by Switch Server. Viewing log
messages
through the
Switch Web
Portal on
page 317

Manage job boards and/or dashboards.

Job boards provide info about the status of your jobs.

Dashboards provide info about the number of job being
processed, and these numbers are visualized by means of
widgets (counters, tables, graphs). If you don't have access
to this functionality, the button to create new dashboards is
missing.

Finding
Switch jobs
through the
Switch Web
Portal on
page 324.

Managing
dashboards
on the
Switch Web
Portal on
page 328.

5.4.3.  Changing the language of the Switch Web Portal
By default the language on the Switch Web Portal is determined by your system's local settings.

To select a different language (i.e. one of the Switch languages), proceed as follows:

1. In the top right corner of the screen, click your user name.

The name displayed is your user name as defined in the Users pane in the Switch Designer.

2. Click the language of your choice.

Possible languages:

• English
• German
• French
• Japanese
• Chinese
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Your choice is remembered. Next time you sign in to the Web Portal (through the same
browser), the content will be displayed in the chosen language.

5.4.4.  Setting a homepage
When you're often using the same page on the Switch Web Portal, you can bookmark that page
as your homepage.

To do so, proceed as follows:

1. Display the page you want to use as homepage, for example the Submit jobs view or the
Messages view.

2. In the top right corner of the screen, click your user name.

The name displayed is your user name as defined in the Users pane in the Switch Designer.

3. From the menu, select Set as homepage.

Next time you log in, the chosen homepage will be displayed as your start page. Clicking the

home icon  (anywhere on the Portal) also gives access to this homepage.

5.4.5.  Viewing log messages through the Switch Web Portal
If you have the right permissions, you can view the log messages in a browser without having to
open a Switch Designer. The permissions are set through the Users pane.

To view the log messages

1. Sign in to the Switch Web Portal.

See Signing in to the Switch Web Portal on page 313.

2.
If the messages are not displayed, in the navigation area on the left, click  Messages.
The current date's log messages are displayed, in chronological order, most recent
messages at the top. If the autorefresh option is turned on (indicated by the auto refresh

icon ), the list is automatically renewed. Info, warning and error messages are shown by
default, debug messages are hidden. See also: The Messages overview on page 286.

You can now show more messages or filter out the messages you're not interested in, or export
the messages to a csv file. Refer to Filtering log messages on page 290 and Exporting log
messages  on page 292.

5.4.5.1.  The Messages overview
This topic describes the Messages overview.

You can open this overview

• Through the Switch Web Portal.
• From within Switch, by clicking the Messages button in the toolbar of the Switch Designer.

Alternatively, you can press F6 or select View > Messages.
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Note:  If opened from within Switch, it's possible to have the messages shown inside
the Switch Designer (For more info, refer to User interface category of the Switch
preferences(last setting)).

Buttons and menus

The table below explains the meaning of the main buttons, labels, icons and menus in the
Messages overview.
 

 

Button/menu Description

Shows the name of the user that logged in.

If you click the icon , you'll get a menu where you can
change the language and sign out as required.

See Changing the language of the Switch Web Portal on page
316.

Note:  If you open the Messages overview from
within Switch, this option is not available. In that
case, the Messages overview is displayed in the
language of the Switch Designer.

Indicates the date(s) on which the shown messages were
issued, and allows you to select a different date or date
range.

• : Show messages of the previous day

• : Show messages of the next day

• : Show messages of a particular date or date range.
You can also choose "Full history", i.e. all messages
since the last message cleanup (as defined in the
Switch preferences (Application data category)).
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Button/menu Description

Indicates the time frame in which the shown messages
were issued. You can move the blue arrows to enlarge or
reduce the time frame.

The red vertical lines represent error messages. This
way you can immediately see when error messages were
issued.

 

 

The applied filters are listed right above the Search field.
When two different filters are applied, all log messages
that match one of the strings are shown (in this example:
messages that have "PitStop Server" OR "ScriptExecutor"
in the description).

This part of the overview allows you to configure filters,
to select messages that contain certain strings (in the
message itself, in the name of the flow, the name of the
job, …) Refer to Filtering log messages on page 290.

Opens a menu with the following options:

• Flow, Job, Module, Element, Prefix: Refers to the
columns in the overview. Click to hide or show columns
as required.

• Reset view: Allows you to reset the columns to their
default size and position: only Flow, Job and Element
are shown by default.

• Export: Allows you to export the filtered log messages
to a .csv file. You can either open the file or save it
locally.

• Clear all: Allows you to remove all log messages from
the log database. Note that there is no undo for this
action!

Message types, indicating the severity level of the
message.

If colored, the messages of that type are displayed in the
overview, in a background with the corresponding color. In
the example, info, warning and error messages are shown,
whereas debug messages are hidden (default). You can
click a message type to switch from hidden to shown and
vice versa, or you can click the arrow to the right, to only
show the messages of that particular type.

Note:  Info messages are displayed in a white and
gray background.

Note that the Debug button also shows or hides assert
messages. See also the table below (Message types).
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Button/menu Description

By default, the page refreshes automatically, so you
always have an up-to-date overview.

You can turn off this option by clicking the auto refresh

button , which will turn into a blue arrow .

Columns

The following table describes the columns in the Messages overview.

Remember that you can hide columns as required via the icon  just below the search field. It's
also possible to resize the columns.

Column Description

Time Time when the message was triggered.

Flow The name of the flow that triggered the message.

Job The name of the job for which this message was issued.

Module The Switch module (such as Control) or type of flow element (such as
folder, Mail receive, ...) that triggered the message.

Element The name of the flow element that triggered the message.

Prefix The unique name prefix of the job referred to in the message, or blank if
there is no unique name prefix.

Message The message itself.

Message types

The following table describes the different types of messages that can appear in the Type
column of the Messages overview.

Type Description

Info An informational message that has no other purpose than to inform the
user of a certain occurrence.

Info messages are always shown in the Messages overview (unless a filter is
applied).

The Messages overview displays all types of info messages (related to
Switch Server and to Switch Designer).

Warning A warning message that informs the user of a recoverable problem or non-
fatal error.

Warnings are always shown (in orange) in the Messages overview (unless a
filter is applied).
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Type Description

Error An error message that informs the user of a fatal error.

Errors are always shown (in red) in the Messages overview (unless a filter is
applied).

Debug An informational message solely intended for debugging purposes (often
generated by configurators).

Debug messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Switch Preferences: Logging.

Assert A message solely intended for debugging purposes that is issued only when
a coding error is discovered.

Assert messages are not shown by default. If the Log debug messages
preference is enabled, you can display them using the Debug message type
filter.

Refer to Refer to Switch Preferences: Logging.

Note:  Scripters have access to all messages, to be able to debug their scripts.

5.4.5.2.  Filtering log messages
By default, all info, warning, and error messages issued on the current date are shown in
the Messages overview. You can however change this and only display the messages you're
interested in.

To filter the log messages

1. Pick the date(s) of which you want to see the messages.

By default, today's messages are shown.

To ... Do the following ...

Show messages of the previous
day

Click 

Show messages of the next day Click 

Show messages of a particular
date or date range

Click 

Show messages of a particular
date or date range

Click  and select the appropriate option
from the menu:

• Today
• Yesterday
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To ... Do the following ...

• Choose date(s): Opens a calendar. Click
the date you want to select. In case of
a date range, click the first and the last
date.

• Full history: Displays all messages since
the last messages cleanup (as defined in
the Switch preferences (Application data
category)).

2. Pick the appropriate time frame:

• To indicate the start time, click the blue indicator to the left of the slider and drag it to the
time of your choice.

• To indicate the end time, click the blue indicator at the right of the slider and drag it to
the time of your choice.

By default, the messages of the current date are shown. The blue part indicates the
currently shown time. The red vertical lines indicate when time error messages were
issued.

Note:  If the end time is not the current time, the auto refresh is disabled and the
auto refresh button will turn into a blue arrow. If you click this blue arrow, auto
refresh is turned on again and the end time is reset to the current time.

3. Pick the type of messages you want to see in the overview:

• Click the name of the message type to show or hide it in the overview. If the name is
shown in a colored background, the messages are shown in the same background color,
if the name is shown in white, the messages are hidden. Note that info messages are
shown in a white and grey background.

• Click the small arrow next to the message type to open a menu with two options:

• Hide messages of this type
• Only show messages of this type

By default, all types except for debug messages are shown.

4. Set a filter as required:

a. Select the column in which you want to search for a particular string. If the column
doesn't matter, choose Any.

b. In the search field, enter one or more strings to only view the messages that contain
those strings. The case of the entered strings is not taken into account.

c.
Press enter or click the  button.

The filter is applied immediately. The messages that match the filter are shown, and the
filter definition is displayed just above the filter field.

Remarks:

• Alternatively, you can select a string somewhere in the overview and click Search this
(which appears automatically). The filter is configured and applied automatically.

Example:
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Resulting filter:
 

 

• To view messages that contain several strings in one entry (e.g. configurator AND
workflow), type those strings in one filter field.
 

 

• To view messages that contain either string x or string y (e.g. configurator OR workflow),
type those strings in two different filter fields (see screenshot).
 

 

5. To clear a filter, click the cross button in the filter label.
The label is removed and the messages overview is updated immediately.

Note:  Remark for Web Portal users only: You can save your message filters by clicking
the + Save current filter button in the blue sidebar/navigation area.

5.4.5.3.  Exporting log messages
Log messages can be exported to a CSV file for processing by third-party tools. If you have set
filters, these filters are taken into account; only the messages that are shown will be exported
to a file.

To export log messages

1. Open the Log messages overview.

2. Click the icon  below the search field.

3. Click Export.
A log.csv file is created.

5.4.5.4.  Clearing log messages
Log messages are stored in a database on disk and thus remain available after quitting and
restarting Switch. The application data preferences determine for how long messages are
retained.
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To permanently clear all log messages

1. Open the Log messages overview.

2. Click the icon  below the search field.

3. Click Clear all.
A confirmation dialog appears. If you click Clear, all messages will be removed from the log
database. Note that there is no undo for this action!

5.4.6.  Finding Switch jobs through the Switch Web Portal

5.4.6.1.  About job boards

Job boards (aka Job finder boards) provide you with a handy tool to follow up on the status of
your jobs. No need to use a (Remote) Designer to watch how your jobs move through the flows;
instead you can open a browser on any computer, log into the Switch Web Portal and create your
own job board(s) with only those flows and jobs that are of interest to you.

Here is an example of a job board that shows you which jobs are in which stage. The jobs can be
further grouped by flow or state, using the Group by field in the top right corner of the screen.

At the bottom of the screen, there is an extra filter 'Include jobs finished in the last x* hours',
which allows you to determine how long finished jobs should remain on the job board.

Note:  Access to job boards and dashboards is configured through the Users pane in
Switch, hence it's possible that you don't have access to this functionality or that you can
only view shared boards but not create new ones yourself.

* Remark for Switch administrators: Note that this value cannot be higher than the value of Keep
internal job tickets for (hours) in the Switch Application data preferences; if the internal job ticket
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is removed, the job does not exist anymore in Switch, hence it cannot be shown anymore on a
job board.

5.4.6.2.  Creating a job board
A job board on the Switch Web Portal can display the jobs of your choice. You can select the
flows for which you want to display jobs and - if you want to - only show those jobs that have a
certain job status or that are in a certain job stage.

Note:  Job boards are linked to your user account. Other users can't see them, unless
you share them.

To create a job board

1.
In the navigation area on the left, click  Boards.

Make sure the navigation area is expanded (by clicking ).

2. With the Boards view selected, click + Manage.

If you don't see + Manage in the expanded navigation area on the left, you may not have the
permissions to create boards.

The Manage boards dialog appears.

3. In the bottom right corner of the dialog, click New job board.

If you don't see the New job board button, you may not have the permission to create boards.

4. Configure your board:

a. Enter a name for your board.
b. Click Select flows (the blue button to the right of the navigation area).
c. In the dialog that appears, select the flows you want to see on your job board. To do so,

click Select all (if applicable) or click the flow name of the flows you want to select.

Flow groups are shown in gray, flow names in blue. You can select all flows in a group by
clicking the group name.

Note:  Make sure to select all flows you want to see on your job board; in the next
step you can divide these flows over different columns.

d. Click Apply.

5. Configure the first column of your job board:

a. Enter a column name.
b. Select at least one flow.
c. Select the flow stages if applicable.

Problem jobs and No stage are by default available. If stages have been defined in the
selected flows, they will be added and can be shown as well.

If nothing is selected, all jobs are shown, regardless of their job stage.

6.
To add another column, click the plus button  to the right of the configured column and
proceed in the same way. You can add as many columns as you need.
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7. Click Save.

5.4.6.3.  Managing a job board
This topic explains how to handle the custom job boards on the Switch Web Portal.

Proceed as follows:

1.
In the navigation area on the left, click  Boards.

Make sure the navigation area is expanded (by clicking ).

2. Click + Manage.
The Manage boards dialog appears. This dialog gives an overview of the boards you have
access to. The grayed out boards are shared by other users; you can view them but not make
any changes. The other boards are your own boards and are fully controlled by you.

3. Do one of the following as required:

To... Do the following:

To create a new job
board

Click New job board (blue button in the bottom right
corner). See also Creating a job board on page 325.

To show or hide
a job board in the
navigation area

Click the slider  in front of the job board you
want to show or hide. If the slider is blue, the job board
is visible in the sidebar.

Note:  This functionality is useful for job boards
you want to keep for later use or for job boards
that you want to use as dataset for a dashboard
(for users of the Reporting module).

To edit a job board Click the edit button  (which becomes visible when
you hover over the job board concerned).

Note:  Alternatively, you can click the edit

button  beside the job board name in the
navigation area.

You can now edit the board name and the columns:

• To change the number of flows on board level, you
should click the blue button ("x flows selected") next
to the board name.

• To add a new column, click the plus icon to the right

of the last configured column. 
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To... Do the following:

• To move the columns to another position, click the

icon  and drag the columns you want to move
sideways.

Note:  Instead of dragging the sliders to make
a selection, you can just click the group, flow
or stage name to make a selection or to undo a
selection.

To return to view mode, click the Save button (in the top
left corner, next to the name of the board).

To share a job board
or to stop sharing it

Job boards can be shared with other members of the
same user group (as configured in Switch).

To share or stop sharing, in the Sharing column of the
board concerned:

1. Click Private/Shared.
2. In the dialog that pops up, select or clear the

checkbox of the group(s) with whom you want to
share your board. If no dialog pops up, you cannot
share the board (for example because you're not
configured as member of a group).

Note:  Shared boards can only be viewed
(not edited!) by other users.

To import or export a
job board

Boards can be exported (and kept as a backup) and
imported again if needed.

To export a board, click the export button  next
to the board you want to export. A Switch board is
saved with extension .sboard. Note that the export
button becomes visible when you hover over the board
concerned.

To import a board, click the Import button at the bottom
of the dialog and select the board (*.sboard) of your
choice.

To permanently
remove a job board Click the remove button.
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4. To save the changes made in the Manage jobs dialog, click Apply.

5.4.6.4.  Viewing and finding jobs on a job board
If you have the right permissions, you can view Switch jobs through the Switch Web Portal. The
permissions are set by the Switch administrator through the Users pane.

To find jobs on a job board

1.
In the navigation area on the left, click  Boards.

Make sure the navigation area is expanded (by clicking ).

2. Select one of the boards in the navigation area, below the divider.

There are two types of boards listed below the divider: job boards and dashboards (only
available if the Reporting Module is licensed). The board type is mentioned in the Manage
boards dialog (which can be opened by clicking + Manage). Boards displayed in white are
owned by you, boards displayed in blue are shared boards (which cannot be edited by you).

The selected job board is shown to the right of the navigation area. The jobs are listed in
columns. What is shown depends on the configuration of the board.

3. To reorganize the overview, click the Group by list field in the top right corner of the screen,
and select the option of your choice (Flow, Stage, State or None (which removes any
previous grouping).

A group adds an extra level to a column.

For example, suppose one of the columns of your board lists all problem jobs of all flows.
With 'Group by' set to 'None', the jobs are put arbitrary one after the other. With 'Group by'
set to 'Flow', the Problem jobs column is divided into different sections per flow, so you can
easily see which problem job belongs to which job.

4. To search for a particular job for example to see if it reached a particular flow stage, enter
(part of) the job name in the search field in the top right corner of the screen.

The search is limited to the file name (name and extension).

5. To display recently finished jobs (by default, they are not shown), enter a value in the Include
jobs finished in the last x hours field at the bottom of the job board.

6. To see the log messages, metadata or private data of a particular job on the board, simply
click the job concerned.

Note that this feature is only available if you have turned off the autorefresh option (by
clicking it at the bottom of the screen).

5.4.7.  Managing dashboards on the Switch Web Portal

5.4.7.1.  About dashboards and widgets
As of Switch 2018 update 1, it is possible to create your own dashboards on the Switch Portal.
This requires a license for the Reporting Module.
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Dashboards on the Switch Web Portal can give you a quick overview of the number of jobs that
are being processed by the Switch Server. You can for example display a counter (how many
jobs failed, how many jobs are in a particular stage,…) or a graph with numbers per file type,
flow,... It's also possible to visualize historical job data (e.g. number of problem jobs per week
over the past 3 months).

The graphs and counters are actually widgets that can be configured at wish. The input for
these widgets (i.e. the data that is visualized) comes from a job board. The widgets can be
customized to a certain level: you can for example add a frame around a widget in the color of
your choice, you can add a title, in case of a graph you have the choice between a bar, a donut or
a pie chart,...

Currently, seven different widgets are available for use on the Switch Web Portal. They are
listed below.

Note:  Access to job boards and dashboards is configured through the Users pane in
Switch, hence it's possible that you don't have access to this functionality or that you can
only view shared boards but not create new ones yourself.

Column layout

This is actually a layout that helps you position the widgets on the screen. You need it to put
different widgets next to each other. If you want to put the widgets one after the other, in a
vertical arrangement, you don't need a layout.

Example of 2 live counters in a column layout (horizontal arrangement):
 

 
Example of 2 live counters without column layout (vertical arrangement):
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See also: Dashboard widgets - Column layout on page 336

Custom HTML

This widget allows you to add a title, a logo, text and even a movie to your dashboard.

See also: Dashboard widgets - Custom HTML on page 337

Live counter

This widget displays a number, representing the amount of jobs currently present on the
selected job board.

See also: Dashboard widgets - Live counter on page 337

Live graph

This widget counts both the total number of the jobs on the selected job board and the number
of jobs per column, and presents this data as a graph.
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See also: Dashboard widgets - Live graph on page 339

Live table

This widget displays information about the jobs counted in a live graph on the same dashboard.
For example, if your graph gives an overview of the number of jobs per flow, the live table
displays detailed information about these jobs (job name, flow name, stage and state of the job).

See also: Dashboard widgets - Live table on page 340

Messages

This widget gives a real-time overview of messages based on a messages filter (that you have
configured yourself). You can choose the columns you want to display and the maximum number
of messages.
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See also: Dashboard widgets - Messages on page 341

History graph

This widget visualizes the evolution of the number of jobs or the job size over a particular period
of time, for example the total number of problem jobs of the last month, grouped by week.
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See also: Dashboard widgets - History graph on page 343

5.4.7.2.  Creating a dashboard
A dashboard is an overview screen with one or more widgets that visualize job data.

Before you start, make sure to create a job board with the data you want to display on the
dashboard. Alternatively, you may use a shared job board. A job board to start from is necessary
for all widgets, except for the history graphs and custom HTML. For example, if you want your
dashboard to display the total number of problem jobs on the server, you need a job board that
collects all problem jobs.

Note:  Job boards are linked to your user account. Other users can't see them, unless
you share them.

To create a dashboard

1.
In the navigation area on the left, click  Boards.

Make sure the navigation area is expanded (by clicking ).

2. With the Boards view selected, click + Manage.

If you don't see + Manage, you may not have the permission to create boards.

The Manage boards dialog appears.

3. In the bottom right corner of the dialog, click New dashboard.

If you don't see the New dashboard button, you may not have the permission to create
boards.

4. Configure your board:

a. Enter a name for your board.
b. Choose a layout:

• If you want to place the different widgets one below the other (vertical arrangement),
you don't need a layout. If there is one on your dashboard (default configuration when

creating a new board), click the remove button  to remove it.

• If you want a horizontal arrangement with two or more columns next to each other,
you need a column layout. If there is one on your dashboard (default configuration

when creating a new board), click the edit button  to configure it. Refer to
Dashboard widgets - Column layout  on page 336.

c. Drag and drop one or more widgets onto the column of your choice (in case of a column
layout) or directly onto the dashboard and configure them as required:

• Dashboard widgets - Custom HTML on page 337

• Dashboard widgets - Live counter on page 337

• Dashboard widgets - Live graph on page 339

• Dashboard widgets - Live table on page 340
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• Dashboard widgets - History graph on page 343
d. To switch between configuration or edit mode and view mode:

• Click the edit button  in the header of the widget to make changes.

• Click the view button  in the header of the widget to view the result of your
changes.

5. Click Save.
The dashboard is added to the navigation area.

Note that you can still make changes by clicking the edit button  beside the name of the
dashboard in the navigation area.

5.4.7.3.  Managing a dashboard
This topic explains how to handle the custom dashboards on the Switch Web Portal.

Remember that dashboards are only available if the Reporting Module is licensed.

Proceed as follows:

1.
In the navigation area on the left, click  Boards.

Make sure the navigation area is expanded (by clicking ).

2. Click + Manage.
The Manage boards dialog appears. This dialog gives an overview of the boards you have
access to. The grayed out boards are shared by other users; you can view them but not make
any changes. The other boards are your own boards and are fully controlled by you.

3. Do one of the following as required:

To... Do the following:

To create a new
dashboard

Click New dashboard (blue button in the bottom right
corner). See also Creating a dashboard on page 333.

To show or hide a
dashboard in the
navigation area

Click the slider  in front of the dashboard
you want to show or hide. If the slider is blue, the
dashboard is visible in the sidebar.

Note:  This functionality is useful for
dashboards you want to keep for later use.

To edit a dashboard Click the edit button  (which becomes visible when
you hover over the dashboard concerned).

Note:  Alternatively, you can click the edit

button  beside the dashboard name in the
navigation area.
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To... Do the following:

You can now add or remove widgets and make changes
to the widgets as required:

• To add a widget, click it (in the right part of the
screen) and drag it onto the dashboard.

• To remove a widget, click the remove button  in
the header of the widget.

• To make changes to a widget, click the edit button

 in the header of the widget.

• To view your changes, click the view button  in the
header of the widget.

Do not forget to save your changes, by clicking the Save
button (in the top left corner, next to the name of the
dashboard). By saving your changes, you automatically
switch to view mode.

To share a dashboard
or to stop sharing it

Dashboards can be shared with other members of the
same user group (as configured in Switch).

To share or stop sharing, in the Sharing column of the
board concerned:

1. Click Private/Shared.
2. In the dialog that pops up, select or clear the

checkbox of the group(s) with whom you want to
share your board. If no dialog pops up, you cannot
share the board (for example because you're not
configured as member of a group).

Note:  Shared boards can only be viewed
(not edited!) by other users.

To import or export a
dashboard

Boards can be exported (and kept as a backup) and
imported again if needed.

To export a board, click the export button  next
to the board you want to export. A Switch board is
saved with extension .sboard. Note that the export
button becomes visible when you hover over the board
concerned.

To import a board, click the Import button at the bottom
of the dialog and select the board (*.sboard) of your
choice.

To permanently
remove a dashboard Click the remove button.
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4. To save the changes made in the Manage jobs dialog, click Apply.

5.4.7.4.  Viewing a dashboard
If you have the right permissions, you can create and view dashboards through the Switch Web
Portal. The permissions are set by the Switch administrator through the Users pane.

To view your (earlier created or shared) dashboards on the Switch Web Portal

1.
In the navigation area on the left, click  Boards.

Make sure the navigation area is expanded (by clicking ).

2. Click one of the boards in the navigation area, below the divider.

There are two types of boards listed below the divider: job boards and dashboards (only
available if the Reporting Module is licensed). The board type is mentioned in the Manage
boards dialog (which can be opened by clicking + Manage). Boards displayed in white are
your own boards, boards displayed in blue are shared boards (which cannot be edited by
you).

The dashboard is shown to the right of the navigation area. There may be several widgets
present on the dashboard. Some of the widgets show extra information when hovering or
clicking the legend. For more information, refer to the description of the widgets (Dashboard
widgets overview on page 336).

5.4.7.5.  Dashboard widgets overview
This is an overview of the widgets available for use on a Dashboard on the Switch Web Portal.

Dashboard widgets - Column layout

About the Column layout

The column layout is actually a layout, so not a graph or a counter. It allows you to place several
widgets next to each other in columns, for a horizontal arrangement. If no column layout is
chosen, the widgets will be placed one after the other, in a vertical arrangement.

How to configure the Column layout
By default, two columns are available, but you can add more columns by switching to edit mode

 and clicking the  button.

Note that you should first configure the column layout; afterwards (after having saved/having
clicked the  button) you can drag the widgets onto the layout.

Properties

Property Description

Spacing White space between two columns.

You can enter a value expressed in the unit of your choice: px, em or %
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Property Description

When using pixels or em, the size of the white space will be fixed; when
using a percentage, the white space will adjust when the screen is resized.

Note that this setting is optional and only needed when you want separate
the widgets.

Columns
with width
settings

For each of the individual columns you can either define a column width or
a minimum and/or maximum width.

The width can be fixed (expressed in px or %) or "fit the content" (meaning
that you let Switch decide which is the best size).

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

Dashboard widgets - Custom HTML

About the Custom HTML widget

This widget allows you to add text, tables, pictures, movies and links to your dashboard. You can
use the text color and font of your choice, insert bullets, ...

How to configure the Custom HTML widget

You can type text in the text field and modify it using the tools in the editor.

An overview of shortcuts is available behind the question mark button. 

Properties

Property Description

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

Dashboard widgets - Live counter

About the Live counter widget

This widget displays a number, representing the amount of jobs currently present on the
selected job board. Note that all jobs in all columns are taken together, resulting in one number,
for example the number of problem jobs.
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This number can be linked with a color, for example, if the number of jobs remains below a
certain threshold, the background of the widget turns green; otherwise it turns orange or red.

The counter is updated at regular intervals (see properties), giving a live view on the Switch
server.

How to configure the Live counter widget

You can configure the properties listed in the table below.

Properties

Property Description

Job board Job board data that will be used for the dashboard.

'None' is not a valid option.

Set By default, the data in all columns of the selected job board will be used
("All"), unless you select one particular column.

Include jobs
finished
in the last
(hours)

The value chosen here determines how long after finishing the jobs will be
included in the live counter.

If you enter '0', only jobs that are still moving through the flow and haven't
reached an output folder will be included.

If the widget doesn't behave as expected, contact your Switch administrator.
There may be a conflict with the Keep internal job tickets for (hours) in the
Switch Application data preferences.

Color Background color of the widget based on the value of the counter.

To change a value, click it and increase or decrease the value using the
small arrow buttons.

To change a color, click it to open the color picker and select the color of
your choice.

Note that there's also a small text field below the color patches. You can
click it and type the text of your choice. This text will be displayed below the
counter.

Refresh
interval (in
seconds)

This value indicates how often the number of jobs is recalculated.

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.
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Dashboard widgets - Live graph

About the Live graph widget

This widget counts both the total number of the jobs on the selected job board and the number
of jobs per column, and presents this info in a graph.

Note that this requires a job board with more than one column; each column is represented as a
separate section in the graph. You can choose between a pie, a bar and a donut chart.

How to configure the Live graph widget

You can configure the properties listed in the table below.

Properties

Property Description

Chart Type of chart to be used. Options are:

• Pie
• Donut
• Bar

Tip:  Use "Pie" and "Donut" to show how the parts (i.e. values per
column) compare to the whole (total number of jobs); use "Bar" to
show how the parts compare to each other or to show trends.

Show grid
lines

If selected, grid lines are shown to make it easier to read the values.

Note:  This option is not relevant (hence not available) for pie and
donut charts.

Job board Data that will be used for the dashboard. For this type of charts, you should
have a board with more than one column.

'None' is not a valid option.

Include jobs
finished
in the last
(hours)

The value chosen here determines how long after finishing the jobs will be
included in the live graph.

If you enter '0', only jobs that are still moving through the flow and haven't
reached an output folder will be included.

If the widget doesn't behave as expected, contact your Switch administrator.
There maybe a conflict with the Keep internal job tickets for (hours) in the
Switch Application data preferences.

Refresh
interval (in
seconds)

This value indicates how often the values are recalculated.

Pick custom
colors

When selected, you can change the default colors of each column that will
be used in the graph. To change a color, simply click the color page and
then click the color of your choice.
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Property Description

Use column
names as
labels

("Pie" only) When selected the names of the columns are displayed on the
graph.

• Default: "<number of jobs> jobs" e.g. "15 jobs"
• This option enabled: "<column name>: <number of jobs>" e.g. "column1:

15"

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use Live graphs

Smaller parts are not always easy to read, so when hovering over one particular part of
the chart, this part is highlighted and you get a small dialog with the column name and the
percentage value of the highlighted part.

When clicking an item in the legend, the corresponding part of the chart is disabled (grayed out
in the legend) and taken out of the chart. Clicking once more will bring it back.

Dashboard widgets - Live table

About the Live table widget

This widget displays information about the jobs counted in a live graph or a live counter on the
same dashboard. For example, if your graph gives an overview of the number of jobs per flow,
the live table can display detailed information about these jobs (job name, flow name, stage and
state of the job).

How to configure the Live table widget

You can configure the properties listed in the table below.

Properties

Property Description

Height Size of the table.

Options:

• Small
• Medium
• Large (default)

Parent Live graph or live counter that is used as dataset for the live table.

'None' is not a valid option.
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Property Description

Visible
columns

Enable the column(s) you want to see in the live table. Options are:

• Set
• Name
• Flow
• Stage
• State

At least one column must be selected.

Show header When selected, the columns in the table have a column header.

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use live tables

To see the details of a particular part/category in the chart, e.g. one slice of the pie, just click
in the chart. Only the details of the corresponding jobs will be shown in the table. Clicking once
more will reset the table.

To search for a particular job/a set of jobs, you can filter the table by entering a key word in the
filter fields below the column headers. Note that these filter fields are not case sensitive.

To sort the list in ascending or descending order, click the column header of the column by
which you want to order it. Note that the small arrow in the column header will become a bit
darker, to indicate this.

Dashboard widgets - Messages

About the Messages widget

This widget displays log messages based on a saved messages filter. Refer to Filtering log
messages on page 290.

How to configure the Messages widget

You can configure the properties listed in the table below.

Properties

Property Description

Height Size of the table.

Options:

• Small
• Medium
• Large (default)
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Property Description

Filter Messages filter that is used as dataset for the live table.

'None' is not a valid option.

Note:  If the messages filter is removed afterwards, the widget
won't work anymore... you'll get a warning ("Data could not be
loaded").

Visible
columns

The columns of the Messages overview that will be shown in the widget.

Options:

• Time
• Type
• Flow
• Job
• Module
• Element
• Prefix
• Message

At least one column must be selected.

Number of
messages

Maximum number of messages to be shown.

Options:

• 10
• 20
• 50
• 100

Refresh
interval (in
seconds)

Indicates how often (e.g. every 10 seconds) Switch checks for new
messages.

Show header When selected, the columns in the table have a column header.

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use the Messages widget

To search for a particular message/a set of messages, you can filter the table by entering a
key word in the filter fields below the column headers. Note that these filter fields are not case
sensitive.

To sort the list in ascending or descending order, click the column header of the column by
which you want to order it. Note that the small arrow in the column header will become a bit
darker, to indicate this.
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Dashboard widgets - History graph

About the History graph widget

A history graph visualizes the evolution of the number of jobs or the job size over a particular
period of time, for example the total number of problem jobs of the last month, grouped by
week. A further subdivision is possible, you can for example further group the jobs by file type,
flow, stage or state.

Note that this graph only counts jobs that are completely finished, meaning that they have left
the Switch flows. The maximum period of time to go back in the past is defined by the number of
days set in the Reporting preference, for example for 120 days.

How to configure the History graph widget

You can configure the properties listed in the table below.

Properties

Property Description

Chart Type of chart to be used. Options are:

• Line
• Spline (curved line)
• Bar
• Pie

Show grid
lines

If selected, grid lines are shown to make it easier to read the values.

Note:  This option is not relevant (hence not available) for pie
charts.

Job board Job board to be used for the history graph.

'None' is a valid option for history graphs: if selected, all jobs on the Switch
server are taken into account!

Set Column to be used.

If 'None' is selected as Job board, this option is not available.

Unit Determines what is counted and displayed:

• Number of jobs
• Total size

Group by Determines how the values are grouped:

• None: no grouping; the total number of jobs or the total size is
mentioned. For example, 200 jobs on day1, 190 jobs on day 2, etc.

• Type: the total number or the total size is further divided by file type. For
example, 100 PDF files and 100 text files on day1, 90 PDF files and 100
text files on day2, ...
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Property Description

• Stage: the total number or the total size is further divided by flow stage.
For example, 75 jobs in stage1 and 125 in stage2 on day1, 70 in stage1
and 120 in stage2 on day2, …

Note:  Stages that were not selected on the job board are not
shown.

• State: the total number or the total size is further divided by job state.
For example, 33 jobs in state1 and 167 in state2 on day1, 22 in state1 and
168 in state2 on day2, ...

• Flow: the total number or the total size is further divided by flow. For
example, 50 jobs in flow1, 50 in flow2 and 100 in flow3 on day1, 99 in
flow, 1 in flow2 and 90 in flow3 on day2, ...

Note:  Flows that were not selected on the job board are not
shown.

• Element: the total number or the total size is further divided by flow
element. For example, 2 jobs have been put in the recycle bin, 7 jobs
have been processed by the Enfocus PitStop Server configurator, … Note
that all elements in all flows are taken together, regardless of the name
of the instance in the flows. For example, even if the recycle bins in your
flows are called 'Trash1', 'Trash2', Trash3', in the graph you'll see 1 flow
element 'recycle bin' (with all jobs collected in all 3 trash folders).

As for the folder element: only input folders are taken into account.
Intermediate and output folders nor problem folders are represented in
the graph.

Period Determines how the data will be grouped, i.e. which data will be taken
together.

• Day
• Week
• Month

For example, if grouped by week, you'll get one value for all jobs of a
particular week (optionally further divided by flow, file type, etc.)

Note:  This field is not available if the 'Pie' chart is chosen.

Days
previously

Refers to the time period that will be shown in the graph.

For example, if set to '200', the data of the last 200 days (= today minus
200 days) will be shown. Note that the maximum number of days that is
possible is determined by the Reporting preference (see higher).

Use group
names as
labels

("Pie" only) When selected, the names of the grouped items (see the Group
by option) are displayed on the graph.

• Default: "<number of jobs> jobs" e.g. "15 jobs"
• This option enabled:
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Property Description

• Group by set to None: "Overall: <number of jobs>" e.g. "Overall: 15"

• Group by set to <item>: for each <item>, <name of the item>:<number
of jobs> e.g. if grouped by 'Element': "Submit point: 9","Checkpoint:
6",...

Show target
line

("Spline" and "Line" only) When selected, a line will be drawn at a given
target value. This option triggers the following property:

Target value Value that determines where the target line will be drawn on the spline or
line graph.

Show frame When selected, a thin frame is drawn around the widget and the following
additional properties are displayed:

Title Text that will be shown in the title bar of the widget. You can leave it empty
as required.

Frame color Color that will be used for the title bar and the frame around the widget.
Clicking the color patch will open a color picker dialog.

How to use history graphs

Smaller parts are not always easy to read, so when hovering over one particular part of the
chart, this part is highlighted and you get a small dialog with more information (for example the
number of jobs/the total size per group; if there is no grouping, the dialog mentions the "overall"
value).

When clicking an item in the legend, the corresponding part of the chart is disabled (grayed out
in the legend) and taken out of the chart. Clicking once more will bring it back.

5.4.8.  Submitting and checking jobs through the Switch Web
Portal

Submitting and checking jobs through the Switch Web Portal is only possible if you have
licensed the SwitchClient Module or the Web Services Module.

Overview

An active SwitchClient/Switch Services Module gives access to the following functionality:

• Connect to one or more Switch Servers on the local network/internet.
• Submit jobs (files or job folders) and metadata describing these jobs to a Submit point in a

flow.
• Review and act on jobs being held in a Checkpoint in a flow.
• View progress information and the status of submitted jobs.
• View log messages issued by processes on the server.

Good to know

• Access to particular Submit points and Checkpoints can be restricted, by configuring access
rights at user or user group level.
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• Metadata information attached to a job can be used to make automated routing decisions or
to provide variable input to various tools and configurators.

• If you want to connect to more than one Switch Server at a time, you must open a browser
window per server and sign in to the Switch Web Portal for each server separately. The IP
address of the server is displayed in the URL.

5.4.8.1.  Setup in Switch
Allowing users to submit and check jobs via the Switch Web Portal, requires some preparation
in Switch, usually done by a system administrator.

This includes:

• Installing and activating Switch (this includes activating the SwitchClient Module)
• Designing and activating one or more flows that will process the jobs submitted and

monitored through the Switch Web Portal.
• Configuring user access rights (in the Users pane)
• Configuring or checking the communication settings (through the Switch user Preferences)

Installing and activating Switch and the SwitchClient Module

Licenses
A regular SwitchClient Module includes a license for up to five concurrent connections. If this
is not sufficient, you can purchase additional licenses. The number of licenses can be raised by
entering a new activation key in the Manage licenses dialog in Switch.

An active SwitchClient Module allows you access to the following flow elements:

• Submit point
• Checkpoint
• Checkpoint via mail

If SwitchClient is not licensed, the above flow elements will not be available and you will not be
able to submit and check jobs through the Switch Web Portal.

How to proceed
Follow the guidelines and instructions described in the chapter on installing, activating and
starting Switch. :

1. Install Switch.
2. Activate Switch, including the SwitchClient Module.
3. Activate additional licenses if required.

Designing flows for use with the Switch Web Portal
Managing files through the Switch Web Portal requires a particular flow design in Switch.

About flows in Switch

To design a flow, the Switch user drags flow elements (such as Submit points, processors and
folders) on the canvas and connects them according to the desired job flow. After configuring
appropriate property values for each flow element (and in some cases, the connections), the
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Switch user can activate the flow for execution. From then on, Switch automatically moves and
processes jobs along the flow.

If you're new to Switch, we recommend having a look at the Switch Quick Start Guide (available
on the Enfocus website).

Dedicated flow elements

Submit points and Checkpoints are flow elements designed for use with the Switch Web Portal.
For more information, refer to the description under Flow elements: overview > Communication.

Note:

• Make sure the flows you want to use with the Switch Web Portal are active. A user
with the appropriate access rights can access Submit points, Checkpoints and jobs in
inactive flows but the jobs will not move along the flow.

• The Switch Web Portal only interacts with the Switch Server, not with the Switch
Designer. Users can safely quit the Designer without disturbing the operations via
the Portal as long as the Switch Server is running. For more info on the behavior of
Switch when exiting the flow designer, refer to the Switch user preferences (User
interface).

Example flow

Here's a flow example as it is shown on the Switch canvas:

 

 

Since this example focuses on Web Portal features, there is a lot of interaction with human
operators and little automated processing (other than moving jobs around). Real-life flows
would probably include processing steps such as preflight or color conversion.

The Submit point on the left (Creatives) allows submitting jobs to the flow in a controlled way
using the Switch Web Portal. The user's name is automatically remembered; multiple users
can use the same Submit point since each user is identified to Switch through his/her user
name and password. The "Set User Name" script serves to add a user name for jobs submitted
through a regular hot folder (Henry).
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The first Checkpoint (Visual Proof) holds the incoming jobs for inspection by a user through the
Switch Web Portal. The user will see the names of the output connections (Approve and Decline)
as buttons in the job card. Pressing one of these buttons moves a job along the corresponding
connection.

The second Checkpoint (Output Jobs) allows a Switch Web Portal user to decide how the jobs
will be stored or processed. This Checkpoint is configured to allow multiple outputs at the same
time; for example both "Store in DAM" and "Create Proof".

Setting up a Submit point

When setting up a Submit point (Creatives in the example flow), you can configure it in such a
way that the user must enter one or more data fields before submitting a job to this Submit
point. The entered values are associated with the job as metadata.

To enable this option, in the properties of the Submit point element:

1. Set Submit to Job and metadata or Metadata only (if the user should only submit a form,
without a job).

2. In the Metadata fields property, define the metadata fields for which the user should provide
a value, for example a Job ID and the date of submission.

3. The Dataset name field is completed automatically. This is the name of the dataset that will
be created containing the contents of the metadata fields entered by the user.

4. Invalidate user metadata cache on login and Invalidate metadata cache condition have to
do with caching dynamic values, which can be useful to speed up processing.

For a full description, refer to 'Defining metadata fields' in the Switch Reference Guide.

The following screenshot shows how a user will have to enter the data (Job ID and Date)
configured in the Submit point.

 

348



Switch

 

Note:  As of Switch 2019 Spring, it's also possible to set up a Submit point that triggers
an Action. In that case, the Submit point on the Switch Web Portal acts like a button:
when a user clicks it, a dummy job (*.dummy) moves through the Switch flow and
(depending on the flow) this job can start a process, call a database, ...

Setting up a Checkpoint

Similarly, when setting up a Checkpoint (Visual Proof and Output Jobs in the example flow), you
can ask Switch to display additional information about the job, and the user may be asked to
enter additional data fields before acknowledging a job. (This is the case if the Enter and display
metadata property is set).

Furthermore, the output connections of the Checkpoint determine which buttons will be shown
to the user for acknowledging a job.

For example, the Visual Proof  Checkpoint in the example flow is configured in such a way that
the user will see two radio buttons ('Decline' and 'Approve', named after the connections);
clicking one of the buttons causes the job to move along the corresponding connection. This is
the default behavior of a Checkpoint if two output connections are defined and no metadata has
been enabled.

 

349



Switch

 

On the other hand, the Output Jobs Checkpoint in the example flow is configured in such a way
that the user can select more than one option, causing a duplicate of the job to be sent out over
each of those connections. This is possible if the Allow multiple outputs property is enabled.

In this example, the user that has to review the files will see 3 checkboxes (the names come
from the output connections in Switch) and can select one, two, or three checkboxes as
required.

 

 

For an overview of all properties, refer to the description of the Checkpoint flow element.

Metadata in Submit points and Checkpoints - default values

When defining the default values for the metadata fields, you can use a number of variables that
automatically retrieve information from the computer that is used to submit or check jobs. As a
consequence, this information does not need to be entered explicitly by the user; it can even be
sent along with the job without being displayed.

The variables concerned are the so-called Connection variables:

• [Connection.Email]
• [Connection.FullUserName]
• [Connection.IP]
• [Connection.UserName]

If you use those as default values for your metadata fields, they will be replaced automatically
with their actual values.

To make this happen, "bidirectional communication" is established between Switch and the
Switch Web Portal:

1. The Switch Web Portal requests the default value of the metadata fields, being a connection
variable.

2. Switch Server sends the connection variable e.g. [Connection.IP] to the Portal.
3. The Portal replaces the variable with its actual value and sends the actual value along with

the job back to Switch Server.

Use case: To keep track of the clients used to submits jobs, you could configure a metadata
field "IP address" and set the default to [Connection.IP]. When a file is submitted, the IP address
of the system used to submit this file is entered automatically and sent along with the job. It
depends on the metadata field properties whether or not this field (with the actual value) is
shown to the user and whether or not it can be changed.

Re-using metadata fields from a Submit point in a Checkpoint

Switch provides an easy way to re-use the metadata fields defined for Submit points in a
particular Checkpoint.
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To re-use an existing metadata field, simply click the  button (instead of the green plus
button) in the Define metadata fields dialog. This will open a dialog like the one shown below.

 

 

You can now select the metadata fields you want to re-use (based on the Submit points defined
for the current flow). Note that the added metadata fields have only two editable options: Read
only (yes/no) and Display metadata field (yes/no). The other options are grayed out and cannot
be changed.

Remark: Although all Submit points present in the flow are shown, you must keep in mind that
only the Submit point that is used for the job will send metadata. Refer to the example below:
since all jobs in Checkpoint 1 come from Submit point 1, it does not make sense to add metadata
from Submit point 2 to Checkpoint 1 (and vice versa).

If configured incorrectly, the connection variables (if used) will not be replaced with the actual
values (users will see e.g. [Connection.UserName]) and metadata fields for which there is no
value entered will be blank.

If configured correctly, when checking the Alert job on the Portal, the connection variables (if
used) will be replaced with the actual values (e.g. EAW13DL399 instead of the [Connection.IP])
and the metadata fields that were completed at the time of submission will show the entered
data.
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Configuring user access

How to proceed

Follow the guidelines and instructions described in the chapter "Configuring Switch users". :

1. Set up the appropriate users and configure their user name, password, email address,...
2. Give them access to the appropriate Submit points and Checkpoints.

Configuring the communication settings
To configure the communication settings for communication with the Switch Web Portal

1. Navigate to:

• On Windows: Edit > Preferences.
• On Mac OS: Enfocus Switch > Preferences.

The User preferences dialog appears.

2. In the left part of the dialog, click the Web services category.

3. Make sure the Port for the Switch Web Portal preference is set to 51089, unless there is a
good reason to change it.

4. Click OK.

5.4.8.2.  The Submit jobs view
The Submit jobs view allows you to submit jobs to the Switch Server. You can see all Submit
points that you have access to, based on your permissions (as set in the Users pane in Switch).
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Note:  The first Submit point ("Artwork for production") is slightly grayed out, because
the Switch flow is currently not running. As a consequence it is not possible to submit
jobs to that Submit point. You can hide these inactive Submit points by clicking the Hide
Inactive button next to the search field.

Submit point types
There are four different types of Submit points. You can recognize them by the image and
text mentioned on the Submit point. It depends on the configuration in Switch which types are
available on the Portal.

Submit point Description

This Submit point only accepts job files and folders, no
metadata.

Click the first button  to upload files, click the

second button  to upload folders. Note that you can
also drag and drop jobs onto the Submit point.

This Submit point accepts both job files and folders
and metadata (= extra information about the job that
has to be supplied when uploading a job).

Click the first button  to upload files, click the

second button  to upload folders. Note that you can
also drag and drop jobs onto the Submit point.

Once you have uploaded the job(s), a form is opened
where you can enter the requested information.
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Submit point Description

This Submit point only accepts metadata. You need to
fill out a form.

Click the button  to open the form and supply the
requested information.

This Submit point allows you to send a trigger.

When you click the button , a database is called, a
process is started, … (depending on the configuration in
Switch). A notification will be shown to confirm that the
trigger was sent.

Favorite Submit points

You can mark your favorite Submit point(s) by clicking the star icon , so it turns blue .
Favorites are displayed in a collapsible, separate section at the top of the page. The number of
favorites is mentioned in the header.
 

 
Via the menu in the top right corner, you can switch to List view (see further) and open the
Submit points management dialog (by clicking "Settings"). The table below lists what you can do
through this dialog.
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What you can do: How:

Remove Submit points from the Favorites
overview

Click the blue star icon  next to the
Submit point you want to remove. Note that
it's only removed from the Favorites section,
not from the All Submit points section.

Change the order of the Submit points in the
Favorites overview

Click the icon  preceding the Submit
point and drag and drop the Submit point
upwards or downwards as required.

List view

It's possible to display the Submit points in "list view", optionally even sorted by flow and flow
group.

This view can be displayed via the gear wheel button next to the Search field.
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Progress indicator

Once you have submitted a job, you may see one of the following icons in the sidebar:

Icon Meaning

Indicates that a job is being uploaded.
You can click it to see the percentage of
completion.

Indicates that the jobs that were submitted
in the current session were uploaded
successfully. You can click the icon to see
which jobs were uploaded.
 

 

Note that trigger jobs and metadata only
jobs are also present in this overview. They
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Icon Meaning

get a name with extension "dummy", e.g.
2019051712345.dummy.

5.4.8.3.  The Check jobs view
This view allows you to view jobs submitted through a Submit point on the Switch Web Portal,
and to check and route jobs waiting in a Checkpoint.

It depends on your user permissions (set in the Users pane in Switch) which jobs you can see
and/or further process.

 

 

This view has a couple of extra buttons:

Button Meaning

Click this button to manage the filters that allow
you to only display a subset of the jobs that you have
access to.

When you click this button, the navigation area
expands automatically, so you can see the pre-
configured filters (My jobs, Alert jobs, Active jobs,
Completed jobs) and the ones you have created
yourself (see screenshot below).

The label in the upper part of the overview refers to
the custom filter that is currently applied. If you want
to stop filtering based upon that filter, you can click
the cross icon.

Note that pre-configured filters are not marked by a
label when they are applied. You can see that they are
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Button Meaning

applied, when they are highlighted in the navigation
area.

This button allows you to change the sort order of
the jobs in the overview. In this example, the jobs
are sorted in descending order (arrow down) by
the date they were last updated (= value of the field
"Updated").

 

 

This button allows you to Switch between table view
and grid view (as on the screenshot):

• In table view, every row represents a job; the job
details are shown in the different columns.

• In grid view, every job card represents a job; the
job details are listed on this card.

Filters
This is an example of how the navigation area looks when expanded.

The filter that is applied ("Filter Drupa files" in this example) is highlighted.
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Note the counter next to 'Check jobs'. It indicates the number of "alert" jobs waiting to be
processed.

5.4.8.4.  Submitting jobs through the Switch Web Portal
It is possible to submit single files or multiple files, or files contained in a folder (for example
a page layout with its accompanying images and fonts or the individual pages in a book). A job
folder may contain nested subfolders (which can contain other files and folders, recursively).

If the files are contained in a folder, they will be considered as one job with one dataset; it will
not be possible to enter metadata for each file separately.

As of Switch 2019 Spring, it's also possible to submit metadata only (so a form without a job), or
to send a trigger.

Note:

• Remember that the Switch Server must be running and that the Switch flow must be
activated. Otherwise, the jobs will not be processed.

• Some Submit point require that you install Switch Helper on your computer. If (the
appropriate version of) Switch Helper is not installed, you will get a warning and a
link to download this free tool from the Enfocus website. Note that the Switch Helper
tool does not function well when you're launching the Web Portal through an HTTPS
connection in Firefox or Safari (due to security constraints implemented in these
browsers), so we recommend using HTTP, or HTTPS but with a different browser
(like Google Chrome or Edge).

To submit a job to a particular Submit point:

1.
In the Switch Web Portal, in the navigation area, click  Submit jobs.
You can see the Submit points you have access to. Note that not all Submit points accept all
types of jobs... the accepted type ("files", "metadata", "trigger") is mentioned on the Submit
point. Refer to Submit jobs view.

2. Do one of the following:

• To upload job files or folders, "drag and drop" the file(s) or folder(s) you want to submit

onto the Submit point of your choice (that accepts files). Alternatively, click  to upload

a file or  to upload a job folder.

Note:  To select multiple files or folders, hold down the Ctrl key while selecting.

• To upload metadata only, click the "metadata only" Submit point and proceed to step 4 of
this procedure.

• To send a trigger, simply click the "trigger" Submit point. The trigger is sent immediately.
You're done!

3. If you have selected several files, you must first decide if you want to process them as
separate jobs or as one job. Click the button of your choice.

If you choose to process them as one job, the files will be submitted to and moved along the
flow as a single entity.
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4. If the Submit point has been configured to request additional information about the job
("metadata"), you'll get a dialog with one or more entry fields. Enter the requested
information.

5. Change the job name as required.

The chosen job name will replace the file name. For example, if the job name is "testjob",
the job file "customerX.pdf " will be renamed "testjob.pdf". The file extension remains the
same.

In case of a job folder, the job name will replace the name of the folder. The files contained
in this folder will not be renamed.

In case of multiple files being submitted in one go, you cannot enter a job name, unless you
have chosen to process them as one job; in that case, they are put in a folder and the chosen
job name will be the folder name.

6. Click Submit.

Note that there is a progress indicator in the sidebar. When you click the icon, you can see which
files have been submitted successfully, and/or which are still uploading.
 

 

When uploading is finished, the progress indicator changes from  to .

5.4.8.5.  Creating a shareable Submit points URL
Submit point URLs are direct links to one or more Submit points. The URLs can easily be
distributed, for example via email.

Note that only Switch administrators (= Switch users registered as administrator in the Switch
Users pane) have the right to create shareable URLs.

To create a shareable Submit point URL

1. With the Submit jobs view selected, click + Manage.

If you don't see the +Manage link, you may not have the required user permissions.

2. In the Manage Submit points URL dialog, click New URL.
A row is added to the dialog. The first column is empty: the URL will be added after you have
selected the Submit point(s) and after having clicked Apply.
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3. Enter a description.

4. Drag the slider to the left to disable the authentication option as required.

• Note that the authentication option is only available if the Web Services Module is
licensed. If that is not the case, users will always need to enter their credentials before
getting access to the Submit point(s).

• By default, authentication is enabled, meaning that the user needs to enter his Switch
credentials to get access to the Submit point(s). Note that the user's other permissions
are also taken into account. For example, if the user has no right to submit jobs, he won't
see the Submit jobs view, so he won't be able to use the URL. The other way around, if
the user has access to other functionality, or to more Submit points, he will have the
same options as when he had signed in through the regular Web Portal address.

• If authentication is disabled, everyone who clicks the link will have access to the selected
Submit point(s). No credentials will be required. Only the selected Submit points are
accessible, all other functionality on the Portal is hidden.

5. In the Submit points column, click Select to select the Submit point(s) concerned.

6. In the Expiration date column, click the None link to enter an expiration date as required.

The URL will become invalid as of the set date. The format in which the date is displayed, is
determined by your browser settings.

7. Click Apply.
The URL is added.

8. To copy the URL (for distribution), click the Copy URL to clipboard icon.

You can later make changes to the configuration of the URL, for example add extra Submit
points or change the authentication setting. This won't change the (probably already distributed)
URL in the first column.

5.4.8.6.  Viewing jobs through the Switch Web Portal
To view Switch jobs through the Switch Web Portal

1.
In the Switch Web Portal, in the navigation area, click  Check jobs.
You can see all jobs you are allowed to see based on your user permissions (set in the
Switch Users pane). The counter (only shown if the menu is expanded) indicates the number
of files waiting in a Checkpoint.

2. To view only a particular set of jobs, apply a filter.

Make sure the navigation area is expanded (by clicking  or ).

• Click one of the pre-configured filters in the navigation area below Check jobs, for
example 'My jobs'. Refer to Job filters on page 363.

• Create a filter yourself. Refer to Creating a custom filter on page 364.

The jobs matching the selected filter (now highlighted in the navigation area) are shown. If
you don't see the jobs you expected to see, check if:

• The Switch Server is running.
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• The information displayed is up-to-date. Refresh your browser window to update the
information from the Switch Server.

Note that you can stop filtering by clicking the filter name in the navigation area once more.
Alternatively, in case of a custom filter, you can create the cross icon in the label (shown in
the upper part of the overview).

3. To view the jobs presented in a different way, click the table view or the grid view button at
the bottom of the screen.

View Example

Table

Table-specific options:

•
To hide a column, click the icon  in the top right corner and clear
the checkbox of the column you want to hide. Note that you can
go back to the default view (and column size/position) via the
Refresh columns option at the bottom of this list.

• To move the columns, drag them sideways.

• To sort the overview, click the header of the column you want to
use to sort the overview and click the order of your choice (A-Z or
Z-A).

Grid
view

4. To view the details of a job and eventually review and process the job:
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• In table view, click the row concerned.
• In grid view, click the Process button of the job you want to check and/or process.

See also: Reviewing and processing jobs through the Switch Web Portal on page 366.

Job statuses
The following table gives an overview of the statuses a job can have on the Switch Web Portal.

Status Meaning

Processing The job resides somewhere in the flow but not in a Checkpoint,
and it is not finished yet. This includes jobs in the Problem jobs
flow element.

Alert The job resides in a Checkpoint and is waiting for intervention by
an operator. The number of alert jobs is indicated by a counter in
the navigation area of the Web Portal.

Error The job failed. You should contact your system administrator for
more information.

Completed The job has been processed and has arrived in the output folder
of the flow.

Job filters

Default job filters

The table below provides an overview of the default, pre-configured filters in the Check jobs
view on the Switch Web Portal.

Filter Displays:

My Jobs All jobs submitted by you, i.e. the current user, regardless of their
current status (processing, alert, completed).

Alert Jobs All jobs waiting in a Checkpoint.

Note:  You can only see the jobs in a Checkpoint that you are
allowed to access (as configured in the Users pane in Switch).

Active Jobs All jobs that are somewhere in the flow, but not in an end folder (that is,
not yet completed). This includes files that reside in the Problem jobs
folder.

Note:  This only applies to jobs that are visible to you.

Completed
Jobs

Displays all the jobs that reside in an end folder in Switch.

Note:  This only applies to jobs that are visible to you.
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Custom job filters

You can as well create your own filters, for example you can create a filter to display all jobs in
a particular Submit point or Checkpoint, all jobs with a particular status, all jobs initiated before
or after a particular time, etc.

Refer to Creating a custom filter on page 364.

Note that these filters are not visible to other Switch users signing in to the Switch Web Portal.

No filter applied

If no filter is applied, you can see all jobs you are allowed to manage.

Creating a custom filter
In the Check jobs view on the Switch Web Portal, you can create your own, custom filters.

You could for example create a filter that displays all jobs with a certain status that were
submitted to a particular Submit point.

To create a custom filter

1. Do one of the following:

• In the navigation area, click + Create filter.
• Click in the upper part of the screen on "Create filter".

2. In the dialog that pops up, beside the Close button, enter a meaningful name for the custom
filter.

Each filter needs to have a unique name.

3. Configure a filter rule: select the appropriate filter field, choose an operator and enter the
value of your choice.
 

 

Example filter fields are: Checkpoint, On alert since, Files, Flow, ... "Familystarter" refers
to the first job in a job family, being a set of jobs that have been generated from the same
original job. For example, a PDF, its Preflight Report, the preflighted and the low res
version, ... they all belong to the same job family.

4. To configure a second rule or rule set, click the appropriate button:

• To add one rule, click the green Add rule button.
• To add several rules, which are related to each other (through an AND/OR relation), click

the green Add group button.

If you have made a mistake, you can remove the rule concerned by clicking the red Delete
button.

5. Once you have configured your rules, make sure to indicate the relation between the rules
and the rule groups, by clicking the appropriate button:
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•
 means that for each job it is checked if all rules apply. For example, with

Checkpoint = Checkpoint 1 AND job status = alert only the jobs in Checkpoint 1 that have the
alert status will be shown.

•
 means that at least one of the rules should apply. For example, with Checkpoint =

Checkpoint 1 OR job status = alert, all jobs in Checkpoint 1 are shown (regardless of their
status) and all jobs that have the alert status (regardless of the Checkpoint they are in).

The And/Or option is only relevant if you're configuring more than one rule.

The following example results in a list of jobs submitted to Submit point 1 AND having a
certain status, which can be either Alert OR Error.
 

 

6. If required, repeat step 5 until you have configured all rules you need.

7. Click Apply or Apply and save as required.

The newly created filter is displayed in the blue navigation area on the left and in the upper part
of the screen as a blue label. The label indicates that the filter is applied; to stop filtering the
jobs, simply click the cross icon in the label. The filter remains available for later use in the
navigation area.

Managing custom filters
This topic explains how to handle the custom filters in the Check jobs view on the Switch Web
Portal.

The filters are listed in the blue navigation area below the pre-configured filters.

• To create a new filter, in the blue navigation area, click + Create filter.

Refer to Creating a custom filter on page 364.
• To edit a custom filter, click the pencil button  beside the filter name.

Refer to Creating a custom filter on page 364.
• To apply a filter, simply click the filter name in the blue navigation area. The filter will be

applied immediately, and you'll see the filter name appear in a blue label just above the jobs
overview.

• To stop applying a filter, click the filter name once more (so it's no longer highlighted) or
click the cross button in the label.
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• To remove a custom filter permanently, in the navigation area, click the cross button beside

the filter name. 

5.4.8.7.  Reviewing and processing jobs through the Switch Web
Portal

Checkpoints are intermediate folders in a flow where jobs that arrive are being held until they
are reviewed by an operator. Once reviewed, the operator indicates how they should move along
the flow.

You can review these jobs one by one, or in batch as described below.

Processing one job at a time
To review a job being held in a Checkpoint:

1. In the Switch Web Portal, click  to expand the navigation area as required.

2. In the navigation area, click Check jobs.
All jobs that you have access to, regardless of their status, are displayed in the overview. The
counter indicates the number of jobs that are waiting in a Checkpoint, so all jobs with the
'alert' status.

3. Click Alert jobs.

This is a pre-configured filter.

The selected filter is highlighted in the navigation area and applied immediately. In the
overview, you will see all jobs that arrive in the Checkpoints you have access to. Remember
that you can switch between table and grid view as required (buttons at the bottom of the
screen).

4. Select the job you want to review and route:

• In table view: Double-click the job concerned.
• In grid view: In the job card of the job concerned, click the Process button.

A dialog opens and displays more detailed information about the selected job.

5. Review the job as required, using the buttons in the top left corner of the dialog.

For an overview, refer to Review options on page 368.

6. Enter extra info ("metadata") if requested.

This depends on the setup in Switch.

Note:  If you entered metadata before locking or replacing a job, you will be
requested to enter it again.

7. Route the job:

• If you see radio buttons, choose one of the options.
• If you see checkboxes, you can select more than one option if appropriate.

8. Click Push.
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The dialog is closed automatically. The job will move along the chosen connection(s) in
Switch. The job status will change over 'processing' to 'completed', so it will no longer be
present in the Alert jobs overview.

Processing multiple jobs as one
This topic explains how you can process a number of alert jobs in one go.

Note that this is only possible for:

• Alert jobs waiting in the same Checkpoint,
• Which all need to be moved along the same output connection,
• With the same metadata values.

To process multiple jobs proceed as follows:

1. In the Switch Web Portal, click  to expand the navigation area as required.

2. In the navigation area, click Check jobs.
All jobs that you have access to, regardless of their status, are displayed in the overview. The
counter indicates the number of jobs that are waiting in a Checkpoint, so all jobs with the
'alert' status.

3. Click Alert jobs.

This is a pre-configured filter.

The selected filter is highlighted in the navigation area and applied immediately. In the
overview, you will see all jobs that arrive in the Checkpoints you have access to. Remember
that you can switch between table and grid view as required (buttons at the bottom of the
screen).

4. In the Check jobs area, with the Alert jobs filter selected, click the checkboxes of the jobs
you want to combine.

In grid view, the checkboxes become visible when you hover over the job cards. As soon as
you have selected a job, the jobs waiting in a different Checkpoint are grayed out, because
you can only combine jobs that are waiting in the same Checkpoint.

5. Click Process multiple in the bottom right corner of the screen.

The number of jobs contained in the selection is shown.

6. To review the jobs one by one, use the arrows in the top left corner to navigate between
them.

For more information about the buttons, refer to Review options on page 368.

7. Enter extra info ("metadata") if requested.

This depends on the setup in Switch. The metadata value should be valid for all jobs in the
selection; it's not possible to have a different value per job file.

8. Route the job:

• If you see radio buttons, choose one of the options.
• If you see checkboxes, you can select more than one option if appropriate.

Note that your choice applies to all jobs in the selection.
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9. Click Push.
The dialog is closed automatically. The jobs will move along the chosen connection(s) in
Switch. The job status will change over 'processing' to 'completed', so it will no longer be
present in the Alert jobs overview.

Review options
This is an overview of the buttons that are available when you're reviewing a job that is held in a
Checkpoint.

Some of the buttons may be missing; this depends on the setup in Switch. For example, if editing
or report viewing are not allowed, these buttons do not show up.

Option Meaning

View

Allows you to view the job file(s). The job is opened in the browser, if
the browser supports the job's file type (e.g. PDF, JPEG). If the browser
cannot open the file and also in case of a job folder, you will be asked to
save the file(s) or folder locally, or they will be downloaded. The behavior
depends on your browser settings.

When a job is being viewed, it cannot be modified or saved. The job is not
locked automatically, so it remains editable for other users, unless you
lock it by clicking the Lock button (see further).

Note:  You may have to turn off pop-up blockers.

Save

Allows you to save the job locally. In case of a job folder, the job folder
content is compressed and you can download the zip file.

Replace

Allows you to replace the current job file with another one. The uploaded
file(s) will be further moved along the Switch flow.

Note:  If another user is trying to replace the job at the same
time, a warning is displayed. You can then either cancel your
replacement request or overrule the other user's replacement
process and start your own. This can be useful if the other user
has left the computer in the middle of a replacement request and
cannot be reached, or in case of a system crash.

Report

Allows you to view a report with metadata, if there is one associated with
the job.

For more information, refer to the documentation on Checkpoints.

Lock / Unlock

Lock: Allows you to lock the job, so that the job (and the report) cannot be
processed, edited, reverted or replaced by any other user.

Other users can still view the job, save a local copy and open the
individual job card, but they will get a message stating that the job is in
use by another user.

Unlock: Allows you to unlock jobs you have locked yourself.
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Option Meaning

Note:  Users that belong to the administrator group can unlock
all jobs; group managers can unlock all jobs from users in their
group.

Edit in
(application)

Allows you to edit the job file in the native application.

While a job is being edited, following buttons are displayed:

•
: to upload the changed job file

•
: to cancel editing

For the full procedure, refer to Editing a job in a Checkpoint (Switch Helper)
on page 369.

Note:  This option is only available if you have installed the
Switch Helper (a small tool that you can download from the the
Enfocus website). If you haven't, you can also edit the job file, but
you'll first have to download and save it locally. Refer to Editing a
job in a Checkpoint (no Switch Helper) on page 369.

Editing a job in a Checkpoint (Switch Helper)
If you have installed the Switch Helper (a small tool that you can download from the the Enfocus
website), you'll have an Edit <in application> button.

Note:  This option is not available if you're launching the Web Portal through an HTTPS
connection in Firefox or Safari (due to security constraints implemented in these
browsers).

To edit a job

1. Click the Edit button .
The file is opened in the native application, for example Adobe Acrobat. The Edit button on

the Portal is replaced with an Update  and a Cancel button .

2. Make the required changes.

3. Save the file in the native application.

4. Click the Update button  to upload the changed version.

Editing a job in a Checkpoint (no Switch Helper)
This procedure is applicable if you're using Switch 2017 or if you haven't installed the Switch
Helper application.

To edit a job

1. Lock the job file(s), so no one else can make changes while you're busy with the file.
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2. Save the job locally.

3. Make the required changes to your local copy.

4. Use the Replace button  to upload the changed version.

5.4.9.  Using the Web Portal Admin view

Switch administrators (i.e. users that are part of the Administrators group as set in the Users
pane) have an additional view: the Admin view. This view gives access to additional functions,
such as the option to start and stop flows remotely.
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5.4.9.1.  Admin view: Switch news

Administrators have immediate access to information about Switch, for example the
announcement of a new version, the publication of an interesting article or blog post, tips and
tricks, ...

5.4.9.2.  Admin view: Flows

Administrators can remotely start and stop Switch flows through this view.

However it's not possible to edit the flow properties; to do that, you still need Switch Designer.
That's also the case if your flow is invalid or incorrectly configured.

Note that this view also gives a quick overview of all your flows, and shows which flows are
running and which flows are stopped.
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Note:  Starting or stopping flow groups (so a number of flows in one go) is not possible
through this view. That is only possible through the flow viewer.

5.4.9.3.  Admin view: Flow viewer

Administrators have access to the flow viewer: a remote and read-only view on their Switch
flows.

The flow viewer page layout
When you click the Flow viewer button in the Admin view, the flow viewer opens in a separate
tab. Below the screenshot, you can find a description of the flow viewer's page layout.

Screen part Description

1. Title bar and menu button The title bar displays the name of the flow that is
currently selected in the Flows tab of the Flows panel
(2). This is also the flow that is displayed in the right
part of the screen.

The menu  has two options:

• Back to the Switch Portal
• Print View
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Screen part Description

2. Flows panel with two tabs The Flows tab gives an overview of the flow groups
and the flows on the Switch Server (similar to the
Flows pane in the Designer), in a tree structure. You
can expand or collapse the flow groups by clicking the
arrows in front of the flow group names.

The selected flow is shown in the right part of the
screen. Its properties are shown below the Flows panel.

Note the flow status icons:

: The flow is running.

: The flow is scheduled.

: One or more flows (but not all) of the flow group are
running.

The three dots button  (to the right of the flow/flow
group) enables you to stop or start the flow or the flow
group.

The Annotations tab displays the annotations added to
the selected flow. The content can be viewed by clicking
the annotation.

Clicking the icon  in the top right corner of the panel
expands or collapses the side panel.

3. Properties panel This panel shows either the properties of the flow
(selected in the Flows tab) or the properties of a flow
element (selected in the right part of the screen).

4. Canvas with the flow design This is a read-only view of the flow selected in the
Flows panel.

Some tips to improve readability:

• To zoom in and out: press CMD (CTRL on Windows)
and "+" or "-"

• To move the flow on the canvas: click somewhere

near the flow until the cursor changes to  and
then drag the flow to the place of your choice.

• To modify the size of big flows so they fit on the
screen, open the context menu and click Scale to fit.

Note:  You can leave the flow viewer via the menu  in the top left corner; choose Back
to the Switch Portal.
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Viewing flow and flow element properties
To view the properties of a flow and/or the properties of the flow elements through the Switch
Web Portal, proceed as follows:

1. Select the Admin view and choose Flow viewer below the divider.

2. In the Flows panel, with the Flows tab selected, select the flow of which you want to see the
properties.

• You can use the search field to quickly find the flow you need.
• If the flow is part of a flow group, click the arrow icon to expand the flow group.

The flow properties are displayed below the Flows panel.

3. To view the properties of a particular flow element, click the element in the canvas.
The properties of the selected flow element are shown below the Flows panel.

Note:  To go back to the properties of the flow, click somewhere on the canvas (not
on a flow element), or click the flow name in the Flows panel.

Starting and stopping flows
To start and stop flows remotely, proceed as follows:

1. Select the Admin view and choose Flow viewer below the divider.

2. In the Flows panel, with the Flows tab selected, do one of the following:

• If you want to start or stop all flows in a flow group in one go, select the flow group.
• If you want to start or stop one single flow, select that flow.

3. Click the three dots button .

4. Select the appropriate option from the menu that appears:

• In case of a flow group, click Start Group or Stop Group as required.
• In case of a single flow, click Start Flow or Stop Flow as required.

Note:

• If a flow cannot be activated (for example because the properties are not
configured correctly), a warning appears. It's not possible to make changes to a
flow via the Flow viewer, so you'll have to fix the flow in Switch Designer.

• If you start a flow group, but not all flows could be activated, an orange icon  is
shown next to the name of that flow group.

Adding annotations to a flow
To add an annotation to a flow in the flow viewer (admin only), proceed as follows:

1. Select the Admin view and choose Flow viewer below the divider.
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2. Place your mouse pointer on the canvas, somewhere near the flow element about which you
have a remark or a question.

You can afterwards still move (click and drag) the annotation as required.

3. Open the context menu and choose Add Annotation.

4. Enter the requested info:

• Choose an icon. This icon will be visible on the canvas.

Icon Meaning

Info

Warning

Question

Note

• Add a short description (mandatory)

• Add a more detailed description (optional)

5. Click Post.

The annotation is added to the canvas and to the Annotations tab in the Flows panel. You (and
any other Switch administrator) can view the content by clicking the corresponding icon on the
canvas or in the Anntotations tab. Note that the name of the user who created the annotation is
also mentioned, as well as the creation date and time.

Viewing, editing and deleting annotations
The small circles with an info, note, question or warning icon in the flow design on the canvas
represent annotations. You can view and edit your own annotations and those of the other Switch
administrators (if any).

To view the content of an annotation in the flow viewer (admin only), proceed as follows:

1. Select the Admin view and choose Flow viewer below the divider.

2. Select the flow of which you want to view the annotations.

3. Do one of the following:
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• Switch to the Annotations tab in the Flows panel and click the annotation that you want to
view.

• Switch to flow design and click the annotation that you want to view.

The content of the annotation as well as the name of the author and the creation date and
time are shown.

4. To edit the annotation, proceed as follows:

a.

Click the 3 dots  in the top right corner of the annotation.
b. From the menu that appears, choose Edit.
c. Make the required changes (all fields can be modified).
d. Click Post.

The modification date or the name of the editor are not displayed.

5. To delete the annotation, proceed as follows:

a.

Click the 3 dots  in the top right corner of the annotation.
b. From the menu that appears, choose Delete.
c. Click Delete to confirm.

A notification is shown in the top right corner of the screen (Success: "<annotation>"
deleted!)

Viewing and printing the flow documentation

Note:  Via the print function you can also save the flow documentation as a PDF.

To view and print the flow documentation (including the annotations) through the Switch Web
Portal, proceed as follows:

1. Select the Admin view and choose Flow viewer below the divider.

2. Select the flow that you want to print in the Flows tab of the Flows panel.

3. In the top left corner of the screen, click the menu  and choose Print View.
The print documentation (the flow plus all properties) is shown in a separate dialog.

4. To save or print the documentation, click Print.

5. Do one of the following:

• To save the flow documentation: from the Destination list, select Save as PDF and click
Save.
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• To print the flow documentation: from the Destination list, select the printer of your
choice and click Print.

5.4.9.4.  Admin view: System info

In this view, administrators can find information about the Switch processes (CPU, memory, Pid,
time the process was started). A live graph shows the total Switch CPU usage and the Switch
memory usage.
 

 

The orange bars indicate that there is no information for that time period (e.g. because the
browser was minimized, or because you switched to a different tab etc.).

If you want more details about the data on the graph, just hover your mouse over the graph to
display a tooltip with the exact numbers (see screenshot).

5.4.9.5.  Admin view: Logins

The Logins view gives adminstrators an overview of the active users (currently logged in), as
well as an overview of the users that logged in during the last 30 days.

5.4.9.6.  Admin view: Customization

Here administrators can upload their company's logo for display on the Web Portal login page.
The logo must be a PNG file. The size is adjusted automatically; best fit is 400x400 px. Reverting
back to the Switch logo can be done by clicking the Reset logo button.

5.5.  Working with the additional Switch modules
This section discusses the Switch modules that can be added to the Switch Core Engine. It starts
with the feature matrix, which gives an overview of what you can do with each module.
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Note that, in order to be able to use a particular module, you must have a valid license. For
more information on activating modules, refer to Installing, activating and starting Switch on page
10.

5.5.1.  Feature matrix
The following table indicates what you can do in Switch, depending on the activated modules:

Feature Switch
Core
Engine

Config
module

Metadata
module

Scripting
module

Switch
Client
module

Reporting
module

Switch Server and
Designer

 

 

Flow design
(canvas, flows
pane, elements
pane, properties
pane, ...)

 

 

Flow execution
(feedback
on canvas,
messages
overview,
dashboard pane,
statistics pane)

 

 

Built-in tools (see
Flow elements
matrix on page
213), apps

 

 

Configurators
for third-party
applications

 

 

Hierarchy info
and email
info (internal
metadata)

 

 

Variables and
read-only
embedded
metadata (EXIF,
IPTC, XMP)

 

 

Writing and
updating external
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Feature Switch
Core
Engine

Config
module

Metadata
module

Scripting
module

Switch
Client
module

Reporting
module

Xpath-based
metadata (XMP)

External
metadata (XML,
JDF) and writable
embedded
metadata

 

 

Script
expressions and
script elements

 

 

Script
development
environment
(SwitchScripter)

 

 

Scripted plug-
ins (if licensed by
Enfocus)

 

 

Setup for the
Switch Web
Portal (users
pane, Submit
point, Checkpoint)

 

 

Access to
dashboards on
the Switch Web
Portal

 

 

5.5.2.  Configurator Module

5.5.2.1.  About the Configurator Module
If you have licensed the Configurator Module, a number of additional processes can be
performed, i.e. by third-party applications (Adobe Creative Suite, Adobe Acrobat Professional,
Automation Engine… ) integrated in Switch. This is possible thanks to the configurator flow
elements, which allow you to connect to these applications from within a Switch flow.

Configurators are available in the Configurators category of the Flow elements pane, and must
be dropped onto the canvas, just like the other flow elements.
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Note:  You can only use configurators for applications that you have installed -
preferably before installing Switch; if installed while Switch is running, make sure to
restart the service to allow Switch to find the application. Configurators for applications
that are not available are hidden or displayed in gray (depending on your settings - to

change these settings, click  in the upper right corner of the pane).

The configurators are grouped into different categories. Configurators that are not signed
(i.e. NOT approved by Enfocus) - this is possible if you have created them yourself using
SwitchScripter - are placed in a category called "Custom".

How it works

Configurators allow you to send files to 3rd applications from within a Switch workflow. The sent
files are processed by this application, and once processed, they are returned to Switch, so that
Switch can further process the resulting files as required.
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Note:  As the files are managed continually in Switch, Switch job data (hierarchy
information, metadata) is automatically maintained throughout the flow.

In the example below, the input files are first sent to Photoshop for converting the images to
PDF; afterwards the resulting PDFs are sent to PitStop Server to be preflighted. The result of
the preflight (OK or not OK) is used to sort the output files.

 

 

5.5.2.2.  About the configurators

Configurators

After licensing the Configurator Module, you will see a number of configurators in the Flow
elements pane. They are included in the Switch installer and automatically updated if a more
recent version is available in the next update.

However, there are many more third-party applications that have configurators for Switch. For a
complete list, go to https://www.enfocus.com/en/products/switch/partner-integrations-crossroads.

To use these configurators with Switch, you must download and install them.

Note that you must also have installed the third-party application. Otherwise the configurator
may be shown in the Flow elements pane (in gray), but you won't be able to use it.

Note:  When installing an application, make sure to close Switch during the installation,
or to restart Switch afterwards. This is necessary for Switch to recognize the newly
installed application.

Additional flow elements for which no configurator is available

As it is not feasible to have a configurator for every application on the market, the following two
flow elements can be used to automate or interact with third-party applications for which there
is no configurator:

• Execute command allows you to configure command-line applications through the regular
Switch user interface (rather than console commands and options). As of Switch 2019 Fall,
you no longer need a license for the Configurator Module, an active license for the Core
Engine is enough.
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• Generic application allows you to control any third-party application that supports hot folders.
For this flow element, you still need to have licensed the Configurator Module.

PitStop Server and PitStop Server PDF2Image Configurator

If you have an active PitStop Server license, you don't need to activate the Configurator Module
to use the PitStop Server and the PitStop Server PDF2Image Configurator. In that case, the
PitStop Server Configurators are also available if you have only licensed the Core Engine
Module.

More information needed?

• Go to the Switch Partner Integrations page on the Enfocus website.

• In Switch, right-click the Configurator and select Info on third-party application or
Documentation.
 

 

• Check this Reference Guide. It may contain additional information about the configurator you
are interested in (See Remarks/Extra documentation in Configurator overview  on page 382).

Configurator overview

Configurator Remarks/Extra documentation

AccuZIP

Adobe Acrobat Distiller Scripted plug-in as of Switch 13*

Adobe Acrobat Professional Scripted plug-in as of Switch 13*

Adobe Illustrator Scripted plug-in as of Switch 13*, updated
in Switch 2017

Adobe InDesign Scripted plug-in as of Switch 13*, updated
in Switch 2017

Adobe InDesign Server Scripted plug-in as of Switch 13*

Adobe Photoshop Scripted plug-in as of Switch 13*, updated
in Switch 2017

Alwan ColorHub

Apago PDF Enhancer

Apago PDFspy
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Configurator Remarks/Extra documentation

Apple Automator Scripted plug-in as of Switch 2017 update
1*

Aproove

Automation Engine Extra documentation (system requirements
and troubleshooting) for the Automation
Engine Configurator is available at: http://
www.enfocus.com/manuals/Extra/Switch/
SwitchAutomationEngineConfigurator.pdf

Axaio MadeToPrint InDesign

Axaio MadeToPrint InDesign Server

Axaio MadeToPrint Illustrator

Axaio MadeToPrint QuarkXPress

Caldera Nexio Collect Available since Switch 13

Caldera Nexio Submit Available since Switch 13

callas PDFaPilot

callas pdfToolbox Server

callas pdfaPilot

callas Toolbox Actions

callas Toolbox Compare

callas Toolbox ConvertColors

callas Toolbox Impose

callas Toolbox Profiles

CHILI Publisher

ColorLogic ProfileTagger

ColorLogic ZePrA

Convert to Twixl Web Reader

CorelDRAW As of Switch 13, compatible with
CorelDRAW X7

Note:  The Fail jobs with
unavailable images option must
be set to Yes, if you're using
CorelDRAW X7; this option can
only be turned off if you're using an
older version of CorelDRAW.

DesignMerge Pro New in Switch 2017 update 1

Dynagram InpO2

EFI Fiery XF
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Configurator Remarks/Extra documentation

Elpical Claro

Elpical Claro Premedia Server

Enfocus PitStop Server

Enfocus PitStop Server PDF2Image Available since Switch 13

Note:  This configurator is installed
and updated with PitStop Server.
If you're using PitStop Server 13
update 1 or later, the configurator
is able to handle Switch metadata
attached to the PDFs you're
converting!

Firstlogic DQ-U.S. New in Switch 2017

GlobalVision Inc Barproof Windows only

GMG ColorServer New in Switch 2017 update 1

Harlequine RIP New in Switch 2017 update 1

HP SmartStream Designer Ganging

HP SmartStream Designer Impositon

HP SmartStream Designer VDP

HP SmartStream Production Center JDF
Control

HP Digital Front End JDF Controler

Imaging Solutions VIESUS

Made ToPrint Illustrator

Made ToPrint InDesign

Made ToPrint InDesign Server

Made ToPrint QuarkXPress

Microsoft Excel

Microsoft PowerPoint

Microsoft Word Separate versions for Mac OS and Windows

Phoenix Plan

QuarkXPress (Mac only) Support for QuarkXPress 2015 (Switch 13)

Quite Hot Imposing

Saxonica Saxon Available since Switch 13

StuffIt Deluxe

Ultimate Impostrip On Demand

Upload to Twixl Distribution Platform
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Configurator Remarks/Extra documentation

WoodWing Enterprise Download

WoodWing Enterprise Upload

* As of Switch 2017, the old versions of the Adobe configurators (C++ applications) are no longer
supported. The new scripted plug-ins are compatible with Adobe CC 2015 (and later) and Adobe
Acrobat DC.

Downloading and installing a configurator from within Switch
A number of configurators are installed by default, together with Switch, but you can afterwards
install additional configurators as required.

Note:

• It is only useful to install configurators for third-party applications that you have
installed. Otherwise you will not be able to use these configurators.

• You must have licensed the Configurator module.

To install a configurator from within Switch

1. In Switch, go to Help > Download configurators (only available if you have licensed the
Configurator module).
The Enfocus Pack Manager is displayed.

2. In the Sources column, click Web.

The colors of the icons refer to the installed version of the configurator:

• Green indicates that the latest version of the configurator is installed, so no need to
update it.

• Orange indicates that a newever version of the configurator is available.
• Grey indicates that the configurator has not been installed yet.

3. Select the appropriate configurator.

Move your cursor over the configurator, to see a tooltip with (version) information.

Tip:  If you don't find the configurator you need, click the Actions button (in the top
right corner of the dialog) and select Browse all configurators. This brings you to
the the Enfocus website (the Switch Partner integrations overview).

4. Click Download (button in the bottom right corner) and save the configurator (with file
extension .enfpack) to your local system.

5. To install the configurator, do one of the following:

• Double-click the downloaded enfpack.
• Drag the downloaded enfpack onto the Flow elements pane in Switch.
•

In the Flow elements pane, click , select Open and install and choose the
downloaded enfpack.

6. Click OK to confirm.
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The configurator is added to the Flow elements pane (in the Configurator category). In Pack

Manager, the icon next to the configurator has become green ( ).

If for any reason you would like to uninstall a configurator, you can do so via the context menu of
the configurator in the Flow elements pane.

Downloading and installing a configurator from the Partner
integrations overview on the Enfocus website
A number of configurators are installed by default, together with Switch, but you can afterwards
install additional configurators as required.

Note:

• It is only useful to install configurators for third-party applications that you have
installed. Otherwise you will not be able to use these configurators.

• You must have licensed the Configurator module.

To install a configurator from the Enfocus website

1. Go to the the Enfocus website (Switch Partner integrations overview)

2. Search for the Integration partner of your choice.

3. Search for the appropriate configurator.

4. Download it to your local computer.
A configurator is a file with file extension .enfpack.

5. To install the configurator, do one of the following:

• Double-click the downloaded configurator.
• Drag the downloaded enfpack onto the Flow elements pane in Switch.
•

In the Flow elements pane, click , select Open and install and choose the
downloaded enfpack.

6. Click OK to confirm.
The configurator is added to the Flow elements pane (in the Configurator category). In Pack

Manager, the icon next to the configurator has become green ( ).

If for any reason you would like to uninstall a configurator, you can do so via the context menu of
the configurator in the Flow elements pane.

Installing a different version of a configurator
There may be several reasons why you need a different version of a configurator. The most
obvious one is that you want to upgrade to the most recent version, but you can also have to
switch to another version because of compatibility with the third-party application or with the
version of Switch.

To install a different version of configurator that is already installed in your Switch
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1. In Switch, go to Help > Download configurators (only available if you have licensed the
Configurator module).
The Enfocus Pack Manager is displayed.

2. Do one of the following:

• To download the latest version of an already installed configurator:

1. In the Sources column, click Installed.
2. Select the configurator you want to update.
3. Click Download latest version and save the configurator (with file extension .enfpack)

to your local system.
• To download a particular version of a configurator:

1. In the Sources column, click Web.
2. If you consider installing an older version of the configurator (for example for

compatibility reasons), click the Actions button (in the top right corner) and select
Show > Show old versions.

3. Select the configurator and the version of your choice.
4. Click Download and save the configurator (with file extension .enfpack) to your local

system.

3. To install the downloaded version, do one of the following:

• Double-click the downloaded enfpack.
• Drag the downloaded enfpack onto the Flow elements pane in Switch.
•

In the Flow elements pane, click , select Open and install and choose the
downloaded enfpack.

4. Click OK to confirm.

5.5.2.3.  Smart Preflight
The following topics are only relevant if you're using the Enfocus PitStop Server configurators,
as only these configurators support Smart Preflight. It's explained further in this document what
Smart Preflight is and how it can be used in the Enfocus products in general and in Switch in
particular.

About Smart Preflight
Smart Preflight is a functionality that allows you to handle many different job types and
specifications by using only one Preflight Profile. This is possible, thanks to the use of variables.

For example, if one of your preflight settings checks the page size, it is sufficient to define one
Profile using a variable with the most commonly used page size (e.g. A4) as the default. If a
document type with a different page size comes in (e.g. a leaflet or a newspaper), you can select
the required page size from a pre-defined list or type the appropriate value (depending on how
the variable is defined) in the dialog that pops up when running the preflight check.

There are three types of variables:
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• Constant variables are variables that get their value from user input (in PitStop Pro, as in the
example above) or from a Job Ticket or a database (in PitStop Server and Connect):

• In PitStop Pro, a dialog pops up just before running the preflight check. You can manually
enter the required values.

• In PitStop Server, you must send an XML/JDF Job Ticket along with the PDF. The
information in this Job Ticket (e.g. the page size) is used to determine the value of the
variables.

• In the PitStop Server Configurator (for use with Switch), the information can be taken
either from a Job Ticket or from a database.

• In Connect, you can create Job Tickets that collect job information for each document
processed by a Connector. The metadata in these Job Tickets will be used to determine
the value of the variables.

• Calculation-based variables are variables of which the value is calculated by multiplying,
dividing, subtracting, adding up, … certain values (fixed values or variables).

For example, in large format printing, the required resolution depends on the viewing
distance; the bigger the distance, the lower the required resolution. The optimal resolution
can be calculated with a calculation variable.

Another example is point size: if a large poster will be viewed on a small display, the point
size should be smaller; the optimal point size can be calculated by dividing the regular value
(a fixed value) by the scaling factor (stored in a variable).

• Rule-based variables are variables of which the value is based on other variables (possible
in all Enfocus products)

For example, suppose you want to check the ink coverage using a Preflight Profile. The
optimal ink coverage depends on several different factors, just like the paper type and the
printing method. Without variables, you must define different Profiles for each combination
of paper and printing method, each with fixed total ink coverage values (e.g. Profile 1 for
Uncoated + Sheetfed Litho and Profile 2 for coated + Sheetfed Litho, ...). However, using
variables, you can define one Profile and enter the required information for the job (paper
type and printing method) to calculate the optimal ink coverage at run-time.

The different types of variables can be combined (e.g. rule-based variables calculated based on
a drop-down of constant variables), making it possible to configure multiple checks and fixes
based on a single user input (PitStop Pro) or on only one value in a Job Ticket or database.

Constants

User
input

Constants

Job
Tickets

Constants

Databases

Rule-
based

Calculation-
based

PitStop Pro

PitStop Server

PitStop Server with
Enfocus Switch*

Enfocus Connect/
Connectors

* The PitStop Server Configurator also supports the Switch variables. Refer to Smart Preflight
Variables: types on page 392.
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Note:  Variables can be used in Action Lists as well, in a similar way as in Preflight.

Getting started with Smart Preflight

Variables and Variable Sets

Before you can start working with Smart Preflight, you need to define the variables you want to
use and save them within a Variable Set (a file format which can be exported and imported).

When defining your Preflight Profile, you can then select the variables you need from this
Variable Set. Note that you can create different Variable Sets (e.g. if you would like to define
different Variable Sets for different document types or different Enfocus products) and that
a Variable Set can contain as many variables as required. However, you can apply only one
Variable Set at a time (e.g. one per hot folder in PitStop Server, one active Variable Set in PitStop
Pro) and it should match the Variable Set used in the Preflight Profile concerned.

Note:  PitStop Pro and PitStop Server can share the same Smart Preflight Variable Sets,
much like they can share Preflight Profiles or Action Lists. However, some variable
types (see further) are useful in PitStop Pro only and others work only in PitStop Server.
Unsupported variables will use a default value or will generate a failure.

How to decide which preflight settings could be configured as variables?

Good candidates are preflight settings that can change from job to job, for example:

• Trim page size
• Total ink coverage
• Number of colors defined

Preflight settings that are often the same can better be configured as fixed values. Some
examples:

• Embedded fonts
• Security settings
• Document contains pre-separated pages

Getting started

The following topics explain step by step how to configure a Variable Set and how to use the
variables in your Preflight Profiles.

Setting up Smart Preflight

Smart Preflight setup: overview
This topic describes the steps required to set up and use Smart Preflight.

1. Configure a Variable Set:
a. Create a Variable Set.
b. Define the Variables to be used.
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2. Apply the variables to the appropriate checks in your Preflight Profile.

3. Run the Preflight Profile with the variables enabled.

Configuring a Variable Set

Creating or editing a Variable Set

You need a Variable Set (which contains the variables you need) in order to use variables in a
Preflight Profile or Action List. You can create a new one or re-use an existing one (i.e. add any
new variables as required).

Important:

• Although you can create more than one Variable Set, we recommend that you keep
all your variables in one Set. Only if you are working with both PitStop Pro and PitStop
Server, you might consider using different sets. However, if you use variables of
different Variable Sets within a single Preflight Profile, only the "active" (applied)
Variable Set variables will contain values. Variables used from inactive Variable Sets
will be blank!

• Do you want to use a Variable Set with the PitStop Configurator in Switch? To get
access to the Switch Variables (see Smart Preflight Variables: types on page 392),
you should edit the Variable Set in Switch (not in PitStop Server).

To create or edit a Variable Set

1. In the Properties pane of the PitStop Server Configurator

a. Locate the Variable Set property.
b.

Click .
c. Click Select Variable Set.

The Select variable set: Variable Set Panel appears, displaying all the installed Variable Sets
as well as any local Variable Sets that have been defined.

2. Do one of the following:

• To edit an existing Variable Set, double-click the Set concerned.
• To create a new Variable Set, from the actions menu ( ), select New > New.

The Enfocus Variable Set Editor appears.

3. Enter the appropriate details (a meaningful name and a description) and lock the Variable
Set if required.

See Locking a Variable Set (optional) on page 391

4. Define the Variables you need.

See Defining Smart Preflight variables on page 391

5. Click Save.
The new Variable Set is saved to your Local Switch folder.

Note:  This Local folder is shared with any other Enfocus applications that you may
have installed.
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Locking a Variable Set (optional)

You can lock a Variable Set with a password, to prevent other users from editing the Variable Set
and viewing details when they open it in the Enfocus Variable Set Editor.

To lock a Variable Set

1. Open the Variable Set.

See Creating or editing a Variable Set on page 390

2. In the Enfocus Variable Set Editor, click SETUP > General.

3. From the Permissions list, select Locked.

4. Enter a password and repeat it.

Note that you can change the password at any point of time if required, by clicking the
Change Password button.

5. Click OK.

6. Click Save.

The Variable Set is locked. Users wanting to edit or view the details of the Variable Set must

click the Lock icon  and enter the correct password.

Defining Smart Preflight variables

The Smart Preflight variables for use in Preflight Profiles must be defined before you can use
them. This topic explains how you can create and define new variables.

To define Smart Preflight variables

1. Open the dialog with the Variable Set that will contain the new variable.

See step 1 of Creating or editing a Variable Set  on page 390.

2. In the left part of the Enfocus Variable Set Editor, under Variables, click .

3. Enter the required details for the new variable:

Field Meaning

Name Choose a meaningful name, for example, the check the
variable is intended for.

This name will be visible in the Preflight Profile editor or in
the Action List editor, when applying a variable to a check
or fix (see Applying variables to a check in a Preflight Profile
on page 402). For this reason, it is advisable to keep this
name as short as possible.

User Readable
Name

Use this field if the variable name is too technical or too
short to be clear enough.

Type (First list) Choose the appropriate type. Refer to Smart Preflight
Variables: types on page 392.
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Field Meaning

Type (Second list) The type of the values produced by this variable. For
example, if a variable for a trim page size is to be created,
then it must have a "Length" variable type. If a variable is
needed to select or deselect a check box (such as to turn
on a correction), then a Boolean variable type needs to be
defined. Some examples for each option:

• Number - Page count, Number of separations, etc
• Length (i.e. a number of measurement fields) - Page

trim size, bleed amount, etc
• String - Entry for a metadata field
• Boolean - Selection for any checkboxes

Note:  Make sure that this value type matches
the preflight check setting it is intended for.
When applying variables to a preflight check
setting, only the variables that match that type of
entry will be displayed.

Type (Third list) In case of a Job Ticket in combination with value type
"Length", a third list is available, allowing you to choose the
appropriate unit, for example "Points", "Inches", ...

Note:  The unit displayed in the Default Value field
(lower) depends on the application Preferences.

Description Optionally, provide a brief description.

4. Proceed with the fields in the lower part of the dialog.

This part of the procedure depends on the chosen variable type:

• Constant variable definition on page 393.

• Calculation-based variable definition on page 395.

• Rule based variable definition on page 397.

• Variable definition: Text with variables  on page 399.

• Variable definition: Script expression  on page 401.

Note:  For example variables, have a look at the Smart Preflight Variable Set -
PitStop Pro - v1.4. (available under Standard > Smart Preflight).

5. Click Save.

Smart Preflight Variables: types

When defining a variable, you must choose a type. The table below gives an overview of the
available variable types per application and explains their meaning.
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Type Meaning Application

Constant In PitStop Pro, when a Constant variable is applied
to a preflight check, a default value will be displayed
to the operator, allowing him to override it before
running that preflight check. Constants can be a text
string, a number, a length (i.e. a measurement) or a
boolean (yes/no or on/off) value.

Constant variables are available in PitStop Server to
stay compatible with PitStop Pro. Only their default
value is used when processing. No choice to override
their value is given at the time of processing,
since PitStop Server is intended to process files
completely "hands-off".

PitStop Pro/Server

PitStop Server
Configurator in
Switch

Enfocus Connect

Rule Based A Rule Based variable allows you to take values from
other variables and use them to create a new value,
based on different conditions. For example, variables
representing paper type and printing method could
both be used to define the value for the necessary
Total Ink Coverage.

PitStop Pro/Server

PitStop Server
Configurator in
Switch

Calculation
Based

A Calculation Based variable allows you to make
calculations. You can divide, multiply, subtract, add
up, ... fixed and variable values as required.

PitStop Pro/Server

PitStop Server
Configurator in
Switch

Enfocus Connect

Job Ticket Job Ticket variable values are extracted from an
XML/JDF file submitted to PitStop Server or a
Connector in conjunction with the PDF job file. These
variables can either change a single setting or be
linked to Rule Based variables for more complex
processing.

Note:  The Job Ticket variables of PitStop
Server cannot be used in Switch. However,
you can change the Job Ticket variables
to either Text with Variables or Script
Expression and modify them to correspond
to the behavior of Switch.

PitStop Server

Enfocus Connect

Text with
variables

Variable values are defined using the Switch
variables. Note that this type is only available if
you open the Variable Set via the PitStop Server
Configurator in Switch.

PitStop Server
Configurator in
Switch

Script
expressions

Variable values are defined using JavaScript.
Note that this type is only available if you open the
Variable Set via the PitStop Server Configurator in
Switch.

PitStop Server
Configurator in
Switch

Constant variable definition
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Options

The following table gives an overview of the constant-specific options.

Option Description

Default Value Fixed value, which will be used when Switch runs a Preflight Profile that
needs this variable.

Note:  Constant variables used in PitStop Server cannot be
manipulated by the user. Hence, PitStop Server will only use the
default value.

Allow manual
input

Enables users to type values when they run the Preflight Profile.

Show a
predefined
list of values

Enables users to select a predefined value from a list of values.

If the value type is Number or Length, you will have the possibility to mask
the value and provide an alternate name for the user.

Tip:  You can change the order of the items in the list by just
selecting a value and dragging it up or down and dropping it in the
desired position.

Example

Below you can see an example of a constant variable definition (left) and the resulting list the
users will see when running the Preflight Profile (right).
 

 
.

Combining options

Allow manual input and Show a predefined list can be combined. The following table explains
what this means.
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Selected options Meaning

Both enabled Users can either select a value from the predefined list
but or manually enter a value.

Both disabled Users will see the default value in a read-only text box.
They cannot change it.

Only Allow manual input
enabled

Users can manually enter a value. There is no list to
choose from.

Only Show a predefined list
enabled

Users can select a value from the predefined list. They
cannot enter a value themselves.

Calculation-based variable definition

Calculation-based variables allow you to calculate a value by multiplying, dividing, subtracting,
adding up, … certain values (both fixed and variable values).

You can build your calculation (in the Variable Value entry field) as follows:

• You can type it directly into the Variable Value field.

• To insert the digits and operators, you can also use the calculator beneath the entry field.
Note that 'Clear' clears the whole entry field.

• To insert variables:

1. Click the Add variable button or enter a square bracket ([) in the entry field. This will
open a drop-down list with all variables defined in the current Variable Set.

2. Click the variable you want to insert.

Example

This is an example of a calculation variable that is used to check the resolution of images in
large formatting. This is the value that triggers an error.

The first screenshot shows the variable definition. The value is calculated by dividing and
multiplying fixed values and variable values (the viewing distance and the scaling factor), which
both have an impact on the allowed image resolution. Note that the variable definitions for
viewing distance and scaling factor must be defined as variables in the same Variable Set.
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The second screenshot shows how the variable is used in an Action List to check the image
resolution of grayscale and color images.

More examples can be found in Variable Set 1.4 (under Preferences > Variable Sets). These
variables were configured for use with the GWG Profiles for Packaging (2015 Specifications).

Remark
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The most common value type of calculation variables will be Number. However, if your
Preflight check or Action expects a different type, this is also possible. For example, in case of
a "Boolean" variable, the result of the calculation will be converted to false (if it's 0) or true (if
not 0). In case of "Length", the result of the calculation will be converted to a value in the unit
chosen in the Preferences (so x points will be converted to the corresponding value in cm, mm,
feet, etc).

Rule based variable definition

About rule based variables

The concept of a rule based variable is to build a variable that will change based on the state of
another setting. For example:

Rule based variable "Image Resolution" is defined as follows:

IF "Job type" is "Offset" THEN set "Image Resolution" to 300 ppi
ELSE
IF "Job type" is "Digital", THEN set "Image Resolution" to 150 ppi

Rule based variables get their values based on one or more rules. Each rule has two parts:
a condition to trigger the rule (IF) and the value to be used when that condition is triggered
(THEN).

The condition contains one or more comparisons of a variable with a value. In the above
example, the variable "Job type" is compared with the value "Digital". These comparisons can
be combined with "AND" and "OR" to create complex conditions.

If a rule is not triggered, the next rule is tried. There must be an ELSE rule at the very end, that
is triggered if none of the conditions are met.

Because a rule based variable always needs to be compared with one or more other variables,
you will always need to create at least one other variable to make a rule based variable work. In
the above example, you need to know the value of the "Job type" variable in order to determine
the value of "Image Resolution". In PitStop Server, the variable to compare with will usually be a
Job Ticket variable. In PitStop Pro, this will usually be a constant variable which offers the user
a list of predefined constant values to choose from.

How to proceed

Proceed as follows:

Note:  Before starting the configuration in the software, we recommend writing down
the rule for yourself (using IF/ELSE statements). This will make clear which variables
you need.

1. Define the variable(s) you need.
2. Define the rule based variable itself:

• Choose Rule Based as Type and determine the value type, for example "Number".

• Build the rules:
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• The first list (preceded by "IF") allows you to select any earlier defined variable.
• Choose "is", "is not", "begins with", ... as required and enter or select the appropriate

value. Options depend on the variable chosen in the previous step.
• Click the appropriate operator (AND/OR). (The chosen operator is added to the rule.)

AND/OR statements will add a condition to the selected rule, making the rule
dependent on two or more conditions.

• Enter/Select the resulting value (the type depends on the chosen value type).

• If required, click ELSE to add an alternative rule to the overall variable (=IF) and
proceed in the same way.

• Determine what should happen in case none of the conditions are met. You can either
generate a failure (so the preflight check will generate a preflight error) or enter a
default value.

3. Save the Variable Set.

Example 1

Below you can see the definition of the "Image Resolution" rule based variable (value type =
Number). It makes use of an earlier defined variable: "Job type", which is a constant (text)
variable with "Offset" and "Digital" as possible values.

Depending on the value of "Job type", the Image Resolution will be different (300 or 150). If the
Job type is different from the ones for which a rule has been configured, a preflight error will be
generated.
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Example 2

Below you can see the definition of the "Convert to grayscale" rule based variable (value type =
Boolean). It makes use of an earlier defined variable: "Color conversion", which is a constant
(text) variable with "Grayscale" as one of the possible values.

If the value of the "Color conversion" variable is "Grayscale", the value of "Convert to grayscale"
will be "Yes". If this is not the case (e.g. Color conversion is "CMYK"), the value of "Convert to
grayscale" will be "No" (=default value).
 

 

Variable definition: Text with variables

About Text with variables

This type of variable provides access to run-time information about the Switch flow environment
and about the job, including embedded metadata fields and external metadata fields, without the
need for scripting.

Note that you need an active license for the Switch Databases Module, if you want to use
database information, and active license for the Switch Metadata Module, to use metadata
fields.

Length/Unit

When you select "Length" as the value type for this variable, an additional dropdown menu
called Unit appears, allowing you to choose the appropriate measuring unit.

Note:  Make sure to use the same unit in the Variable Value text box below. Otherwise,
the chosen value from the Unit list will be ignored. For example, if you choose
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"Centimeters" in the Unit dropdown and enter "20 mm" in the Variable Value text box,
then Smart Preflight will consider millimeter as the unit and centimeter will be ignored.

How to proceed

To define a variable using the text with variables option, proceed as follows:

1. To determine the Variable Value, click the ... button.
2. In the Define text with variables dialog, select the appropriate Variable Group (first column),

Variable (2nd column) and attributes (3rd column).
3. Click Insert variable.

Tip:  Use a sample job to see the actual value of the inserted variable.

For more details, refer to Defining text with variables on page 408

Example 1

Below you can see the definition of the "JobName" variable (Text). The value returned from the
sample Job is "Duotone".

This is a basic example. For more complex cases, refer to the chapter Metadata on page 407
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Variable definition: Script expression

About script expressions
A script expression is a JavaScript program that gets evaluated in the context of a job (file or
jobfolder) to determine the value of a particular property of a flow element or connection. This
allows the property value to depend on the job or its associated metadata.

Note that you need an active license for the Scripting Module in order to configure and use this
type of variable.

Length/Unit

When you select "Length" as the value type for this variable, an additional dropdown menu
called Unit appears, allowing you to choose the appropriate measuring unit.

Note:  Make sure to use the same unit in the Variable Value text box below. Otherwise,
the chosen value from the Unit list will be ignored. For example, if you choose
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"Centimeters" in the Unit dropdown and enter "20 mm" in the Variable Value text box,
then Smart Preflight will consider millimeter as the unit and centimeter will be ignored.

How to proceed

To define a variable using a script expression, do one of the following:

• Type the JavaScript source code in the Variable Value box and click Save to save the code to a
file.

• Click Open and select an existing script (*.js). The content of the selected script will be
shown in the Variable Value box. If you make any changes, makes sure to save them to a file
(Save/Save as).

Applying a Variable Set
Once you have defined your Variable Set, you must "apply" or activate the Variable Set you
want to use. This is extremely important if you have defined more than one Variable Set; if
the variables used in your Preflight Profile are taken from a different Set than the one that is
activated, the variable values in the Profile will remain blank.

To apply a Variable Set

1. In the properties of the Switch Server Configurator, click .

2. Select the Variable Set that contains the variables used in a Preflight Profile.

Applying variables to a check in a Preflight Profile
Variables allow you to process different jobs and job types with one Preflight Profile; instead of
using multiple Profiles with different, fixed values, you enter a variable which is defined when
running the Preflight Profile.

Note that you need to have defined a Variable Set with Smart Preflight variables before you can
use variables in a Preflight Profile.

To use variables in a Preflight Profile

1. Click PitStop Pro > Preflight Profiles and double-click the Preflight Profile concerned.

2. In your Preflight Profile, open the CHECK ON: category for which you want to use a variable.

3. Do one of the following:

• If a variable should be used for enabling or disabling all checks on the tab, click the
Actions link in the top right corner of the tab and select Enable Variable Names. A button

 appears next to the checkbox of Enable checks without restriction/Enable checks of
<restriction>.

• If a variable should be used for one particular check, in the attributes of the check

concerned, click the Enable Variable Names button . A button  appears next to each
property where it is relevant.

4. Click  next to the property for which you want to use a variable.

Note that this button is only shown when the check can have a variable applied.
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5. In the Select a Variable dialog, make sure Use a Variable from the selected Variable Set is
selected and select a Variable Set as required.

6. Double-click the variable you want to use for the property concerned.

Only the variables that match the type required for the property concerned are shown. For
example, if you want to define the page width, you need a variable of the type Length.

The name of the variable is shown in the Preflight Profile.

Running a Smart Preflight check
If you want to preflight PDF files in Switch using the PitStop Server Configurator, you must
build a flow with the PitStop Server Configurator and set all properties correctly. As PitStop
Server is an automated system, there is no manual intervention, so the values cannot be
entered by the user. Instead, the values are taken from a Job Ticket - at least if the variable type
is "Job Ticket". If this is not the case (i.e. if the variable type is "rule based" or "constant"), the
default values are used. See also Smart Preflight Variables: types on page 392.

Note that all PDF files moved to the PitStop Server Configurator will be preflighted. No
additional setup is required.

To learn more about the PitStop Server Configurator, search for the configurator in the Flow
Elements pane and select Documentation from the context menu.

Using Smart Preflight variables in Action Lists
Smart Preflight variables can also be used in Action Lists.

Using variables instead of fixed values in Action Lists
You can also use Smart Preflight variables to define attributes of your Actions contained in your
Action Lists. The advantages are the same as for Preflight Profiles, i.e. you don't need different
Action Lists but you can dynamically modify the values just before running the Action or by
taking them from a Job Ticket or database.

This topic explains how you can configure an Action to use variables instead of fixed values.

To define your Actions using variables instead of fixed values

1. Click PitStop Pro > Action Lists and double-click the Action List concerned.

2. Select the Actions you want to define using a Smart Preflight variable.

3. Click the Actions link (in the top right corner of the attributes for the Action concerned).

4. Select Enable Variable Names.

This option is only available if it is relevant for the Action concerned.

The icon  appears where it is possible to use a variable.

5. Click .

6. Select the variable you want to use.

You will only see the variables that can be used in the field concerned. Note that you can
choose a different Variable Set if necessary.

7. Click OK.
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Running an Action List with Smart Preflight variables enabled
If you want to run an Action List with variables enabled on your PDFs using the PitStop Server
Configurator or the PitStop Server PDF2Image Configurator, you must build a flow with this
Configurator and set all properties correctly. As PitStop Server is an automated system, there
is no manual intervention, so the values cannot be entered by the user. Instead, the values are
taken from a Job Ticket - at least if the variable type is "Job Ticket". If this is not the case (i.e.
if the variable type is "rule based" or "constant"), the default values are used. See also Smart
Preflight Variables: types on page 392.

Note that all PDF files moved to the PitStop Server (PDF2Image) Configurator will be processed
with the selected Action List. No additional setup is required.

To learn more about the PitStop Server and PitStop Server PDF2Image Configurator, search for
the configurator in the Flow elements pane and select Documentation from the context menu.

Troubleshooting for Smart Preflight
Following topics explain how to fix some issues you may run across while working with Smart
Preflight.

Variable not available to apply a preflight check

Issue

Although the variable is present in the Variable Set, you are not able to select it for a particular
preflight check.

Cause/Context

When configuring a preflight check, you must first select the Variable Set concerned. Only
variables that belong to this set can be applied.

Variables are (among others) defined using a particular type (Constant, Rule Based, Job Ticket)
and value/measurement type (Number, Length, String, Boolean). This value type must match
the preflight check settings it is intended for, otherwise it is not displayed when you try to select
it.

Fix

Make sure the correct Variable Set is selected. If the variable you want to use is present in a
different Variable Set, you may decide to switch Variable Sets or add the variable to the currently
selected Variable Set.

Next, review the variable and ensure it's defined as the right "value type" (Number, Length,
String or Boolean) to match the preflight check.

Variable Set not supported

Issue

While importing a Variable Set, you get one of the following errors:
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• This Variable Set has settings not supported by this version of software. These may be
changed or removed when editing the Variable Set.

• The selected Variable Set has been created with a more recent application and cannot be
used.

Cause/Context

Variable Sets created with earlier versions of the software are always compatible with new
versions. You can import them and use any new features of the software as required. No error
messages will be shown.

Variable Sets created with newer versions of the software than the one you're using can be used
as long as no new settings were used (as they are not supported by the software). If there is a
version mismatch, one of the above mentioned error messages appears.

Fix

If you can import the Variable Set, remove or change the variables containing settings that are
not supported.

If you cannot import the new Variable Set, you can either upgrade the software (recommended)
or re-create the Variable Set using the older version of the software.

Note that, while saving Variable Sets, Enfocus PitStop Pro will automatically choose the lowest
possible Variable Set version number to ensure maximum portability.

Red exclamation mark in front of a variable

Issue

When opening your Variable Set in the Variable Set Editor, you notice that one or more variables
in the Variable Set have a red exclamation mark in front of them. Possible warnings:

• The variable uses the unkown variable type ... and cannot be edited.
• Variables from ... are not supported because ... Module is not licensed.

Cause/Context

Not all variable types are compatible with all Enfocus products. For example, "Text with
Variables" can only be used with Switch. If a variable is "unknown" to an Enfocus product, it
cannot be used or edited, but it won't harm either.

In Switch, some variable types are linked to a particular Switch module. For example, the "text
with variables" variable using database fields is only supported if you have an active license for
the Switch Database module.

The problem can also be linked to a rule-based variable; if the variable is based on another
variable that has been removed or is invalid, the rule-based variable becomes invalid as well
and gets a red exclamation mark in front of it.

Fix

If you want to use "unknown" variables, you must change the variable type to a type supported
by the product you're using.

If you don't want to use it, just leave it in there; it won't do any harm. You can use (or edit) it
again when working with other Enfocus products.
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If you want to use variables that require a license that you don't have, please contact Enfocus to
buy a license.

In case of invalid rule-based variables, review the rule(s) and correct or re-define the dependent
variable(s) as required.

5.5.3.  Metadata Module
The Metadata Module enhances the use of metadata in Switch flows: in addition to Switch-
specific metadata, it gives access to other types of metadata originating from other applications
or stored in other formats that are common in the graphical industry.

5.5.3.1.  Getting started with the Metadata Module

Access to other types of metadata

Metadata is information about the job you are processing, such as its size, creation date,
number of pages, paper type, ... In Switch, this information can be used to route jobs, to rename
them, to make decisions, etc.

With the Metadata Module, you have - in addition to Switch-specific metadata - access to XMP
metadata (embedded in side the job and available in most jobs created with Adobe products) and
to metadata in external files (XML or JDF tickets) submitted with the job.

You can:

• Use metadata in Switch just like regular variables to process your jobs dynamically.
• Visualize metadata for jobs submitted through the Switch Web Portal or processed with a

Connector.
• Use the Metadata tools (listed below) to export metadata and convert XML information,

preflight logs and reports into other XML formats, HTML or human-readable information.

Metadata tools

With the Metadata Module, you get access to the tools in the Metadata category of the Flow
Elements pane:

• XML Pickup

• JDF Pickup

• XMP Pickup

• XMP Inject

• Opaque pickup

• Export metadata

Note:  Want to know how these tools work? Take a look at the eLearning course about
this topic (for subscribers and maintenance users only).

Metadata variables

Once you have "picked up" the metadata set you need using one of the Metadata tools, you can
select the variable of your choice from the Metadata variables group. This group is only available
if you have an active license for the Metadata Module.

406

https://learning.enfocus.com/course/view.php?id=237


Switch

5.5.3.2.  Metadata

Metadata overview

What is metadata

In the Switch context, metadata is descriptive information about a job (file or job folder) in
a structured electronic form. Metadata is often used to store administrative information
associated with a job, and to exchange such information between systems. Metadata can be
distinguished from the job contents proper, even if it happens to be embedded in the job.

Historically, metadata has been stored in various proprietary or standard formats. TIFF, EXIF
and IPTC tags (often found in image files) are classic examples. More recently, the industry has
moved to store metadata as XML, building on the strengths of this ubiquitous format. JDF and
Adobe XMP, two XML-based formats, are often used in the publishing industry in addition to
generic XML.

Metadata categories

Switch recognizes three categories of metadata depending on the storage mechanism used to
convey the information, as described in the following table.

Category Description

Internal Switch-specific information stored in the internal job ticket for
each job; for example hierarchy info and email info

Embedded Metadata that is embedded inside the job (as part of the file); for
example EXIF or IPTC tags, or an embedded Adobe XMP packet;
see Embedded metadata on page 450.

External Metadata that travels with the job but is stored as a distinct entity;
for example an XML or JDF file, or a standalone Adobe XMP packet
(possibly extracted from the job file); see External metadata on
page 453.

Support for metadata

Switch supports working with metadata in various ways as defined in the following table.

Feature Benefits

Internal job ticket Maintaining hierarchy info, email info and other internal
metadata used by the Switch tools

Variables Read-only access to embedded metadata (EXIF, IPTC, XMP) and
file information

Pick-up and export Picking up external metadata (XML, JDF, XMP) from foreign
sources and exporting it for external use

Scripting Read-write access to embedded metadata and external metadata
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Defining text with variables
Text properties that support variables can be edited with the Define single-line text with
variables property editor.

 

 

The text field at the bottom contains the text being edited. Variables are simply mixed-in with
static text and enclosed in square brackets [ ] (see Variables on page 417). The list boxes and
text fields in the top portion of the property editor offer guidance for dealing with variables, as
explained below.

Arguments

The rightmost column shows any arguments relevant for the selected variable; for example:
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See Data types on page 421, Formatting on page 421, Indexed variables on page 424, and
String manipulations on page 425.

Entering text
You can type constant text in the text field at the bottom at any time. You can also leave the field
empty and just insert one or more variables using the procedures explained in the following
sections.

If you understand variable syntax, you can enter or modify variables directly in the text field.
However, it makes more sense to let the Property editor assist you with inserting and updating
variables, as explained below.

Inserting a variable
Note:  Switch interprets the opening square bracket '[' as the beginning of a new
variable. To use the square bracket as static text, you need to double it: '[['. Note that
there is no need to double the closing square bracket.

Example:

• Input: This the value of the [[Job.Name] variable: [Job.Name] (the first instance of
[Job.Name] is to be interpreted as static text; the second as a variable)

• Result for a job with the name TestFile.pdf: This is the value of the [Job.Name]
variable: TestFile.pdf (only the second instance of [Job.Name] is replaced by the actual
job name)
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To insert a new variable in the text, proceed as follows:

1. In the text field at the bottom, place the text cursor in the location where you'd like to insert
a variable; make sure it is not inside a pair of square brackets [ ] that mark a variable; if the
text field is empty, just leave the cursor at the start of the field.

2. Select a variable group in the leftmost list ("Switch" in the example above); the list to the
right adjusts to list all the variables in this group.

3. Select a variable in the second list ("Date" in the example above); the text area to the right
adjusts to provide a brief description of the variable, the title bar indicates the variable's
data type, and the rightmost column shows any arguments relevant for this variable (see
Characteristics of variables on page 418).

4. If the rightmost column contains any text fields, enter the appropriate values for the
variable's arguments (see Metadata on page 450); leave a field blank to use its default
value.

5. Once you are satisfied with the selected variable and argument values, click the Insert
variable button.

Updating a variable
To update a variable that was previously inserted, proceed as follows:

1. In the text field at the bottom, place the text cursor inside the variable you would like to
update, that is, inside the pair of square brackets [ ] that mark the variable; the fields in the
top portion of the property editor automatically synchronize with the contents of the variable.

410



Switch

2. Adjust the argument values for the variable in the text fields at the right, or select a new
variable (possibly in another group) as desired.

3. Once you are satisfied with the changes, click the Update variable button.

Defining a condition with variables
Conditional properties that support variables can be edited with the Define condition with
variables property editor. A conditional property has a Boolean result (true or false). For
example, the file filtering properties on connections are conditional properties.

The property editor discussed here offers a user interface to create comparison expressions
with support for locating a variable and entering its arguments.

Its more advantageous to compare variables from a job with other variables (for example: from
an external source like database or dataset). Therefore, Switch allows users to select multiple
variables when setting up a condition. Select one of the following three property editors in the
drop-down menu (highlighted in the screen given below):

• Inline Value
• Text with Variable...
• Script expression...

 

 

The example condition is true if the job being tested contains a single file smaller than 1MB or if
one of the associated email addresses has the 'enfocus.com' domain.

Defining a condition
The property editor has two distinct parts:

• The main dialog box which allows defining one or more comparisons between a variable and
a constant value, forming the condition.

• The pop-up dialog box which serves to locate a variable and enter its arguments, similar to
defining text with variables.

The group and variable listboxes in the pop-up are synchronized with the corresponding
dropdown menus for the currently selected comparison in the main dialog box.
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Defining a single comparison

When the property editor for a certain property is displayed for the first time, a single
comparison row is shown. To define this comparison, proceed as follows:

1.
Click this  button beside the first textbox. The Define text with variables dialog box
appears.

2. Select a variable group in the first listbox. The second listbox adjusts to list all the variables
in this group. Select a variable in the second listbox.

• The text area to the right adjusts to provide a brief description of the variable, the title
bar indicates the variable's data type, and the rightmost column shows any arguments
relevant for this variable (see characteristics of variables).

3. Click Insert variable button.

• Define text with variables pop-up dialog box closes.

• The selected variable group and variable are inserted in the first textbox of the main
dialog box.

4. The dropdown menu next to the textbox adjusts to list the appropriate comparison operators
for the variable's data type. Select the desired comparison operator.

5. In the last dropdown menu, select the appropriate property editor. Enter or select the
appropriate values.

6. Once you are satisfied with the configuration, click the OK button.

Defining multiple comparisons

The property editor allows defining a condition that combines multiple comparisons. Each
comparison is represented as a separate row in the lower portion of the property editor. The
radio button in front of each row indicate which of the comparisons is currently synchronized
with the upper portion of the property editor; it is called the currently selected comparison.

The dropdown menu to the left of each row (starting with the second row) indicates the logical
operator (OR or AND) used to combine the consecutive comparisons. It is also used to add and
remove comparison rows.

• To add a new comparison:

1. Locate the dropdown menu at the bottom left (in front of an empty row) displaying "----".
2. In that dropdown menu, select the desired logical operator "AND" or "OR" instead; a new

comparison row is added.
• To remove a previously added comparison:

1. Locate the dropdown menu at the start of the comparison row displaying the logical
operator "AND" or "OR".

2. In that dropdown menu, select "----" instead; the comparison row is removed.

You cannot remove the first condition since it does not have a logical operator dropdown
menu.

• To change the logical operator combining two comparisons:
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1. Locate the dropdown menu at the start of the second comparison row displaying the
logical operator "AND" or "OR".

2. In that dropdown menu, select the other logical operator instead; be careful NOT to
select "----" because that would cause the comparison row to be removed.

Operator precedence

If three or more comparison rows are combined with different logical operators (that is, both
"AND" and "OR" are used), the meaning of the condition depends on the order in which the
logical operations are performed. Thus in that case the property editor displays an extra section
at the very bottom, allowing to select operator precedence:

• OR then AND: the logical OR operations are performed first, then the logical AND operations.
• AND then OR: the logical AND operations are performed first, then the logical OR operations.

The following table provides some examples of conditions with their meaning for each choice of
operator precedence.

Condition OR then AND means AND then OR means

A OR B AND C (A OR B) AND C A OR (B AND C)

A OR B AND C OR D (A OR B) AND (C OR D) A OR (B AND C) OR D

A AND B OR C AND D A AND (B OR C) AND D (A AND B) OR (C AND D)

A AND B OR C OR D A AND (B OR C OR D) (A AND B) OR C OR D

Comparison operators

Variable data
type

Comparison operators Comparison value

Equal to

Not equal to

Contains

Does not contain

Starts with

Does not start with

Any text stringText

Matches

Does not match

A regular expression

Boolean True

False

None

Integer Rational Equal to

Not equal to

Less than

A decimal integer or floating point
number, example, "-12" or "0.56"
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Variable data
type

Comparison operators Comparison value

Less than or equal

Greater than

Greater than or equal

A constant expression using + - * /
operators; example:

• 5 * 1024 * 1024

• 2/3

• 6.77 + 8.55

Date Equal to

Not equal to

Earlier than

Earlier than or same

Later than

Later than or same

An ISO 8601 formatted date/time
(equivalent to format string "yyyy-
MM-ddThh:mm:ss.zzz") or any portion
thereof.

If present, the date part of the string
must have one of the following formats:
"yyyy-MM-dd", "yyyy-MM", "yyyy".

For example, you may enter "yyyy-MM"
for the format string and "2019-01" as
the comparison value to compare year
and month.

Sample jobs
Defining text with variables and Defining a condition with variables offer a mechanism to display
actual metadata variables derived from sample jobs while configuring the property value(s) in
the editor.

Limitations

A job can be a sample job only if it has a unique name prefix and a valid internal job ticket.

Sample jobs should be entered as live jobs into the flow being edited so that they can be
managed by Switch and variables can be tracked.

Working with sample jobs
To benefit from this feature, you should design a prototype of the desired flow and process one
or more sample jobs through the flow to the point where the jobs have accumulated the relevant
metadata.

Follow these steps to work with a sample job in your flow:

1. Create a valid prototype of the desired flow.

2. Activate the flow.

3. Put the connections which are present at the end of the flow on hold to prevent jobs from
completing the flow. This allows Switch to detect all the variables that are available in the
sample job.

4. Place sample jobs in the flow and let them process to the desired stage.
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5. Deactivate the flow.

6. Do one of the following:

• Bring up the desired property editor that supports variables.
• Click the Inspect jobs button in the toolbar.
• Click the Flow > Inspect jobs menu option.

7. In the upper part of the dialog that pops up, select the job that you want to inspect.

8. Select the variable you want to check by clicking the appropriate item in each column.
For example, if you want to check the date the job was processed by Switch (represented by
the Switch.Date variable):

• In the first column (Groups), select Switch.
• In the second column (Switch variables), select Date.
• In the third column, enter the format of your choice, e.g. dd.MM.yyyy

The value is shown in the lower part of the third column. If there's no value specified, you'll
see the string 'Sample value'.

Building a location path
The "Build location path" dialog offers assistance with building location paths for the variables
in the Metadata group using picked up metadata by a sample job. The dialog supports the
various data models known in Switch.

See also XMP location path syntax on page 471.

Showing the dialog

The property editors Defining text with variables and Defining a condition with variables show
a button called Build location path when a variable in the Metadata group is selected and at
least one valid sample job is available (See Working with sample jobs on page 414).

When you click this button, the Build location path dialog is displayed. When you click the OK
button after some modifications, the selected Metadata variable is updated accordingly.
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Metadata dataset

This section lists the various datasets associated with the job. You can select the embedded
dataset (which is always available, even if it is empty) or one of the external datasets associated
with the job (if any).

Location path syntax

The data model for the selected dataset determines the available options for the location path
syntax. Unavailable options are automatically disabled in the user interface.

The selected location path syntax determines the layout and behavior of the dialog's bottom
portion, as described in the following sections.

Result data type

The result of the location path configured in the dialog's bottom portion (evaluated in the context
of the sample document) determines which Result data type options are available. Unavailable
options are automatically disabled in the user interface.

The selected Result data type determines which of the variables in the Metadata group is used
to produce the result.

Location path

For the choices "XMP/XML/JDF location path" the bottom part of the dialog displays the
following two items:

• An editable text field labeled "xxx location path".
• A tree view representing the metadata in the sample document, labeled "xxx data tree".
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You can expand and collapse the nodes in the tree view, but the tree is not otherwise editable.

When you select a node in the tree view, the dialog displays the corresponding location path in
the editable text field (discarding anything that was already there).

Vice versa, when you modify the contents of the editable text field, and the contents represents
a valid location path pointing to an existing node, the dialog selects that node in the tree (and
expands and scrolls the view to make it visible if needed).

The OK button is enabled only if the location path is valid and the selected node is compatible
with the selected result data type; otherwise an appropriate alert message is shown at the
bottom of the dialog.

XPath expression

For the choice "XPath expression" the bottom part of the dialog displays the following items:

• An editable text field labeled "XPath expression".

• A read-only text field that displays the result type and value of the expression as it is
evaluated against the metadata, for example: "Integer: 5", "Boolean: false" or "Node set: 3
element nodes"

• A control bar with buttons and checkboxes (see below).

• A read-only multi-line text field that displays the XML for the sample metadata and
highlights the nodes in the result node set, if any.

When you modify the contents of the editable text field, and the contents represents a valid
XPath expression, the text fields are automatically updated to reflect the expression's result.

The control bar offers buttons to navigate between the nodes in a result node set, and two
checkboxes that affect the XML display:

• Auto-indent: when turned on, the XML is "pretty-printed" with nested indentation.

• Color-code: when turned on, each XML node type is displayed in a different color.

The OK button is enabled only if the XPath expression is valid and its data type is compatible
with the selected result data type; otherwise an appropriate alert message is shown at the
bottom of the dialog.

5.5.3.3.  Metadata reference

Variables

Using variables
Switch allows the use of variables in the values of many text properties and for defining file
filters. A variable is a special, well-recognizable text string that gets replaced by a dynamic
value when the flow is being executed. The dynamic value is recalculated each time in the
context of the job being processed.

Variables provide access to run-time information about the flow environment and about a
job, including embedded metadata fields (and external metadata fields), without the need for
scripting. This lowers the barrier for accessing dynamic information in a flow definition since
most users will find it is much easier to use a variable than to create a script expression.
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Entering Variables

Text properties

Variables in text properties are simply mixed-in with static text. Users can insert a variable in
two distinct ways:

• Directly type the variable with the appropriate syntax when entering the text; this requires
understanding variable syntax.

• Use the define text with variables property editor for locating the variable and entering its
arguments; the formatted variable is automatically inserted in the text.

Most users will prefer the second method; however in both cases the final result is regular
text (with variables). When the value of a text property that supports variables is needed while
executing a flow, Switch scans the text for variables and replaces them by their dynamic value in
the context of the current job. All text outside variables remains unchanged.

Conditional properties

A conditional property has a Boolean result (true or false). For example, the file filtering
properties on connections are conditional properties.

A variable-based conditional property is entered through a special property editor that offers a
user interface to create basic comparison expressions with support for locating a variable and
entering its arguments. See defining a condition with variables.

When the value of a condition with variables is needed while executing a flow, Switch replaces
the variables by their dynamic value in the context of the current job and evaluates the
expression.

Using sample jobs

The variable-related property editors (Defining text with variables and Defining a condition
with variables) offer a mechanism to select a sample job and to display actual metadata values
derived from that job while you are configuring (portions of) the property value in the editor.

The Build location path dialog offers assistance with building location paths for the variables in
the Metadata group using actual metadata associated with a sample job.

List of variables

Switch offers a library of variables organized in groups, accessing Switch-specific flow and job
information, various types of metadata embedded in or a associated with a job, and statistics
derived from the file's contents.

See Known variables on page 426 for a complete list.

Characteristics of variables

Name

Each variable is identified by a name including the group name and the variable name proper.
For example: "Switch.Counter" or "Photo.ExposureTime".

See Basic syntax on page 419.
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Arguments

Some variables can have arguments to help determine the dynamic value or the value's
formatting. For example, the "Switch.Counter" variable supports two arguments called "Width"
and "Id", and the "Switch.Date" variable supports an argument called "Format".

See Basic syntax on page 419, Formatting on page 421, Indexed variables on page 424, String
manipulations on page 425.

Data type

Each variable has a specific data type, which is indicated with the variable's description. The
data type is important for two reasons:

• For some data types, the formatting of the variable's text representation can be influenced by
specifying an appropriate argument for the variable.

• When using a variable in a condition, the data type determines the type of comparison
performed.

See Data types on page 421, Formatting on page 421, String manipulations on page 425.

Indexed variables

Some variables access a list of values rather than a single value. These variables are called
indexed variables. For example, the "Job.EmailAddress" variable accesses a list of all email
addresses associated with the job.

Depending on the arguments specified with it, an indexed variable may evaluate to a
concatenated list of all items (with a customizable separator) or to one particular item from the
list.

See Indexed variables on page 424.

Basic syntax

Variable name

In its simplest form, a variable is specified as follows:

[Group.Variable]

The variable name is surrounded by square brackets. Whitespace is not allowed in the variable
specification.

Variable names contain two segments separated with a period. The first segment is the group
name; the second segment is the variable name within the group.

Arguments

Some variables can contain arguments that help determine the variable's dynamic value.
Arguments are specified as follows:

[Group.Variable:ArgumentName1="Value",ArgumentName2="Value"]

In this example, two arguments are defined with names "ArgumentName1" and
"ArgumentName2". If a variable has arguments, the variable name is followed by a colon
which is followed by the arguments. For each argument, the argument name is followed by
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an equal sign and the value of that argument between single or double quotes. The value can
contain single quotes if it is double-quoted, or double quotes if it is single-quoted. A comma
separates the arguments if there is more than one. A variable specification must not contain any
whitespace except when required in a quoted argument value.

Nested variables

The Expression argument of the [Switch.Calculation] variable and the SQL arguments of
Database variables can contain nested variables. These variables are used to define the value of
the argument.

[Group.Variable:ArgumentName1="[Variable1]"]

Nested variables have the same syntax as the regular variables and are always surrounded by
square brackets.

Some examples:

• [Switch.Calculation:Expression="[Job.Size]"]
• [Database.TextIndexed:SQL="SELECT JobName FROM

Jobs",Connection="DBConnection",Separator=", "]
• [Database.Text:SQL="SELECT JobName FROM Files WHERE

FileName='[Job.Name]'",Connection="DBConnection"]

Note:  Nested variables are not allowed in other types of arguments. If you use them,
they will be ignored and treated as regular text.

Nesting can be multi-level, i.e. nested variables can contain other nested variables.

Example:

• [Database.Text:SQL="SELECT PublisherName FROM Jobs WHERE
JobName='[Database.Text:SQL="SELECT JobName FROM Files WHERE
FileName='[Job.Name]'",Connection="DBConnection"]'",Connection="DBConnection"]

(where the nested variable [Job.Name] is included in the variable
[Database.Text:SQL="SELECT JobName FROM Files WHERE
FileName='[Job.Name]'",Connection="DBConnection"])

Note:  If used in an argument that supports nested variables, the opening square
bracket '[' is interpreted by Switch as the beginning of a new variable. To use the square
bracket as static text, you need to double it: '[['. Note that there is no need to double the
closing square bracket.

Example:

• If there is a variable [Database.Text:SQL="SELECT [[JobName] FROM Files WHERE
FileName='[Job.Name]'",Connection="DBConnection"]

• For a job with the name TestFile.pdf, the SQL request SELECT [JobName] FROM
Files WHERE FileName='TestFile.pdf' will be executed.

See also:

• Data types on page 421
• Formatting on page 421
• Comparing on page 423
• Indexed variables on page 424
• String manipulations on page 425
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Data types
Each variable has a specific data type, which is indicated with the variable's description. The
data type is important for two reasons:

• For some data types, the formatting of the variable's text representation can be influenced by
specifying an appropriate argument for the variable.

• When using a variable in a condition, the data type determines the type of comparison
performed with the dynamic value.

The following table lists the supported data types for variables.

Data type Description

Text Text string

Alt Text Possibly localized text string (that is, there may be multiple
language versions)

Switch always uses the default language; so this data type is
equivalent to Text

Text Indexed List of items of type Text (see indexed variables)

Boolean Boolean value true or false

Integer Integer number

Rational Rational number formed by division of two integers

Date A moment in time, including date and/or time information

See also:

• Basic syntax on page 419
• Formatting on page 421
• Comparing on page 423
• Indexed variables on page 424
• String manipulations on page 425

Formatting
The following table describes the formatting options for each data type, including:

• The default representation which is used when no formatting arguments are present.
• The supported formatting arguments, if any, and the corresponding representation.

Data type Description of data type /
Formatting argument

Representation as a text string

Text Text string Text string

Alt Text Possibly localized text
string

Text string (Switch always uses the default
language)
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Data type Description of data type /
Formatting argument

Representation as a text string

Text Indexed List of items of type Text See indexed variables

Boolean Boolean value true or false "True" or "False" (or all-lower-case
versions)

Integer Integer number Decimal representation (including minus
sign if needed; no plus sign; no leading
zeroes)

Rational number formed by
division of two integers

Decimal representation of the form:
numerator, forward slash, denominator;
example: "2/3" or "-17/4"

Rational

Precision="integer" Decimal floating point representation with
the specified number of digits after the
decimal point (minimum precision is 1, max
is 15)

A moment in time,
including date and/or time
information

String representation in the subset of the
ISO 8601 format allowed in XMP Date fields
(see Adobe XMP specification, version dated
September 2005, page 75)

Equivalent to format string "yyyy-MM-
ddThh:mm:ss.zzz"

Date

Format="format-string" String representation in the format specified
by the format string, which must conform to
the syntax described below

Date format string

The following format expressions are recognized and replaced in the date format string:

Expression Output

d the day as number without a leading zero (1 to 31)

dd the day as number with a leading zero (01 to 31)

ddd the abbreviated day name (example: 'Mon' to 'Sun')

dddd the long day name (example: 'Monday' to 'Sunday')

M the month as number without a leading zero (1-12)

MM the month as number with a leading zero (01-12)

MMM the abbreviated month name (example: 'Jan' to 'Dec')
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Expression Output

MMMM the long month name (example: 'January' to 'December')

yy the year as two digit number (00-99)

yyyy the year as four digit number

h the hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display)

hh the hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display)

H the hour without a leading zero (0 to 23, even with AM/PM display)

HH the hour with a leading zero (00 to 23, even with AM/PM display)

m the minute without a leading zero (0 to 59)

mm the minute with a leading zero (00 to 59)

s the second without a leading zero (0 to 59)

ss the second with a leading zero (00 to 59)

z the milliseconds without leading zeroes (0 to 999)

zzz the milliseconds with leading zeroes (000 to 999)

AP or A use AM/PM display; AP will be replaced by either "AM" or "PM"

ap or a use am/pm display; ap will be replaced by either "am" or "pm"

t the timezone (for example "CEST")

'...' any sequence of characters enclosed in single quotes is treated as
literal text

See also:

• Basic syntax on page 419

• Data types on page 421

• Comparing on page 423

• Indexed variables on page 424

• String manipulations on page 425

Comparing

Type of comparison

A variable's data type determines the type of comparison performed in a condition involving the
variable. This is important because comparison semantics for numbers, strings and dates are
very different.
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Variable data type Comparison semantics

Text String

Alt Text String

Text Indexed String

Boolean Boolean

Integer Number

Rational Number

Date Date

Value used for comparison

When used in a condition, the variable's value is obtained in two steps:

• First the text representation of the variable is formatted as usual (see formatting); this
allows influencing the value in interesting ways, such as rounding a rational number or
extracting a date from a date/time.

• Then the value is converted to the data type appropriate for the comparison type (example:
string, number, ...); as indicated in the table above.

See also:

• Basic syntax on page 419

• Data types on page 421

• Formatting on page 421

• Indexed variables on page 424

• String manipulations on page 425

Indexed variables
Some variables access a list of values rather than a single value. These variables are called
indexed variables. All indexed variables support the indexing arguments described in this
section.

In general, if an Index argument is provided for an indexed variable, the variable evaluates to
a single value from the list. Otherwise, the variable evaluates to a sequence that contains all
values in the list. The following table describes the indexing arguments and their effect in more
detail.

Indexing arguments
provided(don't combine!)

Description of result

None Concatenation of all values in the list separated by a
semicolon, all on the same line

If there are no values, the result is the empty string
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Indexing arguments
provided(don't combine!)

Description of result

Index="integer" The list value indicated by the specified one-based index

If the Index argument is provided, all other arguments
are ignored

Separator="separator-string" Concatenation of all values in the list separated by the
specified string, all on the same line

If there are no values, the result is the empty string

If the Separator argument is provided, the Prefix and
Suffix arguments are ignored

Prefix="prefix-string"

Suffix="suffix-string"

Concatenation of all values in the list, each on a separate
line of the form: <prefix-string><value><suffix-string>

If there are no values, the result is the empty string

Examples

Text in a property value Evaluates to

[Job.EmailAddress:Index="1"] tvr1@enfocus.com

[Job.EmailAddress] tvr1@enfocus.com;tvr2@enfocus.com

[Job.EmailAddress:Separator=",
"]

tvr1@enfocus.com, tvr2@enfocus.com

The email addresses for this
job are:

[Job.EmailAddress:Prefix=" - "]

The email addresses for this job are: - tvr1@enfocus.com
- tvr2@enfocus.com

See also:

• Basic syntax on page 419

• Data types on page 421

• Formatting on page 421

• Comparing on page 423

• String manipulations on page 425

String manipulations
Variables of data type Text, Alt Text and Text Indexed support additional arguments to perform
simple manipulations on the text value of the variable. For Indexed variables, the manipulation
is performed on each item in the list (that is, before the items are sequenced).

If multiple arguments are present, the manipulations are performed in the order as they are
listed in the table (regardless of the order in which they occur in the variable).
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Argument Value Result

Space One of "trim", "norm" trim = leading and trailing white
space removed

norm = trimmed and consecutive
white space compressed to a
single space

Case One of "upper", "lower", "first",
"word"

The string converted to the
specified case (first = first
character is upper case, word =
first character of every word is
upper case)

After Search string (non-empty) The substring after (and not
including) the last occurrence of
the search string

Before Search string (non-empty) The substring before (and not
including) the first occurrence of
the search string

Segment Start and end index (one-based)
separated by a comma or a
hyphen; if one of the indices is
missing this indicates the start or
end of the string

The substring between and
including the characters
indicated by the indices

Search Regular expression (use anchors
to match start or end of string)

The first substring that matches
the regular expression

See also:

• Basic syntax on page 419

• Data types on page 421

• Formatting on page 421

• Comparing on page 423

• Indexed variables on page 424

Known variables
Switch offers a library of variables organized in groups, as listed in the table below. Follow the
links in the first column in this table for a list of variables in each group, with corresponding
technical reference information.

A description for each variable is displayed in the property editors for defining text with variables
and defining a condition with variables. This description is not repeated in the help topics.

Group Type of information Source

Connection Client connection attributes like
user name, IP...

Switch settings, system
environment
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Group Type of information Source

Database Database fields

Note:  This group is only
available if you have
an active license for
the Switch Databases
Module.

Database (ODBC
dataset)

Doc Title, keywords, author(s),
copyright terms

Embedded metadata:
XMP

Email Components of the email
message through which this job
was originally delivered

Mail receive flow
element

Image Resolution, orientation, color
mode

Embedded metadata:
EXIF (TIFF tags)

Iptc Contact, location, headline,
instructions

Embedded metadata:
IPTC

Job Filename, size, email info,
hierarchy info, fail info, origin

File system, internal job
ticket

Metadata Arbitrary field in any dataset
associated with the job

External metadata or
embedded metadata

Office Microsoft Office variables,
such as Application (Excel,
PowerPoint, Word), Author,
Description, Presentation
Format, ...

Embedded Microsoft
Office metadata

Photo Exposure time, aperture, focus,
flash

Embedded metadata:
EXIF (EXIF tags)

Stats File format, number of pages,
page labels, colorants

File format & contents

Switch Flow element name, date/time,
counter

Flow definition, system
environment

Connection group

These variables are Switch-specific. They provide access to the attributes of the client
connection. The third column indicates the scripting API function that returns the variable's
dynamic value.

Variable name Data type Scripting API equivalent

Connection.Email Text ClientConnection.getEmail()
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Variable name Data type Scripting API equivalent

Connection.UserName Text ClientConnection.getUserName()

Connection.FullUserName Text ClientConnection.getFullUserName()

Connection.IP Text ClientConnection.getIP()

Note:  The variables from this group are valid only in context of a client
connection. Please refer to the note in the description of the method
Environment.getClientConnection(). When used without an active client connection, the
Connection variables will return empty values. This amounts to the empty string for Text
variables and 0 for Integer variables.

Database variables

What are database variables?

Database variables are variables that at run-time are replaced with values from a database.
These variables can only be used if you have an active license for the Switch Databases Module.

You can use the database variables in the same way as the regular Switch variables:

• Use them as values for the tools and the configurator properties.

• Use them as values for conditions, for example to filter jobs on a connection.

• Use them as values to fill a drop-down menu in the Submit point and Checkpoint metadata
properties.

They are also accessible in the same way as other variables, i.e. via the Define Text/Condition
with Variables option in the properties of the Switch tools. They are collected in a separate
group: the "Database" variable group (see screenshot).
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The table below lists the available data types.

Variable name Data type

Database.Text Text

Database.TextIndexed Text Indexed

Database.Boolean Boolean

Database.Integer Integer

Database.Rational Rational

Database.Date Date

How to build an SQL statement?

After you have selected the Database group in the first column, and the data type in the
second column, you must create an SQL statement. The Build SQL statement dialog box (see
screenshot) will assist you in creating the SELECT statement and obtaining the appropriate
values from the database.
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Tip:  We recommend using a sample job, so you can see immediately if your SQL
statement is valid and correct.

 

 

To build an SQL statement, proceed as follows:

1.
Click the  button beside the SQL textbox and choose Build SQL statement.

2. Select a data source.

a. Click the Configure button.
b. In the ODBC data sources dialog, select a data source from the list of predefined data

sources (Refer to ODBC data sources for more information on how to define the data
sources).

3. Select a table and a column in the Table and the Column drop-down menus.
4. Select the Condition checkbox and specify or select the conditions in the first and the third

menu, choose the comparison operator in the middle drop-down menu and choose the AND
or OR logical operator in the last drop-down menu.

5. Alternatively, in order to choose more than one column or to choose a column from any
other table or not to choose any columns, select the Manual editing checkbox and enter the
statement manually.

6. After setting the SQL statement, click the Validate statement button to check if the query
is valid. If the query returns any value or error, it is displayed on screen. The Sample value
menu displays the sample value for a query. If a query returns multiple values, they will be
listed in a comma separated list. For example: "val11,val12,val21,val22...".

7. Click the OK button to insert the statement.
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Doc group

These variables access embedded metadata fields in the Adobe XMP format. The third column
indicates the XMP location path for the variable in the XMP data model.

The metadata fields accessed by the variables in this table can be viewed and edited using the
"File > File Info..." dialog in Adobe Creative Suite applications. The fourth column indicates the
label of the field that corresponds to each variable.

The "Alt Text" data type indicates a possibly localized text string (that is, there may be multiple
language versions). Switch always uses the default language; so this data type is equivalent to
Text.

Variable name Data
type

XMP location
path

Acrobat
Document

Properties
label

Photoshop File Info
label

Doc.Application Text xmp:CreatorTool Application Description /
Application

Doc.Author Text dc:creator/*[1] Description / Author

Doc.Authors Text
Indexed

dc:creator Author Description / Author

Doc.AuthorTitle Text photoshop:
AuthorsPosition

Description / Author
Title

Doc.Category Text photoshop:
Category

Categories /
Category

Doc.City Text photoshop:City Origin / City IPTC
Image / City

Doc.Copyright
Notice

Alt Text dc:rights Description /
Copyright Notice

Doc.Copyright
Status

Boolean xapRights:
Marked

Description /
Copyright Status

Doc.Copyright
Terms

Alt Text xapRights:
UsageTerms

IPTC Status / Rights
Usage Terms

Doc.Copyright
URL

Text xapRights:
WebStatement

Description /
Copyright Info URL

Doc.Country Text photoshop:
Country

IPTC Image /
Country

Doc.Created Date xmp:CreateDate Description /
Created
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Variable name Data
type

XMP location
path

Acrobat
Document

Properties
label

Photoshop File Info
label

Doc.Credit Text photoshop:Credit Origin / Credit IPTC
Status / Provider

Doc.DateCreated Date photoshop:
DateCreated

Created Origin / Date
Created

Doc.Description Alt Text dc:description Subject Description /
Description

Doc.Description
Writer

Text photoshop:
CaptionWriter

Description /
Description Writer

Doc.Format Text dc:format Description /
Format

Doc.Headline Text photoshop:
Headline

Origin / Headline
IPTC Content /
Headline

Doc.Instructions Text photoshop:
Instructions

Origin / Instructions
IPTC Status /
Instructions

Doc.Keywords Text
Indexed

dc:subject Keywords Description /
Keywords

Doc.Modified Date xmp:ModifyDate Modified Description /
Modified

Doc.Source Text photoshop:
Source

Origin / Source IPTC
Status / Source

Doc.State Text photoshop:State Origin / State-
Province IPTC
Image / State

Doc.
Supplemental
Categories

Text
Indexed

photoshop:
Supplemental
Categories

Categories /
Supplemental
Categories

Doc.Title Alt Text dc:title Title Description /
Document Title

Doc.
Transmission
Reference

Text photoshop:
Transmission
Reference

Origin /
Transmission
Reference IPTC
Status / Job
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Variable name Data
type

XMP location
path

Acrobat
Document

Properties
label

Photoshop File Info
label

Doc.Urgency Integer photoshop:
Urgency

Origin / Urgency

Email group

These variables access the components of the email message through which this job was
originally delivered. The values are empty if the job was not delivered via email or if the email
message did not contain the requested component.

The Mail receive flow element associates this information with the job as a metadata dataset.
Refer to Email message schema on page 458 for details on the format of this metadata. The
third column in the table lists the element name in this schema corresponding to each variable.

(*) See email message schema.

Variable name Data type Element name (*)

Email.Body Text body

Email.Cc Text cc

Email.Date Text date

Email.From Text from

Email.MessageId Text message-id

Email.ReplyTo Text reply-to

Email.Sender Text sender

Email.Subject Text subject

Email.To Text to

Image group

These variables access embedded metadata fields in the EXIF format (synchronized with Adobe
XMP). The third column indicates the hexadecimal TIFF tag corresponding to each variable.

Variable name Data type XMP location path TIFF tag

Image.Artist Text tiff:Artist & dc:creator/*[1] 0x013B

Image.ColorMode Integer photoshop:ColorMode --

Image.Copyright Alt Text tiff:Copyright & dc:rights 0x8298
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Variable name Data type XMP location path TIFF tag

Image.DateTime Date tiff:DateTime &
xmp:ModifyDate

0x0132 &
0x9290

Image.ICCProfile Text photoshop:ICCProfile --

Image.ImageDescription Alt Text tiff:ImageDescription &
dc:description

0x010E

Image.ImageLength Integer tiff:ImageLength 0x0101

Image.ImageWidth Integer tiff:ImageWidth 0x0100

Image.Make Text tiff:Make 0x010F

Image.Model Text tiff:Model 0x0110

Image.Orientation Integer tiff:Orientation 0x0112

Image.Photometric
Interpretation

Integer tiff:Photometric
Interpretation

0x0106

Image.ResolutionUnit Integer tiff:ResolutionUnit 0x0128

Image.SamplesPerPixel Integer tiff:SamplesPerPixel 0x0115

Image.Software Text tiff:Software &
xmp:CreatorTool

0x0131

Image.XResolution Rational tiff:XResolution 0x011A

Image.YResolution Rational tiff:YResolution 0x011B

IPTC group

These variables access embedded metadata fields in the IPTC format (synchronized with Adobe
XMP). The third column indicates the XMP location path for the variable in the XMP data model.
The Iptc4xmpCore prefix has been omitted in the location paths.

The metadata fields accessed by the variables in this table can be viewed and edited using the
File > File Info... dialog box in Adobe Creative Suite applications. The fourth column indicates
the label of the field that corresponds to each variable.

(*) The Iptc4xmpCore prefix has been omitted in the location paths.

Variable name Data type XMP location path (*) Photoshop File Info label

Iptc.City Text photoshop:City IPTC Image / City

Iptc.ContactAddress Text CreatorContactInfo/
CiAdrExtadr

IPTC Contact / Address
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Variable name Data type XMP location path (*) Photoshop File Info label

Iptc.ContactCity Text CreatorContactInfo/
CiAdrCity

IPTC Contact / City

Iptc.ContactCountry Text CreatorContactInfo/
CiAdrCtry

IPTC Contact / Country

Iptc.ContactEmail Text CreatorContactInfo/
CiEmailWork

IPTC Contact / E-mail(s)

Iptc.ContactPCode Text CreatorContactInfo/
CiAdrPcode

IPTC Contact / Postal
Code

Iptc.ContactPhone Text CreatorContactInfo/
CiTelWork

IPTC Contact / Phone(s)

Iptc.ContactState Text CreatorContactInfo/
CiAdrRegion

IPTC Contact / State-
Province

Iptc.ContactWebsite Text CreatorContactInfo/
CiUrlWork

IPTC Contact / Website(s)

Iptc.CopyrightNotice Alt Text dc:rights IPTC Status / Copyright
Notice

Iptc.Country Text photoshop:Country IPTC Image / Country

Iptc.CountryCode Text CountryCode IPTC Image / ISO Country
Code

Iptc.Creator Text dc:creator/*[1] IPTC Contact / Creator

Iptc.CreatorJobTitle Text photoshop:Authors
Position

IPTC Contact / Creator's
Job Title

Iptc.DateCreated Date photoshop:DateCreated IPTC Image / Date
Created

Iptc.Description Alt Text dc:description IPTC Content /
Description

Iptc.Description
Writer

Text photoshop:CaptionWriter IPTC Content /
Description Writer

Iptc.Headline Text photoshop:Headline IPTC Content / Headline

Iptc.Instructions Text photoshop:Instructions IPTC Status / Instructions

Iptc.Intellectual
Genre

Text IntellectualGenre IPTC Image / Intellectual
Genre
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Variable name Data type XMP location path (*) Photoshop File Info label

Iptc.JobID Text photoshop:
TransmissionReference

IPTC Status / Job
Identifier

Iptc.Keywords Text
Indexed

dc:subject IPTC Content / Keywords

Iptc.Location Text Location IPTC Image / Location

Iptc.Provider Text photoshop:Credit IPTC Status / Provider

Iptc.RightsUsage
Terms

Alt Text xmpRights:UsageTerms IPTC Status / Rights
Usage Terms

Iptc.Scene Text
Indexed

Scene IPTC Image / IPTC Scene

Iptc.Source Text photoshop:Source IPTC Status / Source

Iptc.State Text photoshop:State IPTC Image / State-
Province

Iptc.SubjectCode Text
Indexed

SubjectCode IPTC Content / IPTC
Subject Code

Iptc.Title Alt Text dc:title IPTC Status / Title

Job group

These variables are Switch-specific. The third column indicates the scripting API function that
returns the variable's dynamic value.

Variable name Data type Scripting API equivalent

Job.ByteCount Integer Job.getByteCount()

Job.EmailAddress Text Indexed Job.getEmailAddresses()

Job.Extension Text Job.getExtension()

Job.FileCount Integer Job.getFileCount()

Job.Hierarchy Text Indexed Job.getHierarchyPath()

Job.IsFile Boolean Job.isFile()

Job.IsFolder Boolean Job.isFolder()

Job.JobState Text Job.getJobState()

Job.Name Text Job.getName()
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Variable name Data type Scripting API equivalent

Job.NameProper Text Job.getNameProper()

Job.Path Text Job.getPath()

Job.Priority Integer Job.getPriority()

Job.PrivateData Text Job.getPrivateData()

Job.Size Text --

Job.UniqueNamePrefix Text Job.getUniqueNamePrefix()

Job.UserEmail Text The user's email address associated
with the job (as entered in the Users
pane). If no user information has
been linked to the job, the variable
remains empty.

Job.getUserEmail()

Job.UserFullName Text The user's full name associated
with the job (as entered in the Users
pane). If no user information has
been linked to the job, the variable
remains empty.

Job.getUserFullName()

Job.UserName Text Job.getUserName()

Job.FileCreationDate Date The creation date/time of the job file
or folder as taken from file system

File(job.getPath()).created

Job.EmailBody Text The email body text in the email info
associated with the job

Job.getEmailBody()

Job.NestedName

Indent=" "

Text Indexed A list of indented names (including
extension) for all files and folders in
the job; by default each level indents
with 4 spaces; on a particular level
names are sorted alphabetically;
see example below

The Indent argument specifies the
string added for each indentation
level (default value is 4 spaces)

Script that recursively iterates over
job contents
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Nested name example:

The variable [Job.NestedName:Prefix="-> ",Indent=". "] might be replaced by the following lines:

-> My job folder 
-> . First.pdf 
-> . Second.pdf 
-> . Subfolder 
-> . . Readme.txt 
-> . Third.pdf

The following variables access a job's occurrence trail to provide information on the job's origin
and on why the job was sent to the problem jobs folder. Each of the variables access the most
recent occurrence of a particular type, as listed in the table.

Variable name Data type Most recent
occurrence of
type

Scripting API equivalent

Job.FailElement Text Failed Occurrence.getElement()

Job.FailFlow Text Failed Occurrence.getFlow()

Job.FailMessage Text Failed Occurrence.getLocalizedMessage()

Job.FailModule Text Failed Occurrence.getModule()

Job.FailTime Date Failed Occurrence.getTimeStamp()

Job.Origin Text Produced Occurrence.getOrigin()

Job.Origin

Use this variable to get the original location of the job before it was injected or submitted into
the flow:

• For a Submit point, this is the path to the backing folder of the Submit point if the job has
been submitted via the Switch Web Portal.

• For an FTP receive element, this is the path to the file on the FTP server that was used to
download the file.

• For a Mail receive element, this is the ‘From’ address of the email.
• For a Script element, this is the path that was passed into "createNewJob". Note that the

"createNewJob" function can be called with or without a path parameter, so it's up to the
script writer to provide the Job.Origin value or to leave it empty.

Note:  For other elements, this variable is empty!

Metadata group

These variables allow access to an arbitrary field in any dataset associated with the job (external
metadata or embedded metadata).

There is a variable for each data type supporting the appropriate formatting and/or indexing
arguments. This enables the user to express the expected data type for the metadata value and
control its formatting.
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Variable name Data type

Metadata.Text Text

Metadata.TextIndexed Text Indexed

Metadata.Boolean Boolean

Metadata.Integer Integer

Metadata.Rational Rational

Metadata.Date Date

Selecting a data field

The variables in the Metadata group support the following arguments for selecting a particular
metadata field from a particular dataset.

Argument Value

Dataset The name of the external dataset to be accessed, or empty/missing to indicate
the embedded dataset

Model The data model used for querying the data set; when empty/missing the data
model is derived from the dataset; allowed values are "XML", "JDF" and "XMP"

This argument can be omitted except when forcing a JDF data model to be
queried using regular XML semantics (that is, using "evalToString" rather than
"getString")

Path The location path or expression for selecting a field (or calculating a value)
using syntax appropriate for the data model:

• XML: XPath expression (which includes XPath location paths)

• JDF: JDF location path (which is really the same as an XPath location path)

• XMP: XMP location path

• All prefixes used in the location path or expression must occur in the
default namespace map for the data set; there is no way to specify explicit
mappings.

Make sure to use the correct prefix:

For the XML data model, use the prefix "dn", for example:

[Metadata.Text:Path="/dn:XML/dn:ResourcePool/dn:CustomerInfo/
@DescriptiveName",Dataset="Xml",Model="XML"] 

For the JDF data model, use the prefix "jdf", for example:

[Metadata.Text:Path="/jdf:JDF/jdf:ResourcePool/jdf:CustomerInfo/
@DescriptiveName",Dataset="Jdf",Model="JDF"]
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Argument Value

For more information, refer to "XML data model" and "JDF data model" in
the Switch Scripting Guide, available on the Enfocus website.

Data type conversions

Switch does not guarantee that the value of a variable in the Metadata category conforms to the
string representation of its data type. The user is responsible for selecting the correct data type
by using the appropriate variable in the Metadata category.

The variable is always set to the string value of the query (for Text Indexed, each item in the list
is converted separately).

In other words:

• For the JDF and XMP data models there is never a conversion, because the result of the
query is always a string (the text content of the node specified by the location path).

• For the XML data model, the result of the XPath expression is converted to a string using
XPath semantics (unless it was a string to begin with).

Office group

These variables access metadata fields embedded in Microsoft Office documents (Excel files,
Word documents, PowerPoint presentations).

Note:  If a Microsoft Office document is password protected, Switch has no access to the
metadata, hence these variables cannot be used.

Variable name Data
type

Description

Office.Application Text Name of the application that created the
document, for example: Microsoft Office
Word

Office.AppVersion Text Version of the application that created the
document; string of the form XX.YYYY (X
and Y representing numerical values), for
example: 14.0000

Office.Author Text Author of the document

Office.Category Text Category of the document

Office.Company Text Name of a company associated with the
document

Office.ContentStatus Text Status of the document content, for
example: Draft, Reviewed, Final, ...

Office.ContentType Text Type of document content, for example:
Whitepaper, Security Bulletin, Exam, ...

Office.Created Date Date and time when the document
was created, for example:
2014-02-05T10:10:36.000Z. You can modify
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Variable name Data
type

Description

the format, for example: dd:MM:yy mm:ss
(UTC time zone) will result in 05:02:14 10:36

Office.Custom Text The metadata value selected from
the document using XPath expression
provided in the 'Path' argument. The
argument 'Set' defines the metadata set
where the required value is searched for.
The possible values for the 'Set' argument
are 'Core' and 'Extended' (used as the
default value). For more details, refer to
the section below.

Office.Description Text Textual description of the document

Office.DocSecurity Integer Security level of the document:

• 0 = None
• 1 = Document is password protected
• 2 = Document is recommended to be

opened as read-only
• 4 = Document must be opened as read-

only
• 8 = Document is locked for annotation

Office.HyperlinkBase Text Base string used for evaluating relative
hyperlinks in this document

Office.HyperlinksChanged Boolean Indicates whether or not hyperlinks were
changed:

• True = One or more hyperlinks in this
part were updated exclusively in this
part by a producer

• False = No hyperlinks were updated

Office.Identifier Text Identifier of the document

Office.Keywords Text Keywords that specify the topic of the
document

Office.Language Text Language of the document

Office.LinksUpToDate Boolean State of the hyperlinks in the document:

• True = Hyperlinks are up-to-date
• False = Hyperlinks are outdated

Office.Manager Text Name of a supervisor associated with the
document

Office.Modified Date Date and time when the document was
last modified
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Variable name Data
type

Description

Office.ModifiedBy Text Author of the last modification in the
document

Office.NumberOfCharacters Integer Total number of characters in the
document

Office.NumberOfCharacters

WithSpaces

Integer Last count of the number of characters
(including spaces) in this document

Office.NumberOfHiddenSlides Integer Number of hidden slides in the
presentation

Office.NumberOfLines Integer Total number of lines in the document
when last saved by a conforming producer

Office.NumberOfMMClips Integer Total number of sound or video clips that
are present in the document

Office.NumberOfNotes Integer Number of slides in the presentation
containing notes

Office.NumberOfPages Integer Total number of pages in the document

Office.NumberOfParagraphs Integer Total number of paragraphs found in the
document

Office.NumberOfSlides Integer Total number of slides in the presentation

Office.NumberOfWords Integer Total number of words in the document
when the document was last saved

Office.PresentationFormat Text Intended format for the presentation, for
example a presentation intended to be
shown on video has PresentationFormat
Video, a presentation to be shown on
screen, could have On-screen (4:3), ...

Office.Printed Date Date and time when the document was
last printed

Office.Revision Integer Revision number

Office.ScaleCrop Boolean Display mode of the document thumbnail:

• True = Thumbnail is scaled to fit the
display

• False = Thumbnail is cropped to show
only sections that fit the display

Office.SharedDoc Boolean Indicates whether or not the document is
shared:
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Variable name Data
type

Description

• True = Document is currently shared
between multiple producers

• False = Document is not shared

Office.Subject Text Subject of the document

Office.Template Text Name of an external document template
containing format and style information
used to create the document.

Office.Title Text Title of the document

Office.TotalTime Integer Total time that the document has been
edited. The default time unit is minutes.

Office.Version Integer Version number

Office.Custom

Use this variable if there is a metadata tag in your Office document that does not have a
dedicated Switch variable. The [Office.Custom] variable allows you to retreive the value of this
tag, on condition that you have the correct XPath expression. Note that the data type of this
variable is 'Text', so only text manipulation arguments are available for it.

The metadata value is selected from the document using the XPath expression provided in the
Path argument. All prefixes used in the expression must occur in the default namespace map
for the metadata XML file. There is no way to specify explicit mappings. The default namespace
is automatically available using prefix 'dn'.

The argument Set defines the metadata set where the required value is searched for. The
possible values are 'Core' and 'Extended' (used as the default value):

• The 'Core' set corresponds to the document properties (normally located in the file
docProps/core.xml). Normally, the XPath for this set will begin with '/cp:coreProperties'.

• The 'Extended' set contains extended properties (normally located in the file docProps/
app.xml). The XPath begins with '/dn:Properties' where 'dn' is the prefix for the default
namespace, automatically provided by Switch.

Examples

[Office.Custom:Path="/dn:Properties/dn:Application"] - This gives the same result as
 [Office.Application]
[Office.Custom:Path="/dn:Properties/dn:TitlesOfParts/vt:vector/
vt:lpstr[1]",Set="Extended"] - The title of some document part
[Office.Custom:Path="/cp:coreProperties/dc:title",Set="Core"] - This gives the same
 result as [Office.Title]

More information about the Office Open XML format and its metadata can be found here: http://
en.wikipedia.org/wiki/Office_Open_XML_file_formats.

Photo group

These variables access embedded metadata fields in the EXIF format (synchronized with Adobe
XMP). The third column indicates the hexadecimal EXIF tag corresponding to each variable.

443

http://en.wikipedia.org/wiki/Office_Open_XML_file_formats
http://en.wikipedia.org/wiki/Office_Open_XML_file_formats


Switch

Variable name Data type XMP location path EXIFF tag

Photo.ApertureValue Rational exif:ApertureValue 0x9202

Photo.BrightnessValue Rational exif:BrightnessValue 0x9203

Photo.ColorSpace Integer exif:ColorSpace 0xA001

Photo.CompressedBitsPer
Pixel

Rational exif:CompressedBitsPerPixel 0x9102

Photo.Contrast Integer exif:Contrast 0xA408

Photo.CustomRendered Integer exif:CustomRendered 0xA401

Photo.DateTimeDigitized Date exif:DateTimeDigitized 0x9004 &
0x9292

Photo.DateTimeOriginal Date exif:DateTimeOriginal 0x9003 &
0x9291

Photo.DigitalZoomRatio Rational exif:DigitalZoomRatio 0xA404

Photo.ExposureBiasValue Rational exif:ExposureBiasValue 0x9204

Photo.ExposureIndex Rational exif:ExposureIndex 0xA215

Photo.ExposureMode Integer exif:ExposureMode 0xA402

Photo.ExposureProgram Integer exif:ExposureProgram 0x8822

Photo.ExposureTime Rational exif:ExposureTime 0x829A

Photo.FlashEnergy Rational exif:FlashEnergy 0xA20B

Photo.FlashFired Boolean exif:Flash/exif:Fired 0x9209 bits

Photo.FlashFunction Boolean exif:Flash/exif:Function 0x9209 bits

Photo.FlashMode Integer exif:Flash/exif:Mode 0x9209 bits

Photo.FlashRedEyeMode Boolean exif:Flash/exif:RedEyeMode 0x9209 bits

Photo.FlashReturn Integer exif:Flash/exif:Return 0x9209 bits

Photo.FNumber Rational exif:FNumber 0x829D

Photo.FocalLength Rational exif:FocalLength 0x920A

Photo.FocalLengthIn35mm
Film

Integer exif:FocalLengthIn35mmFilm 0xA405
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Variable name Data type XMP location path EXIFF tag

Photo.FocalPlane
ResolutionUnit

Integer exif:FocalPlaneResolutionUnit 0xA210

Photo.FocalPlaneX
Resolution

Rational exif:FocalPlaneXResolution 0xA20E

Photo.FocalPlaneX
Resolution

Rational exif:FocalPlaneYResolution 0xA20F

Photo.GainControl Integer exif:GainControl 0xA407

Photo.ImageUniqueID Text exif:ImageUniqueID 0xA420

Photo.ISOLatitude Integer exif:ISOSpeedRatings/*[2] 0x8827

Photo.ISOSpeed Integer exif:ISOSpeedRatings/*[1] 0x8827

Photo.Lens Text aux:Lens --

Photo.LightSource Integer exif:LightSource 0x9208

Photo.MaxApertureValue Rational exif:MaxApertureValue 0x9205

Photo.MeteringMode Integer exif:MeteringMode 0x9207

Photo.PixelXDimension Integer exif:PixelXDimension 0xA002

Photo.PixelYDimension Integer exif:PixelYDimension 0xA003

Photo.Saturation Integer exif:Saturation 0xA409

Photo.SceneCaptureType Integer exif:SceneCaptureType 0xA406

Photo.SensingFunction Integer exif:SensingFunction 0xA217

Photo.Sharpness Integer exif:Sharpness 0xA40A

Photo.ShutterSpeedValue Rational exif:ShutterSpeedValue 0x9201

Photo.SpectralSensitivity Text exif:SpectralSensitivity 0x8824

Photo.SubjectDistance Rational exif:SubjectDistance 0x9206

Photo.SubjectDistance
Range

Integer exif:SubjectDistanceRange 0xA40C

Photo.UserComment Alt Text exif:UserComment 0x9286

Photo.WhiteBalance Integer exif:WhiteBalance 0xA403
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Stats group

These variables access statistics derived from the actual file contents for a number of supported
file formats. The values are empty for a job in an unsupported file format and for a job folder.

File format

For a list of supported file formats, please refer to the description of the FileStatistic class in the
Scripting documentation available on the Enfocus website.

Variable name Data type Scripting API equivalent

Stats.FileFormat Text FileStatistics.getFileFormat()

Content statistics

The Stats group includes an additional variable for each additional statistic supported by the
FileStatistics class (see Supported statistics). The variable has the same name and data type as
the statistic (where string maps to Text and string list maps to Text Indexed).

Variable name Data type Supported for

Stats.NumberOfPages Integer All supported formats

Stats.SamplesPerPixel Integer JPEG, TIFF, PNG

Stats.PixelXDimension Integer JPEG, TIFF, PNG

Stats.PixelYDimension Integer JPEG, TIFF, PNG

Stats.ColorMode Integer JPEG, TIFF, PNG

Stats.ColorSpace Integer JPEG, TIFF, PNG

Stats.ICCProfile Text JPEG, TIFF, PNG

Stats.Colorants Text Indexed TIFF

Stats.CellWidth Integer TIFF

Stats.CellLength Integer TIFF

Stats.TileWidth Integer TIFF

Stats.TileLength Integer TIFF

Stats.ColorIntent Integer PNG

Stats.Version Text PDF

Stats.PageWidth Rational PDF
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Variable name Data type Supported for

Stats.PageHeight Rational PDF

Stats.PageLabels Text Indexed PDF

Stats.Colorants Text Indexed PDF

Stats.Fonts Text Indexed PDF

Stats.SecurityMethod Text PDF

Stats.PageBoxesEqual Boolean PDF

Stats.MediaBoxWidth Integer PDF

Stats.MediaBoxHeight Integer PDF

Stats.CropBoxWidth Integer PDF

Stats.CropBoxHeight Integer PDF

Stats.BleedBoxWidth Integer PDF

Stats.BleedBoxHeight Integer PDF

Stats.TrimBoxWidth Integer PDF

Stats.TrimBoxHeight Integer PDF

Stats.ArtBoxWidth Integer PDF

Stats.ArtBoxHeight Integer PDF

Stats.PDFXVersionKey Text PDF

Stats.ColorSpaceFamilies Text Indexed PDF

Stats.TransparentColor Boolean PDF

Stats.FontTypes Text Indexed PDF

Stats.PageRotation Rational PDF

Note:  The FileStatistics class allows reading both defined and effective values of PDF
page (and page boxes) width and height. The corresponding variables from the Stats
group support this by providing the 'Type' argument with possible values 'Defined' and
'Effective'.
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Switch group

These variables are Switch-specific. The third column indicates the scripting API function that
returns the variable's dynamic value.

Variable name Data type Scripting API equivalent

Switch.Calculation Rational This allows you to use variables (that
are by default treated as text) to do
calculations.

It is also possible to manually enter
this syntax while selecting other
variables. Therefore, you can perform
calculations on variables that result
in a number anywhere in the Switch
application, provided you have access to
the variables pane from there.

The ‘Expression’ argument specifies the
arithmetic expression to be calculated.
The expression may contain other
Switch variables, constant numbers,
parentheses, the arithmetic operators
(‘+’, ‘-‘, ‘*’, ‘/’ and ‘%’) and the ‘round’
function. Note that the behavior of the
round() function (which rounds the value
of a number to the nearest integer) is
sometimes different from Excel. For
example, -10,5 is rounded to -10 (<
>Excel: -11).

Example of the Calculation variable
syntax : [Switch.Calculation:Expression
= "[Stats.PageHeight]
*0.352777778",Precission="1"] x
[Switch.Calculation:Expression
= "[Stats.PageWidth]
*0.352777778",Precission="1"]

Switch.Counter Text -- (see below)

Switch.Date Date -- (the current date/time)

Switch.ElementName Text Switch.getElementName()

Switch.FlowName Text Switch.getFlowName()

Switch.Language Text Environment.getLanguage()

Switch.LanguageEnvironment Text Environment.getLanguageEnvironment()

Switch.ServerName Text Environment.getServerName()
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Variable name Data type Scripting API equivalent

Switch.OutgoingName Text Indexed A list of names for the outgoing
connections in alphabetical order; if a
connection name is empty the target
folder name is used as a fallback; if
the folder name is empty as well, the
connection is not listed

Script that iterates over connections,
determines the (fallback) name and
sorts the list

Note:

• Switch.OutgoingName cannot be used to define metadata fields in Checkpoints and
Submit points.

Counter operation

The Switch.Counter variable evaluates to an automatically incrementing decimal integer with a
fixed number of digits. For example, if the variable has never been used before, it will evaluate
to "00001". Next time, it will evaluate to "00002" and so forth. After the counter reaches "99999"
it circles back to "00000".

The most recently used value of the counter is retained across multiple invocations of the
Switch Server.

Counter: number of digits

The Width argument specifies the number of decimal digits in the number; leading zeroes
are inserted when needed. The default value for width is 5; the minimum value is 1 and the
maximum value is 15. An invalid value is replaced by the nearest valid value.

The internal counter is always 15 digits wide; the Width argument specifies how many of the
right-most digits are actually shown.

Identifying counters

A counter variable refers to a particular physical counter through an identifier (ID). Switch
uses the same physical counter for all counter variables with the same ID, even if these
variables are used in properties of a different flow element or in a different flow (in the same
Switch instance). A physical counter is incremented each time a counter variable with its ID is
evaluated, regardless of where the variable occurred.

A counter variable can explicitly specify an ID or it can rely on the default value.

If the "ID" argument is present and has a non-empty value, this explicitly specifies the ID.
Otherwise a default ID is generated that is unique to the flow element in which the counter is
used. This makes the counter variable "local".

If a property uses the same counter variable more than once, each invocation of the variable is
deemed a new invocation and will cause the counter to be incremented. For example, assuming
no counters have been used yet in a flow element, the property value
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Demo [Switch.Counter] - [Switch.Counter]

evaluates to

Demo 00001 - 00002

Metadata

Embedded metadata
Switch offers direct access to metadata embedded in a job in the EXIF, IPTC and Adobe XMP
formats, without the need for a separate "pick-up" action. Switch provides read-only access to
embedded metadata through variables and read-write access to embedded metadata through
scripting.

Also see "Metadata overview".

Embedded metadata formats

Switch supports the following embedded metadata formats:

Format Description Reference

EXIF A binary format designed to store
information about a photograph

Generated by all digital cameras and
used by many desktop applications and
asset management systems

Exif Version 2.2 specification
dated April 2002 (JEITA
CP-3451)

IPTC A binary format designed to store
news-related information in
photographs

Used by many applications including
asset management systems

IPTC – NAA Information
Interchange Model Version 4
dated July 1999

IPTC Core Schema for XMP
Version 1.0 Revision 8 dated
March 2005

XMP An XML-based format defined by Adobe

Embedded in images or compound
documents; used by Adobe Creative
Suite and many other applications

Adobe XMP specification dated
September 2005

Also see "Supported file formats" below.

Read-only access through variables

Switch allows the use of variables in the values of many text properties and for defining file
filters. Variables provide access to run-time information about a job including embedded
metadata fields.

Examples of embedded metadata fields that can be accessed through variables include:
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Group Type of information Metadata format

Doc Title, keywords, author(s), copyright
terms

XMP

IPTC Contact, location, headline, instructions IPTC

Image Resolution, orientation, color mode EXIF (TIFF tags)

Photo Exposure time, aperture, focus, flash EXIF (EXIF tags)

Read-write access through scripting

Enfocus Switch offers complete access to embedded metadata through the scripting API:

• The Job.getEmbeddedDataset() function retrieves a dataset object representing the job's
embedded metadata.

• The XMP data model query functions allow reading fields in the embedded dataset.

• The XMP data model update functions allow writing or updating fields in the embedded
dataset for certain supported file formats.

Rather than providing separate data models for each embedded metadata format, Switch
synchronizes the binary EXIF and IPTC tags with the XMP properties – offering a unified view of
all metadata using the XMP data model. See Supported file formats on page 451.

Supported file formats

The following table lists the embedded metadata capabilities for the supported file formats.

File format Metadata
access

XMP packet
handling

EXIF & IPTC
synchr.

Image data
synchr.

JPEG, TIFF Read and write
(*)

Smart read and
write (*)

For reading
and writing (*)

For reading

Photoshop Read and write
(*)

Smart read and
write (*)

For reading
and writing (*)

None

PNG Read and write
(*)

Smart read and
write (*)

None For reading

PDF Read and write
(*)

Smart read and
write (*)

None None

InDesign,
PostScript

Read-only Smart read-
only

None None

Other formats Read-only Generic read-
only

None None

(*) Write access is available only through scripting
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XMP packet handling

There are two distinct methods to locate XMP packets embedded in a file:

• Scan the complete file for the magic markers at the head and tail of a packet: this works
for any file format, but may possibly locate the wrong packet in case a composite document
contains multiple packets.

• Interpret the file format's structure to track down the packet: this guarantees that the
correct packet has been located and it is usually much faster, but it requires a specific
algorithm for each distinct file format.

As indicated in the table, Switch offers three levels of support for embedded XMP packets
depending on the file format:

• Smart read and write: interprets the file format to allow reading, updating and inserting an
XMP packet.

• Smart read-only: interprets the file format to locate the appropriate document-level XMP
packet but does not allow changes.

• Generic read-only: uses generic packet scanning to locate one of the XMP packets in the
document; does not allow changes.

EXIF and IPTC synchronization

As indicated in the table, for some file formats Switch performs two-way synchronization
between binary EXIF and IPTC tags on the one hand and XMP properties on the other hand,
similar to the behavior of the Adobe Creative Suite applications.

For supported file formats, when creating the embedded dataset for a job, Switch performs
these steps:

• Locate the primary embedded XMP packet and parse it into an XMP object model; if there is
no XMP packet start with an empty XMP object model.

• Read the appropriate binary EXIF and IPTC tags, if present and merge their values into the
XMP object model as the equivalent XMP properties.

• Offer access to the resulting unified XMP object model.

For supported file formats, when saving changes for a writable embedded dataset, Switch
performs these steps:

• If any changes were made to the dataset as compared to the original XMP packet, save the
complete unified XMP information in an updated or inserted XMP packet.

• If changes were made to one or more synchronized properties that are "user-editable",
update or insert the corresponding binary EXIF or IPTC tags. Properties that reflect
characteristics of the image (and thus should never be edited by a user) are not updated in
the binary tags.

Image data synchronization

As indicated in the table, for some file formats Switch retrieves basic information about the
image from the image data itself and writes this information to the appropriate fields in the XMP
packet. This ensures that the following fields are always present for these formats:

Variable name XMP location path

Image.ColorMode photoshop:ColorMode

Image.ICCProfile photoshop:ICCProfile
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Variable name XMP location path

Image.SamplesPerPixel tiff:SamplesPerPixel

Photo.ColorSpace exif:ColorSpace

Photo.PixelXDimension exif:PixelXDimension

Photo.PixelYDimension exif:PixelYDimension

Locating the backing file

The backing file for an embedded dataset is determined as follows:

• If the job is an individual file, use it as the backing file.

• Otherwise if the job folder immediately contains a single Adobe InDesign file (that is, at the
uppermost level), use that InDesign file as the backing file.

• Otherwise use the job folder path for the backing file and return an empty read-only dataset.

External metadata
Switch offers substantial support for importing, exporting, transforming and using metadata
through a combination of:

• Standard tools for picking up and exporting metadata associated with a job.

• Complete access to metadata from the Switch scripting environment.

For example, using simple script expressions you can route a job and set its processing
parameters based on metadata provided with the job.

Also see metadata overview.

Picking up metadata

Switch allows permanently associating metadata with a job moving through the flow (by storing
a reference to it in the job's internal job ticket). Each distinct set of metadata fields (for example,
a JDF job ticket or an XMP packet) are stored in a separate metadata dataset. Switch supports
several types of datasets, each with a specific data model that determines the semantics for
querying values from the dataset. See below for information on supported data models.

Metadata can originate from a number of different sources including a job ticket provided with a
job, an XMP packet embedded in a file, statistics derived from a file's contents and manual data
entry through the Switch Web Portal. Certain flow elements, including several built-in metadata
pickup tools, can associate a new metadata dataset with a job being processed through the
tool. Each dataset is given a unique name. Therefore, multiple datasets of the same type can be
associated with a job (for example: two JDF job tickets, each in its own dataset with a distinct
name).

To pickup metadata from a particular source, a flow designer must explicitly place the
appropriate pickup tool or configurator in the flow, at a location before the metadata is actually
queried. See below for a list of typical metadata sources and the corresponding Switch tools.

Using metadata

The Switch scripting API provides access to the contents of all metadata datasets already
associated with a job and offers the appropriate functions for querying metadata values in
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each dataset, depending on its data model. Furthermore, the scripting API allows adding a new
dataset or replacing an existing one.

Using script expressions, a flow can route a job and set its processing parameters based on the
contents of metadata fields associated with the job. Script elements offer complete freedom for
importing, exporting, transforming and using metadata at will.

Variables in the Metadata group provide access to any external metadata field associated with a
job. Switch allows the use of variables in the values of many text properties and for defining file
filters.

Updating metadata

The datasets picked up in the manner described above are called external datasets, as opposed
to the embedded dataset which references information stored inside the file - see embedded
metadata.

Switch does not support updating the value of individual metadata fields within an external
dataset. This limitation does not apply to an embedded dataset (see Read-write access through
scripting on page 451) or to hierarchy info and email info (which is stored directly in the
internal job ticket and not in a metadata dataset).

Note that, despite this limitation, it is possible to replace an external dataset as a whole by a
new version.

Exporting and transforming metadata

Any metadata dataset associated with a job can be exported as a separate file (in the same
format) using the export metadata tool. The result can be further transformed to an appropriate
XML, HTML or text file using the XSLT transform tool.

Metadata data models

Switch supports the following metadata data models and corresponding querying mechanisms:

Data model Description Query
mechanism

Scripting API

XML Any well-formed XML file (with or
without XML namespaces); refer to
the XML 1.0 specification

XPath 1.0
expression
and/or location
path

Dataset class,
XML data
model

JDF A JDF file conforming to the JDF
1.3 specification

XPath 1.0
location path

Dataset class,
JDF data
model

XMP An Adobe XMP packet or file
conforming to the Adobe XMP
specification dated September 2005

Adobe XMP
location path
(subset of
XPath)

Dataset class,
XMP data
model

Opaque An arbitrary data file (allows
associating information such as a
human readable report with a job)

None Dataset class,
Opaque data
model
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Metadata resources

The following table lists various metadata sources and the corresponding metadata data
models. The default dataset name can be overridden in most cases to allow associating more
than one dataset of the same type with a job.

Source Pickup tool Data model Default
dataset
name

Email message
components

Mail receive XML Email

Manual entry in
the Switch Web
Portal

Fields defined in Submit point or
Checkpoint

XML Submit or
Check

Separate XML file XML pickup XML Xml

Separate JDF file JDF pickup JDF Jdf

Separate XMP file XMP pickup XMP Xmp

Embedded XMP
packet

XMP pickup XMP Xmp

Any data file Opaque pickup Opaque Opaque

Adobe Acrobat
JDF

Uncompress MIME file; then JDF
pickup

JDF Jdf

QuarkXPress Job
Jacket

JDF pickup JDF Jdf

PDF contents
statistics

Apago PDFspy configurator XML Pdf

Preflight results callas pdfInspektor or Enfocus
PitStop Server or Markzware
FlightCheck Professional
configurator (with XML report); then
XML pickup

XML Xml

Text log or PDF
preflight report

Any configurator with outgoing traffic
light connections (set the "carry this
type of files" property to "data with
log")

Opaque Log

Pickup modes
The metadata pickup tools (XML pickup, JDF pickup, XMP pickup) allow associating metadata
from various sources as a metadata dataset with a job's internal job ticket. The tools support
several distinct mechanisms to locate the metadata source and its corresponding asset, as
described in the following subsections.
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Terminology

• Metadata source: the file (or sometimes the portion of a file) that contains the metadata to be
picked up.

• Asset: the file or job folder that is being described by the metadata and that will be moved
along in the flow after its internal job ticket has picked up the metadata.

• Pickup mode: a particular mechanism/algorithm to locate the metadata source and its
corresponding asset.

Metadata alongside asset

The metadata source (which is always a single file) and the corresponding asset (which may be
a file or a job folder) are both placed in one of the pickup tool's input folders (the same folder
or a different one) at the top level (that is, immediately under the input folder). Both have the
same name but a different filename extension. The supported filename extensions are defined
through flow element properties for the pickup tool.

The pickup tool waits until both the asset and the metadata source have arrived and then
performs the following steps:

• Create a new metadata dataset with a copy of the metadata source as its backing file.

• Associate this dataset with the asset's internal job ticket under the dataset name specified
through a flow element property for the pickup tool (replacing any existing association with
the same name).

• Remove the metadata source.

• Move the asset to the output folder.

Property Description

Metadata
filename pattern

One or more file types or filename extensions that are recognized as
metadata files

Orphan timeout
(minutes)

The time delay after which an incoming metadata source or an
incoming asset is considered orphaned because it can't be matched to
a counterpart

Orphaned jobs are moved to the problem jobs folder

Metadata in job folder asset

The asset (which is always a job folder) is placed in one of the pickup tool's input folders and
the metadata source (which is always a single file) resides inside the job folder. The pickup tool
provides flow element properties for locating the metadata source within the job folder (nesting
level and filename pattern).

The pickup tool waits until the job folder has fully arrived and then performs the following steps:

Locate the metadata source; if none is found the next two steps are skipped.

• Create a new metadata dataset with a copy of the metadata source as its backing file.

• Associate this dataset with the asset's internal job ticket under the dataset name specified
through a flow element property for the pickup tool (replacing any existing association with
the same name).

• Move the job folder asset to the output folder.

Note that the metadata source is not removed in this case.
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Property Description

Metadata file
filters

File filter that determines which of the files in the job folder
represents the metadata; files are scanned starting at the topmost
nesting level (at each level the scan order is arbitrary); the file filter is
evaluated in the context of each file and the first file that matches is
used as metadata source

Search depth The number of nesting levels in which to look for the metadata; "1"
means the topmost level only

Metadata refers to asset

The metadata source (which is always a single file) is placed in one of the pickup tool's input
folders and it contains a reference to the asset (which may be a file or a job folder) in some
other location accessible through the file system. Thus the asset itself is never directly placed in
a flow input folder.

The pickup tool provides flow element properties for locating the asset reference inside the
metadata source (a location path) and for determining whether the original copy of the asset
should be removed or not.

When the pickup tool detects an incoming file, it expects it to be a metadata source and it
performs the following steps:

• Locate the asset reference in the metadata source, locate the asset, and ensure that it is
readable. If any of these steps fail, report an error and quit.

• Create a new metadata dataset with a copy of the metadata source as its backing file.
• Associate this dataset with the asset's internal job ticket (which in fact is the metadata

source's job ticket) under the dataset name specified through a flow element property for the
pickup tool (replacing any existing association with the same name).

• Copy or move (depending on the property settings) the asset from its original location to the
output folder.

• Remove the metadata source.

Property Description

Asset path A script expression or a single line text with variables that evaluates to
the file or folder path referring to the asset to be copied (*)

Delete asset Determines whether the original copy of the asset is deleted after it
has been copied into the flow; this can be an explicit value or a script
expression (*)

(*) Usually script expressions are evaluated in the context of an incoming job before the tool acts
on the job. As an exception to this rule, here the script expressions are evaluated AFTER the
incoming metadata has been picked up (but before the asset has been located) so that the script
expression can access the metadata to calculate its return value.

Note:  Based on the remark above, a flow designer could assume that, at the moment
the dynamic values for the 'Asset path' and 'Delete asset' properties are calculated,
the incoming job is already converted to a metadata dataset. However, this is only true,
when the flow is active (and a job arrives), not at flow design time. This means that, when
designing a flow, it is not possible to hold a job (XML or JDF) for the purpose of building
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an XPath for example, as the incoming job has not yet been converted to a dataset. As
a workaround, the designer can create an additional test flow that attaches the job as
dataset to itself. This test flow can be used for building, for example, XPath expressions
that afterwards can be copied to the element property in the main flow.

Metadata embedded in asset

The asset (which is always a single file) is placed in one of the pickup tool's input folders and the
metadata source is embedded in the asset file according to some format (which depends on the
pickup tool).

When the pickup tool detects an incoming file, it expects is to be an asset and it performs the
following steps:

• Extract the metadata source from the asset and store it into a standalone file; if the asset
does not contain embedded metadata of the appropriate type, the next two steps are skipped.

• Create a new metadata dataset with this standalone file as its backing file.

• Associate this dataset with the asset's internal job ticket under the dataset name specified
through a flow element property for the pickup tool (replacing any existing association with
the same name).

• Move the asset file to the output folder.

Property Description

Synchronize EXIF/
IPTC fields

If set to "Yes", for supported file formats the values of binary EXIF
and IPTC tags are merged with the embedded XMP packet before it is
picked up (the packet embedded in the asset remains unchanged)

If set to "No", the embedded XMP packet is picked up without change -
if present

Metadata is asset

The pickup tool with a fourth pickup mode: "Metadata is asset" is used to implement for JDF,
XML and XMP pickup.

When a job (example: JDF) file is sent to a pickup tool using this feature, the resulting file is the
JDF file with its own content as JDF metadataset. So tools have only three properties: Name,
Dataset name and Pickupmode. There is no need for additional properties when this pickup
mode is selected.

Email message schema
The mail receive tool automatically picks up the contents of incoming email messages as
metadata. Specifically, for each incoming message the mail receive tool creates a metadata
dataset that contains the relevant components of the message, such as the sender, to, cc, and
reply-to addresses and the complete email body text. This dataset is then associated with the
job ticket for all files delivered by the message under the standard dataset name "Email".

Data model and schema

The email message dataset uses the XML data model with a simple schema without
namespaces.

The XML document element name is "email". It contains an element for each message
component as described in the table below; each element contains the text of the corresponding
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message component. If a message component is not present or it contains only white space, the
corresponding element is missing.

Leading and trailing white space is removed (except for the body text, where it may be
significant). Otherwise, no parsing or reformatting is performed. For example, a list of email
addresses (including its separators) is stored exactly as it was provided in the incoming
message.

Element name Message component

message-id An identifier for the message (assigned by the host which generated
the message)

subject The subject line of the message

date The date and time when the message was sent (formatted as it
appeared in the message header)

from The email address(es) of the author(s) of the message

sender The single email address of the sender of the message; if there is
a single author the sender is identical to the author, otherwise the
sender should be one of the authors

reply-to The email addresses to which a response to this message should be
sent

to The email addresses of the primary recipients of this message

cc The email addresses of the secondary recipients of this message

body A plain-text rendition (without markup) of the body text of this
message

Processing results schema
The FTP send and Mail send tools produce a log file with processing results. This log file is
carried along the outgoing log connections.

This log file can be associated with the job as a metadata dataset by using a "data with log"
connection (see the "Carry this type of files" property of traffic light connections).

Data model and schema

The processing results log file uses the XML data model with a simple schema without
namespaces.

The XML document element name is "ProcessingResults". It contains a sequence of elements
with a name and contents as described in the following table. If a data item is not applicable, the
corresponding element may be missing.

Element name Data type Description

Destination Text For FTP, the complete target URL for the job
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Element name Data type Description

For Mail, the list of destination email addresses

FlowElementName Text The name of the flow element that produced this
log file (as displayed in the canvas)

FlowElementType Text The type of the flow element that produced this
log file (e.g. "FTP send" or "Mail send")

FlowName Text The name of the flow (as displayed in the flows
pane) containing the flow element that produced
this log file

JobArrivalStamp Integer The arrival stamp for the processed job as an
unsigned integer number; a lower arrival stamp
indicates a job that arrived in the flow earlier (and
vice versa)

Several jobs may have the same arrival stamp,
for example when multiple jobs are generated
from the same original job

JobByteCount Integer The size in bytes of the processed job; if it is a job
folder, all files in subfolders are included in the
count, recursively

JobExtension Text The processed job's filename extension, or the
empty string if there is none

JobFileCount Integer The number of files in the processed job,
including all files in subfolders, recursively
(folders and subfolders themselves do not
contribute to the count)

JobFiles Sequence of
"File" elements

A sequence of one or more "File" elements
representing the files in the processed job in
arbitrary order; each File element has the Text
data type and contains the relative path of a file
within the job (using a forward slash as path
separator)

Folders are NOT represented in this list

JobIsFile Boolean True if the processed job is a single file, false
otherwise

JobIsFolder Boolean True if the processed job is a folder, false
otherwise

JobName Text The file or folder name for the processed job,
including filename extension if present, but
excluding the unique filename prefix
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Element name Data type Description

JobNameProper Text The file or folder name for the processed job
excluding filename extension and excluding the
unique filename prefix

JobOrigin Text An indication of the origin of the processed job
before it was injected in the flow; for example,
a Submit point writes the absolute path of the
original job (on the client computer) in this field

JobPath Text The absolute file or folder path for the processed
job as it resided in the input folder before being
processed, including unique filename prefix

JobPriority Integer The job priority assigned to the processed job as a
signed integer number

JobUniqueName
Prefix

Text The unique filename prefix used for the
processed job, without the underscores; for a job
called "_0G63D_myjob.txt" this would be "0G63D"

JobUserName Text The user name associated with the processed job,
if any

ProcessingEnded Date The date-time when the operation was completed
(in the ISO 8601 format also used for Switch date
variables)

ProcessingStarted Date The date-time when the operation started (in
the ISO 8601 format also used for Switch date
variables)

ServerAddress Text The name or IP address of the destination server

ServerLoginName Text The user name used to login at the destination
server

ServerPort Integer The port of the destination server

Defining metadata fields
The Submit point and the Checkpoint tools allow defining metadata fields which can be viewed
and/or edited by the Switch Web Portal user when submitting or routing a job. The values of
display-only fields are determined by evaluating a script expression so that they can depend
on metadata associated with the job. After a user submits a job or moves it along, the values of
editable fields (as entered by the user) are associated with the job as metadata (with the client
fields schema).

Defining metadata fields
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The property editor for editable metadata fields allows creating an ordered list of field
definitions (using the buttons under the listbox on the left-hand side). For each field definition,
the property editor allows editing the properties described in the table below (using the edit
fields and controls on the right-hand side).

Property Description

Label The label shown in front of the field.

Description Description for this field shown as tool tip when user hovers over the
label or the data field in the Switch Web Portal.

Show if parent and
Parent value

Only available if the Metadata field has a parent. Dependencies are set
using the arrow keys in the field list.

These properties allow you to set a condition for showing the child.
For example, if the parent field is "Add Bleed?", the child field
"Amount of bleed" only needs to be displayed if the value of "Add
Bleed?" is Yes (So: Show if parent equals Yes).

Note:  If you choose the "Matches" option for "Show if
Parent" property then regular expression will be used for all
parent values.

Data type The field's data type: Dropdown list (Single-line text, Password, Date,
Number, Hours and minutes, No-yes list, Dropdown list).
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Property Description

Data format Only available when "Data type" is set to single-line text or number.
Format the metadata field using a regular expression. Leave empty to
not set any special formatting (Single-line text, Regular expression).

Data values and
Ignore duplicates

Only available when "Data type" is set to "Dropdown list". Define the
drop down list (Edit multi-line text, Define multi-line text with
variables, Define script expression, Define values from dataset,
Define values from ODBC data source).

The Ignore duplicates option defines if a value can be shown twice in
the dropdown list.

Default The default value for the field (Single-line text, Single-line text with
variable, Condition with variables, Date and Script expression), i.e.
the value that is shown when the form is displayed to the user.

Using variables:

It is possible to use variables to define the default value for your
metadata field (Single-line text with variables, Condition with
variables). However, most variables (e.g. doc author, page height,
number of pages, ...) are not suited, as the requested information is
only available after the job has been submitted to the Switch Server.
At the time of submitting the job, only the variables of the Switch
variables group (e.g. date, flow name, server name, ...) are available
and can be displayed to the user.

Some examples:

• [Job.Size] as default value is invalid; this will result in see "0
bytes" as the job size is unknown as long as the job hasn't been
submitted to the Switch Server.

• [Switch.Date:TimeZone="UTC"] is valid and will show the current
date and time (= the date/time you're using the Switch Web Portal
to submit the file).

Mismatches:

In case "Data type" is Dropdown list with dynamically generated
content, this default value might not correspond with one of the list
items. In this case the "Default value" is empty in the Switch Web
Portal.

In case the "Data type" format and the default values format do not
match, Switch tries to force the formatting of the data type property
(example, Data type is hour and minute and the Default value is a text
variable). If forcing is not possible, the Default value is empty in the
Switch Web Portal.

Remember last
value

If set to "Yes", the most-recently value entered by the user (in this
field) is displayed.

In case "Data type" is Dropdown list with dynamically generated
content, the previous value might become irrelevant. The previous
value is however stored so we can also compare it with the content of
the list. If the stored value matches one of the data values, then this

463



Switch

Property Description

value is shown. If the stored value no longer appears in the list, no
value is shown.

Read only Set this to "Yes" to make this field read-only, so it cannot be edited by
the user.

Value is required If set to "Yes", the user must enter a non-blank value (relevant only if
Data type is string).

Display metadata
field

If set to "Yes" this field is displayed to the user and when set to "No"
it is hidden. See Using metadata on page 453 and Defining metadata
fields on page 461 for more information.

Cache dynamic
values

This property determines if the dynamic metadata field values are
calculated once and then stored in the cache (to save processing
time) or recalculated each time metadata is requested for the job
or Submit point. On the Switch Web Portal metadata is requested
when submitting and processing a job (= when the form for entering
metadata is displayed to the user).

Dynamic values are values that are calculated using script
expressions, defined using variables, or taken from a database.
An example is a metadata field "Product" that is defined as a
dropdownlist with products taken from a database. If cached, the
products are retrieved from the database only once; if not cached,
Switch retrieves the products each time metadata is requested.

Options are:

• Do not cache (default): The dynamic values are recalculated
whenever they are requested. This takes more time but is advised
in case of fast changing data (e.g. quickly changing database
values, the [Switch.Counter] variable, …).

• Cache per user: The dynamic values are calculated once and then
stored for each user separately. When a different user logs in,
the dynamic values are calculated again and stored in that user's
cache. This option is recommended if the dynamic values are
based on user names or email addresses, such as a variable like
[Connection.UserName].

• Cache for all users: The dynamic values are stored in a common
cache for all users. For example, when user 1 submits a job, the
dynamic metadata field values are calculated and stored in the
common cache. If user 2 submits a job, the stored values are re-
used (instead of recalculated). This option is recommended for
job-dependent variables or script expressions.

Note:

• Fixed or static values are always cached.
• Options to clear the cache (e.g. at user login or on a

certain condition) can be set in the properties of Submit
points and Checkpoints.
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Note:  For the Checkpoint tool, when a user selects "Define values from dataset"
in the Data Values field, the Build location path window appears using which XPath
expressions can be created. The regular variables from a dataset returns only one single
value where as the result of the XPath can be a list of values.

Note:  For the Submit point and the Checkpoint tools, when a user selects the "Define
values from ODBC data source", Build SQL statement window appears. The regular
variables from database returns only one single record where as the result of the SQL
statement can be a list of records.

Note:  Switch.OutgoingName cannot be used to define metadata fields in Checkpoints
and Submit points.

Update metadata

Click the button present below the Metadata fields list to access a dialog box which displays
a two level tree: first level table tree of all Submit points (level 1) and second level for their
metadata fields (level 2).

In the list, a Submit point can be checked (including all its fields) or an individual field can
be selected. The fields that are checked are added to the Metadata fields list. Possible
dependencies are preserved.

The fields from a Submit point are clearly marked (using color or some other mark). Therefore,
user can distinguish such fields from a newly added Checkpoint field. All properties from these
fields are grayed-out, except the Show if parent equals ... property, the Read only property and
the Display metadata field property.

Behavior of updated fields in the Switch Web Portal

The metadata from the submit dataset is shown as the default value.

On the Switch Web Portal, users can read and change this data (if allowed). The new value is
written to the check dataset. So technically, this is not a real update from the data but a copy
from a field of one dataset (submit) to another (check). The Switch user can of course use the
same name for the submit and check dataset. In this case the first dataset is overwritten.

If metadata fields are changed or added on a Submit point, the user will probably wish to
update those fields in the Checkpoint too. Switch however does not offer an automatic update
mechanism, so the user has to delete the field and re-import it again.

If users delete a field from a Submit point, they are also responsible for deleting that field
from the Checkpoint metadata list as well. If a user does not remove the deleted field from the
Checkpoint metadata list, then the field is still shown but the default value will then be empty.

Defining display-only fields
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The property editor for display-only metadata fields allows creating an ordered list of field
definitions (using the buttons under the listbox on the left-hand side). For each field definition,
the property editor allows editing the properties described in the table below (using the edit
fields and controls on the right-hand side).

Property Description

Label The label shown in front of the field

Description A hint displayed when the cursor hovers over the field

Data type The field's data type: Boolean or string

Calculated value A script expression that evaluates to the value of the metadata field;
it is evaluated in the context of the job being viewed by the user so
that it can use metadata associated with the job

Client fields schema
The Submit point and Checkpoint tools pickup metadata fields entered by the user when
submitting or routing a job through the Switch Web Portal.

Specifically, when a user submits a job and the list of field definitions in the Submit point's
"Metadata fields" property is not empty, the Submit point:

• Creates a metadata dataset containing the contents of the metadata fields entered by the
user.
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• Associates this dataset with the job ticket for the submitted job under the dataset name
specified in the "Dataset name" property.

Similarly, when a user routes a job residing in a Checkpoint and the list of editable field
definitions in the Checkpoint's "Metadata fields" property is nonempty, the Checkpoint creates a
metadata dataset and associates it with the job's job ticket under the specified dataset name.

Note that a Checkpoint always creates a completely new dataset, i.e. it does not update or
modify an existing dataset (even if the job was previously moved through the same or another
Checkpoint). If the job already has dataset association with the same name, the reference to the
old dataset is removed and replaced by the new one.

Data model and schema

The client fields dataset uses the XML data model with a simple schema without namespaces.

The XML document element name is "field-list". It contains a "field" element for each item in
the list of editable metadata field definitions associated with the Submit point or Checkpoint
under consideration. The "field" elements occur in the same order as in the list of field
definitions, and a "field" element is present even if the corresponding field's value is empty.

Each "field" element in turn contains zero or one occurrence of each element listed in the table
below. Within the contents of those child elements leading and trailing white space is removed.

Element name Description of element contents Element is present

tag The field name; in the current implementation
this is equal to the human-readable field label

Always

type The field's data type; that is, "boolean", "string"
or "choice"

Always

format A regular expression that matches the values
allowed for the field (relevant only if data type is
string)

If type is string
and if regexp is not
blank

required Equals "true" if the user is required to enter a
non-blank value, "false" otherwise (relevant only
if data type is string)

If type is string

value The value for the field:

• For boolean data types: "true" or "false"

• For string data types: the value entered by
the user after removing any leading and
trailing white space (may be the empty string
unless required is set to true)

Always

items The field's possible choices if type is choice

Introduction to XPath 1.0
XPath 1.0 is used in the Switch scripting API for querying the contents of XML documents in the
XML and JDF data models and in the XML module.
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Note:  The current version of Switch does not support XPath 2.0.

Refer to the XPath 1.0 specification, the XML 1.0 specification, the XML namespaces
specification, and widely available literature for full details on XPath 1.0.

The remainder of this topic provides a brief introduction to a very small subset of XPath 1.0.

Expressions and location paths

XPath models an XML document as a tree of nodes. There are different types of nodes, including
element nodes, attribute nodes and text nodes. XPath defines a way to address specific nodes
in the node tree, to compute a string-value for each type of node and to perform more general
calculations with these values.

The primary construct in XPath is the expression. An expression is evaluated to yield an object,
which has one of the following four basic types:

• node-set (an unordered collection of nodes without duplicates).
• boolean (true or false).
• number (a floating-point number).
• string (a sequence of Unicode characters).

One important kind of expression is a location path. A location path selects a set of nodes. The
result of evaluating an expression that is a location path is the node-set containing the nodes
selected by the location path. Location paths can recursively contain expressions that are used
to filter sets of nodes.

Location paths

A location path is a sequence of one or more location steps separated by a slash. Each location
step in turn (from left to right) selects a set of nodes relative to the context node determined by
the previous step. The initial context node is determined by the location path's context (for the
data model queries in Switch this is always the document's root node; in the XML module it is
the node being queried). A slash in front of a location path makes the location path absolute,
that is, the "/" refers to the root node of the document.

Here are some examples of location paths:

para

selects the para element children of the context node

*

selects all element children of the context node

text()

selects all text node children of the context node

@name

selects the name attribute of the context node

@*

selects all the attributes of the context node

para[1]

selects the first para child of the context node

para[last()]
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selects the last para child of the context node

*/para

selects all para grandchildren of the context node

/doc/chapter[5]/section[2]

selects the second section element in the fifth chapter element in the doc document element

chapter//para

selects the para element descendants of the chapter element children of the context node

//para

selects all the para descendants of the document root and thus selects all para elements in the
same document as the context node

//olist/item

selects all the item elements in the same document as the context node that have an olist
parent

.

selects the context node

.//para

selects the para element descendants of the context node

..

selects the parent of the context node

../@lang

selects the lang attribute of the parent of the context node

para[@type="warning"]

selects all para child elements of the context node that have a type attribute with value warning

para[@type="warning"][5]

selects the fifth para child element of the context node that has a type attribute with value
warning

para[5][@type="warning"]

selects the fifth para child element of the context node if that child has a type attribute with
value warning

chapter[title="Introduction"]

selects the chapter child elements of the context node that have one or more title child
elements with string-value equal to Introduction

//field[name="JobID"]/value

selects all value elements in the document that have a parent field element and a sibling name
element with string-value equal to JobID

chapter[title]

selects the chapter child elements of the context node that have one or more title child
elements

employee[@secretary and @assistant]
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selects all the employee child elements of the context node that have both a secretary attribute
and an assistant attribute

Expressions

The location paths listed in the previous section contain a few examples of simple expressions
used to filter nodes (such as @type="warning" to filter out elements with a particular attribute
value). Expressions can also stand on their own, and can be used to express calculations
based on the result of a location path. XPath provides a limited number of functions for use in
expressions.

Here are some examples of expressions:

para

evaluates to the text contents of the para element(s)

@type

evaluates to the text contents of the type attribute

(2 + 3) * 4

evaluates to the number 20

number(@type) > 10

evaluates to true if the contents of the type attribute represents a number that is greater than
10; and to false otherwise

count(//field)

evaluates to the number of field elements in the document, regardless of their position in the
node tree

count(/doc/chapter[5]/section)

evaluates to the number of section elements in the fifth chapter element in the doc document
element

string-length(normalize-space(para))

evaluates to the number of characters in the text contents of the para element, after removing
leading and trailing white space and replacing sequences of white space characters by a single
space

Namespaces

The examples above assume that the XML document being queried does not use namespaces.
In practice however many XML documents do use namespaces to avoid conflicting element and
attribute names when information of a different type or origin is mixed.

A namespace is identified by a Unique Resource Identifier (URI) which resembles a web page
address but in fact is just a unique string (most URIs do not point to an actual web page). Rather
than repeating this URI each time, element and attribute names use a namespace prefix (a
shorthand) to refer to a namespace. The mapping between namespace prefixes and namespace
URIs is defined in namespace declarations in the XML file.

For example:

xml:lang

is the name of a standard xml attribute for indicating a natural language

jdf:node
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is the name of a node element in the JDF specification, assuming that the jdf prefix is mapped to
the JDF namespace URI

Namespaces and XPath

If the XML file being queried uses namespaces, the XPath expressions and location paths must
use namespace prefixes as well. The mapping between those prefixes and the corresponding
namespace URIs must be passed to the query function separately, since this information can't
be expressed in XPath.

Note that namespace URIs must match between the XPath expression and the XML file; the
namespace prefixes may differ.

XPath does not have the concept of a default namespace. If the XML file being queried defines a
default namespace, the XPath expression must specify a namespace prefix to refer to elements
in that namespace. The default_switch_ns prefix can be used to specify elements using the
default namespace.

Introduction to Adobe XMP location paths
The Adobe XMP specification dated September 2005 defines the XMP data model (the abstract
node hierarchy represented by an XMP packet or file). Other Adobe publications define a
mechanism to address a specific node in the XMP data model, using a syntax that is a (very
small) subset of the XPath 1.0 location path syntax. In this documentation we refer to this
mechanism as XMP location paths.

XMP location path syntax

An XMP location path points to a specific node in an XMP node hierarchy (whether the node
exists or not).

An XMP location path is a series of one or more XMP location steps separated by a slash. Each
location step address the next child element, depending on the structure of the document.

Each location step is one of the following:

• A prefixed field name

• An array index selector

• A language selector

A language selector may occur only as the very last location step. The first location step is
always a prefixed field name.

Field name

A field name addresses a named element (also called a field).

For example:

xmp:SomeProperty

Addresses a field named "SomeProperty" in the namespace to which the "xmp" namespace
prefix is mapped.

Index selector

An index selector addresses an item in an array. Indices are one-based, that is, the first item in
an array has index 1. The last item in an array can be addressed with the special index "last()".
In all cases the index must be enclosed in square brackets and preceded by an asterisk.
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For example:

*[1]

*[4]

*[last()]

Address the first, the fourth and the last item of an array, respectively.

Language selector

A language selector addresses an item in a collection with language alternatives (a collection
of strings with the same meaning but localized for different human languages). The language
is indicated by a 2-letter language code (ISO 639), optionally followed by a 2-letter country code
(ISO 3166). The special language code "x-default" indicates the default language. The language
code must be embedded in special XPath syntax for addressing the xml:lang attribute.

For example:

*[@xml:lang='enUS'] *[@xml:lang='x-default']

Address U.S. English and the default language item, respectively.

Examples

The following examples address properties in the XMP Dublin Core schema, which is usually
associated with the "dc" prefix. Thus these examples assume that the "dc" prefix is mapped to
the Dublin Core namespace URI (http://purl.org/dc/elements/1.1/).

Examples:

dc:format

Addresses the top-level data format property.

dc:creator/*[1]

Addresses the first item in the list of document creators, which by convention is the primary
author of the document.

dc:description/*[@xml:lang='x-default']

Addresses the default item in the list of language alternatives for the document's description.

5.5.4.  Scripting Module
If you have an active license for the Scripting Module, you have access to the Script element
in the Flow elements pane. This allows you develop your own scripts (using the SwitchScripter
application, which comes with Switch), for example to extend the capabilities of Switch. You
can also create your own configurator(s) using SwitchScripter, for interaction with third-party
applications that are not yet supported by Switch.

Note:  If you want to create your own configurators, in addition, you need a Configurator
SDK key. Such a key adds extra functionality to SwitchScripter and allows you to convert
your scripts into configurators.
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For more information, refer to the Switch Scripting documentation on the Enfocus website. There
is also a guide with sample scripts available on the Enfocus website.

5.5.5.  Database Module
The Database module is an advanced module that allows read/write access to databases
(through ODBC data sources) without the need for extensive scripting. With the database
module, business or job management software can be used in conjunction with Switch
workflows to further automate job decisions.

An active Database module license provides you with access to:

• The ODBC data sources option in the User preferences dialog (required to set up a database
connection and to use database variables).

• The Database connect flow element (available in the Database category of the Flow elements
pane). This flow element allows you to configure certain settings in databases without having
to script them.

• Database variables. This allows you to use any values from your database in Switch.

• Database values when defining metadata for a Submit point on page 181 on the Switch
Web Portal or a Connector in Connect ALL (see the Connect documentation on the Enfocus
website).

5.5.5.1.  Getting started with the Database Module
The Switch Database Module automates the communication between any database and Switch.

This means you can use database information in Switch, for example to make decisions based on
existing job or customer information. For example, if information about the paper type of a job is
available in your MIS system, you can attach this information to the job and use this information
to decide whether or not it should go to an Ink Optimizer.

Moreover, you can also change the information in your database from within your workflow to
store information obtained in the workflow, for example to indicate that the job is done or to
store preflight information. You can as well add or delete records in your database.

The illustration below shows how data from different types of databases (MIS/DAM/CRM
database) can communicate with Switch through ODBC data sources ("connections to the
database").
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If you're using the Switch Web Portal or Connect ALL to submit jobs to Switch, the Database Module
offers an extra feature, i.e. the possibility to present database values to the users and give them
the chance to attach the appropriate values to the job. For example, instead of asking the users
to type the correct customer ID (risk of typos!), you could show them a list of customer IDs
available in the database to choose from.

Database connect

An active license for the Database Module gives access to the Database connect flow element.
 

 
This element allows you to establish a connection with the database of your choice (using ODBC
data sources) and to build an SQL statement to determine what data should be collected, added,
modified, filtered, changed…

When a job passes through this flow element, the SQL statement is executed. To keep an eye on
the changes, you can log the result of the SQL statement.

In the following example, when a job arrives in the Database connect flow element, Switch
connects to the MIS database and checks the paper type for the current job. Only if the job
matches the SQL statement, the job is “successful” and the job will be sent to the Ink Optimizer.
For each job, a log file is created and stored in a separate folder.
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Database variables

Additionally, the Database Module gives access to an extra set of variables, e.g. the Database
variables which also retrieve data from your database but which can be used wherever variables
can be used in Switch (so not only in combination with the Database connect flow element).

Variables in Switch are “placeholders” - they are replaced with actual values when a job is being
processed. For example, if you want that the customer receives a notification whenever a job
is finished, you should use the [Job.EmailAddress] variable (in the Mail send element) to make
sure that the email is sent to the right email address (i.e. the address associated with the job).
However, if you have activated the Database Module, you can select (additional) email addresses
available in your database. The variable will start with "Database", e.g. [Database.Text:SQL="
SELECT Email FROM Customers"] (SQL statement to select records from the column "Email" in
the table "Customers").

Database fields in the Switch Web Portal and Connect ALL

A Submit point (in Switch) or a Connector (created with Connect ALL) can be configured to ask
for metadata when a job is submitted. Metadata is additional information about the job, sent
along with the processed job in the background as an XML, TXT or CSV file (called Job Ticket).
It is often used to store administrative information associated with the job or to exchange such
information between systems.

If you have licensed the Database Module, you can define your metadata fields using values from
your database (again using an SQL statement).
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Note:  It is only possible to visualize content from the database, for example the
possible values for a particular field. It is NOT possible to extract the correct value for
a particular job; the operator who submits a job to a Submit point or a Connector has to
select it manually.

5.5.5.2.  Database Module - Setup
To able to use the features of the Database Module, make sure to:

• Activate your license for the Database Module

• Set up your ODBC database connection.

About ODBC data sources in Switch

Guidelines

Please take into account the following guidelines when accessing ODBC data sources in Switch:

Before you set up the connection to the data source, you should have defined your database
(i.e. the Database Source Name (DSN)) in the DSN settings of your operating system. Read the
documentation of your database to learn how to set up the DSN.

Windows users can find more information on the Microsoft website: http://msdn.microsoft.com/
en-us/library/ms710252%28v=VS.85%29.aspx
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Mac users should install an ODBC Administrator, for example http://www.odbcmanager.net/, to
be able to set up ODBC connections on Mac.

Note:  Switch allows you to use both User and System DSN on Windows and Mac
platforms.

Make sure to install a 64-bit ODBC driver.

• Example Windows OS: In case of MySQL database, the ODBC driver installer mysql-
connector-odbc-5.1.8-winx64.msi is used. When you launch this installer and choose the
Custom installation, you will see that two drivers are available: 32-bit and 64-bit. Install the
64-bit driver and preferably disable the 32-bit driver, to avoid mix-up of driver versions in the
future. This will guarantee that Switch uses the correct driver.

For more information on ODBC drivers and data sources, refer to http://msdn.microsoft.com/en-
us/library/ms710285%28v=VS.85%29.aspx .

• Example Mac OS X: In the MySQL database, two versions of Mac OS X ODBC drivers are
available: 32-bit and 64-bit. You must use the 64-bit version (mysql-connector-odbc-5.2.7-
osx10.7-x86-64bit.dmg).

Make sure to use the 64-bit version of the ODBC Administrator tool to configure your data
sources (DSNs).

On 64-bit Windows computers, two ODBC Administrator tools are available:

• 32-bit version: ..\windows\sysWOW64\odbcad32.exe

• 64-bit version: ..\windows\system32\odbcad32.exe

Use the 64-bit version from \windows\system32\odbcad32.exe to configure your DSNs for
Switch.

• If you install only the 64-bit ODBC driver and then launch the 32-bit version of the tool, you
will not be able to configure any DSNs, because the 32-bit version of the tool does not show
the 64-bit ODBC drivers.

• If you have installed the 32-bit ODBC drivers, then in the 32-bit version of the tool you will see
the 32-bit driver and you will be able to configure DSNs for that driver. However, Switch will
not work with these DSNs and you will get the error message The specified DSN contains an
architecture mismatch between the Driver and Application".

For more information on managing data sources, refer to http://msdn.microsoft.com/en-us/
library/ms712362%28v=VS.85%29.aspx .

Using the INGRES database in combination with Switch?

You should set the following flag (in the INGRES database):

return NULL for SCHEMA columns in ODBC catalog function result sets 

Otherwise, you will get an error ("invalid table") when setting up SQL statements.

Setting up an ODBC database connection
If you want to use Switch with an ODBC data source (and you have licensed the Database
module), you must set up a connection to the preferred database.

Note:  If you have more than one database, you can configure different database
connections as required.
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To configure an ODBC database connection

1. In Switch, navigate to Edit > User Preferences > ODBC data sources.

2. Do one of the following:

•
Select the ODBC data source information field and click .

• Double-click the ODBC data source information field.

The ODBC data sources dialog appears.

3.
To add and configure an ODBC data source, click .
The ODBC sources field now contains one data source, temporarily called Data Source. You
can rename it in the next step of this procedure.
 

 

4. In the Properties pane, in the Data Source text field, provide a name for the data source.

5. In the Description text field, provide a small definition for the data source.

6.
To select the DSN (Database Source Name) from the library, click .

The DSN must be defined in the DSN settings of your operating system. For more
information, refer to About ODBC data sources in Switch on page 48.

7. Provide a Username and Password.

These two fields can also be left blank if username and password are not required, or if they
have already been defined for the DSN.

8. From the drop-down menus, select the appropriate Query codec and Data codec, if required.

9. To test the database connection, click Check connection.
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If the connection succeeded, a message box appears displaying the message Connection
successful.

Note:  In case of problems, you will see an error message generated by the ODBC
tool of your operating system.

10. To close the message, click OK.

If you have more than one database, repeat step 3 to 10 and add as many data sources as
you have databases.

11. To close the ODBC data sources dialog, click OK once more.

5.5.5.3.  Database connect

This tool helps in configuring certain settings in the databases (like selecting Datasource,
adding SQL statement etc) without the use of scripting. It is only available if you have licensed
the Database module.

Drag and drop the Database Connect to the workspace.

Keywords
If you enter one of the following keywords in the Search field at the top of the Flow elements
pane, the Database Connect element will be shown in the list:

• SQL
• database
• metadata
• xml
• export
• select
• insert
• update
• delete

Connections
Database Connect needs at least one incoming connection.

Property

Property Description

Name Provide a name for the flow element. This
name is displayed in the workspace.

Description A description of the flow element displayed
in the canvas. This description is also shown
in the tooltip that appears when moving your
cursor over the flow element
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Property Description

Select data source Select a data source from the list of
predefined data sources.

Note:  If the list is empty, you
should first set up a data source.
Refer to the ODBC data sources
option in the User preferences
dialog (See Setting up an ODBC
database connection on page 49).

SQL statement Specify SQL statements using any one of the
following three options:

• Edit multi-line text
• Define multi-line text with variables
• Define script expression

Note:  Please pay special attention
when using other variables and
make sure that the result of the
multi-line text is a valid SQL
statement.

Log name Specify the name of the log where the result
of the statement should be written by using
one of the following three options:

• Inline value
• Define single-line text with variables
• Define script expression

Binary data in opaque dataset If the result of the SELECT statement
returns binary data (for example: video
form), select Yes.

Otherwise, select No and configure the
subordinate properties.

Log type Only available if Binary data in opaque dataset
is set to No.

Format of the log (where the result of the
statement will be written). Options:

• CSV

• XML

Encode binary data Only available if Binary data in opaque dataset
is set to No.

Defines the way binary data is converted.

• Encode with Base64: default
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Property Description

• Keep as is: Use this option if the ODBC
driver returns binary table fields. This is
for example the case when you're using
FileMaker in combination with Switch.

Note:  Be careful with this
option; it may lead to a
corrupted logfile.

At present there is no SQL editor available. Therefore, copying statements generated by the
variables, multi line text with variables, database group and build SQL statement dialog box may
result in errors.

Note:  Refer this site for an SQL Tutorial.

5.5.5.4.  Database variables

What are database variables?

Database variables are variables that at run-time are replaced with values from a database.
These variables can only be used if you have an active license for the Switch Databases Module.

You can use the database variables in the same way as the regular Switch variables:

• Use them as values for the tools and the configurator properties.

• Use them as values for conditions, for example to filter jobs on a connection.

• Use them as values to fill a drop-down menu in the Submit point and Checkpoint metadata
properties.

They are also accessible in the same way as other variables, i.e. via the Define Text/Condition
with Variables option in the properties of the Switch tools. They are collected in a separate
group: the "Database" variable group (see screenshot).
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The table below lists the available data types.

Variable name Data type

Database.Text Text

Database.TextIndexed Text Indexed

Database.Boolean Boolean

Database.Integer Integer

Database.Rational Rational

Database.Date Date

How to build an SQL statement?

After you have selected the Database group in the first column, and the data type in the
second column, you must create an SQL statement. The Build SQL statement dialog box (see
screenshot) will assist you in creating the SELECT statement and obtaining the appropriate
values from the database.
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Tip:  We recommend using a sample job, so you can see immediately if your SQL
statement is valid and correct.

 

 

To build an SQL statement, proceed as follows:

1.
Click the  button beside the SQL textbox and choose Build SQL statement.

2. Select a data source.

a. Click the Configure button.
b. In the ODBC data sources dialog, select a data source from the list of predefined data

sources (Refer to ODBC data sources for more information on how to define the data
sources).

3. Select a table and a column in the Table and the Column drop-down menus.
4. Select the Condition checkbox and specify or select the conditions in the first and the third

menu, choose the comparison operator in the middle drop-down menu and choose the AND
or OR logical operator in the last drop-down menu.

5. Alternatively, in order to choose more than one column or to choose a column from any
other table or not to choose any columns, select the Manual editing checkbox and enter the
statement manually.

6. After setting the SQL statement, click the Validate statement button to check if the query
is valid. If the query returns any value or error, it is displayed on screen. The Sample value
menu displays the sample value for a query. If a query returns multiple values, they will be
listed in a comma separated list. For example: "val11,val12,val21,val22...".
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7. Click the OK button to insert the statement.

5.5.6.  SwitchClient Module
SwitchClient is a Switch module allowing users to access the Switch Server remotely, via Submit
points (to submit jobs) and Checkpoints (to monitor jobs).

With an active license of the SwitchClient Module, users can for example:

• Connect to one or more Switch Servers on the local network/internet.
• Submit jobs (files or job folders) and metadata describing these jobs to a Submit point in a

flow.
• Review and act on jobs being held in a Checkpoint in a flow.
• View progress information and the status of submitted jobs.
• Access the REST API and build a custom Job Client.

Good to know

• Access to particular Submit points and Checkpoints can be restricted, by configuring access
rights at user or user group level. For more information, refer to Configuring Switch users on
page 57.

• Metadata information attached to a job can be used to make automated routing decisions or
to provide variable input to various tools and configurators.

• SwitchClient comes with a documented REST API, which enables our customers to build
their own Switch client tailored to their specific needs. The API can be accessed without a
licensed Web Services module for limited, internal usage. For extended usage, e.g. customers
wanting to make a Submit point available online, the Web Services module is required;
otherwise their end users will run into an "API limit reached" error.

5.5.7.  Switch Web Services
The Switch Web Services is a REST-based development tool designed to create custom Switch
client interfaces within existing applications or web-based interfaces. This can be useful for
external users when they need access to jobs or workflows, or in cases where access to jobs
needs to be built into existing application interfaces.

Note that an active Switch Web Services license gives access to the functionality to  submit and
check jobs through the Switch Web Portal.

For more information on the Switch Web Services, please contact your local Enfocus reseller or
contact Enfocus directly.

5.5.8.  Reporting Module
The Reporting Module allows you to create, display and share dashboards on the Switch Web
Portal. You can configure the data you want to use (by defining job boards) and choose from
different widgets to display live data or historical data (to get statistics).

For more information, refer to the chapter on Managing dashboards on the Switch Web Portal on
page 328.
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5.6.  Stopping the Switch Server
For maintenance reasons, it may be necessary to shut down the Switch Server.

To stop the Switch Server

1. Launch Switch with a local Designer.

2. From the File menu, select Stop Switch Server.

Note:  Note the difference with the option Stop processing, which only causes the
Switch Server to stop processing flows.

The Switch Server is terminated and the Designer is closed. Remote Designers will not be able
to connect to the Switch Server. Connecting with a local Designer will restart the Server.

5.7.  Quitting Switch
Quitting Switch means exiting the Switch Designer.

The behavior of the Switch Server (whether or not it is stopped when quitting) depends on the
setting of When exiting the flow designer in the Switch preferences: User interface on page 32.

To quit Switch

Do one of the following:

•
Click the Close button ( ) in the top right corner of the application.

• (Windows) From the File menu, select Quit Switch.
• (Mac) From the Enfocus Switch menu, select Quit Enfocus Switch.
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6.  The Switch Insight Dashboard
The Switch Insight Dashboard is a dashboard that allows you to visualize the usage of your
Switch. The charts on this dashboard will for example show you:

• How many files were processed by the Switch Server.
• How many problem jobs were found.
• Which flows and flow elements were used most.
• Which file types were processed most.
• Which production times were busy and which weren't.
• etc.

The Switch Insight Dashboard is free for maintenance users. Note however, that you should
explicitly opt in via the Insight Dashboard menu option in Switch (see Enabling your Switch Insight
Dashboard on page 486). Otherwise, the Switch Insight Dashboard won't be made available.

Once you have opted in, you can consult your Switch Insight Dashboard from within Switch or
via the account section on enfocus.com (see Consulting your Switch Insight Dashboard on page
487).

Note that this Dashboard is visible to all Switch managers:

• Anyone who has signed in at least once to the Switch Designer.
• Anyone who has been added as Switch manager via the account section on enfocus.com (see

Adding a Switch manager on page 312).

6.1.  Enabling your Switch Insight Dashboard
Enfocus provides a free, personal Switch Insight Dashboard with weekly statistics, exclusively
for its Switch maintenance customers.

To make use of this feature, proceed as follows:

1. Make sure you're signed into Switch with your Enfocus ID.

You can sign in through the About Enfocus Switch dialog (Sign in tab):

• On Windows, go to Help > About Switch

• On Mac, go to Enfocus Switch > About Enfocus Switch

This is necessary because your Switch Insight Dashboard will be linked to your Enfocus
ID (and Switch Server).

2. Click Insight Dashboard > Opt in/Opt out.

3. Read the information and click Yes, I'd like my Dashboard.

Your personal Dashboard is prepared and will be available the next day. Note that you can opt
out whenever you want (via the same menu).
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6.2.  Consulting your Switch Insight Dashboard
Once you have enabled your Switch Insight Dashboard, you have access to charts and statistics
about your usage of Switch. There are two ways to consult your Insight Dashboard:

• From within Switch: Click Insight Dashboard > My Switch Insight Dashboard.
• Via the Enfocus website:

1. Go to http://www.enfocus.com.
2. In the top right corner, click Sign in.
3. Enter your Enfocus ID and password and click Sign in.
4. Click your username to open the account section.
5. Click My Dashboards > My Switch Insight Dashboard.

Note that you can make your Switch Insight Dashboard visible to other users, by making them
manager of your Switch (see Adding a Switch manager on page 312). Remember however that
this also gives them other permissions (e.g. to buy apps).
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7.  Advanced topics

7.1.  Managing application data

About the Switch application data

Switch stores a lot of application-specific data, such as:

• Flow definitions (defined or imported with the flow designer).
• Auto-managed backing folders (and their contents, i.e. jobs being processed through flows).
• Internal job tickets pointing to jobs being processed.
• Log messages.

All this data is stored in a nested folder hierarchy under a single root folder, which is called the
application data root.

The location of the application data root can be found in the Application data preference.

Administrator tools
We provide Switch administrators with two tools related to the application data:

• The Application Data Root Tool allows you to back up, restore and/or change the application
data root. Note that changing the data in the application data root is not allowed!

• The Data Collecting Wizard allows you to collect application data for the Enfocus Support team
(when they need more information on your Switch setup).

7.1.1.  The Application Data Root Tool

About the Application Data Root Tool

The Application Data Root Tool allows you to:

• Create a backup of all your Switch data. We recommend doing this before upgrading or
downgrading Switch. It's also needed when you want to move your Switch installation to a
different computer.

• Restore a previous version (on condition you have made a backup), for example in case of
problems with a newer installation.

• Determine a new location for the Switch application data. This is a way to keep data of multiple
Switch versions/installations on one and the same system, for example for beta testing.

The tool can be found in the Switch installation directory:

• Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe
• Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app

Use case 1: Moving your Switch installation to a different computer

Note:  This new computer may have a different operating system as well,as switching
between operating systems is supported (Mac to Win or vice versa).
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If you want to move your Switch installation to a different computer, these are the steps to take:

1. Make a backup of your Switch application data root location (using the Application Data Root
Tool). Make sure to include all info about active jobs (select the checkbox!) and do not forget
to make a backup of your user-managed folders yourself.

2. Copy the backup to the new computer.
3. Install Switch on the new computer.
4. Restore the backup of the application data root tool (using the Application Data Root Tool).

Include the active jobs.

Use case 2: Using different data application root folders for (beta) testing
Best practice:

1. Install the test version (do not launch Switch Designer!).
2. Set a new Switch application data root location (using the Application Data Root Tool). Do not

move any existing data.
3. Start Switch Designer and test the new version. All data used for testing will be stored in the

new data root location.
4. When testing is finished, change the application data root location back to the original

location (using the Application Data Root Tool).

7.1.1.1.  Making a backup of your Switch installation
This procedure explains how you can make a backup of your Switch application data using
the Application Data Root Tool. The backup includes all data related to flows, properties,
preferences, etc. and (optionally) information about active jobs. Note however that data in user-
managed folders is never stored via the Application Data Root Tool! If you want to keep this data,
make sure to keep it somewhere safe yourself.

Important:  You must be logged in with the user account that was used to start Switch
Server. On Windows, you can select the appropriate user via the backup tool; on Mac,
you must make sure to be logged in with the correct user before starting up the tool.

Proceed as follows:

1. Make sure Switch is not running.

Remember that you can stop all Switch processes via the Switch Designer, by clicking File >
Stop Switch Switch Server.

Ideally, you make a backup right after having installed Switch 2019, just before opening the
Switch Designer for the first time. For future versions, we recommend making a backup
before installing the new Switch version.

2. Launch the Application Data Root Tool.

The tool can be found in the Switch installation directory:

• Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe

• Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app

3. On Windows, select the user account that was used to start the Switch Server.

• If the required user is not in the list, you can add it yourself. Note you will be asked to
enter this user's password.
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• Depending on the configuration of your system, it may be necessary to run the
Application Data Root Tool as an administrator or with elevated permissions.

• Roaming user profiles and users with an empty password are not allowed to select
another user; instead, they should start the Application Data Root Tool using the user
account concerned.

4. Select the Create a backup of the current Switch application data root radio button.

The current application data root folder is mentioned at the top of this dialog. This is
relevant if you have multiple folders with Switch data on your system. If you want a backup of
a different application data root folder, you must first change the application data root folder
(last option in the tool) to the one you want to back up.

5. Select a backup location.

6. If applicable, clear Include jobs in auto-managed folders and info related to all active jobs
in the flows

This option is selected by default and makes sure that job data, such as job tickets,
datasets, global data, … of jobs in auto-managed folders is included in the backup. This is the
preferred option if you're moving Switch data to another location (so you still need this data).
If you only want to take a backup and restore it later after running production for a couple
of weeks, you probably won't need the job info, because the jobs concerned will have been
processed already by that time. Note that this also means that the historical data for this
period will be lost.

7. Click Proceed.

The Switch data root folders are copied to the new location and can be used to restore the
current version as required.

7.1.1.2.  Restoring a previous version of your Switch installation
If you have made a backup of your Switch installation, you can easily restore it to go back to a
previously installed version of the software. Note that the data in the application data root will
be overwritten, so it may be good to first make a backup.

Important:  You must be logged in with the user account that was used to start Switch
Server. On Windows, you can select the appropriate user via the Application Data Root
Tool; on Mac, you must make sure to be logged in with the correct user before starting
up the tool.

Proceed as follows:

1. Make sure Switch is not running.

Remember that you can stop all Switch processes via the Switch Designer, by clicking File >
Stop Switch Switch Server.

2. Launch the Application Data Root Tool.

The tool can be found in the Switch installation directory:

• Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe

• Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app
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3. On Windows, select the user account that was used to start the Switch Server.

• If the required user is not in the list, you can add it yourself. Note you will be asked to
enter this user's password.

• Depending on the configuration of your system, it may be necessary to run the
Application Data Root Tool as an administrator or with elevated permissions.

• Roaming user profiles and users with an empty password are not allowed to select
another user; instead, they should start the Application Data Root Tool using the user
account concerned.

4. Select the Restore a backup of the Switch application data root to the current Switch
application data root location radio button.

If you are not happy with the current application data root location (mentioned at the top of
the dialog), you should first change it by selecting the last option in this dialog.

5. Select the location where the backup was stored.

6. Optionally select Restore jobs in auto-managed folders and info related to all active jobs in
the flows.

Obviously, job data can only be restored if it has been included in the backup (refer to Making
a backup of your Switch installation on page 489).

Remember that jobs in user-managed folders are not included in the backup.

7. Click Proceed.

Note that all data in the current data root location will be overwritten.

8. Read the warning and click Yes to confirm.

7.1.1.3.  Changing the application data root
If you want to easily switch between Switch installations, you can use different locations for the
application data. For example, you could move to another data root for testing a new version,
and afterwards move back to the original version.

Important:  You must be logged in with the user account that was used to start Switch
Server. On Windows, you can select the appropriate user via the Application Data Root
Tool; on Mac, you must make sure to be logged in with the correct user before starting
up the tool.

Proceed as follows:

1. Make sure Switch is not running.

Note that you can stop all Switch processes via the Switch Designer, by clicking File > Stop
Switch Switch Server.

2. Launch the Application Data Root Tool.

The tool can be found in the Switch installation directory:

• Windows: C:\Program Files\Enfocus\Enfocus Switch\ApplicationDataRootTool.exe

• Mac OS: /Applications/Enfocus/Enfocus Switch/ApplicationDataRootTool.app

3. On Windows, select the user account that was used to start the Switch Server.
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• If the required user is not in the list, you can add it yourself. Note you will be asked to
enter this user's password.

• Depending on the configuration of your system, it may be necessary to run the
Application Data Root Tool as an administrator or with elevated permissions.

• Roaming user profiles and users with an empty password are not allowed to select
another user; instead, they should start the Application Data Root Tool using the user
account concerned.

4. Select the Set new Switch application data root location radio button.

5. Click Browse to select the new application data root folder.

This should be an empty folder on your local system. (Note that only for upgrade
installations (upgrade from Switch 2018 or earlier) it's still possible (but not recommended)
to use a network location).

6. If applicable, clear Move data from the current Switch application data root to the new
location

This option is selected by default but can be cleared as required, for example if you want a
clean installation.

7. Click Proceed.

Next time Switch is started, the new location will be used to store the Switch application data.
Note that you can double-check the location of the application data root in the Application data
preference in Switch Designer.

7.1.2.  The Data Collecting Wizard

About the Data Collecting Wizard

The Data collecting wizard is a tool that automatically collects the Switch data files, which are
requested by the Enfocus Support team when they need more information on your Switch setup.

The tool collects the following data:

• Flows
• Preference files
• Job tickets
• logs .db3 file (ServerLogs.db3)
• Information about the Switch files installed on the user's system (layout, name, size,

modification date)
• Relevant registry/plist records
• Information from the Support tab in the About dialog box

• Job datasets

The tool creates a zip package that can be sent to the Enfocus Support team.

Note:  As the file size might be an issue (the .db3 files may be a few GB in size and the
jobtickets may be a 100MB or more), you can as a user exclude certain data files from
the collection.
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Two versions

The Data Collecting Wizard is provided in two versions:

• A stand-alone version (SwitchDataCollector.exe or SwitchDataCollector.app), available in
the Switch installation folder.

• Windows: C:\Program Files (x86)\Enfocus\Enfocus Switch

• Mac OS: /Applications/Enfocus/Enfocus Switch

• A built-in version, available from within Switch through the File menu (File > Collect
application data).

The main difference between the two versions, is the way the flows are collected. Flows in a
Switch installation are a combination of XML and Property sets in various folders. When a user
chooses "Export" in the Designer UI, the XML and Property sets are combined in a file with
extension .sflow. As this logic is difficult to extract outside Server, the stand-alone version does
not offer the .sflow files (only the raw XML and Property sets). Besides, in the stand-alone version
you have to collect either all or none of the .sflow files. You cannot make a selection.

Apart from that, only the stand-alone version allows you to collect data if Switch is not launched
or cannot be launched anymore for any reason. If Switch is running, you are asked to quit.

Using the Data Collecting Wizard

Refer to Collecting application data on page 493.

7.1.2.1.  Collecting application data
To collect the Switch application data

1. Do one of the following:

• Locate the SwitchDataCollector in the Switch installation directory (make sure Switch is
closed!).

• In Switch, choose File > Collect application data.

For more information about the difference, refer to The Data Collecting Wizard on page 492.

The Switch Data Collecting Wizard Welcome screen appears.

2. Click Next.

3. Select the data you want to include in the resulting zip package.

You have the following choices:

• Logs: Server logs in a .db3 file (entire folder "<app_data_root>\logs")

• Preferences: Switch preferences XML (entire folder "<app_data_root>\settings")

• Datasets: Jobs datasets (entire folder "<app_data_root>\datasets")

• Application settings: Switch settings extracted from the registry (on Windows) or plist
files (on Mac). The extracted data is put into an ApplicationSettings.txt file. On Mac, actual
plist files are also included in the zip. This checkbox cannot be cleared.
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• Layout description: Description of Switch installation files, saved into a file called
‘Report.txt'. It includes a listing of all files and folders with their attributes (size,
modification date, permissions etc.) from the Switch installation folder. This checkbox
cannot be cleared.

• Internal log messages: Internal log files for all processes with a more detailed
description of errors and operations. This checkbox cannot be cleared.

Note:  If the file size becomes too big or if collecting files takes too much time, you
may want to exclude certain data types.

4. Choose a destination for the resulting zip package and click Next.

You can as well change the name of the zip package as required. The default name has
the following format: "Switch Data "<current date> <nn-nn-nn>.zip", e.g. Switch Data
2015-09-14 10-29-30.zip.

5. Select the flows you want to collect and click Next.

If you're using the stand-alone version of the tool, you must either select all flows or none;
it's not possible to select a subset.

Îf you're using the Designer version, all flows are displayed in alphabetical order. They are
selected by default, but you can clear the ones you don't need. Note that advanced features
(like grouping, sorting, flags etc) are not supported.

A summary of the chosen options is shown. You can still make changes as required by
clicking the Back button.

6. Click Commit.
The data collection starts.

Note:

• If the wizard is launched from the Switch Designer, it deactivates all active flows,
before collecting the data. Afterwards, the flows are re-activated.

• You can stop the data collection (for example if it takes too much time) by clicking
Abort. However, aborting can be performed only between steps, for example:
between collecting flows and exporting logs. The Wizard will wait until the
previous step is finished and will only then abort the collection process.

7. Once the zip package has been created, click Close.
The zip package is placed in the location chosen in step 4. The structure is very simple: each
data part is placed in a separate subfolder, e.g. Application Data, ExportedFlows, Report,
and Settings. The content of the Application Data subfolder mirrors the contents of the
actual Switch application data root.

If the wizard was launched from Switch, the Report folder will contain a file named
"AboutDialog.txt, which contains information extracted from the About box in Designer.
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7.2.  Switch performance tuning
The performance of Switch is affected by the processes that are being executed, such as file
handling, network transfers and external processes.

To avoid that Switch slows down because too many processes are running at the same time,
there are limits set to the number of concurrent processes. Changing these limits allows you to
tune the Switch performance.

Note:  Do not forget that other aspects, such as computer specifications and network
speed can also affect overall performance.

File handling tasks

Handling files, such as copying or moving files and folders is limited to 5 simultaneous tasks
(see Execution slots on page 301). It is not possible to change this number of concurrent file
transfers.

Flow elements involved:

• Export metadata
• Job dismantler
• Recycle bin
• XML pickup, JDF pickup, XMP pickup, Opaque pickup
• Problem jobs
• Submit hierarchy
• Submit point
• Checkpoint
• Generic application
• XSLT Transform
• Archive hierarchy
• File type
• Folder element

Network transfer tasks

The number of concurrent network file transfers can be set in the Switch preferences
(Preferences > Processing > Concurrent network transfer tasks). The default is set to 2 and
the maximum limit is 100.

Flow elements involved:

• FTP send
• FTP receive
• Mail send
• Mail receive
• Checkpoint via mail
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File processing tasks
The number of tasks required to process files by using one of the flow elements listed below
simultaneously can be set in the Switch preferences (Preferences > Processing > Concurrent
processing tasks).

By default this preference is set to 4 simultaneous processes (that is the maximum available
with a regular Switch Core Engine license), but licensing additional processes can expand this
limit to a maximum of 100.

Flow elements involved:

• All flow elements in the Apps and Configurators sections
• The following elements in the Basics section:

• Set hierarchy path
• Ungroup job
• Split multi-job
• Assemble job
• Execute command

• The following elements in the Tools section:

• Sort by preflight state
• Archive
• Unarchive
• Split PDF
• Merge PDF
• Hold job
• Inject job
• Rename job
• Sort job
• Log job info
• Sort files in job

• The Script element in the Scripting section:

Custom scripts are affected by the "Concurrent processing tasks" preference as soon as
the script is a "heavy script".  A script is considered to be "heavy", if it takes longer than one
second to execute.

Light scripts, timerFired, webhookTriggered and flowStopTriggered calls belong to separate
categories and these processes are calculated in a different way. For more details, see
Execution slots on page 301.

• The following elements in the Communication section:

• HTTP request
• Pack job
• Unpack job
• Monitor confirmation

• The XMP inject element in the Metadata section.

• The Database connect element in the Database section.
• The following elements in the Legacy section:

• Compress
• Uncompress
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Accumulative limitation
Each task listed has its own upper limit. In addition to this, Switch is limited to an upper limit of
200 for all simultaneous tasks. This is the accumulation of File Handling, Network Transfers and
External processes.

For more information on Switch Preferences see User Preferences.

For more information on tuning performance for file processing tasks, see Changing flow
properties.
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8.  Need more help?
1. Consult the product documentation

Documentation Description Where to find?

Quick Start
Guide

Switch basic information

Consult this guide if you're
new to Switch.

Go to the Switch manuals on the Enfocus
website. Alternatively, to go there
from within the application, select
the Help > Online resources > Online
documentation menu.

Reference
Guide

Switch detailed information
and advanced topics

Go to the Switch manuals on the Enfocus
website. Alternatively, to open the help
from within the application, press F1 or
select the Help > Switch help menu.

Switch
Scripting
Documentation

Switch scripting reference Go to the Switch manuals on the Enfocus
website. Alternatively, to go there
from within the application, select
the Help > Online resources > Online
documentation menu.

Example
Scripts

Example scripts, with a short
explanation and the option to
download

Go to the Switch manuals on the Enfocus
website. Alternatively, to go there
from within the application, select
the Help > Online resources > Online
documentation menu.

Configurator
Documentation

Documentation about the
Switch configurators

To get information about a configurator

1. Open Switch in a workspace view.
2. In the Flow elements pane, right-

click a configurator.
3. Click Documentation...

2. Consult the Solution articles in the Enfocus knowledge base

The Enfocus knowledge base provides answers to frequently asked questions, workarounds,
and tips and tricks.

To access the knowledge base, go to: https://www.enfocus.com/en/support/known-issues-and-
solutions.

Note:  Alternatively, you can go there from within Switch, by selecting the Help >
Solution articles menu.

3. Visit the Switch Partner integrations overview

As of June 2016, Crossroads, the community portal around Enfocus Switch, has been replaced
with the Switch Partner integrations overview on the Enfocus website. Here you can find all
information about partner integrations and download flows and configurators.

You can use the following link: https://www.enfocus.com/en/products/switch/partner-integrations.
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Note:  Alternatively, you can access this overview from within the application, by
selecting the Help > Online resources > Partner integrations menu.

4. Visit the Enfocus Community

The Enfocus Community is a forum where you can exchange ideas with other users of Enfocus
software.

URL: http://forum.enfocus.com/

5. Contact your reseller

A list of authorized resellers is available on the Enfocus web site (http://www.enfocus.com/
FindReseller.php).

6. Contact Enfocus customer support

If you cannot find the answer to your question in Switch help or on the web, create a case on the
website at http://www.enfocus.com/supportportal.
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9.  Copyrights
© 2020 Enfocus BV all rights reserved. Enfocus is an Esko company.

Certified PDF is a registered trademark of Enfocus BV.

Enfocus PitStop Pro, Enfocus PitStop Workgroup Manager, Enfocus PitStop Server, Enfocus
Connect YOU, Enfocus Connect ALL, Enfocus Connect SEND, Enfocus StatusCheck, Enfocus
CertifiedPDF.net, Enfocus PDF Workflow Suite, Enfocus Switch, Enfocus SwitchClient, Enfocus
SwitchScripter and Enfocus Browser are product names of Enfocus BV.

Adobe, Acrobat, Distiller, InDesign, Illustrator, Photoshop, FrameMaker, PDFWriter,
PageMaker, Adobe PDF Library™, the Adobe logo, the Acrobat logo and PostScript are
trademarks of Adobe Systems Incorporated.

Datalogics, the Datalogics logo, PDF2IMG™ and DLE™ are trademarks of Datalogics, Inc.

Apple, Mac, Mac OS, Macintosh, iPad and ColorSync are trademarks of Apple Computer,
Inc. registered in the U.S. and other countries. Windows and Windows Server are registered
trademarks of Microsoft Corporation.

PANTONE® Colors displayed here may not match PANTONE-identified standards. Consult
current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, Inc.
trademarks are the property of Pantone, Inc. ©Pantone, Inc., 2006.

OPI is a trademark of Aldus Corporation.

Quark, QuarkXPress, QuarkXTensions, XTensions and the XTensions logo among others, are
trademarks of Quark, Inc. and all applicable affiliated companies, Reg. U.S. Pat. & Tm. Off. and
in many other countries.

This product and use of this product is under license from Markzware under U.S.Patent No.
5,963,641.

Other brand and product names may be trademarks or registered trademarks of their
respective holders. All specifications, terms and descriptions of products and services are
subject to change without notice or recourse.
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10.  Third-Party License Information
The third-party applications included in Switch are listed below. Additional information
about third-party licenses can be found in the Resources > Licenses subfolder of the Switch
installation folder.

 This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2009 Jack Lloyd
      2001 Peter J Jones
      2004-2007 Justin Karneges
      2004 Vaclav Ovsik
      2005 Matthew Gregan
      2005-2006 Matt Johnston
      2006 Luca Piccarreta
      2007 Yves Jerschow
      2007-2008 FlexSecure GmbH
      2007-2008 Technische Universitat Darmstadt
      2007-2008 Falko Strenzke
      2007-2008 Martin Doering
      2007 Manuel Hartl
      2007 Christoph Ludwig
      2007 Patrick Sona
      2010 Olivier de Gaalon
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:

      1. Redistributions of source code must retain the above copyright
      notice, this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
      notice, this list of conditions, and the following disclaimer in the
      documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
      IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
      WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
      ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
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      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
      BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
      WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
      OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
      IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
    
------------------------------------------------------------

This product includes PANTONE Color Libraries.

    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
    
------------------------------------------------------------

This product includes curl.

      Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.
      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.

      Except as contained in this notice, the name of a copyright holder shall not
      be used in advertising or otherwise to promote the sale, use or other dealings
      in this Software without prior written authorization of the copyright holder.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
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      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes Minizip.

       Copyright (C) 1998-2005 Gilles Vollant
      Modifications of Unzip for Zip64
       Copyright (C) 2007-2008 Even Rouault
      Modifications for Zip64 support on both zip and unzip
       Copyright (C) 2009-2010 Mathias Svensson
       http://result42.com
      Modifications for AES, PKWARE disk spanning
       Copyright (C) 2010-2014 Nathan Moinvaziri

      This software is provided 'as-is', without any express or implied
      warranty.  In no event will the authors be held liable for any damages
      arising from the use of this software.
    
------------------------------------------------------------

This product includes zlib.

      Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler

      This software is provided 'as-is', without any express or implied
      warranty.  In no event will the authors be held liable for any damages
      arising from the use of this software.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes Google Breakpad.

      Copyright (c) 2006, Google Inc. All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:
      * Redistributions in binary form must reproduce the above
      copyright notice, this list of conditions and the following disclaimer
      in the documentation and/or other materials provided with the
      distribution.
      * Neither the name of Google Inc. nor the names of its
      contributors may be used to endorse or promote products derived from
      this software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
      OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
      LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
      DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
      THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
      (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
      OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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------------------------------------------------------------

This product includes curl.

      Copyright (c) 1996 - 2011, Daniel Stenberg, <daniel@haxx.se>.
      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes Google Logging Library (glog).

      Copyright (c) 2008, Google Inc.
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:
      * Redistributions of source code must retain the above copyright
      notice, this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above
      copyright notice, this list of conditions and the following disclaimer
      in the documentation and/or other materials provided with the
      distribution.
      * Neither the name of Google Inc. nor the names of its
      contributors may be used to endorse or promote products derived from
      this software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
      OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
      LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
      DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
      THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
      (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
      OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Protocol Buffers.

      Copyright (c) 2008, Google Inc.
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:

      * Redistributions in binary form must reproduce the above
      copyright notice, this list of conditions and the following disclaimer
      in the documentation and/or other materials provided with the
      distribution.
      * Neither the name of Google Inc. nor the names of its
      contributors may be used to endorse or promote products derived from
      this software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
      OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
      LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
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      DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
      THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
      (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
      OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes gSOAP.

      EXHIBIT B.
      
      Part of the software embedded in this product is gSOAP software.
      Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
 Genivia inc. All Rights Reserved.

      THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
 OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
 SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
 OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
 GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
 CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
 TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICU.

      Copyright (c) 1995-2014 International Business Machines Corporation and others
      All rights reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal in
 the
      Software without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of the Software,
 and
      to permit persons to whom the Software is furnished to do so, provided that the
      above copyright notice(s) and this permission notice appear in all copies of the
      Software and that both the above copyright notice(s) and this permission notice
      appear in supporting documentation.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
      SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
      CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
      WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
      CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
      WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes iODBC.

      Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin.
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

       1. Redistributions of source code must retain the above copyright notice,
          this list of conditions and the following disclaimer.
       2. Redistributions in binary form must reproduce the above copyright
          notice, this list of conditions and the following disclaimer in the
          documentation and/or other materials provided with the distribution.
       3. Neither the name of OpenLink Software Inc. nor the names of its
          contributors may be used to endorse or promote products derived from
          this software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS
      BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
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      OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
      THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes Little CMS.

    Little CMS
    Copyright (c) 1998-2011 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes libpng.

      Copyright (c) 2000-2002 Glenn Randers-Pehrson

      The PNG Reference Library is supplied "AS IS".  The Contributing Authors
      and Group 42, Inc. disclaim all warranties, expressed or implied,
      including, without limitation, the warranties of merchantability and of
      fitness for any purpose.  The Contributing Authors and Group 42, Inc.
      assume no liability for direct, indirect, incidental, special, exemplary,
      or consequential damages, which may result from the use of the PNG
      Reference Library, even if advised of the possibility of such damage.
      There is no warranty against interference with your enjoyment of the
      library or against infringement.  There is no warranty that our
      efforts or the library will fulfill any of your particular purposes
      or needs.  This library is provided with all faults, and the entire
      risk of satisfactory quality, performance, accuracy, and effort is with
      the user.
    
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:
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    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes mongodb.

        Copyright (c) 2018 MongoDB, Inc.

        THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
        APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
        HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM тАЬAS ISтАЭ WITHOUT WARRANTY
        OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
        THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
        PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM
        IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF
        ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes IP*Works!.

      Copyright (c) 2017 /n software inc. - All rights reserved.

      DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
 WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
 SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE
 USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS
 OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS
 TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL
 OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE
 A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY
 ON ANY SUCH INFORMATION OR ADVICE.  FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-
TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE
 CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS
 IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS,
 AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE
 FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR
 SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS
 SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH
 RISK ACTIVITIES.
      LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
 IN NO EVENT WILL /N SOFTWARE'S TOTAL AGGREGATE AND CUMULATIVE LIABILITY TO YOU FOR
 ANY AND ALL CLAIMS OF ANY KIND ARISING HEREUNDER EXCEED THE AMOUNT OF LICENSE FEES
 ACTUALLY PAID BY YOU FOR THE LICENSED SOFTWARE GIVING RISE TO THE CLAIM IN THE TWELVE
 MONTHS PRECEDING THE CLAIM. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO
 LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF
 USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING,
 IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS
 BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL,
 INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION,
 ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
 LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY
 PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE
 SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT
 ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
 MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE
 SEVERABLE.
    
------------------------------------------------------------

This product includes IP*Works! SSH.

      Copyright (c) 2017 /n software inc. - All rights reserved.
      
      DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
 WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
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 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
 SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE
 USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS
 OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS
 TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL
 OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE
 A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY
 ON ANY SUCH INFORMATION OR ADVICE.  FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-
TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE
 CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS
 IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS,
 AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE
 FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR
 SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS
 SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH
 RISK ACTIVITIES.
      LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
 IN NO EVENT WILL /N SOFTWARE'S TOTAL AGGREGATE AND CUMULATIVE LIABILITY TO YOU FOR
 ANY AND ALL CLAIMS OF ANY KIND ARISING HEREUNDER EXCEED THE AMOUNT OF LICENSE FEES
 ACTUALLY PAID BY YOU FOR THE LICENSED SOFTWARE GIVING RISE TO THE CLAIM IN THE TWELVE
 MONTHS PRECEDING THE CLAIM. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO
 LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF
 USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING,
 IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS
 BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL,
 INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION,
 ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
 LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY
 PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE
 SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT
 ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
 MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE
 SEVERABLE.
    
------------------------------------------------------------

This product includes sqlite3.

Copyright (c) MapBox
All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this
  list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this
  list of conditions and the following disclaimer in the documentation and/or
  other materials provided with the distribution.
- Neither the name "MapBox" nor the names of its contributors may be
  used to endorse or promote products derived from this software without
  specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes javascript-obfuscator.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

  * Redistributions of source code must retain the above copyright
    notice, this list of conditions and the following disclaimer.
  * Redistributions in binary form must reproduce the above copyright
    notice, this list of conditions and the following disclaimer in the
    documentation and/or other materials provided with the distribution.

508



Switch

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL <COPYRIGHT HOLDER> BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
       
        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
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         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes patented technology.

      This product and use of this product is under license from Markzware
      under U.S. Patent No. 5,963,641.
    
------------------------------------------------------------

This product includes Python.

      Copyright (c) 2001, 2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011,
 2012 Python Software Foundation. All Rights Reserved.
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      PSF is making Python available to Licensee on an "AS IS"
      basis.  PSF MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR
      IMPLIED.  BY WAY OF EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND
      DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS
      FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON WILL NOT
      INFRINGE ANY THIRD PARTY RIGHTS.

      PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
      FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS
      A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON,
      OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.
    
------------------------------------------------------------

This product includes Qt Script for Applications (QSA).

      Copyright (C) 1992-2007 Trolltech AS. All rights reserved.

      This software is provided AS IS with NO WARRANTY OF ANY KIND, INCLUDING THE
      WARRANTY OF DESIGN, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
    
------------------------------------------------------------

This product includes Qt.

      The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C)
 2019 The Qt Company Ltd.

      Portions of this software are copyright (C) 2006-2015 The FreeType Project
 (www.freetype.org). All rights reserved.
      
      Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
      This software is based in part on the work of the Independent JPEG Group.
      
      Secure Hash Algorithm SHA-3 - brg_endian
      Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

      LICENSE TERMS

      The redistribution and use of this software (with or without changes)
      is allowed without the payment of fees or royalties provided that:

       1. source code distributions include the above copyright notice, this
          list of conditions and the following disclaimer;

       2. binary distributions include the above copyright notice, this list
          of conditions and the following disclaimer in their documentation;

       3. the name of the copyright holder is not used to endorse products
          built using this software without specific written permission.

      DISCLAIMER

      This software is provided 'as is' with no explicit or implied warranties
      in respect of its properties, including, but not limited to, correctness
      and/or fitness for purpose.
    
------------------------------------------------------------

This product includes QtActiveQt.

        Copyright (C) 2017 The Qt Company Ltd.
        
        Redistribution and use in source and binary forms, with or without
 modification, 
        are permitted provided that the following conditions are met: *
 Redistributions of 
        source code must retain the above copyright notice, this list of conditions
 and the 
        following disclaimer. * Redistributions in binary form must reproduce the
 above 
        copyright notice, this list of conditions and the following disclaimer in the 
        documentation and/or other materials provided with the distribution. * Neither
 the 
        name of The Qt Company Ltd nor the names of its contributors may be used to
 endorse 
        or promote products derived from this software without specific prior written 
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        permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
 AND ANY 
        EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
 WARRANTIES 
        OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
 EVENT 
        SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
        INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
 LIMITED 
        TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
 PROFITS; OR 
        BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
 IN 
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 ARISING IN 
        ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 SUCH 
        DAMAGE.
    
------------------------------------------------------------

This product includes QtDeclarative.

      The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.
    
------------------------------------------------------------

This product includes QtCopyDialog.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------
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This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes Qt SQL driver plugin (qsqlodbc).

      Copyright (C) 1992-2008 Trolltech ASA. All rights reserved.

      Warranty Disclaimer: The Licensed Software is licensed to Licensee
      "as is". To the maximum extent permitted by applicable law, Trolltech on
      behalf of itself and its suppliers, disclaims all warranties and
      conditions, either express or implied, including, but not limited to,
      implied warranties of merchantability, fitness for a particular purpose,
      title and non-infringement with regard to the Licensed Software.
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      Limitation of Liability: If, Trolltech's warranty disclaimer
      notwithstanding, Trolltech is held liable to Licensee, whether in
      contract, tort or any other legal theory, based on the Licensed
      Software, Trolltech's entire liability to Licensee and Licensee's
      exclusive remedy shall be, at Trolltech's option, either (A) return of
      the price Licensee paid for the Licensed Software, or (B) repair or
      replacement of the Licensed Software, provided Licensee returns to
      Trolltech all copies of the Licensed Software as originally delivered to
      Licensee. Trolltech shall not under any circumstances be liable to
      Licensee based on failure of the Licensed Software if the failure
      resulted from accident, abuse or misapplication, nor shall Trolltech
      under any circumstances be liable for special damages, punitive or
      exemplary damages, damages for loss of profits or interruption of
      business or for loss or corruption of data. Any award of damages from
      Trolltech to Licensee shall not exceed the total amount Licensee has
      paid to Trolltech in connection with this Agreement.
    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtWebEngine.

      The software uses QtWebEngine, licensed under LGPL v3. The Qt Toolkit is
 Copyright (C) 2019 The Qt Company Ltd.
    
------------------------------------------------------------

This product includes chromium.

        Copyright 2015 The Chromium Authors. All rights reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:

           * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
           * Redistributions in binary form must reproduce the above
        copyright notice, this list of conditions and the following disclaimer
        in the documentation and/or other materials provided with the
        distribution.
           * Neither the name of Google Inc. nor the names of its
        contributors may be used to endorse or promote products derived from
        this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes jQuery CookieBar.

      UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING, LICENSOR

514



Switch

      OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY
      KIND CONCERNING THE WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE,
      INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE, MERCHANTIBILITY,
      FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR THE ABSENCE OF
      LATENT OR OTHER DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS,
      WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE
      EXCLUSION OF IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

      Limitation on Liability.* EXCEPT TO THE EXTENT REQUIRED BY
      APPLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL
      THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY
      DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF
      LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes UnRAR.

      Copyright (c) 1993 Alexander Roshal

      THE RAR ARCHIVER AND THE UNRAR UTILITY ARE DISTRIBUTED "AS IS".
      NO WARRANTY OF ANY KIND IS EXPRESSED OR IMPLIED.  YOU USE AT
      YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
      DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING
      OR MISUSING THIS SOFTWARE.
    
------------------------------------------------------------

This product includes XMP Toolkit.

      Copyright (c) 1999 - 2010, Adobe Systems Incorporated
      All rights reserved.

      Redistribution and use in source and binary forms, with or
      without modification, are permitted provided that the following
      conditions are met:

      * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the documentation
      and/or other materials provided with the distribution.
      * Neither the name of Adobe Systems Incorporated, nor the names of its
      contributors may be used to endorse or promote products derived from this
      software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
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      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes zlib.

      Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler

      This software is provided 'as-is', without any express or implied
      warranty.  In no event will the authors be held liable for any damages
      arising from the use of this software.
    
------------------------------------------------------------
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